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1.1

1.2

1.3

Introduction

About This Guide and Related Documentation

This document is intended for MOTOTRBO radio network administrators as well as
dispatchers responsible for the TRBOnet dispatch console operations. It provides
guidance on the installation, configuration, and maintenance of the TRBOnet Server
and Dispatch Console applications.

About TRBOnet

TRBOnet is a suite of professional applications for MOTOTRBO digital two-way radio
networks. TRBOnet manages voice and data communication paths across network
endpoints. It provides a unified graphical dispatcher workbench interface for the
entire range of workforce fleet management tasks.

Contacts
Region Phone Email & Support

EMEA +44 203 608 0598 .
info@trbonet.com — general and
commercial inquiries

Americas +1872 222 8726 support@trbonet.com — technical
support
http://kb.trbonet.com — online

APAC +61 28 607 8325 knowledge base
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2 Hardware and Software Requirements
TRBOnet Server/Agent with IP connection only ‘
Voice Channels | 4 8 16 24 24+
CPU Intel Core i3 Intel Core i5 Intel Core i7, 4 Cores Intel Core i7, 6
Cores
Contact
Memory 2 GB 4 GB 4GB 8 GB technical
HDD 300 MB for installation files, +1 MB per 1 minute of voice recording support
Sound Card No

Supported OS

Windows 7/8.x/10, Windows Server 2008/2012/2016

Note:

Windows Server 2008/2012/2016 requires Desktop Experience
Role/Feature installed.

Software

.NET Framework 4.6.x, MS SQL Server 2008 R2 or higher

TRBOnet Server /Agent with Control Stations

Control Stations 1 2+

CPU Intel Core i5

Memory 2 GB

HDD 300 MB for installation files, +1 MB per 1 minute of voice recording
Multi-channel Sound Card required;
Recommended:

Sound Card Integrated sound card can be used. 1. M-Audio Delta 1010 LT

2. Roland OCTA CAPTURE Hi-SPEED USB
Audio Capture

Additional Devices

Cable connector Motorola PMKN4016

Supported OS

Windows 7/8.x/10

Software

.NET Framework 4.6.x, MS SQL Server 2008 R2 or higher

Dispatch Console ‘

CPU Intel Core i3

Memory 4 GB

HDD 70 MB for installation files

Sound Card Yes

Display 1280x1024 minimum resolution, 1600x900 recommended resolution

Additional Devices

Speakers and microphone, or headset; Imtradex devices are recommended

Supported OS

Windows 7/8.x/10

Software

.NET Framework 4.6.x

TRBOnet Enterprise — User Manual
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System Architecture Overview
TRBOnet Server, Agent and Console

The TRBOnet software is designed as a client-server architecture,

where TRBOnet Server is PC-based and runs as a Windows service on a network
computer, stores data in an MS SQL database, and allows client connections from
Web Consoles, Dispatch Consoles, and Mobile Clients. The TRBOnet service can be
located on a dedicated remote PC, a local PC (along with the Dispatch Console), or
on a virtual machine.

In addition, remote software agents, such as TRBOnet Agent, and/or hardware
agents, such as TRBOnet Swift A200, can be connected to TRBOnet Server providing
additional voice and data communications paths to and from remote sites. Such
configurations can be used when radio equipment can't be connected directly to
TRBOnet Server due to IP network limitations (see section 3.3, IP Backend Network

Requirements).
TRBOnet Dispatch Console is a PC-based voice dispatch and data application for
MOTOTRBO professional digital two-way radio systems.

TRBOnet Server

TRBOnet Agent

FEE

Local
Radio Infrastructure

Radio Infrastructure

TRBOnet
Web Console

TRBOnet
Dispatch Console
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3.2
3.2.1

3.2.2

MOTOTRBO Radio Systems
Single Site conventional system

A Single Site conventional system is a digital conventional two-way MOTOTRBO
system that includes one digital repeater and allows you to transmit voice and data
via two conventional channels. Radio groups and radio units are assigned to these
conventional radio channels.

IP Site Connect

An IP Site Connect (IPSC) system is a digital conventional two-way MOTOTRBO
system that provides two wide-area channels to increase your communications RF
coverage area. It is possible to connect up to 15 repeaters (each geographical
location of a repeater is called a "site") into one system using an IP connection,
which allows increasing the coverage area for voice and data transmissions. The
main objective of an IPSC system is to provide a stable connection between the
radio units and control centers regardless of the distance.

1% 2% 3%
L& o L & o ® o
L & ® ®

Master Repeater 1 Peer Repeater 2 Peer Repeater 3

TRBOnet
Server

.

LAN/WAN

LSRR\ LR\ LT\

Dispatcher 1 Dispatcher 2 Dispatcher 3
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3.2.3

Capacity Plus

Capacity Plus (also known as Capacity Plus Single Site) is a digital trunked two-way
MOTOTRBO system that is designed for high volume communications at a single
site location. The system is designed to provide communications among a large
number of users within a building, a set of buildings, or a single geographical region.
This system type allows you to effortlessly increase the number of channels for both
voice and data transmission between the radio units and control centers. As this
system type is trunked instead of standard conventional, radio units are always
automatically forwarded to a free channel rather than being programmed to remain
on a single slot, thereby utilizing/sharing the available unused/free RF resources
(channels) among different users. The main objective of Capacity Plus is to support
more simultaneous voice and data transmissions within one capacious system.

Paa=——uuN
Dispatcher 1

LFE\
Dispatcher 2

E Voice Repeater 3

LR
Dispatcher 3

e

Master Voice Repeater 1

Voice Repeater 2

Data Repeater 4

Data Repeater 5

TRBOnet
Server
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3.2.4 Linked Capacity Plus (LCP)

Linked Capacity Plus (also known as Capacity Plus Multi Site) is a digital trunked
multisite two-way MOTOTRBO system that enables you to accommodate both high
volume and wide area communications. This system design allows you to connect
via IP up to 15 Linked Capacity Plus sites located in one geographical region (for
example, City of Charlotte) or in larger geographically separated territories (for
example, covering the Florida Keys from Miami to Key West). This system type allows
you to increase the RF coverage area and the number of channels for voice and data
transmission between the radio units and control centers. The main objective of
Linked Capacity Plus is to support more simultaneous voice and data transmissions
regardless of the distance.

P2
Dispatcher 1

E Router + Switch

Dispatcher 2

LAN/WAN

- Router + Switch y

Dispatcher 3

E] Router + Switch

Server
Voice Repeater 5 Voice Repeater 6 Data Repeater 7 Data Repeater 8

Control Control Control
Station 1 Station 2 Station N

Site 2

"
-
-
Ll

"
&
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3.2.5

Connect Plus

Connect Plus is a digital trunked multisite two-way MOTOTRBO system that enables
you to accommodate high volume, wide area communication that's required for
your business allowing you to connect via IP multiple sites located in one
geographical region or in larger geographically separated territories. This system
type allows you to increase the RF coverage area and the number of channels for
voice and data transmission between the radio units and control centers. Radio units
are always automatically forwarded to the control channel. The main objective of
Connect Plus is to support more simultaneous voice and data transmissions
regardless of the distance as well as to provide a more structural addressing of the
transmissions provided by XRC controller and XRT gateway.

XRC 9000 XRC 9000

Dispatcher 1

e

Dlspatcher 2

TRBOnet
Server*

L
LS

Dispatcher 3

Voice Repeater 1

Data Repeater 2

Router 1

Talk Group 1

%%

Talk GroupZ

XRT 9000

Voice Repeater 3

Data Repeater 4

Router 2

PN

* TRBOnet Server requires connections to only one XRT 9000 Controller and one XRC 9000 Controller in the system

Talk Group 3

Talk Group 4
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3.2.6 Capacity Max

Capacity Max is MOTOTRBO's next-generation trunking solution. Built on the DMR
Tier Il Mode of Operation, it delivers smooth scalability, low cost of ownership and
reliable operation.

Il Czpacity MAYX companents TREOnet companents

Application Server Capacity MAX System Server

Dispatch Position
Trunked Controller

TREON

RBOnet Dispatch

MNIS Data Gateway MNIS VRC Gateway

Application network CMSS network

. Router
Dispatch position

BOnet Dispatch

Console

~

[ 3™ party network

3.3 IP Backend Network Requirements

Before planning any IP connected MOTOTRBO system, read System Planner (chapter
4.6.3.2 Characteristics of Backend Network).

If the

Delay/Latency

The amount of time it takes for voice to leave the source repeater and arrive at
the destination repeater. The delay should be less than 60 ms. It can be up to
90 ms, but requires changes in CPS for both radio units and repeaters.

Jitter

The variation of the packet inter-arrival time. It should be less than 60 ms.
Packet Loss

In the case of voice, the ongoing call ends if six consecutive packets do not
arrive within 60 ms of their expected arrival time. In the case of data, the
repeater waits for the expected number of packets (as per the data header)
before ending the call.

Bandwidth

Refer to System Planner for bandwidth calculations, but roughly, it requires 96
kbps for each repeater connection and should be summed up for all repeaters.

IP backend network does not satisfy MOTOTRBO requirements, it will degrade

audio quality significantly, including dropped voice calls.

TRBOnet Enterprise — User Manual
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3.3.1

4.1

4.2

4.3

Linked Capacity Plus Specific Requirements

¢ Addresses and Ports
A static IP Address and UDP Port for the master repeater must be made
available to all peer devices on the Linked Capacity Plus system.

= When a peer device registers with the master repeater, the network supplies
the return IP address and UDP port of the peer device to the master
repeater. The IP address and UDP port must then be made available to all
other MOTOTRBO™ LCP devices on the system.

TRBOnNet Enterprise and Dependencies Installation

TRBOnet runs on Microsoft Windows-based PCs. For the TRBOnet Enterprise
Compatibility Table, see

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ltemID=73

Installing Microsoft SQL Server
Download and install Microsoft SQL Server 2008 R2 or higher.

You can download and install either a full-featured MS SQL Server or an Express
edition of MS SQL Server. The Express edition of MS SQL Server is free, however, it
has some technical restrictions (maximum database size of 10 GB, RAM usage, and
other restrictions).

For example, Microsoft SQL Server 2008 R2 SP2 - Express Edition (which is free) is
available at:
http://www.microsoft.com/en-us/download/details.aspx?id=30438

Note: We recommend that you download a version of SQL Server with
Tools.

Select the 32-bit or 64-bit version depending on the underlying OS. Accept the
defaults for the setup.

See also section 5.2.1.1, Windows Authentication on page 14.

Installing .NET Components

Windows 8 and later, as well as Windows Server 2012 and later, include the required
.NET 4.6 components as part of the operating system.

The .NET Framework redistributables are available from Microsoft at:
https://www.microsoft.com/en-us/download/search.aspx?g=.net%20framework

Installing TRBOnet Enterprise

e Contact Neocom Software to obtain the latest installation package of the
TRBOnet Enterprise software, unzip, and run the setup file as a local
administrator.

e When the TRBOnet Enterprise Setup wizard appears, click Next.

e On the End User License Agreement page, accept the terms of the license,
and then click Next.


http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=73
http://www.microsoft.com/en-us/download/details.aspx?id=30438
https://www.microsoft.com/en-us/download/search.aspx?q=.net%20framework

neocom
sofFtware

10

Choose Setup Type .
Choose the setup type that best suits your needs

TRBOnet Dispatch Console
This is @ dispatcher computer and only Dispatch Console must be installed

TRBOnet Server and Dispatch Console

This is a Server computer and you need to install Server software and
Dispatch Console

= Custom
E Allows users to choose which program features will be installed and where
2 they will be installed.

Neocom Software

< Back Next > Cancel

e On the Choose Setup Type page, click one of the following options:
* TRBOnet Dispatch Console

Choose this option to install only TRBOnet Dispatch Console on your
computer.

TRBOnet Server and Dispatch Console

Choose this option to install both TRBOnet Server and

TRBOnet Dispatch Console at once on your computer.

Custom

Choose this option to select from the list one or more components to be

installed.
Custom Setup '
Select the way you want features to be installed.

Click on the icons in the tree below to change the way features will be installed.

(= ~ | Dispatch Console TREOnet Enterprise 5.2 Agent
e () 7 | Server Instance

Agent Instance |

This feature requires 199MB on
your hard drive.

Location:  C:'Program Files (x85)\Neocom Software|TRBOnet

Browse...
Enterprise\

Neocom Software

Reset Disk Usage < Back Cancel

For example, you may install only TRBOnet Server Instance:

Custom Setup r
Select the way you want features to be installed.

Click on the icons in the tree below to change the way features wil be installed.

e X _~ | Dispatch Console TRBOnet Enterprise 5.2 Server
(=T
b X

~ | Agent Instance

This feature requires 209MB on
your hard drive.

Location: C:\Program Files (x86)Neocom Software\TREOnet

Browse...
Enterprise}

Neocom Software

Reset Disk Usage < Back Cancel

o Accept the defaults for the rest of the setup and complete the installation.

TRBOnet Enterprise — User Manual
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To start TRBOnet Server, click the corresponding shortcut on the desktop,
or click Start > All Programs > Neocom Software > TRBOnet Server x.x

License Information

The TRBOnet software requires a valid license in order to operate. Depending on the
License Type (see next section), the license can be obtained via TRBOnet's website or

from a Neocom representative.

License Types

There are three license types available for TRBOnet Enterprise:

License

Type

Commercial

Validity 60 days By Request

Permanent (non-expiring)

Quantity of Up to 2 control stations
Control or 1 IP repeater

Stations and | connection By Request According to Customer order
Radio Units | 10 Radio Units
Features Limited functionality By Request According to Customer order

Assigned to server's
Hardware ID.

For more details on

How to It can be downloaded Hardware ID, see
obtain from the web page. the article at
http://kb.trbonet.com/

public.pl?Action=Public

FAQZoom;ltemID=31.

Assigned to server's Hardware ID.

Assigned to the serial numbers of
master repeaters and control
stations. To retrieve serial
numbers, use Control Station's
codeplug (do not rely on a serial
number printed on the device's
label).

For more information on the license and renewals, contact our technical support at info@trbonet.com

To see how the Hardware ID and control stations and/or repeaters are assigned in
your license, open the INFO file delivered with the license file (for example, in

Notepad):

License ID: aada3405-4e5f-4254-843f-alballeTc473
License generated by: John Smith

License generation date: 7/20/2016

TRECnet Support iz active up to: 7/20/2017
Product: TRBOnet Enterprise (4.0.0.138

License for: Neocom Software Ltd

Licensed instance: [Defaulrt]

Server limitations

EIVer Rardware Keys: — 1
42B1-BA64-D473-D6ES-DFAC

Remote Agent connections: 5

System types: Unlimited

Agent limitations
Agent hardware keys: Any
Humber of master radios or master repeaters: 5

"

/

Fa=ter radicos master repeaters serial numbers: ¢84TNL2887; ¢84TNL2888; 484TNL2889; 484TNL2BI0; 484TNL2E3Y]

Total number of peers in IP Site Connect or Capacity Plus systems: 10

Serial numbers of peers used in IP 3ite Connect or Capacity Plus systems: Unlimited

Limitation for Client connections
Remote Dispatch connections: 10
Number of Remote Dispatch accounts: 10

Subscriber radios limitations
Humber of subscriber radios: 10

11
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5.1.2

5.1.3

5.14

12

1. Your license is assigned to the Hardware ID.

2. Your license is assigned to the serial numbers of master repeaters and control
stations.

Moving TRBOnet Server to a Different Server PC

If there is a need to use TRBOnet Server on a different server PC, please contact your
Neocom sales representative for further instructions.

Using Spare Repeaters

If the plan is to use spare repeaters, for example, as replacement for damaged ones,
communicate the total number of repeaters when ordering a license.

For example, 3 repeaters will be actively used with TRBOnet Server and 1 spare
repeater. Communicate the following repeaters limitation: 3 active 1 spare and
provide the serial numbers of all 4 repeaters when placing an order (also include the
spare repeater’s serial number).

License Manager

¢ In the Configuration pane on the left, select License.
In the right pane, you can see the text of your current license.

Configuration

o service

0 Network

& Redundancy

Database

(@ Reports

£¥ Service Management

," Advanced settings
(RN Geocoding Servers
& Radio Networks

52| Remote Agents

52 Friendly Servers

ﬁ Telephony

} Data Sources

3% Modbus TCP

24 Email

B SMS

=] e
Set Defaults

To apply the new license:

License

License is valid -
License ID: 6b6b2281-c761-4747-9eec-8b61260d782b

Hardware ID: 428 1-BA64-D473-D6E3-DFAC

License generated by: Marina Eidelman

License generation date: 03-Mov-2016

TREOnet Support is active up to: 20-Jul-2017

Product: TRECnet_Enterprise (4.0.0.138)

License for: demo

Active instance: [Default]

Licensed instance: [Default]

Demo License
Expiration date: 20-Jul-2017

Server limitations

Server hardware keys:
42B1-BA54-D473-DSES-DFAC
Remote Agent connections: 5
System types: Unlimited

Agent limitations
Agent hardware keys: Any
Mumber of master radios or master repeaters: 5

License Manager Send Email Copy to Clipboard

Apply oK Cancel

1. Click the License Manager link in the right pane.
The License Manager wizard appears.

2. Click Next.

3. Click the ellipsis (...) button on the right-hand side of the License file box.
The Open dialog box appears.

4. Locate the license file you received from our technical support and click

Open.

The full path of the license file appears in the License file box.

Click Next.

6. Click Finish to close the wizard.

TRBOnet Enterprise — User Manual
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7. Click Apply and then confirm to restart TRBOnet Server.

5.2

Note: To use a single license for multiple TRBOnet software
instances, you need TRBOnet License Server. For detailed
instructions on how to use TRBOnet License Server, refer to
TRBOnet License Server Configuration Guide.

TRBOnet Server Database

¢ In the Configuration pane, select Database.

Configuration Database
' Service
G Network
& Redundancy
2 Reports
LF Service Management
/’ Advanced settings
)\ Geocoding Servers
@ Radio Networks

SOL Server: (local)\SQLEXPRESS -

Database: TRECnet h

Authentication: Windows h

= ¥4 Spedify the path for database archives
5| Remote Agents

[ Friendly Servers Fath: D:{Temp TRECNet

E Telephony 1 Use custom folder for audio files
}" Data Sources
3 D:{Temp\Audio
32 Modbus TCP g \rempla
24 Email
[ 5Ms Test Connection
E License Upgrade Database >
Create Database -
Set Defaults Apply oK Cancel

¢ In the Database pane, specify the following database-related settings:

SQL Server

Enter the location of the Microsoft SQL Server name and instance. For
example, in the screenshot above, the default instance name of Microsoft
SQL Server Express installed on the local computer is shown.

Database
Enter the name of the TRBOnet database.

Authentication

Select the authentication method for the TRBOnet database. The default
method is Windows Authentication. See also section 5.2.1, Database
Authentication Methods (page 14).

Login and Password
Enter a valid SQL Server login and password if the SQL Server
Authentication is selected for the database.

Specify the path for database archives

Select this option, and in the corresponding Path box enter the full path of
the custom folder for database backups. Or, click the ellipsis (...) button and
in the Browse For Folder dialog box locate the appropriate path.

Use custom folder for audio files

Select this option, and in the corresponding Path box enter the full path of
the custom folder for audio recordings of the voice calls/sessions. Or, click
the ellipsis (...) button.

13
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Path to Audio Files X
Root Folder:
D:\audio

File Format:
SoYEAR %o\ %MONTH G\ %D A %]

Channel Name SystemID System Name Call Tvpe Source Source Type
Source ID Recipient Recipient Type Recipient ID

Example:
D:\Audio\2017Y05423 oo wav

oK Cancel

¢ In the Path to Audio Files dialog box, select the Root Folder, and in the
File Path Template box enter the information (by clicking the
appropriate links below: Year, Month, Day, etc.) that will be used to
generate the file/path name.

Note: If you don't specify folder paths for the database archives
and audio files, TRBOnet Server will use the following
default paths:

%ProgramData%\Neocom Software\TRBOnet Enterprise\Backups -
for database archives.

%ProgramData%\Neocom Software\TRBOnet Enterprise\Audio -
for audio.

e When you finish configuring the required database parameters, click
Create Database.

e After you create or upgrade a database, click Apply and then confirm to
restart TRBOnet Server.

5.2.1 Database Authentication Methods
5.2.1.1 Windows Authentication

e From the Authentication drop-down list, select Windows.
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Configuration Database
' Service
G Network SQL Server: (local)\SQLEXPRESS -
¢ Redundancy Databage: TRECnet -
Database —

- : Nindow:

2 Reports Authentication: \J'I.ndDJ\S =
L} Service Management Windows

SQL Server

f Advanced settings
;A Geocoding Servers

Q Radio Networks ! Specify the path for database archives
5| Remote Agents

[ Friendly Servers Fath: D:{Temp TRECNet

E Telephony W] Use custom folder for audio files
}' Data Sources

iH 3 D:TempiAudio
3% Modbus TCP Fath emlA
24 Email
(5 sMs Test Connection
E License Upgrade Database >
Create Database -
Set Defaults Apply oK Cancel

To provide access permissions for TRBOnet Server to connect to MS SQL Server,
create an account with sysadmin privileges.

During the installation process, MS SQL Server 2008 automatically grants sysadmin
privileges to the NT Authority\SYSTEM account.

In the case of MS SQL Server 2012 and higher versions, add the

NT Authority\SYSTEM account to the Administrators group during the installation
process. If the database owner privileges are required to work with TRBOnet
Database, you need to assign the sysadmin role to the Local System account. For
instructions on how to install and configure MS SQL Server 2012, see Appendix B:
Configuring SQL Server 2012 for Local System Account.

5.2.1.2 SAQL Server Authentication

e From the Authentication drop-down list, select SQL Server.

Configuration Database
u Service
G Network S0L Server: (local)\SQLEXPRESS h
@ Redundancy Database: TRBOnet -
Database X

I;‘ Reports Authentication: 5QL Server hd
L} Service Management Login: sa
}' Advanced settings Password: | e

i...h Geocoding Servers

& Radio Networks /] Specify the path for database archives

5= Remote Agents

52 Friendly Servers Rl D:\Temp{TRE0net

E Telephony W] Use custom folder for audio files
i} Data Sources

o 3 D:{Temp\Audio
2% Modbus TCP Path e
24 Email
) 5MS Test Connection
E License Upgrade Database >
Create Database -
Set Defaults Apply OK Cancel

To connect to SQL Server using SQL Server Authentication, create an SQL login
with sysadmin privileges in the SQL Server in use. For detailed instructions on how
to create an SQL login, see
http://technet.microsoft.com/en-us/library/aa337562.aspx
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5.3 TRBOnet Server Service

¢ In the Configuration pane, select Service.

Configuration Service

& B

G Network The TRBOnet Server service is not installed!

% Redundancy . " .

Itis recommended to run TRBONet Server as a Windows service: it

— Database will start automatically after a reboot and run even when no user is
i Reports logged on. Click the Install Service button below to install the

'} Service Management TREOnet Server service.

/’ Advanced settings Service logon type:
2N Geocoding Servers (@) Logon as Local System (Recommended)

@ Radio Networks () Logon as User
52| Remote Agents

[ Friendly Servers

7@ Telephony
}* Data Sources
Medbus TCP Install Service
24 Email
o SMS
[ vicense
E\'iev.' Log Entries Export Configuration Import Configuration
Set Defaults Apply oK Cancel

¢ In the Service pane, specify the following service-related parameters:

= Choose the required logon type:

Logon as Local System

Choose this option to use an account with local system administrator
privileges to run the service as a Windows service (Recommended);

Logon as User

Choose this option to use a different account to run the service as a
Windows service. This account must allow the user to run services in
Windows, have read and write access to the Neocom Software folder and
subfolders in the "%ProgramFiles%" (or, "%ProgramFiles(x86)%" for 64-
bit OS) and "%ProgramData%" folders. For example, using such an

account may be required in the following cases:

1. An Active Directory domain network is used, and the current Windows
user is not allowed to use a Local System account to launch services on

the local PC due to domain policy restrictions.

2. MS SQL Server is installed on a remote PC, and Windows
Authentication (see section 5.2.1.1, page 14) has been selected to

connect to the database.
= (Click Install Service.

= Click the Start Service link that appears in the right pane.

Note: If the area, where TRBOnet Enterprise is installed, observes
daylight saving time, it is recommended that, when the
local time is set one hour back, you should stop the service
(Stop Service link) immediately before the time change (for
example, at 2:59) and start it again after an hour (for
example, at 2:59 according to the new time). This procedure

is required to prevent database corruption.
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5.4 Network Parameters

¢ In the Configuration pane, select Network.

Configuration MNetwork
' Service
G Network Network interface: e
# Redundancy Command port: 4021 =
Database ) =
I}) Reparts First VoIP port: 4022 -
L} Service Management VoIP protocol: Tep h
/’ Advanced settings Data protocol: Tep M
(N Geocoding Servers
& Radio Networks Use broadcast mode for audio
52| Remote Agents Broadcast port:
+| Friendly Servers
o i Use proxy server
28 Telephony Configure
}' Data Sources
Encrypt data over network
:.% Modbus TCP
24 Email
[EL]
[ vicense
Set Defaults Apply oK Cancel

¢ In the Network pane, specify the following network-related parameters:

Network interface
From the drop-down list, select the network interface that will be used to

communicate between the Server and Dispatch Consoles. Click ¥ to
refresh the list of network interfaces available on your PC.

Note: If both TRBOnet Server and Dispatch Console are installed
on the same PC, then select 127.0.0.1 (Loopback
Pseudo-Interface).

Command port

Enter the port number to be used by a Dispatch Console to connect to the
Server (4021, by default).

First VolP port

Enter the number of the first VolP port for audio communications between
the Server and Dispatch Consoles (4022, by default). Each additional
Dispatch Console will establish a connection on the next available port
number.

VolIP protocol
From the drop-down list, select the VolP protocol type for communications
between the Server and Dispatch Consoles:

e All - UDP will be used first; if unavailable, TCP will be used:;
e TCP - slower but more reliable (set by default);

e UDP - faster but data packets can be lost; some routers may drop
UDP packets.

Data protocol
From the drop-down list, select the protocol to exchange data other than
voice between the Server and Dispatch Consoles (TCP, by default).
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Use broadcast mode for audio

Selecting this option will help to optimize network load and minimize
transmission delays. The "load" on the network will be reduced as the
Server will utilize a single audio transmission to a group of Dispatch
Consoles instead of sending multiple audio streams to each individual
Dispatch Console. This method of transmission will also minimize the
transmission delays if there's a large number of Dispatch Consoles or the
Server is busy processing other features.

Note: When the broadcast mode is set, a Dispatch Console
cannot run on the same machine as TRBOnet Server, and a
warning message will appear when you select this option.

e Broadcast port
Enter the port number to be used to broadcast audio (5000, by default).

Use proxy server
Select this option to enable an alternative proxy server for TRBOnet
Dispatch Software to access Internet.

¢ C(lick the Configure link to specify the alternative server settings:

Configure the proxy server X

Use an alternative server

Settings

Address:  [177.71.134.70

Part: 80

Authentication
Use authentication

Login: L

e Use an alternative server
Select this option to enable an alternative proxy server.

v Address
Enter the proxy server IP address.

v Port
Enter the proxy server port number.

¢ Use authentication
Select this option to use authentication to connect to the alternative
proxy server.

v Login
Enter the login for the authentication, if needed.

v' Password
Enter the password for the authentication, if needed.

e After you configure the proxy server settings, click OK.
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5.5

5.6

= Encrypt data over network
Select this option to guarantee the security of data transfer between
TRBOnet Server and Dispatch Console, and/or TRBOnet Agent. It is
recommended that this option be used when a connection between system
components is established via the Internet or other public networks.

Reports

¢ In the Configuration pane, select Reports.

Configuration Reports Version: 5.2.0.1312
¥ Service -~
a Network W] Save scheduled reports
& Redundancy Path: D:\Reports
Database
e Format: Pdf -
]

LF Service Management
% Advanced settings
)\ Geocoding Servers
.| Radio Networks
@ Dlgltal Systems

ﬁ Capadty Plus 1

¢ Control Station #1
i..[7] Analog Control Station:

52 Friendly Servers

78 Telephony
}" Data Sources
COM parts w
£ >
Set Defaults Apply OK Cancel

¢ In the Reports pane, select the Save scheduled reports check box and specify
the following parameters:
= Path
Click the ellipsis (...) button and locate the folder on the PC where you wish
to save reports generated by the TRBOnet software.

* Format
From the drop-down list, select the format for the reports (PDF or Excel).

Backup Configuration

TRBOnet Server supports a redundant (secondary/backup) configuration which
allows automatic switching from the primary to the redundant (secondary/backup)
server in case of failure of the primary server. Dispatch Console operation will not be
interrupted.

¢ In the Configuration pane, select Redundancy.
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Configuration
qf Service
G Network
¢
Database
_D\ Reports
L} Service Management

Redundancy

w1 Redundant server mode
Redundancy Mode:

Main servers:
TP Address

Passive

/’ Advanced settings 1 W 10.10.234.152 4021
)\ Geocoding Servers

@ Radio Networks

52| Remote Agents

[ Friendly Servers

7@ Telephony

}' Data Sources

2% Modbus TCP

24 Email

B SMS

[ vicense

Add Edit Delete Test A Y

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, select the Redundant server mode option.

¢ Redundancy Mode
Select a mode for the redundant server from the drop-down list.

For details, see sections Passive Mode and Active Mode on page 373.

e To add a main server, click Add.

Server Properties X

IP Address: | 10.10.234.163|

Fort: 4021

A4k

oK Cancel Test

e IP Address
Type the IP address of the main server.

e Port
Enter the same port number as specified for the Command port.

Note: For more details on Redundant Server configurations, see
Appendix G: Redundant Server (page 372).

5.7  Service Management

The Service Management pane allows you to specify various parameters for the
Check Radio, Location, Telemetry, TMS, and Indoor services.

¢ In the Configuration pane, select Service Management.
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Configuration
@ Service
G MNetwork
& Redundancy
Database
!.'9 Reports
{:} Service Management
X Advanced settings
----- * Geocoding Servers

Service Management Version: 5.3.0.1661

Presence service

Auto request presence timeout: ] minutes

ARS refresh interval: 1440 minutes

Ak 4K

Ignore unregistered Radios

Location service

GPS restart by inactivity timeout: | 5 minutes

B Radio Networks
Remote Agents
E Friendly Servers
@ Telephony

l Data Sources
4 Email

Ab 4b

Dispatch Console update interval: | 1 seconds

& Automatic error correction
Configure
Send the latest GPS data to dispatchers on alert

B8 sMs For the last:
5 License GPS points:
Telemetry service
Request for the status of GPIO when a radio unit is powered on
Text Messaging service
Text Message Format: Sender and Text A
Max. message length: 140 s chars
Split long message into multiple messages
Indoor service
i Remove offine radio from beacon
Ignore beacon position on alarm if GPS is fixed {only K-TERM)
Set Defaults Apply oK Cancel

¢ In the Service Management pane, specify the following service-related
parameters:

5.7.1 Presence Service

The Presence service group includes the following registration-related parameters:

e Auto request presence timeout
Enter the time interval that will be used by the server to regularly check the
online subscriber radios if there has been no activity. The server considers a
radio to be inactive (or, offline) if the radio does not send any GPS, Text, ARS,
or Voice messages.

If you do not have a dedicated channel for data revert, use the following table:

Number of Presence timeout Number of Presence timeout
radio units (minutes) radio units (minutes)

up to 10 5 30 to 40 17

10 to 20 9 40 to 50 21

20 to 30 13 over 50 120

If there is a dedicated data revert channel in the system, you may set this
parameter to a somewhat lower value than indicated in the table.

¢ ARS refresh timeout
Enter the value of the parameter that determines how often a radio unit will
send ARS packets. It is recommended that a value of 30 minutes be used for
this interval. This value may be changed depending on the system load.
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Note: For all radio systems (except for Connect PLUS and Capacity
MAX), the ARS service must be enabled on the subscriber
radio channels (MOTOTRBO CPS, Channels>Channel>ARS).

¢ Ignore unregistered Radios
Select this option so that unregistered radio units will be ignored and thus
won't appear in Dispatch Console.

5.7.2 Location Service

The Location Service group includes the following location-related parameters:

e Dispatch Console update interval
Enter the time interval that will be used to send GPS data packages from the
Server to Dispatch Consoles. The lower the value, the more data traffic will be
present on the network. Adjust this value based on the network bandwidth.
The lower the bandwidth, the higher the update interval.

¢ Automatic error correction
Select this option to enable automatic error correction to detect and correct
invalid GPS data.

Click the Configure link to specify the GPS parameters to be corrected:

Automatic error correction X

In some real world situations, speed and location values from the GPS
receiver may be erratic or unreliable. Use the settings below to apply
automatic error correction to the GPS data feeds.

Discard GPS data if
kmih

meters

AF 4 4

\f GPS time error greater than: 30 minutes

Coordinates have duplicates

Consider speed zero if less than:

Defaults oK Cancel

Discard GPS data if

= Speed greater than
Select this option and enter the maximum possible speed of your vehicles.

As a result, the coordinates with speeds that exceed the maximum limit will
be discarded.

= Location accuracy worse than
Select this option and enter the largest distance for the accuracy of the GPS
receiver. As a result, the coordinates with distances that exceed the
maximum limit will be discarded.

= GPS time error greater than
Select this option and enter the largest allowable time error, in minutes. As

a result, the coordinates with time errors that exceed the maximum limit will
be discarded.
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= Coordinates have duplicates
Select this option to remove duplicate coordinates from the GPS data.

= Consider speed zero if less than
Select this option and enter the low-speed threshold. Speeds below this
threshold will be considered as zero by the server.

¢ Send the latest GPS data to dispatchers on alert
Select this option so that dispatchers receive the latest GPS data when an alert
occurs. Then choose one of the following options:

= For the last X minutes
Choose this option and enter the time, in minutes, to be used as the last
time period for the latest GPS data.

= GPS points
Choose this option and enter the number of GPS points to be used for the
latest GPS data.

5.7.3 Telemetry Service

The Telemetry Service group includes the following telemetry-related parameters:

¢ Request for the status of GPIO when a radio unit is powered on
Select this option to enable the server to request the status of a radio unit's
telemetry information when the radio is powered on.

5.7.4 Text Messaging Service

The Text Messaging Service group includes the following message-related settings:

e Text Message format
From the drop-down list, select one of the pre-defined formats for text
messages, or select the Custom format.

e Custom Format
Enter your own format for text messages in this box if you have selected
'‘Custom’ from the list above. The Custom Format will default to
{Sender} | {Text}. There are four choices: {Sender}, {Text}, {Date}, and {Time}.
Another example would be: {Date} | {Time} | {Text}.

¢ Max. message length
Enter the maximum number of characters that TRBOnet will send per text
message. The recipient of the text message may not be able to receive the
maximum number of characters due to its design limitations. Therefore, it may
only display a partial text message.

¢ Split long message into multiple messages
Select this option to allow single messages to be split into multiple messages
based on the Max. message length setting.

5.7.5 Indoor Service

The Indoor Service group includes the following indoor-related parameters:
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5.8

Remove offline radio from beacon
Select this option so that an offline radio is not shown on its associated
beacon.

Ignore beacon position on alarm if GPS is fixed (only K-TERM)
Select this option so that beacon positioning is ignored in case of alarm when
a radio transmits valid GPS data.

Note: This feature relates only to K-TERM beacons.

Advanced Settings

¢ In the Configuration pane, select Advanced Settings.

Configuration Advanced settings Version: 5.2.0.1316

U Service
G Network Language: English -
@ Redundancy Logging level: Mormal A
Database

S Administrator Account: Enabled -
i> Reports

o ; Resetpassword
LF Service Management
)’ Audio Recording format: TMA - TRECnet Audio File -

“-.A Geocoding Servers Audio Recording codec: G.711 p-Law/3000 M

@ Radio Networks

85 Friendly Servers Measurement system: Metric -
E Telephony Latitude/Longitudeformat: Degrees, Minutes, Seconds -
i} Data Sources

2% Modbus TCP T Passive timeout: Unlimited < hours

4 Email Voice Mail timeout: Unlimited < hours

L SM5 . - =
B3 License Text Message Passive timeout: Unlimited + hours
Set Defaults Apply OK Cancel

¢ In the Advanced Settings pane, specify the following advanced parameters:

24

Language
From the drop-down list, select the interface language for TRBOnet Server.

Logging level

From the drop-down list, select the logging level that determines the
granularity of log messages in the System Log. The choices are: None, Low,
Normal, and High.

Note: This information is used by technical support for
troubleshooting purposes, so it is recommended that this
value be kept unchanged (Normal).

Administrator Account
From the drop-down list, select either Enabled or Disabled. If you select
Disabled, the administrator won't be able to log in to the Dispatch Console.

¢ Reset password
Click this link to reset the administrator password to the default value.

Audio Recording format
From the drop-down list, select the format to be used to store audio
recordings. The available formats are WAV and TNA.
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Note: The TNA format is a proprietary audio format that contains
additional information about radio calls, such as radio ID,
start time, end time, and other parameters. This format
provides more details about call participants and allows
easy navigation within recorded audio files.

Audio Recording codec
From the drop-down list, select the audio codec to be used to compress the
audio files.

Measurement system
From the drop-down list, select either Metric or US units.

Latitude/Longitude format
From the drop-down list, select the format of Latitude/Longitude pairs.

TX Passive timeout

Enter the time that text and voice messages will be stored and later sent
when the channel becomes available (no longer busy). "Unlimited" is
recommended.

Voice Mail timeout
Enter the time duration where TRBOnet Server will continue to try to send
Voice Mail messages to a recipient. "Unlimited" is recommended.

Text Message Passive timeout
Enter the time duration where the TRBOnet Server will continue to try to
send Text messages to a recipient. "Unlimited" is recommended.

Geocoding Servers

Geocoding servers resolve GPS coordinates to street addresses for reporting
purposes and other needs, for example, 'GPS activity for period' reports. Online
geocoding services, such as Google or Nominatim, can be used and are the standard
default services in TRBOnet. However, their use may be limited by the number of
requests. Furthermore, you can add custom geocoding servers to the system.

You can configure geocoding servers in three ways depending on whether the
Server and/or Dispatch Console have Internet access and on your local geocoding
server settings:

1.

The Dispatch Console has Internet access and the Server has no Internet
access. The Server can connect to preconfigured (Google and Nominatim)
and/or local corporate geocoding servers via the Dispatch Console.

The Server has Internet access and Dispatch Console has no Internet access.
The Dispatch Console can connect to preconfigured (Google and Nominatim)
and/or local corporate geocoding servers via the Server (follow the
instructions below).

You have your own Geocoding server in the local network. In this case, you
can configure data resolving in both the Server and the Dispatch Console.

5.8.1.1 Configuring Geocoding Servers

¢ In the Configuration pane, select Geocoding Servers.
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Configuration Geocoding Servers
' Service
G Network Use MapPuaint location resolving

& Redundancy
Database

(@ Reports

L} Service Management

/’ Advanced settings Server Name
Y)x\ V’ Google

@ Radio Networks W Mominatim

52| Remote Agents
[ Friendly Servers

7@ Telephony
}' Data Sources
212 Modbus TCP
24 Email
[ sMs
9 ticense Add Delete A Y
|:| Request a place name upon receiving GPS coordinates
Set Defaults Apply oK Cancel

¢ In the Geocoding Servers pane, specify the following geocoding-related
parameters:

= Use MapPoint location resolving
Select this option to get street addresses from MapPoint, and enter the
MapPoint Application ID. MapPoint is a service from Microsoft that is
used to transform coordinates into street addresses.

= Google and Nominatim
These are pre-configured geocoding servers, which allow resolving GPS
coordinates to street addresses and street addresses to GPS coordinates.

Note: These geocoding servers can't be deleted from the system.

= Click Add to add a geocoding server to the system.

Map Server for Geocoding X

Server Name: |I\!hGeocodingServer |

Get address by coordinates

‘Hl‘lp -//127.0.0.1/reverse Format =xml&lat ={at }&lon={on }ézoom=184adressdetails=1 |

Test

Get coordinates by address

‘Hl'tp +//127.0.0.1/search q={address }&format=xml

Test

Carcel

e Server Name
Enter the name of your geocoding server.

¢ Get address by coordinates
Select this option to resolve GPS coordinates to street addresses.
In the box below, enter the server address with the appropriate
parameters.
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Note: Keep in mind that the {lat} and {lon} variables are
mandatory to allow TRBOnet Dispatch Console to retrieve
GPS coordinates from the radio unit.

Click Test to check the connection to the geocoding server. Enter a pair
of GPS coordinates and see if the resolved street address appears.

¢ Get coordinates by address
Select this option to resolve street addresses to GPS coordinates (for
example, for the Search by Address feature).
In the box below, enter the server address with the appropriate
parameters.

Note: Keep in mind that the {address} variable is mandatory to
allow TRBOnet Dispatch Console to search map objects by
address.

Click Test to check the connection to the geocoding server. Enter an
address and see if you get the list of map objects corresponding to the
address entered.

Use the Up (\* ) and Down (¥ ) buttons to move the selected geocoding
server up and down in the priority list of geocoding servers. When
requesting GPS data via the geocoding servers configured in TRBOnet
Server, GPS data is requested from the geocoding servers according to the
priority level. The geocoding server at the top of the list has the highest
priority level. In case the first geocoding server is unavailable, data will be
requested from the second geocoding server in the list, and so forth down
the list of geocoding servers.

The administrator must ensure that the geocoding servers in the list are
able to resolve GPS data.

Request a place name upon receiving GPS coordinates

Select this option to resolve GPS coordinates to street addresses
immediately by a GPS event. Note that street addresses and GPS
coordinates are automatically (without user intervention) stored in the
TRBOnet database to optimize the response time for street address
requests (for example, GPS reports) and to reduce geocoding server load.
These street addresses and GPS coordinates will be stored without user
intervention whenever GPS are resolved to street addresses via a request to
a Geocoding Server.

5.9 Radio Networks

By enabling the Radio Networks feature, the TRBOnet Server is able to be connected
to a radio system. Otherwise, you should use Remote agents.

¢ In the Configuration pane, select Radio Networks.

¢ In the Radio Networks pane, select Enable Radio Networks.
Or, in the Configuration pane, right-click Radio Networks and choose Use
Radio Networks.
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Configuration Radio Networks Version: 5.2.0.1312

d’: Service -
& Network
& Redundancy
Database
_b\ Reports

W/ Enable Radio Networks

£} Service Management
)’_ Advanced settings
N Geocoding Servers
.
9 TRBORet Cloud
Q) Digital Systems
LF services
I:B Capadity Plus 1
iy Control Station #1
i..[5| Analog Control Station:
il Friendly Servers
E Telephony
«} Data Sources

< >

Set Defaults Apply Ok Cancel

¢ In the Configuration pane, you can select TRBOnet Cloud.

Note: TRBOnet Cloud is a customizable feature. Please contact
your regional Business/Sales Managers for further details.

¢ In the Configuration pane, select Digital Systems.

¢ In the Digital Systems pane, select or make sure Enable Digital Systems is

selected.

Configuration Digital Systems
o Service ~
0 MNetwork ! Enable Digital Systems

@ Redundancy

Database CAI Network: 12 -

(=]

i Reports CAI Group Metwork: 225 b

L} Service Management

,f_ Advanced settings
..k Geocoding Servers
.| Radio Metworks

Yoot s e

Registered Digital Systems
.. Name

Repeater #1

1P Address
10.10,102.131

Radio ID
54250

Control Station #1
TREOnet Swift Agent#1

192,168.98.2
10.10.110.191

54250
54250

I Services

‘B Repeater #1

¢ Control Station #1

I TREOnet Swift Agent#1
i..[%| Analog Control Stations

5l Remote Agents

[ Friendly Servers
E Telephany

|’ Data Sources
212 Modbus TCP

Add Delete Test
4 Email w

Set Defaults Apply OK Cancel

¢ In the Digital Systems pane, specify the following parameters:

= CAIl Network
The CAl (Common Air Interface) Network is a value that is combined with
the Radio ID to produce the individual radio's air interface network IP
address. All radios must use the same CAI Network ID to be able to
exchange data. It is recommended that the default value of 12 is used.
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The CAl Group Network is a value that is combined with the Group ID to
produce the group's air interface network IP address. The CAI Group
Network ID forms the first or most significant byte of each group's network
IP address. All radios must use the same CAI Group Network ID to be able
to exchange data (225, by default).

Note: The values of these two parameters must match those
configured for the radio units via the MOTOTRBO CPS.

Digital Systems

Configuration

o service ~

& Network

& Redundancy
Database

;\ Reports
£¥ Service Management
/ Advanced settings

..... .\ Geocoding Servers
.| Radio Networks
.£5) TREONet Cloud
..{Z) Digital Systems

L} Services
ﬁ Capacity Max
Iﬂ Capacity Plus #1

; )’_ Advanced settings
| Privacy
F DDMS service
- Advanced setting
L} MMIS data service W
£ >

Set Defaults

PR R R s

Digital Systems

/! Enable Digital Systems

CAT Network:

CAI Group Network:

Registered Digital Systems
.. Name

Capadty Max
il Capadity Plus #1
LCP #1
W1 1Psc
Control Station #1
K TREOnet Swift A100
Kairos #1

Delete

Add MOTOTRBO System
Add Control Station

Add Capacity MAX

Add TREOnet Swift Agent
Add Friendly F5-1000 Station
Add XRC-9000 Controller
Add XRT-9000 Controller
Add SELEX Repeater

Add KAIROS Repeater
Add WAVE Controller

1P Address

10.10.188.35
192,168, 10,100
10.10.133.5
192,168.10.2
10.10.100.86
10.10.155.130

2

Ok

Version: 5.3.0.1686

Ar 4b

Radio ID
54250
54250
64250
54250

64251
654250

Test

Cancel

All radio systems based on MOTOTRBO services are represented in the
Registered Digital Systems table, including their Name, IP Address, and Radio ID

(N:

e To add a radio system, click Add and select the appropriate system type from
the drop-down menu (2).

5.9.2 Services

¢ In the Configuration pane, under Digital Systems, select Services:
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¢ In the Services pane, specify the following Digital System Services-related

30

Configuration

& service

0 Network.

@ Redundancy
Database

_|>‘ Reports

LF Service Management

)’_ Advanced settings

N Geocoding Servers

.| Radio Networks

ﬂ} Digital Systems

:

Repeater #1

)f Advanced settings

1 Privacy

J DDMS service

INIS data service

,f: Advanced settings
L. Audio Paths

-fgry Control Station #1
,f Advanced settings

... TRBOnet Swift Agent#1
}' Advanced settings
L. Redundancy

«[E| Analog Control Stations

33l Remote Agents

[ Friendly Servers

ﬁ Telephony

} Data Sources

#2 Modbus TCP

4 Email

[ 5Ms

[ License

Set Defaults

parameters:

Services

! Automatic Registration service (ARS)
4005

4k

Port:

W Telemetry service (TLM)
4008

4

Port:

/! Text Messaging service (TMS)
4007

4

Port:

i Location service (GPS / Indoor)

Text Messaging service DMR.

Indoaor service (K-TERM)

Indoor LAN Service (K-TERM)

Tallysman Sprite service

F5 5000 location service (GPS)

Swift. Tracker v. 1 service

Swift. Tracker v. 1 service (IP channel)

W Swift.Tracker v. 2 service
4104

4

Port:

Swift. Tracker v. 2 service {IP channel)

Extended Text Messaging service

Telemetry service Novox

G45 R5232 service

Zebra printer service
Configure

Forward Data service

Apply QK Cancel

= Automatic Registration Service (ARS)

Select this option to enable the ARS service for the radios. When the radio
powers up, it automatically registers with the server. This feature is used
with data applications, that is, any data traffic on this channel is associated
with an application server such as MOTOTRBO Text Messaging or

MOTOTRBO Location Services.
Port

Enter the local port number for the ARS service (4005, by default).

= Telemetry service (TLM)

Select this option to enable the Telemetry service, which is the wireless
transmission and reception of measured quantities for remotely monitoring
environmental conditions or equipment parameters.
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Enter the local port number for the Telemetry service (4008, by default).

Text Messaging service (TMS)
Select this option to enable the Text Messaging service which is used to
exchange text messages between the radios and the dispatchers.

e Port
Enter the local port number for the Text Messaging service (4007, by
default).
Location service (GPS / Indoor)
Select this option to enable the Location service. The radio can send its
coordinates when it is in Global Positioning or iBeacon coverage area.
e Port
This is the local port number for the Location service (4001), which
cannot be modified.

Text Messaging service DMR

Select this option to enable the DMR-based Text Messaging service.

e Port
Enter the local port number for the DMR-based Text Messaging service
(5016, by default).

Indoor service (K-TERM)
Select this option to enable the Indoor Location service.
e Port
Enter the local port number for the Indoor service (3022, by default).

Indoor LAN Service (K-TERM)
Select this option to enable the Indoor LAN service.

e Port
Enter the local port number for the Indoor LAN service (3001, by default).

Tallysman Sprite service
Select this option to enable the service for autonomous event and
aggregated event reporting to provide significant reduction in GPS data
overhead.
e Port
Enter the local port number for the Tallysman Sprite service (4004, by
default).

FS 5000 location service (GPS)
Select this option to enable the FS 5000 location service, which is a service
for transmitting GPS data packages. This service uses FS 5000 Option Board.
e Port
Enter the local port number for the FS 5000 location service (4004, by
default).
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= Swift.Tracker v.1 service
Select this option to enable the service to transmit coordinates and data
packages via a radio channel using the Swift.Tracker TR001 device.

e Port
Enter the local port number for the Swift.Tracker v.1 service (4004, by
default).

= Swift.Tracker v.1 service (IP channel)
Select this option to enable the service to transmit coordinates and data
packages via a radio channel and a reserved IP channel using the
Swift.Tracker TROO1 device.

e Port
Enter the local port number for the Swift.Tracker v.1 service with an IP
channel (4080, by default).

= Swift.Tracker v.2 service
Select this option to enable the service to transmit coordinates and data
packages via a radio channel using the Swift.Tracker TRO0O1 device (version
2).
e Port
Enter the local port number for the Swift.Tracker v.2 service (4104, by
default).

= Swift.Tracker v.2 service (IP channel)
Select this option to enable the service to transmit coordinates and data
packages via a radio channel and a reserved IP channel using the
Swift.Tracker TRO01 device (version 2).

e Port
Enter the local port number for the Swift.Tracker v.2 service with an IP
channel (4180, by default).

= Extended Text Messaging service
Select this option to enable the Extended Text Messaging service to include
sending detailed preconfigured templates with the help of TRBOnet
Dispatch Software.

e Port
Enter the local port number for the Extended Text Messaging service
(4010, by default).

= Telemetry service NOVOX
Select this option to enable the Telemetry service based on NOVOX devices.

e Requests port
Enter the local port number to listen for requests (8090, by default).

e Events port
Enter the local port number to listen for events (8091, by default).

= G4S RS232 service
Select this option to enable the custom developed G4S RS232 service.
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Enter the local port number for the G4S RS232 service (4004, by default).

Zebra printer service

Select this option to enable the service for printing Job Tickets. A Zebra
printer is connected to a radio via Bluetooth. The radios should be
Bluetooth-enabled.

e Port

Enter the local port number for Zebra printer service (4072, by default).
Forward Data service
Select this option to enable the Forward Data service. This feature is used to
forward "raw data" via the COM port from one device to another.

e Port
Enter the local port number for Forward Data service (4011, by default).

5.9.3 Adding a Control Station

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add Control Station.

Configuration Control Station #1
' Service -~
G Network.
& Redundancy
Database
2 Reports
LF Service Management
/ Advanced settings
L2 Geocoding Servers
.| Radio Networks
Q) Digital Systems
: Ervices
ontrol Station 1
)f Advanced setti
L Analog Control Station:
5= Remote Agents
[ Friendly Servers
’E Telephony
| Data Sources w

Name: Control Station #1|

Y
-

- e

Radio ID: 64250

IP Address: 192,168.98.2 Test

Mode: 1P Site Connect -

System Identifier: Department 1

Use the radio for RX Data only (GPS Revert or Data Revert)
Speakers (Logitech USE Headset) - &

-8

Playback device:

Recorder device: Line In (2- High Definition Audio Device)

< >

Set Defaults Apply oK Cancel

¢ In the Control Station pane, specify the following control station-related
parameters:

Name

Enter a name for the control station. This name will be displayed in the
Dispatch Console in the Voice Dispatch Radio Interface pane. It will be the
name at the top of the PTT box.

Radio ID

This is the Radio ID of the radio unit connected as a control station.

(for Capacity Plus and Linked Capacity Plus systems, the maximum value is
65535).
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Note: This box is populated automatically once you have
successfully tested the control station by clicking the Test
button.

IP Address
Enter, or select from the list, the IP Address of the control station network
interface.

Note: This value is can be taken from the radio's configuration in
MOTOTRBO CPS, in Network>Accessory IP.

Test

Click this button to check the connection to the control station. If the test is
successful, you'll see the information on the control station you are
connected to, such as radio ID, serial number, firmware version, and other
relevant information.

Mode

From the drop-down list, select the connection mode for the control station
being configured. For more details, see section 5.9.3.1, Control Station
Connection Modes (page 34).

System ldentifier

Enter the system identifier with which the control station is used within a
Capacity Plus or Linked Capacity Plus system. Note that the system
identifier should be the same for all control stations used in a (Linked)
Capacity Plus system.

Use the radio for RX data only (GPS Revert or Data Revert)
Select this option to configure the radio channel so that it will only receive
data, thus having no transmission capability.

Playback device
From the drop-down list, select the playback device on the PC that will be
used to transfer audio data to the connected control station.

Recorder device

From the drop-down list, select the recording device on the PC that will be
used to receive audio data from the control station connected via a line-in
jack.

5.9.3.1 Control Station Connection Modes

Single Control Station

The Single Station mode is the simplest connection mode for receiving and
transmitting voice and data through a conventional channel using one control
station at this particular frequency.
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/ Subscriber #2 \

Control Station ! \
1

E | @; @; |

1 1

\ 1

\\\ Subscriber #1 Subscriber #N//I

USB + Audio TT=---- -
E <7LAN/\NAN4>E
P o
TRBOnet Dispatch Console

Server

IP Site Connect

The IPSC is a digital conventional two way MOTOTRBO system that allows you to
extend the area of your communications by providing 2 wide area channels per
repeater. It is possible to connect up to 15 repeaters in one system using IP
connection.

The Server Connection Modes are as follows:

1. TRBOnet Server is connected to a repeater with two time slots in the "IP
Site Connect" mode. The Server can transmit and receive over IP.

2. TRBOnet Server has no IP connection to a repeater. Two control stations
are required to transmit and receive voice and data, that is, one control
station per time slot.

Control Station
Slot 2

o

Control Station
Audio, Slot 1

=

TRBOnet
Server

usBe

Repeater 1 Master Repeater 2 Peer Repeater 3 Peer

-
- I LAN\WAN B
L

- =

LR
Dispatcher 1 Dispatcher 2 Dispatcher 3
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Common Channel

The Common Channel is a mode where it is possible to use multiple simplex base
stations operating at the same frequency with overlapping communication zones.

This mode allows the customer to provide radio coverage to large areas when there
is only one frequency and additional frequencies are unavailable. While in this mode,
the coverage area is being extended only for the dispatcher, and specifically when
operating at one and the same frequency. When a radio unit initiates a call, the
signal that can potentially be received by several base stations will be filtered on the
server side so that repeated audio playback and recording is prohibited.

The signal filtering is performed based on the "first packet", that is, only the signal
coming first to the server is played back and recorded, while the remaining signals
are discarded.

When a dispatcher initiates a call to a specific base station, the signals received by
the neighboring base stations will be discarded to prevent dispatchers from listening
to their own call at the time of transmission. The dispatcher is not recommended to
place a simultaneous call to all base stations to avoid interference to the subscribers.

The recommended way to use this mode is as follows: each base station is
configured with its own color code, and radio units are equipped with option boards
having a Geo-roaming feature, and each geographic area is assigned its own radio
channel with the corresponding color code.

/ « \ . N
P Subscriber W Y / &~ W N
7N 0o / A D\
| ubscriber y [ Subscriber \\V \
\ Subscriber #N ) I B #p  Suwsuriver |
Loo# i & '
\ / | I

\ / | Subscriber B

\ . 7/ \ !

Control Station #2* - #1
. s USB +Audio \ /
AN e N Control Station /
S ——— - \ 7
H#N* L

_____ -
-

- AN USB +Audi
- ~
S
// % . D USB +Audio

/ Subscriber \
! i}r\ \l
; % #2 Subscr\bem TRBOnet
I
\ Subscriber % o h server D
\ !
/

v #l

\\ //

*\_ Control Station #1* L
NG 7 All control stations in the system

S~ - operating the same frequency.

Dispatch Console

Capacity Plus TRBOnet

Capacity Plus TRBOnet is a limited option. All voice and data are received via IP. At
least one control station is required for outgoing voice and data session at a time.
Private calls and SIP calls require dedicated control stations unless NAI protocol is
used.
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LR

Dispatcher 1

m ;/ e
—
Master Voice Repeater 1

B \ e

Dispatcher 2

Voice Repeater 2

Voice Repeater 3

Data Repeater 4

m )
—

Data Repeater 5

Dispatcher 3

=)

TRBOnet usB
Server +

Audio
&

TX Control Station(s)

All voice and data
are received via IP
connection

Capacity Plus MOTOTRBO

Capacity Plus MOTOTRBO is a digital trunked two-way MOTOTRBO system that
allows you to accommodate high volume communication. It is designed to organize
stable connection in a few groups within one building or a set of buildings. This
system type allows you to increase the number of channels for voice and data
transmission between the subscribers and control centers. The subscribers are
always automatically forwarded to a free channel. The main objective of Capacity
Plus MOTOTRBO is to support more simultaneous voice and data transmissions
within one capacious system.

In the Capacity Plus MOTOTRBO mode you can configure voice and data control
stations to transmit and receive data over the air as it is displayed in System Planner.
Keep in mind that two data control stations are required per each data repeater —
one per time slot. TRBOnet Dispatch Software provides you an option to utilize an IP
connection to receive voice and data.

a=Em
Dispatcher 1 '{

G
Dispatcher 2

LR
Dispatcher 3

]

TRBOnet
Server

Data Repeater 4
usB usB
R L
Audio
Data Control Station(s) —
1Data G p.er 1 data Data Repeater 5
repeater time slot

Voice Control Station(s)
1 Voice CS per 1 talk
group

LAN/WAN
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5.9.3.2 Advanced Settings

¢ In the Configuration pane, under the corresponding Control Station, select
Advanced Settings.

Configuration Advanced settings
o service A
O Metwork i Automatically reset alarm mode
¢ Redundancy i Automatically handle call alert
= Database /1 Emergency CalljAlarm indication
i Reports Use front microphone

£F Service Management

}' Advanced settings
)\ Geocoding Servers

.| Radio Metwarks

| igital Systems TX Timeout: 60 < | seconds

¥ Services

Always transmit when the PTT is pressed ("Impolite”™ channel access)
Use serial port for FTT key up

Contral Station #1 Signaling System: None ~ | Configure

¥ Advanced settings Allow CSBK Data

L Analog Control Stations
5= Remote Agents
I Friendly Servers
ﬁ Telephony

|' Data Sources

2}t Modbus TCP

24 Email b

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following control station-related
advanced settings:

= Automatically reset alarm mode
Select this option to reset alarm mode on the control station radio
automatically. It is recommended to enable this option.

= Automatically handle call alert
Select this option to automatically redirect call alerts from the control
station radio to the Dispatch Console.

= Emergency Call/Alarm indication
Select this option so that audio and visual indication is given by the control
station radio when an emergency Call/Emergency Alarm is received.

= Use front microphone (for PTT key up)
Select this option to use a remote control of the PTT button via a remote
speaker microphone on the radio.

= Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

= Use serial port for PTT key up
Select this option to use a remote control of the PTT button via the serial
port of the PC, and select the serial port from the drop-down list.

= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
dispatcher starts any voice session in the Dispatch Console, the ongoing
transmission will be interrupted after this TX Timeout expires.

= Signaling system
From the drop-down list, select the signaling system.
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¢ MDC-1200 signaling is a Motorola data system using audio frequency

shift keying (ASFK) using a 1,200 baud data rate. A general option setting
for the system is to enable or disable an acknowledgement (ACK) data
packet.

SELECT-5 (5 Tone Signaling System). In the 5 Tone Signaling Systems,
each radio has a unique numeric identity (for example, 12345). To signal
the number 12345, a sequence of 5 tones is sent. Sequences of audible
tones of a very short duration are sent between radios. Most 5 tone
sequences take less than half a second to send. Available for Voice Calls,
Check Radio, Call Alert, and Enable/Disable Radio.

Click the Configure link and specify desired SELECT 5 settings.

Configure Select 5 x

Voice Calls

Private Cal Encoder:

Group Call: Encoder:

Call Type Telegram ID Source 1D
\
[
[
[
\
[

[i!
All Call: Encoder:
[

Check Radio
call Alert
Enable Radio

Disable Radio

Quick Call I. Using this signaling system, the radio sends a pair of tones
followed by 50 to 1,000 milliseconds of silence and then a second pair of
tones.

Click the Configure link and specify desired Quick Call | settings.

Quick Call | x
Preamble: Js00] : ms
Tone 1: 1000 S ms
Tone 2: 1000 s oms
Long Tone: 4000 ms
Pause: 200 Sims
Defaults oK G |

Quick Call II. Using this signaling system, the radio sends a single tone
followed by 50 to 1,000 milliseconds of silence and then a second tone.
Click the Configure link and specify desired Quick Call Il settings.

Quick Call Il MOTOTRBO
When this system is selected, the parameters are configured on the radio
unit via the MOTOTRBO CPS.

Allow CSBK Data
Select this option so that GPS data is sent in a single CSBK.
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5.9.3.3 Audio Paths

The Audio Paths are talk paths of the system to make and receive Voice Calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a radio
system be registered in its configuration. If an audio path is not registered, the
TRBOnet operator will not be able to receive and transmit to the corresponding talk

group.

Note: Audio paths are available only when one of the following modes is
selected: Capacity Plus, Linked Capacity Plus, Connect Plus, or
Capacity MAX.

¢ In the Configuration pane, under the corresponding Control Station, select
Audio Paths.

Configuration Audio Paths
/ Advanced settings A
,J\ Geocoding Servers Site ID: 1 :
| Radio Networks Call Type Group ID Site
Q Digital Systems W Grovp Cal 10 Wide
- & Services ! | Group Call 20 Wide
£ IP Site Cnnn.ect J Private Call
Ll Control Station #1
/’_ Advanced settings W Al
. 12 cio Paths
- IZ) TRBOnet Swift Agent#1
% Controller #1
% Controller #1
:é Selex #1
-[2] Analog Control Stations
5= Remote Agents
| Friendly Servers
‘@ Telephony
- )9'_ Advanced settings
- ﬂ' Enberna\ PBX Server add s
/ Advanced settings he
Set Defaults Apply 0K Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
* To add an audio path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
voice calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is an ID of the talk group the dispatcher can
make calls to. The Group ID is not applicable for Private Calls and All Calls.

= In the Site column, select either Local or Wide. The value Wide means that
the audio path will be to all sites in the system and not just to the local site.

5.9.4 Adding a MOTOTRBO Repeater

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add MOTOTRBO System.
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¢ In the Repeater pane, specify the connection parameters.

Configuration Digital Systems
& service -~
0 Network: ' Enable Digital Systems

@ Redundancy

Database CAI Network: 12

¢ Reports CAI Group Metwork: 225
L} Service Management
)’_ Advanced settings Registered Digital Systems

L.\ Geocoding Servers .. Name IP Address

.| Radio Networks

g Digital System: o Add Control Station

Services

[ Analog Contro e Add MOTOTREO System
3=l Remote Agents gp  Add TREOnet Swift Agent
bl Friendly Servers | i A4 Friendly FS-1000 Station
E Telephony
' Data Sources qp  Add XRC Controller
3% Modbus TcP o Add XRT Controller

{ Email &l Add SELEX Repeater
B 5M3
= license

Set Defaulty Set Defaults Apply

Ak Ar

oK

/®

Radio ID
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To ensure your connection parameters match the actual configuration of your
radio network, you may need to use Motorola CPS or Config Advisor tools to

determine the values. Contact your radio network administrator, if you do not
have this information.

Configuration
q Service
G MNetwork
@ Redundancy
Database
L‘ Reports
£} Service Management
)’_ Advanced settings
* Geocoding Servers
.| Radio Metwarks
@ Dlglta\ Systems
L} Services
Repeater #1
)9: Advanced settings

" Privacy
I Slot #1

I Slot #2

: Local Slots
- gigy Control Station #1
=| Analog Control Stations
3=l Remote Agents

3 Friendly Servers

Set Defaults

System Name

Repeater #1

System Name: Repeater #1
TRBOnet Peer ID: 100
TRBOnet Radio ID: 54250
TRBOnet Local Port: 50000

Master Repeater Connection Info:

Master IP Address: 10.10.102.131
Master UDP Port: 50011
Authentication Key: 99999
System Type: 1P Site Connect

System Identifier: Departmentl

Use MAT Voice
Use MAI Data (MMIS and DDMS)

Apply

Ak 4K 4r

4r A

Ok

Enter a name of the repeater. This name will be displayed in the Dispatch

Console.
TRBOnet Peer ID

Enter a Peer ID for TRBOnet Server. The Peer ID must be unique among the
repeaters in the radio system.

Note: Motorola recommends that this value be less than 200.

TRBOnet Radio ID

Enter the Radio ID, which is a gateway for voice and data. The Radio ID
must be unique in the radio system (for Capacity Plus and Linked Capacity
Plus systems, the maximum value is 65535).
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TRBOnet Local Port

Enter the local port number that will be used by TRBOnet Server to
establish a connection to the repeater. Use unique port numbers for each
repeater connection if there are several repeaters connected.

Master IP Address
Enter the Ethernet IP address of the master repeater.

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Master IP.

Master UDP Port
Enter the UDP port number of the master repeater.

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Master UDP Port.

Authentication Key
Enter the repeater's authentication key (if any).

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Authentication Key.

System Type

From the drop-down list, select the type of the radio system
('IP Site Connect', 'Capacity Plus', 'Linked Capacity Plus', or
‘Extended Range Direct Mode').

Test

Click this button to check the connection to your master repeater. If the test
is successful, you'll see the information on the repeater you are connected
to, such as the serial number, firmware version, and other relevant
information.

System ldentifier

Enter the system identifier if a Capacity Plus or Linked Capacity Plus system
is used with one or more control stations. Use the same system identifier as
you have specified for the corresponding control stations.

Use NAI Voice

Select this option to connect to the repeater via NAI (Network Application
Interface) for Voice transfer. For more details about NAI, see Appendix F:
NAI VOICE & DATA Support (page 362).

Use NAI Data (MNIS and DDMS)

Select this option to connect to the repeater via NAI (Network Application
Interface) for Data transfer. For more details about NAI, see Appendix F: NAI
VOICE & DATA Support (page 362).

o MNIS
MOTOTRBO Network Interface Service is a Windows application which
acts as a data gateway between the data applications and the radio
system. Data messages are routed through the MNIS.

TRBOnet Enterprise — User Manual



TRBOnet Server

/®

Device Discovery and Mobility Service is a service for tracking the

neocom
SOoftware

presence of radio subscribers in the radio network and transmitting the

data to the server.

5.9.4.1 Advanced Settings

¢ In the Configuration pane, under the corresponding Repeater, select
Advanced settings.

Configuration Advanced settings

o service ~
0 MNetwork
@ Redundancy
Database
2 Reports
L} Service Management
)9: Advanced settings
N Geocoding Servers
.| Radio Networks
@ Digita\ Systems
} Services
‘3 Repeater #1
3 Advanced settings
Privacy

Voice Call Hang Time (ms):
Group Call: 3000
Private Call: 4000

=
-

-

-

Emergency Call: 4000 s
¢ : -
TX Preamble: 120 :
TX Timeout: &0 : seconds

Phone System: Motorola Phone System -

Slot #1
.0 Slot #2
: Local Slots
gy Control Station #1
=| Analog Control Stations
35 Remote Agents
3 Friendly Servers W

Set Defaults Apply s/’ Cancel

¢ In the Advanced Settings pane, specify the following repeater-related
advanced settings:

Voice Call Hang Time (ms):

= Group Call

This value sets the duration the repeater reserves the channel after the end
of a group call transmission. During this time, only members of the group
that the channel is reserved for can transmit.

Private Call

This value sets the duration a radio keeps the private call setup after a user
releases the PTT button. This is to avoid setting up the call again each time
a user presses the PTT button to transmit. During this time, other radios can
still transmit since the channel is essentially idle. After the hang timer
expires, the radio transmits using the TX Contact Name parameter specified
for this channel in MOTOTRBO CPS.

Emergency Call

This value sets the duration the repeater reserves the channel after the end
of an emergency call transmission. During this time, only members of the
Group that the channel is reserved for can transmit.

Note: The values of the above three parameters must be taken
from the corresponding parameter values programmed for
the repeater via MOTOTRBO CPS in General Settings.
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= TX Preamble
Enter the value of the TX Preamble. The TX Preamble is a string of bits
added in front of a data or control message (Text Messaging, Location
Messaging, Registration, Radio Check, Private Call, and other message
types) before transmission. The acceptable range is 0 - 8640 ms. The
recommended value is 120 ms.

= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When the
dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

= Phone system
From the drop-down list, select the system for phone calls:

¢ Motorola Phone System
This system uses a special call type with the parameters specified for a
radio unit in MOTOTRBO CPS. The Motorola Phone System is
recommended for IP Site Connect mode to minimize Radio response
time. For more details on programming Motorola Radios, see Appendix
E: SIP Setup for Motorola Phone System (page 359).

¢ TRBOnet Phone System (TX Interrupt)
This is a phone call system based on the private call type using TX
Interrupt feature. This phone system is available for radio systems with
control stations.

= Allow CSBK Data
Select this option so that GPS data is sent in a single CSBK.

Note: This feature is available only when the MNIS Data Service is
enabled for the repeater.

5.9.4.2 Privacy

¢ In the Configuration pane, under the corresponding Repeater, select Privacy.

Configuration Privacy
d’: Service S
0 Metwork Privacy Type: Enhanced -
@ Redundancy
Database
@ Reports
L} Service Management Enhanced Privacy Keys:
,’_ Advanced settings o] Mame Value
© 17 Geocading Servers T
.| Radio Networks
@ Digital Systems
4L} Services
tﬂ Repeater #1
L3 advanced settings
Privacy
Slot #1
Slot 22

Enhanced Algorithm: ARC4 (40 bit) b

L0 Local Slots
-qlgy Control Station #1

| Analog Control Stations

32l Remote Agents

5zl Friendly Servers L

Add Remove

Set Defaults Apply oK Cancel
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¢ In the Privacy pane, specify the following privacy-related settings:

Privacy Type
From the drop-down list, select one of the privacy types: None, Basic, or
Enhanced.

Basic Privacy Key ID
Enter the Privacy Key ID available for the Basic privacy type.

Enhanced Algorithm
From the drop-down list, select one of the enhanced algorithms if you are
going to use additional encryption.

Enhanced Privacy Keys
Here you add enhanced privacy keys for the selected enhanced algorithm.

e Click Add and specify the required ID, name, and value for the privacy
key being added.

5.9.4.3 DDMS Service

The DDMS, or Device Discovery and Mobility Service is a service for tracking the
presence of radio subscribers in the radio network and transmitting the data to the

server.

¢ In the Configuration pane, under the corresponding Repeater, select
DDMS service.

Configuration DDMS service

¢ Service A
0 MNetwork i/ Use DDOMS service

# Redundancy Local port: 0 s

Database )

@ Reports Service IP Address: 127.0.0.1 - Test
LF Service Management Service port: 3000 b
}" Advanced settings Authentication Port: | 5055 s

.3\, Geocoding Servers

: . =
.| Radio Networks RETEID 2 =
@ Digital Systems Redundant services:
£} Services Service IP Address | Service port Local part
- pffl Repeater #1 1 M : 3000 0

Advanced settings
Privacy
DDMS service
MNIS data service
Slot #1
LI Slot %2
..£17 Local Slots
-y Control Station #1
= Ana\og Control Stations ]

Add Delete Test

Set Defaults Apply oK Cancel

¢ |n the DDMS service pane, specify the following DDMS service-related
settings:

Use DDMS service
Select this option to enable the DDMS service for the server.

Local Port

Enter the number of the local port to be used on a PC with TRBOnet
Dispatch Software for DDMS service.

Service IP Address

Enter the IP Address of the PC with the DDMS service installed and running.
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= Service port

Enter the service port number.

Note: This value is programmed for a DDMS service via
MOTOTRBO DDMS Administrative Client, in
Interfaces >Watcher Settings>PortWatcher.

= Authentication Port

Enter the authentication server port number.

Note: This value is programmed for a DDMS service via
MOTOTRBO DDMS Administrative Client, in
Interfaces >Authentication Server Settings>
AuthenticationServerPort.

= Radio ID list

Enter the list of radios to be monitored.

= Redundant services

Here you see the list of redundant DDMS services for failover purposes.

e Click Add and specify the required parameters for the DDMS service

being added.

e Click Test to test if the selected DDMS service is available.

e UsetheUp (*)and Down (¥ ) buttons to move a selected DDMS
service up and down in the priority list of DDMS services.

5.9.4.4 MNIS Data Service

The MNIS, or Motorola Network Interface Service, is a Windows application which
acts as a data gateway between the data applications and the radio system. Data
messages are routed through the MNIS.

46

¢ In the Configuration pane, under the corresponding Repeater, select

MNIS data service.

Configuration
ﬂ‘ Service -
0 Metwork
# Redundancy
Database
2 Reports
L} Service Management
/f_ Advanced settings
)\ Geocoding Servers
.| Radio Networks
@ Digital Systems
Services

Repeater #1

£ Advanced setti
Privacy

DDMS service

MNIS data ser
,l’_ Advanced :
.00 Audio Paths

< 3

W

Set Defaults

MNIS data service

\/ Use Data Gateway

/! Service is on a local host

IP Address: 172.168.10.2 A
i Control port: 5000 s Test
MNIS Service: &2
Redundant services:
IP Address Control port Local port
Add
Apply oK. Cancel
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¢ In the MNIS data service pane, specify the following MNIS data service-
related settings:

Use Data Gateway
Select this option to enable the MNIS data service for the server.

Service is on a local host
Select this option if the MNIS data service will be used on the local PC.

IP Address
Enter the IP Address used by the MNIS to communicate with the PC.

Note: This value is programmed for a MNIS data service via
MOTOTRBO MNIS Configuration Utility, and can be
retrieved from General>Tunnel Network>Tunnel IP Address.

Control port
Enter the number for the MNIS control port.

Note: This value is programmed for a MNIS data service via
MOTOTRBO MNIS Configuration Utility, in
Advanced>Network>MNIS Control Interface TCP Port.

MNIS Service
Select this option, and from the drop-down list select the available MNIS
service.

Redundant services
Here you see the list of redundant MNIS data services for failover purposes.

e Click Add and specify the required parameters for the MNIS data service
being added.

e Click Test to test if the selected MNIS data service is available.

e UsetheUp (2 )and Down (Y ) buttons to move a selected MNIS data
service up and down in the priority list of MNIS data services.

Advanced Settings

¢ |n the Configuration pane, under MNIS data service, select Advanced
settings.
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Configuration Advanced settings
& Service ~
O Network Add network routes to the Windows routing table

& Redundancy
Database
'b\ Reports Send data to group over control port

LF Service Management Radio Range: 1 : - 16777215 s
}’_ Advanced settings
.\ Geocoding Servers
.| Radio Metworks
(g} Digital Systems

[} Services
= tﬂ Repeater #1
L pdvanced settings
Privacy
DDMS service
)!', Advanced settings
MNIS data service

i )’_ Advanced settings
L. Audio Paths v

Set Defaults Apply oK Cancel

¢ In the Advanced settings pane, you can specify settings that relate to the
remote MNIS data service:

= Add network routes to the local Windows routing table
Select this option to allow TRBOnet Server to add network routes to the
local Windows routing table so that data can be sent to the remote MNIS
data service.

= Add port forwarding rules to the remote MNIS service
Select this option to allow TRBOnet Server to add forwarding rules to the
remote MNIS data service.

= Send data to group over control port
Select this option so that data will be sent via the specified control port.

= Radio Range
Specify the range of radios to be monitored by the MNIS service.

5.9.4.5 Slots

Note: The slots are available only when IP Site Connect is selected in the
Repeater pane.

¢ In the Configuration pane, under the corresponding Repeater, select Slot #1
or Slot #2.
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Configuration Slot #1

' Service -~

G Network V! slot #1

ig Redundancy Mame: IPSC1

= Database Messaging Delay: Mormal -
i Reports

Use the slot for RX Data only (GRS Revert or Data Revert)

Use Privacy

£¥ Service Management
/’ Advanced settings
LA Geocoding Servers
.| Radio Networks
Q) Digital Systems W] Always transmit when the PTT is pressed (“Impolite” channel access)
L F Services
epeater #1
}: Advanced setti
Privacy
I
LI Slot #2
Local Slots
-fligh Control Station #1

Private Call Confirmed
i Emergency Alarm Adk
¥4 Emergency CallfAlarm Indication

< >

Set Defaults Apply oK Cancel

¢ In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters:

Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

Messaging Delay
From the drop-down list, select the inter-repeater messaging delay based
on the IP network configuration.

e Normal
The inter-repeater messaging delay is 60 ms.
¢ High
The inter-repeater messaging delay is 90 ms.
Use the slot for RX data only (GPS Revert or Data Revert)

Select this option to configure the slot so that it will only receive data, thus
having no transmission capability.

Use Privacy
Select this option to use Privacy for the slot.

Note: This option is available only if the Basic or Enhanced
Privacy Type have been selected in Repeater's Privacy
settings.

Privacy Key
From the drop-down list, select the privacy key.

Note: This option is available only if the Enhanced Privacy Type
has been selected in Repeater's Privacy settings).

Allow TX interrupt
Select this option to allow interrupting dispatcher transmissions by radios
that are Transmit Interrupt capable.

Note: This feature is available only when the Use NAI Voice
option is cleared in the Repeater pane.

49



&

neocom
sofFtware

= Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that when the PTT button is pressed, the dispatcher
will start transmitting regardless of whether the channel is free or not (that
is any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

= Data Call confirmed
Select this option to enable data packets in data calls (ARS, GPS, and Text
Message) on the current slot to be confirmed.

Note: This feature is available only when both the Use NAI Voice
and Use NAI Data (MNIS and DDMS) options are cleared
in the Repeater pane.

= Private Call Confirmed
Select this option to set Private calls on the current slot as confirmed. By
default, Private calls are unconfirmed.

= Emergency Alarm Ack
Select this option so that the Dispatch Console is allowed to acknowledge
an emergency alarm received via this slot.

= Emergency Call/Alarm Indication
Select this option so that audio and visual indication is given for an
emergency call/emergency alarm received via this slot.

5.9.4.6 Local Slots
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While on a local slot, voice or data are not transmitted between sites in IPSC
systems. Due to MOTOTRBO limitations TRBOnet Server can only receive
information from local slots, but cannot transmit by IP connection to such slots.

Note: Local slots are available only when IP Site Connect is selected, and
the Use NAI Voice option is selected in the Repeater pane.
If the Use NAI Voice option is cleared, local slots will be available
only through dedicated control stations.

¢ In the Configuration pane, under the corresponding Repeater, select
Local Slots.
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Configuration Local Slots
U Service ~
Load P Map
0 MNetwork S
@ Redundancy Name
Database i/ Local Brine's|
2 Reports

I} Service Management

/’_ Advanced settings

L.k Geocoding Servers

.| Radio MNetwarks

Q) Digita! Systems

- L} Services

1:3 Repeater #1

34 Advanced settings
Privacy

DDMS service

MNIS data service

): Advanced settings
Slot #1

Slot #2

Local Slots

iy Control Station #1 v

Add

Set Defaults

Peer ID Peer Slot

1002 Slot #1
Configure
oK. Cancel

¢ In the Local Slots pane, specify the following Local Slot-related settings:

= To add a Local Slot to the system, click Add.

Enter the Peer ID of the repeater.

Select the option in the first column to enable the selected local slot.

Enter a Name for the local slot. This name will be displayed in the Dispatch
Console.

Note: This value can be taken from the repeater's configuration in

MOTOTRBO CPS, in General Settings>Radio ID.

From the drop-down list, select the Peer Slot.

To configure the selected local slot, click Configure:

T Configuration
Name: _ocal Brine's
Messaging Delay: Mormal

Use Privacy

Private Call Confirmed
/] Emergency Alarm Ack
¥4 Emergency CallfAlarm Indication

Use the slot for RX Data only(GPS Revert or Data Revert)

Always transmit when the PTT is pressed ("Impolite” channel access)

= Specify the desired local slot settings similar to those for a common
repeater slot.

5.9.4.7 Audio Paths

The Audio Paths are talk paths of the system to make and receive Voice Calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
Capacity Plus system be registered in its configuration. If an audio path is not

registered, the TRBOnet operator will not be able to receive and transmit to the
corresponding talk group.
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Note: Audio paths are available only when Capacity Plus or Linked
Capacity Plus are selected.

¢ In the Configuration pane, under the corresponding Repeater, select
Audio Paths.

Configuration Audio Paths
G Network

& Redundancy Losd Groups Map

Database Call Type Group ID Site ID

2 Reports ]| Group call 10 Wide
L ¥ Service Management W Group Call 20 Wide
," Advanced settings W] Private Cal

(RN Geocoding Servers K71 allcall

.| Radio Networks
..{Z) Digital Systems

L} Services
.o TP Site Connect

}' Advanced setti

Privacy
DDMS service
MNIS data ser

)’_ Advanced :
L. Audio Pams/
-fligh Control Station #1
; v Add Delete Configure
< >
Set Defaults Apply oK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
= To add an audio path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
voice calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is an ID of the talk group the dispatcher can
make calls to. The Group ID is not applicable for Private Calls and All Calls.

= Enter the Site ID of the site the audio path will belong to in a Linked
Capacity Plus system. Or, leave zero value in this column. In this case, the
Site ID will be displayed as Wide, meaning that the audio path will belong
to all sites in the system.

= To configure the selected audio path, click Configure.

= Specify the desired audio path settings similar to those for a common
repeater slot.

5.9.5 Adding a TRBOnet Swift Agent

The TRBOnet Swift Agent functions as a gateway to receive and transmit voice and
data.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

e In the drop-down menu, click Add TRBOnet Swift Agent.
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Configuration
U Service
G MNetwork
@ Redundancy
Database
2 Reports
I} Service Management
/’_ Advanced settings
..k Geocading Servers
.| Radio Metworks

TRBOnet Swift Agent#1

Name:;
Radio ID:
1P Address:
Port:

Mode:

System Identifier:

TREOnet Swift Agent#1

64250
10.10.110.191
8002

Single Control Station

Department2|

Ak A4

Test

0 Dl‘gltal Systems Use the radio for RX Data only (GPS Revert or Data Revert)

Y

Repeater #1 VoIP port: 4000 =t

¢ Control Station #1
TRBOnet Swift Agent#1
,f: Advanced settings
: @ Redundancy
e [ Anzlog Control Stations
5l Remote Agents
[ Friendly Servers
E Telephany
|’ Data Sources v

Audio Format: PCM & kHz 16 bit -

Set Defaults Apply oK Cancel

¢ In the TRBOnet Swift Agent pane, specify the following Swift Agent-related
parameters:

Name
Enter a name for the Swift Agent. This name will be displayed in the
Dispatch Console.

Radio ID

This is the Radio ID of the control station connected to the Swift Agent.
(for Capacity Plus and Linked Capacity Plus systems, the maximum value is
65535).

Note: This box is populated automatically once you have
successfully tested the Swift Agent by clicking the Test
button.

IP Address
Enter the IP Address of the Swift Agent network interface.

Port
Enter the port number of the Swift Agent connection (8002, by default).

Test

Click this button to check the connection to the Swift Agent. If the test is
successful, you'll see the information on the Swift Agent you are connected
to, such as Serial number, Firmware version, and other relevant information.

Mode

From the drop-down list, select the connection mode for the Swift Agent
being configured. For more details, see section 5.9.3.1, Control Station
Connection Modes (page 34).

System ldentifier

Enter the system identifier if the control station is used with a Capacity Plus
or Linked Capacity Plus system. Note that the system identifier should be
the same for all control stations used in the radio system.
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Use the radio for RX data only (GPS Revert or Data Revert)

Select this option to configure the radio channel so that it will only receive
data, thus having no transmission capability.

VolP port

Enter the port number for audio communications (4000, by default).

Note: This setting is used for older firmware versions of TRBOnet
Swift Agent.

Audio Format
From the drop-down list, select the format to transmit audio data.

5.9.5.1 Advanced Settings
¢ In the Configuration pane, under the corresponding TRBOnet Swift Agent,

select Advanced Settings.

Configuration Advanced settings

U‘ Service ~
0 Metwork
@ Redundancy
Database
& Reports

/] Emergency CallfAlarm Indication
Always transmit when the PTT is pressed ("Impolite” channel access)

TX Timeout: &0 - | seconds
L} Service Management

}f Advanced settings
N Geocoding Servers
.| Radio Metworks
Q) Digital Systems

FTT Mode: Keylp / DeKey -

Signaling System: None ¥ | Canfigure

Repeater #1
¢ Control Station #1
TRBOnet Swift Agent#1
« Advanced settings
: Redundancy
L Anzlog Control Stations
[l Remote Agents
[ Friendly Servers
E Telephony
|’ Data Sources v

Set Defaults Apply Ok Cancel

¢ In the Advanced Settings pane, specify the following Swift Agent-related
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advanced settings:

= Automatically reset alarm mode

Select this option to reset alarm mode on the control station radio
automatically. It is recommended to enable this option.

Emergency Call/Alarm indication
Select this option so that audio and visual indication is given by the Control
Station radio when an Emergency Call/Emergency Alarm is received.

= Always transmit when the PTT is pressed ("Impolite” channel access)

Select this option so that that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.
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= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

*= PTT Mode
From the drop-down list, select the mode of pressing the PTT on the radio.

= Signaling system
From the drop-down list, select the signaling system.

MDC-1200 signaling is a Motorola data system using audio frequency
shift keying (ASFK) using a 1,200 baud data rate. A general option is to
enable or disable an acknowledgement (ACK) data packet.

SELECT-5 (5 Tone Signaling System). In the 5 Tone Signaling Systems,
each radio has a unique numeric identity (for example, 12345). To signal
the number 12345, a sequence of 5 tones is sent. Sequences of audible
tones of a very short duration are sent between radios. Most 5 tone
sequences take less than half a second to send. Available for Voice Calls,
Check Radio, Call Alert, and Enable/Disable Radio.

Click the Configure link and specify desired SELECT 5 settings.

Quick Call I. Using this signaling system, the radio sends a pair of tones
followed by 50 to 1,000 milliseconds of silence and then a second pair of
tones.

Click the Configure link and specify desired Quick Call | settings.

Quick Call II. Using this signaling system, the radio sends a single tone
followed by 50 to 1,000 milliseconds of silence and then a second tone.
Click the Configure link and specify desired Quick Call Il settings.
Quick Call Il MOTOTRBO

When this system is selected, the parameters are configured for the
radio units via the MOTOTRBO CPS.

5.9.5.2 Redundancy

A Redundant TRBOnet Swift Agent will be used when a connection to the Main
TRBOnet Swift Agent is lost.

¢ In the Configuration pane, under the corresponding TRBOnet Swift Agent,
select Redundancy.
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Configuration Redundancy

U Service ~
0 Network Redundant agents:

# Redundancy IP Address Port Local Port

Database
2 Reports
I} Service Management
/’_ Advanced settings
..k Geocading Servers
.| Radio Metworks
i Digital Systems
L} Services
I:B Repeater #1
{gy Control Station #1
I TRBOnet Swift Agent#1
/ Advanced settings
e [ Anzlog Control Stations
5l Remote Agents
[ Friendly Servers

7§ Telepheny Add Delete Test
|’ Data Sources W

1 M 10.10.0.210 8002 i

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, specify the following Redundant Agent-related
settings:

= Click Add and specify the desired parameters for the Redundant Agent
being added.

IP Address
Enter the IP Address of the Swift Agent that will be used as a Redundant
Swift Agent.

Port
Enter the port number that will be used for connections between the
server and the Redundant Swift Agent (8002, by default).

Click Test to check the connection to the Redundant Swift Agent.

If the test is successful, you'll see the information on the Swift Agent you
are connected to, such as Serial number, Firmware version, and other
relevant information.

Local Port

Enter the port number that will be used for connections from the
Redundant Swift Agent. The value 0 (default) means that a random port
will be used.

5.9.6 Adding an XRC Controller

The XRC Controller is a site controller that provides a channel for transferring data
between sites and managing data flow.
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¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add XRC-9000 Controller.
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Conﬁgurahnn Controller #1
----- A Geocoding Servers -

7 Radio Netwarks Name: Controller #1
Q) Digital Systems
L¥ Services
I:B Repeater #1 System Identifier: Connect Plus 1

lgy Control Station #1 Radio ID list: 105,111 ?
I TRBOnet Swift Agent#1

..... }' Advanced settings
R 59 Redundancy

L Analog Control Stations
5= Remote Agents

IP Address: 192.168.0.250 - Test

[ Friendly Servers
78 Telephony
V' Data Sources
2% Modbus TCP

{ Email
|5 sMs

E License

Set Defaults Apply oK Cancel

¢ In the Controller pane, specify the following XRC controller-related
parameters:

= Name
Enter a name for the XRC controller. This name will be displayed in the
Dispatch Console.

= |P Address
Enter the IP Address of the XRC controller network interface.

= (Click Test to check the connection to the controller.

= System ldentifier
Enter the system identifier. Note that the system identifier should be the
same through all the controllers in a Connect Plus system.

= Radio ID list
Enter a list of the radios to receive data from according to the following
rules:

e To receive data from all radios in the system, leave this box blank.

e To receive data from multiple radios, separate each Radio ID by a
comma, for example, 105,106,111, and so on.

e To receive data from a range of radios, enter the range using the
following example: 105-111.

Note: In the Radio ID list, enter Radio IDs only, without
mentioning Radio Names and/or the word "Radio".

5.9.6.1 Advanced Settings

¢ In the Configuration pane, under the corresponding XRC Controller, select
Advanced Settings.
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Configuration
[N Geocoding Servers -
.| Radio Networks

Digital Systems

I:B Repeater #1
gy Control Station #1
I TREOnet Swift Agent#1
g Controller 1
i (- Redundancy
L Analog Control Stations
95 Remote Agents

[ Friendly Servers
78 Telephony
| Data Sources
21t Modbus TCP
{ Email
|5 sMs

E License

Set Defaults

Advanced settings

Contraller port: 4005

Local port: 1}

! Location service (GP3  Indoor)
Controller port: 4001

Local port: 4001

Use adaptive GPS trigger

W/ Text Messaging service (TMS)
Contraller port: 4007
Local port: 4007

Dispatcher ID: 64250

Multi Gate Connection

Apply oK Cancel

¢ In the Advanced Settings pane, specify the following XRC controller-related
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advanced settings:

= Automatic Registration service (ARS) provides an automated data
application registration for the radio. When the radio powers up, it
automatically registers with the server. This feature is used with data
applications, that is any data traffic on this channel is associated with an
application server, such as MOTOTRBO Text Messaging or MOTOTRBO
Location Service. This option is selected by default and cannot be cleared.

e Controller port

Enter the controller's port number for ARS service (4005, by default).

¢ Local port

Enter the local port of the PC with TRBOnet Dispatch Software. The value
0 (default) means that a random port will be used.

= Location service (GPS)

Select this option to enable Location service on the controller. The radio can
send its coordinates when it is in Global Positioning coverage area. GPS
settings can be configured in the Service Management pane (see section

5.7.2, Location Service).

e Controller port

Enter the controller's port number for Location service (4001, by default).

¢ Local port

Enter the local port of the PC with TRBOnet Dispatch Software (4001, by

default).

¢ Use adaptive GPS trigger
Select this option to use the adaptive GPS polling interval.

= Text Messaging service (TMS)
Select this option to enable text message transmission on the controller.

e Port

Enter the controller's port number for Text Messaging service (4007, by

default).
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e Local port

Enter the local port of the PC with TRBOnet Dispatch Software (4007, by

default).
e Dispatcher ID

Enter the Dispatcher ID. The Dispatcher ID should belong to TRBOnet
Server account in a Connect Plus system.

= Multi Gate Connection

Select this option to use a multi-gate connection and enter the
corresponding Subscribe ID.

5.9.6.2 Redundancy

A redundant XRC controller will be used when a connection to the main XRC

controller is lost.

¢ In the Configuration pane, under the corresponding XRC Controller, select

Redundancy.

Configuration
/J\ Geocoding Servers
.| Radio Metwarks
@ Digital Systems
L} Services
:B Repeater #1
&y Control Station #1

flp‘: Controller #1
..... }' Advanced settings
; ;! Redundancy
. Analog Control Stations
= Remote Agents
[l Friendly Servers
E Telephony
}' Data Sources
3 Modbus TCP
24 Email
[ sMs

E License

Set Defaults

I TRBOnet Swift Agent#1

Redundancy

Redundant controllers:
IP Address Contraller port
1 ] 192.168.0.255 4005

Add Delete Test

Apply QK Cancel

¢ In the Redundancy pane, specify the following redundant XRC controller-

related settings:

= Click Add and specify the desired parameters for the redundant XRC

controller being added.

e |IP Address

Enter the IP Address of the XRC controller that will be used as a
redundant XRC controller.

e Controller Port

Enter the port number of the redundant XRC controller for incoming
connections (4005, by default).

e Click Test to check the connection to the redundant XRC Controller.
If the test is successful, you'll see the information on the XRC controller
you are connected to, such as serial number, firmware version, and other

relevant information.
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e Local Port

Enter the port number that will be used for incoming connections from
the redundant XRC controller. The value 0 (default) means that a random
port will be used.

5.9.7 Adding an XRT Controller

The XRT controller functions as a voice gateway connected to each XRC controller in
a Connect Plus system.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add XRT-9000 Controller.

Configuration Controller #1
L.\ Geocoding Servers ~
.| Radio Metwarks

42} Digitel Systems

System Name: Controller #1

Radio ID: 54250

-4} Services
Iﬁ Repeater #1
iy Contral Station #1

Start Local Port: 0

XRT-2000 Controller Info:

Ab 4

B TREOnet Swift Agent#1
gy Controller #1

): Advanced settings
& Redundancy

Controller IP Address: 192.168.0.225

4

Controller TCP Port: 10001

4k

Test

User Name: Admin

Password:  sssss

System Identifier: Connect Plus 1

1 Audio Paths

.. Redundancy

| Analog Control Stations

il Remote Agents

[ Friendly Servers

E Telephany

J Data Sources v

Manitor Voice sessions (without audio)

Set Defaults

Apply OK Cancel

¢ In the Controller pane, specify the following XRT Controller-related
parameters:
= System Name

Enter a name for the XRT Controller. This name will be displayed in the
Dispatch Console.

= Radio ID
Enter the individual virtual radio ID. The virtual Radio ID is required to do
the following:

e Make all types of voice calls from XRT Controller to radios, dispatchers
and groups.
e Send commands (for example, Remote Monitor).

= Start Local Port

Enter the local port of the PC with TRBOnet Server. The value 0 (default)
means that a random port will be used.

XRT Controller Info:

= Controller IP Address
Enter the IP Address of the XRT controller network interface.
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5.9.7.1 Privacy

Controller TCP Port

Enter the port number of the XRT controller to be used for connections via
TCP (10001, by default).

Click Test to check the connection to the XRT controller.

User Name
Enter the user name. For the user name, refer to the XRT controller
configuration.

Password
Enter the password for the user. For the password, refer to the XRT
controller configuration.

Note: The user name and password should belong to the same
TRBOnet Connect Plus account and be appropriately
configured.

System Identifier
Enter the system identifier. Note that the system identifier should be the
same through all the controllers in a Connect Plus system.

Monitor Voice sessions (without audio)
This is the Billing feature. Select this option to monitor only PTT press
events.

¢ In the Configuration pane, under the corresponding XRT Controller, select
Privacy.

Cnnﬁguratlnn
..... )\ Geocoding Servers A
.| Radio Networks
..{Z) Digital Systems
L} Services
; :B Repeater #1
il Control Station #1
I TREOnet Swift Agent#1 D
iag Controller #1 1
4 advanced settings
@ Redundancy

Privacy

Privacy Type: Enhanced -

Enhanced Algorithm: ARC4 (40 bit) -
Enhanced Privacy Keys:
Name

A [Fee—

ER:TI Controller #1

.. Audio Paths

----- ‘.. Redundancy
=| Analog Control Stations
5= Remote Agents
[ Friendly Servers

E Telephony Add
} Data Sources ©

Remove

Set Defaults Apply oK Cancel

¢ In the Privacy pane, specify the following Privacy-related settings:

Privacy Type
From the drop-down list, select one of the privacy types: None, Basic, or
Enhanced.

Basic Privacy Key ID
Enter the Privacy Key ID available for the Basic Privacy Type.
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= Enhanced Algorithm
From the drop-down list, select one of the enhanced algorithms if you are
going to use additional encryption.

= Enhanced Privacy Keys
Here you add enhanced privacy keys for the selected enhanced algorithm.

e Click Add and specify the required ID, Name, and Value for the privacy
key being added.
5.9.7.2 Data Path
The Data Paths are used to transmit data in a Connect Plus system.

¢ In the Configuration pane, under the corresponding XRT Controller, select

Data Path.
Configuration Data Path
)\ Geocoding Servers -
.| Radio Networks Data Service: ‘Autodetect -
- 0 Digital Systems Radio ID: 64251 :

i LF Services

: :B Repeater #1

il Control Station #1
I TREOnet Swift Agent#1
gy Controller #1

}! Advanced settings
@ Redundancy

f Controller #1

=| Analog Control Stations
5= Remote Agents
I Friendly Servers

ﬁ Telephony
} Data Sources ©

Set Defaults Apply oK Cancel

¢ In the Data Path pane, specify the following data path-related settings:

= Data Service
From the drop-down list, select the data service to be used to transfer data.

= Radio ID
Enter the Radio ID of the data service.

5.9.7.3 Audio Paths
The Audio Paths are talk paths of the system to make and receive voice calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
Connect Plus system be registered in its configuration. If an audio path is not
registered, the TRBOnet operator will not be able to receive and transmit to the
corresponding talk group.

¢ In the Configuration pane, under the corresponding XRT Controller, select
Audio Paths.
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Conﬁgurahnn Audio Paths

----- A Geocoding Servers -
Radio Metworks Call Type Source ID Target ID
g Dlgltal Systems W Group Call 10

} Services ¥ Group Call 20
--,ﬁ Repeater #1 ! Private call 54250

g Control Station #1 M aical

-I) TREOnet Swift Agent#1

g5 Controller #1

- Advanced settings

Redundancy

P Commller #1

Audio Paths
@ Redundancy
... [2] Analog Control Stations
55| Remote Agents
5l Friendly Servers

ﬁ Telephony Add Delete Configure
V' Data Sources v
Set Defaults Apply oK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
= To add an Audio Path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
Voice Calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Source ID for Private Calls. In general, this is TRBOnet's Radio ID.
If more than one Radio ID is specified in a Connect Plus system (for
example, for different dispatchers), the corresponding talk paths should be
added for all of them.

= Enter the Target ID for Group Calls. This is the Radio ID of the talk group to
make a call to. The Target ID is not applicable for Private Calls and All Calls.

5.9.7.4 Redundancy

A Redundant XRT Controller will be used when a connection to the Main XRT
Controller is lost.

¢ In the Configuration pane, under the corresponding XRT Controller, select
Redundancy.

Conﬁgurahnn Redundancy
----- A Geocoding Servers -
.| Radio Networks
g Dlgltal Systems L |
¥ Services 1 |M 1921580226 e g
:B Repeater #1
-l Control Station #1
-I) TREOnet Swift Agent#1
g5 Controller #1
}' Advanced settings
. g Redundancy
- Controller #1
] Privacy
} Data Path
Audio Paths
i @ Redundancy
.. [2] Analog Control Stations
55| Remote Agents
5l Friendly Servers

Redundant controllers:
Controller IP Address | Controller TCP Port | Start Local Port

28 Telephony Add Delete Test
V' Data Sources v
Set Defaults Apply 0K Cancel
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¢ In the Redundancy pane, specify the following Redundant XRT Controller-
related settings:

= Click Add and specify the desired parameters for the Redundant XRT
Controller being added.

= Controller IP Address
Enter the IP Address of the XRT Controller that will be used as a Redundant
XRT Controller.

= Controller TCP Port
Enter the port number of the Redundant XRT Controller to be used for
connections via TCP (10001, by default).

= Start Local Port
Enter the local port of the PC with TRBOnet Dispatch Software. The value 0
(default) means that a random port will be used.

= Click Test to check the connection to the Redundant XRT Controller.
If the test is successful, you'll see the information on the XRT Controller you
are connected to, such as Serial number, Firmware version, and other
relevant information.

5.9.8 Adding a Selex Repeater

The Selex repeater is configured as a stand-alone repeater which supports
connections to MOTOTRBO™ radios to transmit voice and data in digital, analog,
and mixed modes.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add SELEX Repeater.

Configuration Selex #1

A Geocoding Servers -

.| Radio Metworks Name: Selex #1

@) Digital Systems Radio ID: 64250 :
i-LF Services

Repeater #1

iléh Control Station #1

I TREOnet Swift Agent#1

Repeater Mode: Digital -

% Controller #1
% Controller #1

- - Advanced settings
00 Slot #1

I Slot #2
-[%] Analog Control Stations
5 Remote Agents

[ Friendly Servers

78 Telephony

V' Data Sources

%2 Modbus TCP

24 Email W

Set Defaults Apply oK Cancel

¢ In the Selex pane, specify the following Selex Repeater-related parameters:

* Name
Enter a name for the Selex Repeater. This name will be displayed in the
Dispatch Console.
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= Radio ID
Enter the Radio ID for the Selex Repeater (for Capacity Plus systems, the
maximum value is 65535).
The Radio ID is an individual ID that uniquely identifies the radio. This ID is
used by other calling radios when addressing the radio, for instance, when
making a private call or sending a text message.

* Repeater Mode
From the drop-down list, select the mode. The available modes are Digital,

Analog, Mixed, and Tier lll.

5.9.8.1 Advanced Settings
¢ In the Configuration pane, under the corresponding Selex, select Advanced

.
Settings.
Cnnﬁgurahnn Advanced settings
----- )\ Geocoding Servers -
.| Radio Networks Keep Alive Interval: 10 : seconds
g D'g'tal Systems TX Timeout: &0 5 | seconds

i ¥ Services
: tﬁ Repeater #1
iy Control Station #1
i TREOnet Swift Agent#1
% Controller #1
ﬁ Controller #1
I:ﬂ Selex #1
/{, Advanced settings

£ Slot #1

L. Slot #2
=| Analog Control Stations
2| Remote Agents
I Friendly Servers
78 Telephony
" Data Sources
12 Modbus TCP
4 Email W

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following Selex Repeater-related

advanced settings:

= Keep Alive Interval
Enter the time interval, in seconds, for TRBOnet Server to check the
connection to the Selex repeater (10, be default).

= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any Voice Session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires (60, be default).

5.9.8.2 Slots

The Selex repeater has two available slots (in Digital or Mixed mode) to transmit
voice and data.

¢ In the Configuration pane, under the corresponding Selex, select Slot #1 or
Slot #2.
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Configuration Slot #1

N Geocoding Servers -
.| Radio Networks
.. g Digital Systems

L LT Services
I:B Repeater #1
il Control Station #1
- TREOnet Swift Agent#1 Test
i Controller #1
% Controller #1

/] Slot #1

Name: Slot 1

TREOnet IP Address: 10.10.100.99 - & Port: 6080

4K 4

SELEX IP Address: 10.10.9.30 v |Port: | 6080

Use the gateway for RX Data only (GPS Revert or Data Revert)
Use Encryption

Selex #1
}f Advanced settings
I Slot %1
I Slot #2
... [®] Analog Control Stations
5 Remote Agents

Always transmit when the FTT is pressed (Impalite™ channel access)
i/ Data Call Confirmed
W1 Private Call Confirmed

[ Friendly Servers
78 Telephony
| Data Sources
21t Modbus TCP
24 Email he

Set Defaults Apply oK Cancel

In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters:

Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

TRBOnet IP Address
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the
Port number (6080, by default).

SELEX IP Address
Enter the IP Address of the Selex Repeater (refer to the repeater
configuration). Enter the Port number (6080, by default).

Click Test to check the connection to the repeater.

Use the gateway for RX data only (GPS Revert or Data Revert)
Select this option to configure the channel so that it will only receive data,
thus having no transmission capability.

Use Encryption
Select this option to encrypt voice and data traffic over IP.

Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

Data Call Confirmed
Select this option to enable individual packets in data calls (ARS, GPS, and
Text Message) on the current slot to be confirmed.

Private Call Confirmed
Select this option to set Private calls on the current slot as confirmed.
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5.9.8.3 Tier lll and Audio Paths

The Selex repeater can be used in a Tier lll mode. To configure this mode, do the
following:

e While in the Selex pane, select Tier Ill from the Repeater Mode drop-down
list.

¢ In the Configuration pane, under the corresponding Selex, select Tier Ill.

Cnnﬁguratlnn Tier IT1
----- ,J\ Geocoding Servers -
.| Radio Networks
Q) Digital Systems Name:
L Services TRECnetIP Address:  [10,10.100.98  ~ @ Port: 6030 &
-l Repeater 1 SELEX IP Address: 10,10.2.30 +Port: |g080 %
(-l Control Station #1 B—— -

.. TREOnet Swift Agent#1 G
% Controller #1

% Controller #1

gy Selex £1 Use Encryption

}: Advanced settings Always transmit when the PTT is pressed ("Impolite” channel access)
- Audio Paths w/! Private Call Confirmed

... [%] Analog Control Stations

55 Remote Agents

[ Friendly Servers
’E Telephony
|’ Data Sources
2% Modbus TCP
4 Email hd

Set Defaults Apply oK. Cancel

¢ In the Tier lll pane, specify the following Tier Ill-related parameters:

= Use Encryption
Select this option to encrypt voice and data traffic over IP.

= Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

= To configure Audio Paths:

¢ In the Configuration pane, under the corresponding Selex, select
Audio Paths.

Note: Make sure the Tier lll mode has been selected as a
Repeater Mode for the Selex repeater.
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Configuration Audio Paths
A Geocoding Servers -
.| Radio Networks Call Type Entyly

igital Systems ¥4 Group Call 10
Services W Group Call 0
:B Repeater #1 i Private Cal
¢} Control Station #1 | Al cal
-B7) TRBOnet Swift Agent#1
% Controller #1
% Controller #1
j Selex #1
- Advanced settings
Tier IIT
i Audio Paths
- [&] Analog Control Stations
5 Remote Agents

[ Friendly Servers

78 Telephony

V' Data Sources

2% Modbus TCP Add Delete
4 Email h

Set Defaults Apply oK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
= To add an Audio Path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
Voice Calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is a radio ID of the talk group to make a call to.
The Group ID is not applicable for Private Calls and All Calls.

5.9.8.4 Analog channel
The Selex repeater can also use the Analog channel.
¢ In the Configuration pane, under the corresponding Selex, select Analog.

Note: Make sure the Analog or Mixed mode have been selected
as a Repeater Mode for the Selex repeater.

Configuration Analog
)\ Geocoding Servers ]
.| Radio Networks b

Digital Systems MName: Analog

Services TRECnet [P Address: | 10.10.100.99 v @ Port | 6080

:ﬁ Repeater #1

-y Control Station #1

-7 TRBOnet Swift Agent#1 Test

% Controller #1

& Controller #1

y Selex #1

/’_ Advanced settings Always transmit when the PTT is pressed ("Impalite" channel access):
i..qra Analog

.. [2] Analog Control Stations

5= Remote Agents

AF 4r

SELEX IP Address: 10.10.5.30 v |Port: | 6080

[ Friendly Servers

E Telephony

} Data Sources

2} Modbus TCP

4 Email

[E v

Set Defaults Apply oK Cancel

¢ In the Analog pane, specify the following Analog channel-related settings:
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Name

Enter a name for the Selex repeater in the analog mode. This name will be
displayed in the Dispatch Console.

TRBOnet IP Address
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the
Port number (6080, by default).

SELEX IP Address
Enter the IP Address of the Selex Repeater (refer to the repeater
configuration). Enter the Port number (6080, by default).

Click Test to check the connection to the repeater.

Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

5.9.9 Adding a Kairos Repeater

The Radio Activity Kairos repeater is configured as a stand-alone repeater which
supports connections to MOTOTRBO™ radios to transmit voice and data in digital,
analog, and mixed modes.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add KAIROS Repeater.

Configuration Kairos #1 Version: 5.2.5.1409
.| Radio Networks -
..£5) TREOnet Cloud Name: Kairos 1
@ D'Q'ta' Systems IP Address: 10.10. 155,130
L L ¥ Services
H :ﬂ Capadity Max User Name: kairos
ﬁ Capadty Plus #1 Password: [ITIT1]
ﬁ Lep =1 Test
g 1PsC
lgy Control Station #1 Radio ID: 64250
g Kairos #1 Repeater Mode: Mixed (Analog and Digital)
)f Advanced setti
LI Slot #1
{03 slot #2
1 Analog
... [=| Analog Control Station:
5 Remote Agents
5l Friendly Servers
‘@& Telephony v
(‘ o >
Set Defaults Apply OK Cancel

¢ In the Kairos pane, specify the following repeater-related parameters:

Name
Enter a name for the Kairos repeater. This name will be displayed in the
Dispatch Console.

IP Address
Enter the IP Address of the Kairos repeater network interface.
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User Name

Enter the user name. For the user name, refer to the Kairos repeater

configuration.

Password

Enter the password for the user. For the password, refer to the Kairos

repeater configuration.

Radio ID

Enter the Radio ID, which is a gateway for voice and data. The Radio ID
must be unique in the radio system.

Repeater Mode

From the drop-down list, select the mode. The available modes are Digital,

Analog, and Mixed.

5.9.9.1 Advanced Settings
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¢ In the Configuration pane, under the corresponding Kairos, select Advanced
Settings.

Configuration

L} Service Management

,’_ Advanced settings

L.\, Geocoding Servers

.| Radio Networks
() TRBONet Cloud
Q) Digital Systems

-4} Services

g LR 1
g 1Psc

gy Kairos #1

L Slot #1
L. Slot #2
L. Analog

Set Defaults

tﬂ Capadty Max
o} Capacity Plus #1

¢l Control Station #1

=| Analog Control Stations

Advanced settings

Keep Alive Interval: 10

TX Timeout: &0

Voice Call Hang Time (ms):

Group Call: 3000
Private Call: 4000
Emergency Call: 4000

Version: 5.2.5.140%

seconds

seconds

Apply oK Cancel

¢ In the Advanced Settings pane, specify the following Kairos Repeater-related
advanced settings:

Keep Alive Interval

Enter the time interval, in seconds, for TRBOnet Server to check the
connection to the Kairos repeater (10, be default).

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any Voice Session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires (60, be default).

Voice Call Hang Time (ms):

Group Call

This value sets the duration the repeater reserves the channel after the end
of a group call transmission. During this time, only members of the group
that the channel is reserved for can transmit.
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= Private Call
This value sets the duration a radio keeps the private call setup after a user
releases the PTT button. This is to avoid setting up the call again each time
a user presses the PTT button to transmit. During this time, other radios can
still transmit since the channel is essentially idle. After the hang timer
expires, the radio transmits using the TX Contact Name parameter specified
for this channel in MOTOTRBO CPS.

= Emergency Call
This value sets the duration the repeater reserves the channel after the end
of an emergency call transmission. During this time, only members of the
Group that the channel is reserved for can transmit.

5.9.9.2 Slots

The Kairos repeater has two digital slots (in Digital mode) and one analog slot (in
Mixed or Analog mode) to transmit voice and data.

¢ In the Configuration pane, under the corresponding Kairos, select Slot #1 or
Slot #2 (or Analog, if you have selected Mixed or Analog mode).

Configuration Slot #1 Version: 5.2.5.1409
\.A Geocoding Servers ~
.| Radio Networks ¥/ slot #1
£ TREONet Cloud Name: Slot 1
@' Digital Systems Audio Codec: G.711 p-Law/3000 -
-LF Services
ﬁ Caparity Max Audio port KAIROS: 40000
; o} Capadity Plus #1 Audio port TRECnet: 40000
LB Lep #1
Iﬁ PSC Data port KAIROS: 40001
¢ Control Station #1 Data port TRBOnet: 40001
Kairos #1
,’: Advanced setti
LI Slot #1
.0 Slot #2
1 Analog
=| Analog Control Station:
52| Remote Agents
[ Friendly Servers w
<] >
Set Defaults Apply OK Cancel

¢ Inthe Slot #1 (or Slot #2) pane, specify the following slot-related parameters:

= Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

= Audio Codec
From the drop-down list, select the audio codec to be used to compress the
audio files.

= Audio port KAIROS/ Audio port TRBOnet
Enter the port numbers to be used for KAIROS/TRBOnet audio ports.

= Data port KAIROS/ Data port TRBOnet
Enter the port numbers to be used for KAIROS/TRBOnet data ports.
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Note: Use the matching port numbers for KAIROS and TRBOnet.
The default audio and data port numbers are 40000 and
40001 for Digital slot 1, 40002 and 40003 for Digital slot 2,
and 40004 and 40005 for the Analog slot.

5.9.10 Adding a Wave Controller
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Before creating a connection to the Wave controller, make sure the Wave server is
configured to allow 3rd party applications to connect with a Neocom Software-
specified license key.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

e In the drop-down menu, click Add WAVE Controller.

Configuration Wave controller #1 Version: 5.3.0. 1686
: /’ Advanced setti &
rivacy Name: Wave Server 1
I Slot #1 Connection:
T Slot #2 \f Use proxy for connection
Local Slots
& Control Station #1 Controller IP Address: 10.10.150.110 M
I TREOnet Swift A1C
Eﬁ Repeater #1 TRBOnet Local Port: a :
sty Wave Server 1
.. [ Analog Control Station: User Name: testd
52| Remote Agents password: 0w
& Friendly Servers Profile: all-channels -
ﬂ Telephony
/ Advanced settings Test
- /Z& Internal PBX Server
)9'_ Advanced settings
3 External PBX Server
)’_ Advanced settings ,,
< - >
Set Defaults Apply OK Cancel

¢ In the Wave Controller pane, specify the following Wave controller-related
parameters:
* Name
Enter a name for the Wave controller. This name will be displayed in the
Dispatch Console.

= Use proxy for connection
Select this option to use a proxy server to connect to the Wave controller.

= Controller IP Address
Enter, or select from the list, the IP Address of the Wave controller.

= Controller Port
Enter the port number of the Wave controller.

= Local Port
Enter the local port number that will be used by TRBOnet Server to
establish a connection to the Wave controller.

= User Name
Enter the user name. For the user name, refer to the Wave server

configuration.
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= Password
Enter the password for the user. For the password, refer to the Wave server
configuration.
= Profile
From the drop-down list, select the profile to be used on the Wave server.
= Test

Click this button to check the connection to the Wave controller.

5.10 Analog Control Stations

TRBOnet Dispatch Software allows using analog radios as control stations.
¢ In the Configuration pane, select Analog Control Stations

¢ In the Analog Control Stations pane, select Enable Analog Control Stations.

Canﬁguratlan Analog Control Stations

..... )\ Geocoding Servers A

] Radio Networks b/l Enable Analog Control Stations:

..{Z) Digital Systems

Services

:ﬁ Repeater #1

-y Control Station #1

- TRBOnet Swift Agent#1

ﬁ Controller #1

a3 Controller #1

g Selex #1

}' Advanced settings
L. Analog

- [E] Analog Control Stations

ek Control Station A1

55| Remote Agents

5l Friendly Servers

ﬁ Telephony

I Data Sources

.. Name Serial Port
i/ Control Station A1 coM1

% Modbus TCP Add Delete
{ Email ©

Set Defaults Apply oK Cancel

5.10.1 Adding an Analog Control Station
¢ In the Analog Control Stations pane, click Add.

Canﬁguratlan Control Station Al
----- ,J\ Geocoding Servers -
.| Radio Networks Name: Control Station A1
Q) Digital Systems
Services Playback device: Primary Sound Driver r @

ﬁ Repeater #1 Recorder device: Primary Sound Capture Driver - @

gy Control Station #1

B TREOnet Swift Agent#1 Serial port: ComM1 -

ﬁ Controller #1
ﬁ Controller #1

gy Selex #1 TX Timeout: 60 % | seconds

; . Advanced settings

Always transmit when the PTT is pressed ("Impolite" channel access)

H 14 Analog Mic delay time: o : I

- [7] Analog Control Stations

fly Control Station A1
] Remot= Agents Extended protocol: None -
I Friendly Servers
'E Telephony

I Data Sources

3% Modbus TCP

{ Email w

Set Defaults Apply oK. Cancel

¢ In the Control Station pane, specify the following Analog Control Station-
related settings:

73



&

neocom
sofFtware

Name
Enter a name for the analog control station. This name will be displayed in
the Dispatch Console.

Playback device
From the drop-down list, select the playback device on the PC that the
control station is connected to.

Recorder device
From the drop-down list, select the recording device on the PC that the
control station is connected to.

Serial port
From the drop-down list, select the serial port the control station is
connected to on the PC.

Always transmit when the PTT is pressed ("Impolite” channel access) -
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

Mic delay time
Enter the time, in milliseconds, to be used as a delay time interval between
pushing the PTT and starting voice communication.

Extended protocol

From the drop-down-list, select either None, if your radio does not support
the extended protocol, or IC-F1721D v1.01 if the radio supports the
extended protocol.

5.10.1.1 Serial Port

Note: The serial port settings are available only when the
extended protocol IC-F1721D v1.01 is selected for the
analog control station.

¢ In the Configuration pane, under the corresponding Control Station, select
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Serial Port.
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Conﬁgurahon Serial Port

----- A Geocoding Servers -

I:I Radio Networks Baud Rate: 19200 =
Q) Digital Systems P s :

{:} Services
I:B Repeater #1 Parity: Mene
-y Control Station #1
-B7) TRBOnet Swift Agent#1
55 Controller %1 Handshake: Hone T
% Controller #1
:E Selex #1

X Advanced settings

i..q1} Analog
- @ Analog Control Stations

‘qly Control Station A1

E Remote Agents
% Friendly Servers
@8 Telephony
}* Data Sources
2% Modbus TCP v

Set Defaults Apply oK Cancel

4

Stop Bits: 1

¢ In the Serial Port pane, specify the same serial port settings as those on the
radio device connected to the serial port.

5.11 Remote Agents
The Remote Agent is TRBOnet Agent installed on a remote PC.

¢ In the Configuration pane, select Remote Agents.

Configuration Remote Agents
[] Radio Networks ~
@ Digital Systems Registered remote Agents:
{:} Services Agent Name 1P Address Part Redundancy

:B Repeater £1 W Agent: 1 10.10.110. 190 4020 Ne
iy Control Station #1
-E7) TRBOnet Swift Agent#1
% Controller #1
% Controller #1
:é Selex #1
; X Advanced settings
1 Analog
- ﬁ Analog Control Stations
gl Control Station A1
1 Serial Port
% Remote Agents
b Agent: 1
@ Redundancy
% Friendly Servers

28 Telephony Add Delete Test
| Data Sources v
Set Defaults Apply oK Cancel

¢ In the Remote Agents pane, click Add.
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Configuration Agent: 1
.| Radio Networks A
- g Digital Systems Agent Mame: Agent: 1
¥ Services

:ﬁ Repeater #1
~figh Control Station #1 Port: 4020 = Test
-7 TREOnet Swift Agent#1
% Controller #1

-3 Controller #1
g Selex £1

IP Address: 10.10.110, 190

() Use all services

©) Use only specified services:

Service Name

}: Advanced settings
.oy Analog
... [%] Analog Control Stations
.ty Control Station A1
L. serial Port

5 Remote Agents
9 Agent: 1

‘.. Redundancy
5l Friendly Servers

ﬁ Telephony

J Data Sources ~ Load services from agent

Set Defaults Apply oK Cancel

= |n the Agent pane, specify the following parameters:

o Agent Name
Enter a name for the remote agent. This name will be displayed in the
Dispatch Console.

o [P Address
Enter the IP address of the remote agent.

e Port
Enter the local port number that will be used by TRBOnet Server to
accept connections from the remote agent.

e Click Test to check the connection to the remote agent.

¢ Use all services
Choose this option so that all available services will be used on the
remote agent.

e Use only specified services
Choose this option and click the Load services from agent link to load
services available on the remote agent.

5.11.1 Redundancy

A Redundant remote agent will be used when a connection to the Main remote
agent fails.

¢ In the Configuration pane, under the corresponding Agent, select
Redundancy.
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Configuration Redundancy
.| Radio Networks A

Redundant ts:
g Dlgltal Systems edundant agen

Name TP Address Port
__ﬁ Repeater #1 1 ] Backup Agent 1 10.10.110,192 4021
-l Control Station #1 2 w/ Backup Agent 2 10.10.110.101 4022 -
-7 TREOnet Swift Agent#1
% Controller #1
-3 Controller #1
& Selex #1
}' Advanced settings
o T Analog
... [®] Analog Control Stations
ek Control Station A1
L. serial Port

5 Remote Agents
9 Agent: 1

e

5l Friendly Servers

T8 Telephony Add Edit Delete Test A
}* Data Sources ©

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, click Add.

Remote Agent X
Agent Name: Backup Agent 2
IP Address: 10.10.110,101
Port: 4022 s

(@ Use all services

() Use only spedified services

Load services from agent

oK Cancel

In the Remote Agent dialog box, specify the following parameters:

Agent Name
Enter a name of the redundant remote agent.

IP Address
Enter the IP address of the redundant remote agent.

Port
Enter the local port number that will be used by TRBOnet Server to
accept connections from the redundant remote agent.

Click Test to check the connection to the redundant remote agent.

Use all services
Choose this option so that all available services will be used on the
redundant remote agent.

Use only specified services

Choose this option and click the Load services from agent link to load

services available on redundant the remote agent.
Click OK to add a redundant remote agent to the system.
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5.12 Friendly Servers

The Friendly Servers are used to transmit voice over IP between dispatchers
connected to different servers.

¢ In the Configuration pane, select Friendly Servers.

Configuration Friendly Servers
.| Radio Metworks ~
.{Q) Digital Systems Registered Friendly Servers:

I'} Services Name IP Address Port
:B Repeater #1 &/ Region Server £ 1 10.10.101. 167 4021
flgh Control Station 1 W Regio Server # 2 10.10.101.198 4022
I TRBOnet Swift Agent#1
: % Controller #1
% Controller #1
s Gelex #1
}f Advanced settings
g1 Analog

- [7] Analog Control Stations
iggh Control Station A1

L. Serial Port
5= Remote Agents
B
ﬁ Telephony
}* Data Sources

%% Modbus TCP Add Edit
24 Email &

Delete Test

Set Defaults Apply oK Cancel

e In the Friendly Servers pane, click Add.

Server X

Mame: Region Server # 1

1P Address: 10.10.101. 167
Port: 4021 =l
oK Cancel

= In the Server dialog box, specify the following parameters:

e Name
Enter a name for the friendly server. This name will be displayed in the
Dispatch Console.

e |P Address
Enter the IP Address of the server.

e Port
Enter the local port number on the PC to connect to the friendly server.

e Click Test button to check the connection to the friendly server.

e Click OK to add the friendly server to the system.
5.13 Telephony

TRBOnet Server has its own built-in SIP server to support VolP communications
between the radios as well as other SIP-compliant clients. In addition, you can add
an external PBX server to the TRBOnet Server configuration.

¢ In the Configuration pane, select Telephony

¢ In the Telephony pane, select Use Telephony.
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Conﬁgurahon

Local Slots
-flgh Control Station #1
-Z) TRBOnet Swift Agent#1 i
% Controller #1
% Controller #1
o Selex #1
Analog Control Stations
52| Remote Agents
[ Friendly Servers
’ﬂ Telephony
: /’_ Advanced settings
' Internal PEX Server
)’ Advanced settings
} Data Sources
s1% Modbus TCP
{ Email
[E

E License he

Set Defaults

5.13.1 Advanced Settings
¢ In the Configuration pane, under Telephony, select Advanced Settings.

Conﬁgurahcn
: 34 ndvanced setti A
| Privacy
Slot #1
Slot #2
17 Local Slots
fl¢h Control Station #1
; lg TRBOnet Swift A10
w2} Repeater #1
- [&| Analog Control Station:
55| Remote Agents
5= Friendly Servers
IR Telephony
/ Advanced settings
’ﬂ Internal PBX Server
: )’ Advanced settings
8 External PBX Server
)’ Advanced settings
. i Redundancy Y]

Set Defaults

Max Ring Time: 30
Manx Call Time: 10
Public Address:

Phone owner address:

Telephony

] Use Telephony

SIP Server
Internal PEX Server

Add

Apply

Advanced settings

77.232.61.122
Take from database

Apply

OK Cancel

Version: 5.3.0.1670

seconds

minutes

-

Configure

oK Cancel

¢ In the Advanced Settings pane, specify the following parameters:

Max Ring Time

Specify the maximum ringing time, in seconds.

Max Call Time
Specify the maximum call

Public Address

time, in minutes.

neocom
SOoftware

This is the public IP address of your PC. To detect the public address, click

the ellipsis (...) button.

Public IP Address

STUN Server:

Port:

Detect public IP Address over STUN server

stun.ekiga.net

3478 =

IP Address detected:  77.232.61.122

oK

Cancel
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e STUN Server
From the drop-down list, select the STUN Server.

e Detect
Click this button to detect your public IP address.

= Phone owner address
From the drop-down list, select ‘Take from database'. This will enable
determining the street address of a caller.
Click the Configure link.

Address format X

Address format:

, %HOUSE_NUMBER %, %STREET_NAME %] -
Availablefields:

$HOUSE NUMBERS SGFLAT NUMBERS%: STREET NAMESE SCOMMUNITY NAMESG
Y%STATE NAMEY: %%POSTCODEY %%COUNTRY NAME% 3:EXTRA INFO%%

oK Cancel

e Add the required fields to the address information.

5.13.2 Internal PBX Server

80

Make sure the Internal PBX Server option is selected in the Telephony pane.

In the Configuration pane, select Internal PBX Server.

Configuration Internal PBX Server
L LmSet# ~
Slot #2
L0 Local slots
-y Control Station #1
- TREOnet Swift Agent#1
% Controller #1
-2 Controller #1 SIP ID: 1234
:é Selex #1

. Analog Control Stations
5 Remote Agents

Local IP: 10.10.100.99 v & Port: 5080 5

Dispatch Center

SIP User: 1234

[ Friendly Servers
‘& Telephony

L../ZR Internal PEX Server
)’ Advanced settings
V' Data Sources
2% Modbus TCP
4 Email
[ sMs

E License ha

Set Defaults Apply oK Cancel

In the Internal PBX Server pane, specify the following parameters:

= Local IP
Enter the IP address of the PC with TRBOnet Server.

= Port
Enter the local UDP port number for the SIP service (5060, by default).

Dispatch Center

= SIPID
Enter the SIP ID that will be used by the Dispatch Center.
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SIP user

Enter the SIP user name that will be used by the Dispatch Center.

5.13.2.1 Advanced Settings

¢ In the Configuration pane, under Internal PBX Server, select
Advanced Settings.

Conﬁgurahon Advanced settings

- L ¥ Services ~
ﬁ Repeater #1 Packet time (ms): &0 2

¢ Control Station =1 Codecs: PCMU,PCMA, G729, 5PEEX, SPEEX-WE,AMR...
) TREONet Swift Age
% controller #1 Registration Interval (sec): 3800
&3 Controller #1 DTMF Send Mode: RFC 2833

.. [B] Analog Control Station:
52| Remote Agents

First VoIP port: Default

A Ak 4

[ Friendly Servers Use VaIP parts: Al

‘& Telephony
)f Advanced settings
‘& Internal PBX Server
8 External PBX Server
}' Data Sources
22 Modbus TCP
24 Email
[EL] w

<

Set Defaults Apply OK Cancel

¢ In the Advanced Settings pane, specify the following Internal PBX Server-
related advanced settings:

Packet time
Enter the packet length, in milliseconds.

Codecs
In the drop-down list, select/unselect the codecs to be used.

Registration Interval (sec)
Enter the time interval, in seconds, to check the SIP registration status of
subscribers.

DTMF Send Mode
Enter mode for sending DTMF tones. The available modes are RFC 2833,
SIP INFO (DTMF relay), and SIP INFO (DTMF).

First VolP port
Enter the number of the first VolP port for audio communications. The
default value is specified in Network Parameters.

Use VolP ports
From the drop-down list, select which VolP ports will be used (all, even, or
odd).

5.13.3 External PBX Server

You can enable an external PBX server to use the SIP Interconnect feature. This
feature enables calls from the radio to the phone and vice versa. The dispatcher can
make a call from the Dispatch Console to a phone as well as redirect a phone call to
a subscriber radio.
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¢ In the Telephony pane, click Add.
Or, in the Configuration pane, right-click Telephony and choose
Add PBX Server.

Configuration External PBX Server

/’_ Advanced settings  ~
{..C17 Local Slots Address: yourprovider. com uoP -
gy Control Station #1 Port: 5060 s Test
--Hf) TRBOnet Swift Agent#1
-5 Contraller #1 Local IP: 10.10.100.99 ~ ¢ Pport: 5061 3
% Controller #1
I:é Selex #1 Dispatch Center
... [®] Analog Control Stations
55 Remate Agents SIP ID: 57068
[ Friendly Servers SIP User: User 123
= .Telephony P —
,f: Advanced settings
- E Internal PBX Server Test Cal

)’ Advanced settings
3 External PBX Server
/ Advanced settings
" Data Sources hd

Set Defaults Apply oK Cancel

¢ In the External PBX Server pane, specify the following parameters:
= Use External PBX Server
Select this option to enable an external PBX server.
Provider options

= Address
Enter your SIP provider address, and select the protocol from the drop-
down list on the right of the address (for more details, contact your SIP
provider).

= Port
Enter the port number of the SIP provider (5060, by default).

= Click Test to check the connection to the provider.

= Local IP
Enter the IP address of the PC with TRBOnet Server.

= Port
Enter the local port number to make connections from.

Dispatcher Center

Note: This information is provided by the SIP provider.

= SIPID
Enter the SIP ID that will be associated with TRBOnet Server to make and
receive calls.

= S|P user

Enter the SIP user name for the login.

= Password
Enter the password for the login.
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Test Call
Click this button to make a test call.

Note: To make a test call, make sure that the TRBOnet Server
service is not running.

5.13.3.1 Advanced Settings

¢ In the Configuration pane, under External PBX Server, select
Advanced Settings.

Configuration Advanced settings Version: 5.3.0.1698
bl Privacy ~
Slot 21 Packet time (ms): &0 -
Slot %2 Codecs: G7111,G711a,0PUS, OPUS-WB,G729,5PE...
-L11 Local Slots o =
1l Control Station #1 Registration Interval (sec): 3600 p
.. TRBOnet Swift Agent #1 DTMF Send Mode: RFC 2833 -
- [2] Analog Control Stations Do not register users on a PBX server (SIP trunk)
5 Remote Agents
= Do not register internal users on a PBX server
[ Friendly Servers
R Telephony Configure user's authorization
3 )" Advanced settings First VoIP port: Default :
IR Internal PEX Server i
)’ Advanced settings = A M

3 External PEX Server Available SIP numbers: 5555-65666 -
L2 Advanced settings
iﬁ Redundancy

I Data Sources

=4 Email

i..pem Incoming Mail Server v

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following External PBX Server-
related advanced settings:

Packet time
Enter the same value as specified in the phone system;

Codecs
In the drop-down list, select/unselect the codecs specified in the phone
system.

Note: For more details on Phone System configuration, see
Appendix E: SIP Setup for Motorola Phone System
(page 359).

Registration Interval (sec)
Enter the time interval, in seconds, to check the SIP registration status of

subscribers.

Do not register users on a PBX server (SIP trunk)

Select this option so that radios will use the SIP trunk system to get
extensions.

Configure user’s authorization

Click this link to set up user authorization for the systems with enhanced
authorization parameters. It is recommended to be used when Radio ID is
equal to SIP ID. In case when Voice is transmitted via Radio Channel, Radio
ID is used. When voice is transmitted via a GSM channel, the SIP ID is used.
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SIP Authorization users

SIPID User Name

I 010101 iUser # 1

Add Delete
apidd X oK Cancel

e Click Add to add a new user authorization.

e SIPID
Enter the SIP ID for the new user.

e User Name
Enter the User Name for the new user;

e C(lick OK to save the new user authorization.

= First VoIP port
Enter the number of the first VolP port for audio communications. The

default value is specified in Network Parameters.

= Use VolIP ports
From the drop-down list, select which VolP ports will be used (all, even, or
odd).

= Auvailable SIP numbers
Enter the range of SIP phone numbers available on the PBX server.

5.13.3.2 Redundancy
A Redundant PBX Server be used when a connection to the main PBX Server fails.

¢ In the Configuration pane, under External PBX Server, select Redundancy.

Configuration Redundancy Version: 5.3.0.1670

2} Privacy

Slot #1

I Slot #2

17 Local Slots
iy Control Station #1
I TREOnet Swift A1C
nﬁ Repeater #1

- [&|] Analog Control Station:

Redundant PEX Servers:
PBX Server Address  PBX Server Port TREOnet Local Port

123.321.102,.201 5060 5061

55 Remote Agents

[ Friendly Servers

ﬂ Telephony

/ Advanced settings

& Internal PBX Server
)’_ Advanced settings

a External PBX Server
,’_ Advanced settings
.. g Redundancy i Reregister users when changing PEX server

}* Data Sources "

Add Delete Test
4 >

Set Defaults Apply OK Cancel

¢ In the Redundancy pane, click Add.
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= PBX Server Address
Enter the IP address of the redundant server.

= Check the corresponding port numbers (PBX Server Port and TRBOnet
Local Port).

= Select the check box beside the server address.

= Register users when changing PBX server
Select this check box so that phone users will be registered when the PBX
server is switched to the redundant server.

5.14 Data Sources

The Data Sources feature allows receiving data from third-party applications and
devices.

TRBOnet Dispatch Software can work with the following two data source types:
1. Physical or virtual devices connected via a COM port
2. PCs running third-party applications connected via TCP/IP

To allow TRBOnet Dispatch Software to receive data from a third-party application
or device:

¢ In the Configuration pane, select Data Sources.

Configuration Data Sources
:B Repeater #1 -
" Contral Station #1
I TREOnet.Swift Agent #1
% Controller #1
ES Controller #1
=| Analog Control Stations
55 Remote Agents
[ Friendly Servers
‘& Telephony
.. /’_ Advanced settings
= E Internal PEX Server
= 3 External PBX Server
/ Advanced settings

~.I-/ Data Sources

- COM ports

0% 1eppp

2l Modbus TCP

24 Email
B sMs &

Set Defaults Apply oK. Cancel

¢ In the Data Sources pane, select the Enable Data Sources option.

5.14.1 COM Ports

To manage physical or virtual devices connected to the TRBOnet Server PC via COM
port:

¢ In the Configuration pane, under Data Sources, select COM ports.
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Configuration COM ports

:ﬂ Repeater #1 ~

gy Control Station #1 Mame Baud Parity Data... Handsh... StopBits TextE...
~Bg TRBOnet. Swift Agent #1 W] comi 5600 Mone 8 MNone 1 ASCII

XBL £

-8 Contraller #1 ¥ coMz ss00 None 8 None 1 ASCIL
% Controller #1

... [®] Analog Control Stations

55 Remote Agents

[ Friendly Servers
‘& Telephony
. /’_ Advanced settings
'8 Internal PEX Server

.. a External PEX Server

/ Advanced settings

V' Data Sources

. 1F COM parts

:.% Modbus TCP

4 Email

by SMS e Add Delete Edit
< >

Set Defaults Apply oK Cancel

¢ In the COM ports pane, click Add to add a new device.

COM Port X

Serial port name:

Baud rate: 9600 A
Parity-checking protocal: Mone -
Stop bits per byte: 1 -
Data bits per byte: 8 -
Handshaking protocol : Mone -
Protocol: Text -
Text Enceding: ASCIT -
Message delimiter: LINE FEED Ox0A(\n) -

Cancel

¢ In the COM Port dialog box, specify the following parameters:

Serial port name
From the drop-down list, select the COM port on the PC with TRBOnet
Server to which the device is connected to.

Baud rate

From the drop-down list, select the baud rate at which the data is
transmitted.

Parity-checking protocol

From the drop-down list, select one of the values that represent the parity-
checking protocol.

Stop bits per byte

From the drop-down list, select the standard number of stop bits per byte.

Data bits per byte
From the drop-down list, select the standard length of data bits per byte.

Handshaking protocol
From the drop-down list, select the handshaking protocol for serial port
transmission of data.
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Text Encoding

From the drop-down list, select the Text Encoding type.

Note: The Text Encoding types selected in the TRBOnet Server
and in the connected application must be the same to
avoid incorrect text display and incorrect data parsing.

Message delimiter

From the drop-down list, select the type of delimiters in the data.

Note: The Message delimiter types selected in the TRBOnet
Server and in the connected application must be the same
to avoid incorrect text display and incorrect data parsing.

= Click OK to save settings and close the dialog box.

5.14.2 TCP/IP

To manage PCs running third-party applications:
¢ In the Configuration pane, under Data Sources, select TCP/IP.

Configuration

: % Controller #1
% Controller #1

55 Remote Agents
[ Friendly Servers
ﬂ Telephony
- )f_ Advanced settings
.8 Internal PEX Server
.. 3 External PBX Server
}' Advanced settings
I Data Sources
.1 COM parts

212 Modbus TCP
24 Email
BO SMS5

E License

£

Set Defaults

- [7] Analog Control Stations

) TREOnet. Swift Agent #1 A

TCR/IP
Mame Remote IP Port Mode Encoding
W Terminal 1 11002 Client UTF8
W Terminal 2 10.10.102.216 11002 Server  UTF3
M Add Delete Edit
>
Apply oK Cancel

¢ In the TCP/IP pane, click Add to add a TCP/IP connection.

[ Ignere the following data

During: min
Do not consider the following substring:
Cance

External Connection X
Name: Terminal 2
Mode: Server (TREOnet connects to App) -
Remote IP: 10,10, 102,216
Port: 11002 5
Protocol: Text A
Text Encoding: |UTF8 -
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¢ In the External Connection dialog box, specify the following parameters:

= Name
Enter a name for the TCP/IP connection.

= Mode
From the drop-down list, select the connection mode. The connection
mode depends on the type of the application installed on the connected
PC:

e Client
In this case, the application connects to TRBOnet Server which sends the
data to the application.

e Server
In this case, TRBOnet Server accepts connections from the application
and receives the data.

* Remote IP
Enter the IP address of the application server.

Note: Available only when the Server connection mode is
selected.

* Port
In the case of the Client connection mode, select the local port of the PC
with TRBOnet Server PC.
In the case of the Server connection mode, select the port of the PC where
the third-party application is installed.

= Text Encoding
From the drop-down list, select the Text Encoding type.

Note: The Text Encoding types selected in the TRBOnet Server
and in the connected application must be the same to
avoid incorrect text display and incorrect data parsing.

= Ignore the following data
Select this option so that the following messages arriving during the
specified time period will be ignored.

e During
Specify the time period, in minutes, so that similar messages that arrive
during this time period will be ignored.

e Do not consider the following substring
Enter a regular expression that will be used to filter messages upon
arriving and before being processed. For example, the following regular
expression \d{2}:\d{2}:\d{2} means that if a message contains a
substring like 11:01:54, then this substring will be dropped before
processing the message.
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5.15 Email Settings

TRBOnet Dispatch Console allows processing emails as follows:
1. Receive emails from email servers and forward them to a particular radio or
talk group (via a POP3 or IMAP server);

2. Send emails from radios to a particular email address (SMTP Server).

Note: Microsoft Exchange Server can be used as SMTP and POP3/IMAP
servers.

¢ In the Configuration pane, select Email.
¢ In the Email pane, select Enable Email Server.

Configuration Email
gl Control Station 1 ~
) TREOnet. Swift Agent %1 w/‘?;'nable Email Server!

% Controller #1
ﬁ Controller #1

... [®] Analog Control Stations
5= Remote Agents

[ Friendly Servers

‘& Telephony

. /’_ Advanced settings
'8 Internal PEX Server

.. g External PBX Server

I Data Sources

2% Modbus TCP

=4 Email
rers Incoming Mail Server
L..mw Outgaing Mail Server

B SMS v
€ >

Set Defaults Apply oK Cancel

5.15.1 Incoming Mail Server

The Incoming Mail Server is used to synchronize the Incoming Emails folder located
on a mail server with your local PC. If you are using a POP3 server, all incoming
emails can be downloaded from the mail server to the local PC to be then forwarded

as text messages to radios or talk groups.
¢ In the Configuration pane, under Email, select Incoming Mail Server.

Version: 5.3.0.1711

Configuration Incoming Mail Server

i..[#] Analog Control Stations ~
5 Remote Agents Enable
B2 Friendly Servers Server: |imap.gmai\.com |
‘@ Telephony

P oa This server requires a secure connection {S5L)

Advanced settings

=z Inberna\ PBX Server Part: 983 i
/% Advanced settings Protocol: IMAP -
a Exbernal PBX Server
i f Advanced settings Check for new messages
L. @ Redundancy every: |15 =/ seconds
| Data Seurces Connect using

¥ COM ports
- Anonymous access
g___ TCP/IP @] y

24 Email (O windows authentication

WP Incoming Mail Server (®) Uselogin and password

L. QUtgoing Mail Server Logln: |Desbed383 |
i sMs
E License Password: | “““““ |
v
Check New Emails Now
£ >
Set Defaults Apply oK Cancel
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¢ In the Incoming Mail Server pane, specify the following incoming mail-
related parameters:

= Enable
Select this option to enable Incoming Mail Server.

= Server
Enter the server hostname or IP address.

= This server requires a secure connection (SSL)
Select this option to enable a secure connection. Note that a dedicated port
will be used to connect to the mail server via SSL.

Note: The port number will automatically change when you select
this option. For example, from 110 to 995 for POP3, and
from 143 to 993 for IMAP.

= Port
The port number to be used for the connection.

Note: This box is populated automatically depending on the
selected protocol and whether a secure connection is
required.

= Protocol
From the drop-down list, select either IMAP or POP3. Note that if you
select POP3, all email messages will be deleted from the server once you
have downloaded them. In the case of IMAP, all new messages will be
marked as read once you have downloaded them.

Note: The port number will automatically change when you
change the protocol.

= Check for new messages every X seconds
Enter the time interval to check for new email messages (60, by default).

= Connect using
Choose one of the following options:

e Anonymous access
Choose this option to use an anonymous access to the incoming mail
server.

¢ Windows authentication
Choose this option to connect via TRBOnet Service Windows Account, if
it is running under a specific account;

e Use login and password
Choose this option and specify the credentials for the mailbox:

v Login
Enter the incoming mail server login.

v Password
Enter the incoming mail server password.
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= Check New Emails Now

Click this button to synchronize the Incoming Emails folder and check for
new emails.

5.15.2 Outgoing Mail Server

The SMTP Server is used to send emails from users to mail servers as well as
between mail servers to deliver emails to the final destination.

For example, the Administrator can enable email notifications from TRBOnet
Dispatch Console to particular email users when alarms occur on selected radios. In
this case, the radio sends an alarm to TRBOnet Server which in turn converts this
alarm to text and then forwards it as an email message to particular email addresses
(for example, to admin@yourcompany.com).

¢ In the Configuration pane, under Email, select Outgoing Mail Server.

Configuration Outgoing Mail Server Version: 5.3.0,1711
i..[#] Analog Control Stations A
5= Remote Agents Enable
[ Friendly Servers Sender Email: | |
‘& Telephony

/f_ Advanced settings SMTP Server: |smtp.gmai|.com |

: S Internal PBX Server

i / Advanced settings

3 External PEX Server SMITP Server Port: 965 .
/ Advanced settings
# Redundancy

V' Data Sources

. COM ports

Encryption: Implicit (S5L) -

Connect using
(C) Anonymous access
(O windows authentication

é"'EETCPﬂP (®) Use SMTP user name and password

T Emi User name: |besbed383 |

i-.per Incoming Mail Server

..s® Outgoing Mail Server Password: | ========= |

L 5Ms Type: Auto -
E License

& E Send Test Message i
< >
Set Defaults Apply 0K Cancel

¢ In the Outgoing Mail Server pane, specify the following outgoing mail-
related parameters:

= Enable
Select this option to enable Outgoing Mail Server.

= Sender Email
Enter the email address (optional) of the sender.

= SMTP server
Enter the server hostname or IP address of the SMTP server.

= Encryption
From the drop-down list, select the encryption protocol (SSL, TLS) if a
secure connection is required, or select None if not. Note that three
different dedicated ports will be used to connect to the mail server: via SSL,
TLS, or with no encryption.

Note: The port number will automatically change when you select
the encryption protocol. For example, from 25 (no
encryption) to 465 for SSL, and to 587 for TLS.
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= SMTP server port
The port number to be used for the connection.

Note: This box is populated automatically depending on the

selected encryption protocol.

= Connect using
Choose one of the following options:

e Anonymous access
Choose this option to use an anonymous access to the SMTP server.

v" User name

Windows authentication
Choose this option to connect via TRBOnet Service Windows Account, if
it is running under a specific account;

Use SMTP user name and password
Choose this option and specify the credentials for the mailbox:

Enter the SMTP server user name.

v" Password

Enter the SMTP server password.

v Type

From the drop-down list, select the SMPT login type.

= Send Test Message
Click this button to send a test message from the Sender Email address.

SMS Settings

TRBOnet Dispatch Console allows sending SMS notifications to a cell phone when
alarms and other events occur on selected radios (for example, DTMF commands
from radios, Telemetry, Radio State, and other events).
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Configuration
| i3 Controller #1

o B Analog Control Stations

5= Remote Agents
I Friendly Servers
‘& Telephony

/’_ Advanced settings
{8 Internal PEX Server
('% External PBX Server

}* Data Sources
T} COM parts
B 1ep e

:.% Modbus TCP

4 Email
rees Incoming Mail Server
L.awr Qutgoing Mail Server

B85 SMS

§ sMs

E License
£

Set Defaults

SMS

Sender:

Connection to GSM via:
Login:

Password:

¢ In the Configuration pane, select SMS.
¢ In the SMS pane, select Enable SMS Server.
¢ In the Configuration pane, under SMS, select SMS.

Vianett service {www. vianett.com) ~

|Iogin @yourcompany.com ‘

Send Test MMS Send Test SMS

Apply oK Cancel
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¢ In the SMS pane, specify the following SMS-related parameters:

Sender
Leave this box blank.

Connection to GSM via
From the drop-down list, select the type of connection.

¢ COM port GSM modem
Select this item if you are using a GSM Modem connected via COM port.
In addition, select the COM port the modem is connected to, and enter
the SIM Card Pin Code.

¢ Gemalto Cinterion EHS6T LAN
Select this item if you are using a Cinterion EHS6T GSM modem
connected via LAN. In addition, enter the IP address of the modem, and
enter the SIM Card Pin Code.

¢ Vianett service
Select this item to use an account on Vianett service.
For more details on Vianett service, see www.vianett.com

e SMS Broadcast
Select this item to use an account on SMS Broadcast service.
For more details on SMS Broadcast service, see
www.smsbroadcast.com.au

e Clickatell
Select this item to use an account on Clickatell service.
In addition to the Login and Password, you'll have to specify the API ID.
For more details on Clickatell service, see www.clickatell.com

Login
Enter the login for the selected service account.

Password
Enter the password for the selected service account.

Send Test MMS
Click this button to send a test MMS from the selected service account to a
recipient's phone number.

Note: This button is available when connected via Vianett service
only.

Send Test SMS
click to send a test SMS from Vianett account to recipient phone number.

Note: This button is available when connected via Vianett, SMS
Broadcast, or Clickatell services.
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6 TRBOnet Dispatch Console

The key features of TRBOnet can be configured by the Administrator in TRBOnet
Dispatch Console after initial installation and configuration.

6.1 Connecting to Server

Launch TRBOnet Dispatch Console using the desktop or Start menu shortcut.

The default Administrator credentials are admin for the login and admin for the

password.

Connect to TRBOnet Server >

Connect to:

Address: 127.0.0.1 ~

Port: 4021 = Configure
Authentication:

Method: TRBCnet Authentication ~

User Name: |admin ‘

Password: — ‘

|:| Connect on startup

Connect to:

= Address
Enter the IP address of the TRBOnet Server to connect to.

Note: This is the Network interface parameter of TRBOnet Server

configured in section 5.4, Network Parameters (page 17).

* Port
Enter the local port of the TRBOnet Server PC to accept connections from
the Dispatch Console.

Note: This is the Command port parameter of TRBOnet Server

configured in section 5.4, Network Parameters (page 17).

Authentication:

= Method
From the drop-down list, select the Authentication method:

TRBOnet Authentication
Select this method to log on as a User registered in the TRBOnet
Dispatch Console Users list.

Windows Authentication
Select this method to log on using the PC name. The system
automatically shows the PC name as a User Name.

Note: The Windows user must be registered in the TRBOnet

94

Dispatch Console Users list.
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6.2

User Name
Enter the User Name registered in the TRBOnet Dispatch Console Users list.

Password
Enter the user password.

Connect on startup

Select this option to launch the Dispatch Console without having to type
the User Name and Password every time. Use this option if you regularly
connect to the same TRBOnet Server and your workstation is in a secure
location.

Main Window Elements

When the TRBOnet Dispatch Console application is initially launched, the default
Dispatch Console window will be displayed with the Voice Dispatch tab being

active.

q
Voice Dispatch Radio Interface ﬂ

Bl = & & | & 7| @ || redo mterface | Recentcalsfevens |

e ) Firemen Wednesday, April 25, 2018
£ 11:17
(#) 125 (Pete)
®
- [P Repeater #1: Slot #1 [ [« [@
® =N CTE——
= Firemen
® ozt T
(#) Radio 201 i i -
7Y [ record [[r rFie [
ession: To: Selected C| 6
Sender Drag and Drop PTT Box here to
O L] areatz new grow
g = Ra:m Bridge
Unknown r |
Any Groups PII'
Canacity Plus
Recent Calls/Events 7|
5] Playback |l Save- () Print | 11 Pause < Clear ~ i Reload | [ Filter By Racio | = Grouping \/ Auto Filter (> Default Settings || 7 Details \ Show Notes [ Add Note
Date | Radio System | sender | Recpient | Message | Details | Note |
~ 14-Nov-2016 12:21:24  Repeater #1: Slot #1 135 Al Al Call from *125' (00:02) Members: 135 -
3 R Resagia 14Nov-2016 12:21:19  Repeater #1: Sot #1235 al 2l Call from '235' (00:02) Members: 235
B 11-Nov-2016 17:52:44 235 Al Reset Geofencing Alarm
@ peport= S8 11Nov-2016 17:52:38 238 Al eadm left allowed region Route 1
- 3 11-Nov-2016 17:52:38 235 Al Geofencing Alarm [GPS Date: 11-Nov-20.
Event Viewer 5% 11-Nov-2016 17:52:38 235 al Radio left allowed region Route 1' -
o W 4| 4] Record 1ofe0s | w4 ] ) 3
Radio Allocaton fccenCalsfvens | Recont ol | Rewest 7k | i it | ActveTod | Acive s | Ut Acty | i | omsas
127001 g3 By B | B Dispatcher 1 | (8 Licensed to: demo Demo License | @ nctive~

The main user interface elements are as follows:

1.

S O

Note:

Main menu

Radio list pane
Modules tab pane
Radio Interface pane
Activity Monitor panel
Quick Panels pane

The look of the Dispatch Console windows may have been
customized for your specific operation.
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6.3 Main Menu

The TRBOnet Dispatch Console main menu allows the user to manage the main
Dispatch Console options. The main menu is located in the upper left corner of the
main window.

6.3.1 File

The File menu contains the following items:

e File > Connect to TRBOnet Server
Choose this menu item to connect to a different TRBOnet Server, or to use
different credentials for the current connection.

For more details, see section 6.1, Connecting to Server (page 94).

¢ File > Exit
Choose this menu item to exit TRBOnet Dispatch Console.

6.3.2 View

The View menu contains the following items:

e View > Show Navigation Pane
Choose this menu item to toggle the display of the Navigation pane on the
left of the main window. The Navigation pane includes two panes: the Radio
list pane and the Modules tab pane (see section 6.2, Main Window Elements).

e View > Show Touch Keyboard Button
Select this menu item to display a Touch Keyboard button on the bottom of
the Modules pane. Clicking this button will bring up a virtual keyboard on the
screen.

e View > Show Modules
Choose this menu item, and in the drop-down menu select/unselect the
modules to display in the Modules tab pane.

¢ View > Configure PTT Boxes
Choose this menu item to configure the view of PTT boxes.

Configure PTT Boxes X

Radio Interface

Type Mame View Mode Available Calls

Channel Intercom Normal -
Channel Control Station #1 Normal Al

Group Group 1 MNormal Firemen

Group Group 2 Mormal Police -

-

Create  [=hEdit Delete
dhreste Bhadt X okte Conce

In the Configure PTT Boxes dialog box, specify the following PTT box
parameters:
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= Type
In this column, the box type (for example, Channel, Group, Radio or All Call)
is displayed.

Note: The 'Channel' type means that the PTT box has been
automatically created by the radio systems connected to
TRBOnet Server and it can only be partially edited. The Edit
link is grayed out when this PTT box is selected.

* Name
Enter a name for the selected box. This name will be displayed in the title of
the PTT box.
= View Mode
From the drop-down list, select the view mode:
¢ Invisible
Select this mode so that the PTT box will not be displayed.
e Normal

Select this mode so that the PTT box will be displayed in Normal view
mode:

/_ Control Station #1 E

Channel 1
Al call -]

Session:

Free channel

Sender:

L 1

RX [TX

& /

¢ Minimized
Select this mode so that the PTT box will be displayed in Minimized view
mode:

( Control Station #1 EHE-J

Note: Hover the mouse pointer over the Minimized PTT box to
view the PTT box in the Normal view mode.

= Available Calls

From the drop-down list, select target radios or radio groups for the PTT
box.

Create virtual channel boxes

= To create a virtual PTT box, click the Create link in the lower-left corner of
the Configure Voice Boxes dialog box.
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Virtual Channel X
Name: Group Call
Call Type: Call Target:
O alcal (® Select by Dispatcher
(®) Group Call () Selected from list
() Private Call | j

Execute call on channels:
(") Execute call on all available channels
(®) Execute call only on selected channels

W Control Station #1

I Intercom

I¥ Local Brine's
Repeater #1: Slot #1
™ Repeater #1: Slot #2

Cancel

In the Virtual Channel dialog box, specify the following virtual channel
parameters:

Name
Select this option and enter a name for the virtual channel.

Choose a Call Type for the channel.

Call Target

(available only when Group Call or Private Call is selected as the Call Type)
Choose Select by Dispatcher to allow the dispatcher to select a Call Target.
Or, choose Selected from list and from the list below select the desired
group (if the Group Call type is chosen) or individual radio (if the Private
Call type is chosen).

Execute call on channels

(available only when All Call or Group Call is selected as the Call Type)
Choose Execute call on all available channels,

or Execute call only on selected channels and in the list below select the
available channels.

View > Configure Active Calls panel

Choose this menu item to configure call types and advanced settings for the
Active Calls panel. This menu item is available if View > Show Active Calls
Panel is selected.
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Active Calls «
£al 358 | advanced
[~ Show All Call
[ Show Group Calls
[¥ Show Emergency Calls
[ Show Private Calls
[+ Show Remote Monitor

[ Show Intercom All Calls

[ Show Intercom Private Calls

Cancel

= Call Types
On this tab, you can select which call types to display in the Active Calls
panel:

Active Calls X

Call Types A

[ Show Visible Channels
[+ Show Hidden Channels
[+ Show Requests to Call
v Show Missed Calls

Display Time: &00 2 seconds

Cancel

= Advanced
On this tab, you can set following options:

¢ Show Visible Channels
Select this option to display Visible channels in the Active Calls panel.

¢ Show Hidden Channels
Select this option to display Hidden channels in the Active Calls panel.

Note: For the visibility of channels, see Configure PTT boxes,
View Mode.

¢ Show Requests To Talk
Select this option to display Requests To Talk in the Active Calls panel.
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e Show Missed Calls for
Select this option to display Missed calls in the Active Calls panel, and
specify the duration of displaying Missed calls.

The Active Calls panel is displayed in the upper part of the Dispatch Console:

File View Map Tools Help

Voice Dispatch Radio Interface &[0
Bl=t & X7 &

By Y m—r Covs
B administrator =
- U )

Police
B S [ Control Station #1

(1)) veice Dispatch
P Position ession;
S A=

W]nhﬁdﬂfl\a

-n.-n:rhagmnn

Recent Calls/Events ' |
Q _ [ Playback [l Save~ () Print | 11 Pause ¥ Clear + i Reload | [ Filter By Radio | = Grouping [ Auto Filter > Defoult Settings >
L= Date | Radio System | Redpient. | Message | Details | Note |
@ 29-5ep-2016 17:03:17  Control Station... Police Dispatcher ‘Administrator' ... Members: Administrator -
29-5ep-2016 17:02:37  Control Station... Administrator  Police Dispatcher ‘Administrator' ... Members: Administrator
= 29-5ep-2016 17:02:23  Control Station... Administrator  Police Dispatcher ‘Administrator’ ... Members: Administrator
=] event viewer
29-5ep-2016 17:02:00 Control Station... Administrator  Firemen Dispatcher ‘Administrator' ... Members: Administrator
29-5ep-2016 17:01:47  Control Station... Administrator  Police Dispatcher ‘Administrator' ... Members: Administrator
2] Radio Alocation 29-5ep-2016 17:01:25  Intercom Administrator Al Intercom Call: Dispatcher ' bers: Admiistrator o
i) 4] 4| Record1ofare »[m|mi ] »
E Sidaaacttion Recent Cals/Events | RecentCals | Radio State | Active Tasks | | User Actiity | Map | Cameras
127001 By B B B | § Administrator | (8 Licensed to: demo Demo License | @ Active~

e View > Customize Hot Keys

Choose this menu item to configure hot keys for the actions on the selected
channels.

Configure HotKeys X

¥ Show actions panel

HotKey Action Caption
shift Terminate All Transmitions  Terminate all -
Enter Default PTT channels Transmit
L] PTT Intercom
[Shift] +[H] FTT Repeater #1: Slot #1
[shift] +[0] PTT Repeater #1: Slot #2
FTT Local Brine's
PTT Control Station #1
PTT Group 2 o
M Record 5 of 10 M jJ

dpCreate [ShEdit X Delete Show all FTT boxes

o[ e

= To configure hotkey PTT actions to the PTT boxes, click the
Show all PTT boxes link, double-click the desired PTT box(es) to apply the
changes, then assign a hotkey or a combination of hotkeys.

= To configure specific non-PTT actions to PTT boxes (for example, mute
channels or set default PTT channels), click the Create link to make the
changes:
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Action *
HotKey: |Ctr\ Configure
Caption: |Mube Mode
Action: |Mune channels ﬂ

Channels:

I¥ Intercom
[ Repeater #1: Slot #1

™ Repeater #1: Slot 22
I Local Brine's
Control Station #1

In the Action dialog box that appears, specify the following parameters:

o HotKey
Click the Configure button, and on the keyboard, press the key or key
combination you want to assign as a hot key for the selected action.
e Caption
Enter a caption that will be displayed in the Dispatch Console.
e Action
From the drop-down list, select the desired action:

v' Default PTT channel
Selected PTT box functions as a default PTT channel.

v" Mute channels
This action mutes selected PTT boxes.

v Unmute channels
This action unmutes selected PTT boxes.

v" Voice from channels
This action mutes voice from all PTT boxes except for selected one(s).

v Terminate All Transmissions
This action terminates all transmissions for selected PTT boxes.

e Channels
In the list below, select PTT boxes to assign the actions specified above.

= To enable displaying the configured hot keys in the Dispatch Console,
select the Show actions panel option.

All the hot keys you have configured are displayed in the upper part of the Dispatch
Console:
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Radio Interface

Radio Interface | Recent Cals /Events

= /B, oniine Dispatcners (1)
& agministrator

= & )

L) Palice |

All Call -

Drag and Drop PTT Box here to
create new grou

ession: ession:
Free channel

Sender:

Recent Calls/Events

[ Playback (el Save~ () Print | 11 Pause ¥ Clear ~ 5 Reload | " Filter By Radio | = Grouping '\ Auto Filter (0 Default Settings >
Date |Rado system | sender |Recpient | Message | Detais | mote [

295ep-2016 18:15:42  Intercom Administrator Al Intercom Call: Dispatcher ... Members: Administrator ﬂ

$ 29-5ep-2016 17:53:22 RadioServer All Connection to ‘Contral Sta...

29-5ep-2016 17:27:01  Intercom Administrator  All Intercom Call: Dispatcher ... Members: Administrator

29-5ep-2016 17:27:00 Control Station... Administrator  Police Dispatcher ‘Administrator' ... Members: Administrator

29-5ep-2016 17:26:48 Intercom Administrator  All Intercom Call: Dispatcher '... Members: Administrator -

| 4| ¢| Recordtof31s b [w|mi| «] 3

Recent CalefEvents  RecentCals | Radio Siate | Acive Tasks | Actve Routes | user Actvity | Map | Cameras |

127001 G5 By B B | @ Admini

@ ‘ Fesrestimdams Boalieres ‘ @ Active -

e View > Add Radio Interface Tab
Choose this menu item to add a new Radio Interface tab to the Radio Interface
pane.

Configure Voice Boxes X
Mame: |Rad\o Interface #1 |
Type | Mame View Mode Available Calls
Channel Intercom Normal EI
Channel Control Station #1 Normal Al
Group Group 1 Mormal Firemen
Group Group 2 Mormal Police
Channel Repeater #1: Slot #1  Mormal Al
Channel Repeater #1: Slot #2  Mormal Al
Channel Local Brine's Normal Al
Al Call Al Call Normal

Create Edit Delete
s L o ]

= In the Configure Voice Boxes dialog box, specify the following PTT box
parameters for the new radio interface:

¢ Name
Enter a name for the radio interface.

Other parameters can be configured in the same way as when Configuring
PTT Boxes.

The user can switch between Radio Interfaces by clicking on the tab bar in the upper
part of the Radio Interface pane.
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Radio Interface

| Rado nterfoce ” Radio Interface #1] RecntCobsfvents [Rodos|| |

[} & Online Dispatchers (1) Confiqure

B administrator
To: Selected Channels

[y Firemen

[ Police

44

Control Station #1 [
P

Session:

Free channel

Sender:

Recent Calls[Events

5 Playback (el Saver () Print | 11 Pause ¥ Clear + & Reload | [ Filter By Radio | =
Date | Radio System | Sender |Recpient | Message Note |
30-5ep-2016 10:48:54  Intercom Administrator Al Intercom Call: Dispatche. .. Members: Administrator ﬂ
29-5ep-2016 18:15:42 Intercom Administrator Al Intercom Call: Dispatche... Members: Administrator
P 29-Sep-2016 17:53:22 RadioServer Al Connection to ‘Contrel S...
29-5ep-2016 17:27:01 Intercom Administrator Al Intercom Call: Dispatche. Members: Administrator
29-5ep-2016 17:27:00 Control Statio... Administrator  Police Dispatcher ‘Administrato... Members: Administrator
29-5ep-2016 17:26:48 Intercom Administrator Al Intercom Call: Dispatche. Members: Administrator -
| «| 4] Record1of303 v |w|mi| 4] 3
Recent CalsfEvents | RecentCals | RadoState | ActiveTasks | ActiveRoutes | User Acthity | Map | Camerss
127001 @ | 8 Administrator | (28 Licensed to: demo Demo License | @ Active-

e View > Delete Radio Interface Tab
Choose this menu item to delete the Radio Interface tab currently selected in
the Radio Interface pane.

Note: The default Radio Interface tabs can't be deleted.

¢ View > Show Channel Selector Box
Select this menu item to display a separate PTT box that allows selecting a
channel.

(i 0\

1P Site Connect: Slot #1
1P Site Connect: Slot #2

Session:

L 1

O Sender:

Channel not selected

b S

Click the arrow of the drop-down list and select the channel for this PTT box.

e View > Show Call Type Buttons
Select this menu item to display the Call Type Buttons panel in PTT boxes.

f|]]1 Site Connect: Slot #1 | -P

Session:

Free channel

Q C—

RX T

103



neocom
sofFtware

104

¢ View > Show Keypad Panel
Select this menu item to display the Keypad panel in PTT boxes.

(_ IP Site Connect: Slot #1 [= @

0 — T

Qﬂadluhst
—
A A
el o o
e b Ao o
oAb o b <4

RXfTX o

=]

. J

Note: The Keypad panel will be displayed only when the Num
button is pressed in the Call Type Buttons panel.

e View > Audio Message Library

Choose this menu item to add configured Voice Messages to the Queued
Messages panel. For how to configure Voice Message settings, see Tasks,
Voice Message.

Saved Audio Files X

A Add % Remove | [ Filter | Hot Key
Filename Description Severity Hot Key Visibility

Alarm Tone Alarm Hidden

» Bobby.mp3 Information Button

Daisy.mp3 Information Link

send Cancel

* In the Saved Audio Files dialog box, specify the following parameters:

¢ Filename
The name of the message displayed in the Queued Messages panel.

e Description
Enter a description for the Voice Message.

e Severity
From the drop-down list, select the severity level (Information, Alarm, or
Warning).

¢ Hot Key
Click the Hot Key button and press the key or key combination you want
to assign as a hot key for the selected Voice Message box.
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o Visibility
From the drop-down list, select how to display the selected Voice
Message box:

v Hidden

Hide the Voice Message box.
v" Button

Display the Voice Message as a button (1).
v Link

Display the Voice Message as a link (2).

Radio Interface

Radio Interface | Recent Calls/Events.

[Jintercom

. -
ree channel

e View > Extended PTT boxes
Select this menu item to display PTT boxes as shown:

v Control Station #1
‘Control Station #1 ‘ @@
‘Channel 1 4
Free channel
e =
caii: Al Call o [ cneek |
T | G | . | [_m
e —
[ | i |
& & oy oy - w\ --
\_ Sk Mc

e View > Large PTT boxes
Select this menu item to display PTT boxes as shown:

/" Control Station #1 [E8)

¢ View > Medium PTT boxes
Select this menu item to display PTT boxes as shown:
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Control Station #1

g 5l

e View > Small PTT boxes
Select this menu item to display PTT boxes as shown:

[ Control Station #1 @w

Free channel
alcal Channel 1

e View > Custom PTT boxes >

Select Custom PTT Boxes 1 to display PTT boxes as shown:

Control Station #1

Mo

Channel 1

Free channel

Select Custom PTT Boxes 2 to display PTT boxes as shown:

Select Custom PTT Boxes 3 to display PTT boxes as shown:

Slot 1

Al Call @
Free channel ‘£
LINC]

R fTX

e View > Show Active Calls Panel
Select this menu item to display the Active Calls panel in the Dispatch Console.
See also Configuring Active Calls panel.

e View > Show Clock Panel
Select this menu item to display the Clock panel in the Dispatch Console.

¢ View > Show Quick Commands Panel
Select this menu item to display the Quick Commands panel in the Dispatch
Console. For more details, see section 6.5.6, Quick Commands.

e View > Show Queued Messages Panel
Select this menu item to display the Queued Messages panel in the Dispatch
Console. For more details, see section 6.5.7, Queued Messages.
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¢ View > Show Patch Panel

Select this menu item to display the Patch panel in the Dispatch Console.
e View > Telephony Tab

Select this menu item to display the Telephony tab in the Radio Interface pane.
e View > Show Extended Messages Tab

Select this menu item to display the Extended Messages tab in the Radio
Interface pane.

e View > Show Radios Tab
Select this menu item to display the Radios tab in the Radio Interface pane.

The Extended Messages and Radios tabs appear on the top of the Calls pane:

Radio Interface

Radio Interface| RecentCalls/Events | Extended Messages

[Jintercom [ control station #1 3]

@ Al cal | Channel 4 |
jancan ]

i

6.3.3 Map

e Select Location Tracking (1) in the Navigation pane to enable Map Options:
e Click the Map menu (2).

P Growp 10

2 Group 11

Open New Map in Window.. - » G 2 ap Objects

Google Earth Po-EE - Camera 1

iy 7 ject » H
Delete Route on Google Earth =

Show Radios en Google Earth »

i n
- [ Map Routes
(el 111

| 5] RFID Tracker lsEErE
=
Text Messages
Dm
i _ Recent Calls/Events o
[ Playback [l Saver () Print | 11 Pause < Clear + i Reload | [ Filter By Radio | = Grouping 7 Auto Filter & Default Settings
Ga Reports Date | Radio System | Sender | Redipient | Message | Details |
P 09.06.2017 14:43:57 Server Al Connec tion to s 1'h. -
Event Viewer 09.06.201712:43:30  CapacityPlus 1 Administrator u Dispatcher Isgr... Members: Admiistrator, 125
_ | 09.06.2017 12:40:06  Capaity Plus 1 125 1 Radio '125'calls 8)  Members: 125
" 03.06.2017 12:39:55 Capacity Plus 1 Administrator 11 Dispatcher ‘Admi tor' calls gr... Members: Administrator
09.06.2017 12:38:34 Capadity Plus 1 Administrator Police. Dispatcher ‘Administrator' calls ar... Members: Administrator A
i «¢| «| Record 10f305 » [m | mi[ <] »
@ Recent Cals/events | RecentCals | RequestToTak | Radio State | Active Tasks | || User Actvity | Beacons | | Taguist |
127001 &3 & | & Administrator | [ Licensed to: demo | @ Active-

The Map menu contains the following items:

e Map > Select Active Map
Click this menu item to select the map to display in the Dispatch Console.

107



neocom

sofFtware
Select Map.. X
Available Maps
CYCLE -
Add Remave Cancel
= Enter the Caption of the map that will be displayed in the Dispatch
Console.
= In the list of Available Maps, choose the map to be displayed.
[}

You can also add a custom map using the URL.
Click the Add button.

Add Map X
Name: [regen |
Map Type: Custom Map e
URL [Frns:24 rg/fimap=11/59.9497/30.0517 ]

Example: hitp://Aile. openstreetmap.org/ &z} x}/iy}.png

e

e Enter the Name for the new map.
e Enter the URL, as shown in the example.
v Z
Enter the zoom value for the map.
v X
Enter the latitude coordinate (X-direction).
VY
Enter the longitude coordinate (Y-direction).
¢ Map > Save Online Map Data
Click this menu item to save your current map region.

Tiles bulk dewnloader - a x

Region from: N59°57'07.92" E030°14'33.51" to N59°56'48.68” E030°19'02.27"
Expirefies days: |30

Redowrload all ties

Zoom level: 14 Tiles to download: 40

Status: Finished

Loading zoom level: 14
Loaded fromthe web: 0
Updated from the web: 33
Local: 1

Failed: 0

‘Show ties preview [7] Show tles progress

Loaded: 40 of 40 (100 %)
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In the dialog box, specify the following parameters:

Expire tiles days

Enter the time the saved offline map will be stored before it is automatically
updated.

Redownload all tiles
Select this option to re-download the map tiles before saving to your PC.

Zoom level
Move the slider from left to right to increase the detail level of the map.

Show tiles preview
Select this option to show how the map is divided into tiles.

Show tiles progress
Select this option to show the progress bar while the online map is being
saved.

Click Start and wait for the system to save the files. This may take several
minutes.

e Map > Map Content
Click this menu item to specify the folder and settings to store the map data.

Online Map - [m] x
Map cache

Cache foider.
D:\Temp'\Maps

Update: Never -

Map Type: BING_ROAD v

Bing ey [

In the Online Map dialog box, specify the following settings:

Cache folder
Click Change and locate the folder on the PC where you wish to store the
map data.

Update

Select the update interval ('Never', 'Immediately’, or '‘By period') for the map
data stored in the specified Cache folder.

Map Type

From the drop-down list, select the map type. For more details on the maps
used in TRBOnet Dispatch Console, see section 6.3.3.1, Map Types

(page 110).

<Map Provider> key
Enter the key for the selected map.

Note: To obtain the key, click the hyperlink below and follow the
instructions.
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6.3.3.1 Map Types

Online maps:

MAPNIK - free online map. For more details on OpenStreetMaps, visit the
official the website: http://www.openstreetmap.org

Thunderforest — commercial online maps. Visit
http://www.thunderforest.com/docs/apikeys/ to get a key.

Microsoft BING — commercial maps from Microsoft. Includes BING_ROAD,
BING_AREA, and BING_HYBRID subtypes. A user may use BING maps for 90
days and then they must get a Basic Key. Visit
http://msdn.microsoft.com/en-us/library/ff428642.aspx to get a Basic Key.

Google Maps — online mapping service from Google. Visit
https://developers.google.com/maps/documentation/javascript/get-api-

key#key to get a key.

Offline Maps:

TRBOmap - internal map-making resource. A user can customize a part of
online maps according to requirements.

TMap - internal map-making resource. A user can create an offline copy of
online maps for selected regions according to requirements. A user can
create a map from any picture via the TRBOnet Map Edit application.

Click Start > All Programs > Neocom Software > TRBOnet Map Edit
For more details on map calibration, read the following article at:
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;CategorylD=2;ltem
ID=111.

Beacon 2D - two-dimension offline map for Indoor positioning. A user can
create maps using the Beacon2DMapGenerator tool. To get
Beacon2DMapGenerator, contact your local TRBOnet dealer.

Beacon 3D - three-dimension map for Indoor positioning. A user can use
any DirectX file as a map.

e Map > Print
Click this menu item to print the map region currently displayed in the Map
pane.

e Map > Geocoding
Click this menu item to configure geocoding servers in the Dispatch Console.
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* Load data from TRBOnet Server if Geocoding services are inaccessible
from local PC
Select this option to receive location data from the TRBOnet Server PC if the
Dispatch Console is unable to resolve location data.

For other settings, see section 5.8.1.1, Configuring Geocoding Servers
(page 25).
¢ Map > Open New Map in Tab

Click this menu item to add a new map tab to the Map pane.

Select Map... 3

Map Type: Oriine maps

Caption: [y maapl

Available Maps

Name Fath
MAPNIK

cYalE

TRANSPORT

State
oK
oK
oK
oK
oK
oK
oK

LANDSCAPE
EING_ROAD
BING_AREA
BING_HYBRID

Add Remave Cancel
= Map Type

From the drop-down list, select the map type.
= Caption

Enter a caption for the new map tab.

= For other settings, see Selecting Active Map.

Once you have clicked OK, the new tab will appear in the Map pane:
BING ROAD % My Map XI|
5% (i> Fi fer Q Y4 Show Beacons: Al v | & Ruler X Fmdgn Map~ L 4 Drawing Panel A Router <& Geofencing 2

% Z
5, % c)
73 Y c)
° L

o Z
% ‘O
o )
o

o
v
o

e Map > Open New Map in Window
Click this menu item to create a new map window with the specified map.

= For required settings, see Selecting Active Map

Once you have clicked OK, the new Map window will appear:
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235 _ O %
o EDE | Ruler (4 FindonMap~ g, | & Drawing Panel | 7l Route» @ Geofencing
2
g z
E : Ko | KV a8 °
= -
z2le & Online Dispatchers (1) Vasjlyevskly Island
= B adminisirator
& [ Firemen C)
B ® 125 AN
- FER]
[ Police |
=]
s
%/
% Saint
% Andrew's
@ % Cathedral
&£
O/
o
%
o
£ \
‘0 Latfude: 59°5628 50'N; Longlude: 30°1645 67°E |
235

e Map > Google Earth
Click this menu item to open the Google Earth application.

Note: Google Earth must be previously installed on the PC. To
download Google Earth, go to the Google Earth website
https://www.google.com/intl/en/earth/desktop/, and click
Download.

e Map > Delete Routes on Google Earth
Click this menu item delete all routes from Google Earth.

¢ Map > Show Radios on Google Earth
Click this menu item and in the drop-down menu select which radios to
display on Google Earth.

6.3.4 Tools

The Tools menu contains the following items:

e Tools > Event Viewer in Window
Click this menu item to open the Event Viewer in a new window.

Event Viewer - [m] X

Filter events Talk Sessions
(5 Al Messages [ Playback (s Save | Il Pause < Clear '&i Reload | = Grouping '\ Auto Filter
=-{ Text Messages Date v/ Radio system Sender Recpient .
t Inbox () 050ct-2016 15:38:45  Control Station 1 Dispatcher Al -
3 Sent (i) 05-0ct-2016 15:38:93  Control Station #1 Dispatcher Al
(5 Telemetry (i) 05-0ct-2016 15:38:41  Control Station £1 Dispatcher n
1 Obtained signals (i) 040ct-2016 17:38:38  Repeater #1: Sot #1 125 al
¥ st commancs 04-0ct 2016 17:38:32 slhsotsl 23 Al
Talk Sessions E
04-0ct-2016 17:32:42 susbts2  Adminstator Al
@] Registration in a radio network E
- 040ct-2016 17:31:55 ater 1:Sot £ Administrator Al
3% System Messages >
04-0ct-2016 17:30:50 cater #1: Sot 1 125 Al
ey User messages 5
04-0ct-2016 17:30:45 Lsorsl 235 Al
(i) 040ct-2016 17:30:40 LSot#1  Administrator Al
(i) 040ct-2016 17:28:98  Repeater #1: Sot 1 125 Al
(D) 040ct 2016 17:28:45  Repeater #1:Sot #1235 Al
() 040ct-2016 17:18:05  Repeater sL:Slot#1 235 Al
(i) 040Ct-2016 17:16:01  Repeater #1: Sot 1 Administrator Al
(i) 040ct-2016 17:15:58  Repeater #1:Sot $2  Administrator Al
(D) 040ct-2016 16:56:17  Repeater s1:Slot 52 Administrator Al
() 03-0ct-2016 10:51:3  Control Station 1 235 Al =
] @] 4] Record 120F 200 | w[wi] ¢ v
u Sender 235 Date: 04-Oct- 016 17:25:45
Recipient: Al [l Playback [ Save [ AddNote
Al Cal from '235' (00:01)
Members: 235

e Tools > Recent Calls/Events in Window
Click this menu item to open Recent Calls/Events in a new window.
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/@

Recent Calls - [m] X
[ Playback | Save= () Print | 11 Pause ¥ Clear v & Reload | [ Filter By Radio | = Grouping " Auto Filter & Default Settings *|
Date Radio System  Sender Recipient Message Details Note
P 05-0ct-2016 15:92:32 RadioServer All Connection to ‘Control St.. -
D 05-Oct-2016 15:38:45 Control Stati... stcher Al ‘
D 05-Oct-2016 15:38:43 Control Stati... Dispatcher Al
D 05-0ct-2016 15:38:41 Control Stati... Dispatcher All
F 05-0ct-2016 09:99:04 RadioServer All Connection to ‘Repea
3% 04-0ct-2016 17:45:36 Administrator 125 Dispatcher *Admi ator' ...
3% 04-0ct-2016 17:43:26 Administrator 125 Dispatcher ‘Administrator’
D 04-0ct-2016 17:38:38 Repeater #1... 125 Al All Call from 125" (003 Dl) Members: 125
D 04-Oct-2016 17:38:32 Repeater #1 235 Al All Call from '235' (00:00) Members: 235
D 04-0ct-2016 17:32:42. Repeater #1 Administrator  All All Call from dispatcher 'A... Members: Administrator
D 04-0ct-2016 17:31:55 Repeater #1... Administrator Al All Call from dispatcher ‘A... Members: Administrator
[[J 040ct-2016 17:30:50  Repeater #1., 125 Al All Call from '125' (00:00)  Members: 125
D 04-Oct-2016 17:30:45 Repeater #1 235 Al All Call from '235' (00:01) Members: 235
D 04-Oct-2016 17:30:40 Repeater #1 Administrator  All All Call from dispatcher 'A... Members: Administrator
D 04-0ct-2016 17:28:48 Repeater #1... 125 All All Call from '125' (00:01) Members: 125
D 04-Oct-2016 17:28:45 Repeater #1 235 Al All Call from '235' (00:01) Members: 235
3% 04-0ct-2016 17:28:40 Administrator 125 Dispatcher ‘Administrator ...
D 04-0ct-2016 17:18:05 Repeater #1... 235 All All Call from '235' (00:02) Members: 235 -
W[ 4] ] Recordsof st o [mim[«] - T i »
\a Sender: 125 Date: 04-Oct-2016 17:38:38
Redpient: Al (B Plavback [ Save [T Add Note
Al Call from '125' (00:01)

= Click Playback to play back the selected call.
= (Click Save to save the selected call as an audio file.

In the Save As dialog box, locate the folder where you want to save the
audio file, specify the file name, and from the drop-down 'Save as type' list,
select the format (*.wav or *.tna) for the audio file.

= (Click Add Note to add a note to the selected call.

Mote X

Well done j

2
oK Cancel

Add Extension. ..

e Enter the text of the note in the text box.

¢ You can extend the form of a note by clicking the Add Extension link
and adding new fields and their possible values to the form.

¢ Tools > Job Ticketing Monitoring
Click this menu item to open the window that visually represents the job
tickets created by dispatchers and assigned to radios.
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In this window, you can perform the following actions:

= Select a time period for which to display Job Ticketing data.

All data are shown in the form of status diagrams.

Click this menu item to open a new window that displays the radios present in

I
(Cnline, Indoor), (Online, ... n Activity:

& @ &

O

R

ped

7 SEIBELAN ..o

| Police
W

| Cleaners
M 11

W22

¥ Mobile Client

[T >

oK Cancel

@ |

In this window, you can make radio calls, send text messages. In addition, you
can select to display radios by groups and statuses.

Click this menu item to open a new window that displays the Telephony

neocom
sOoftware
e
= Monitor tickets created by dispatchers.
= Monitor tickets assigned to radios.
¢ Tools > Radios in Window
the system.
[T Radios
¢ Tools > Telephony in Window
system present in the system.
114
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Line free

Line free

Line free

In this window, you can make and receive telephone calls.

¢ Tools > Telemetry Monitoring

heocom
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Click this menu item to open the window that displays configured telemetry

profiles for the radios.

Telemetry £1

Show:

Radio ~ | status VIOL

vIO2

= From the Show drop-down list, select the Telemetry profile to display.

See also section 6.4.10, Telemetry (page 202).

¢ Tools > Text Messages in Window

Click this menu item to open a new window to manage text messages.

Text Messages

@V Clear i Reload || Inbox [ Sent

- o x

05-Oct-2016 17:51:19 Received from 235 to 125
His be on
05-Oct-2016 18:01:43 Received from 235 to 125
only6m
a EJ Firemen E 05-Oct-2016 18:06:04 Received from 125 to 235
- nog
®® 125 LA
p= 05-0ct-2015 18:10:53 Sent from Administrator to Police:
B®2s B Q|| stop making me fool
[l Police [=]
Recipient: *% | Poiice | Ed send | ] AttachFile
[
125

In this window, you can perform the following tasks:

= View sent messages in the upper-right pane.

= Select online dispatchers and radio groups in the left pane, or by clicking

the ellipsis (...) button in the lower-right pane.
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= Type messages in the text box in the lower-right pane.
= Send messages by clicking the Send button in the lower-right pane.

¢ Tools > Routes in Window
Click this menu item to open a new window to manage routes.

For more details on Route Management configuration, see section 6.8, Guard
Tour / Route Management (page 304).

e Tools > Camera in Window
Click this menu item to open a new window with a camera view.

® Camerat — [m| *

Camera: |Camera 1

In this window, the camera view is displayed.

= Camera
From the drop-down list, select a camera that is connected to TRBOnet
Dispatch Console.

See also section 6.4.8, IP Cameras (page 198).

e Tools > Reset All GPS Triggers
Choose this menu item to stop/start GPS triggers on all radios.

e Tools > Terminate All Transmissions
Click this menu item to terminate all voice sessions.

This action is a "hard" request to stop all "hung" transmissions in the TRBOnet
software. If a radio communication session is not allowed to be interrupted on
a repeater or base station, it will only be stopped for the TRBOnet software.

e Tools > Phone Book
Click this menu item to open the phone book for reference and editing
purposes.
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) Phone Book *
i Add _—J; Edit | 4 Remove | " Filter . Configure ©0 Import~
SIP ID SIP User Display Name
2409 2409 Walt
Yellow 2235 2235 235
Yellow 2125 2125 125
|4 | 4| Record 10f3 b | M |4 4
call oK Cancel

= Click the Add button to add a new record to the phone book.
= Click the first column, and from the drop-down list select a marker color.

= Double-click the second column.

Phone Mumber >
SIP ID: |2125
SIP User: |2125
Display Name: |John
Cancel
e SIPID
Enter the SIP ID that is used by the user.
e SIP Name

Enter the SIP user name that is used by the user.

¢ Display Name
Enter the name that will be displayed for the user in the Dispatch
Console.

e Click OK to save the phone book.
6.3.4.1 Options

e On the Tools menu, click Options.

117



neocom
sofFtware

Options x

Sound Map  Coverage Map Hardware Advances d Audio Alarm  Telephony
@ Configure the Sound Notification
4

Use Sound Notifications

To confi ounds notifications on every system event , choose
eventfrom the fist and specify a demanded sound file or use a file by default

@), Tak begin

@), Tak end

@ Line busy

@, Alarm or Emergency Cal
@), Text message received
@, Inforr
@, warni =
@), warm received

©), System error

@, alarm Tone

. Private cal from a radio Network to dispatcher

@), Request To Tak from Radio Network to dispatcher

Sound:
(Sound by default) MDD Select...
Alarm or Emergency Call duration: 5 < seconds

Sound
¢ In the Options dialog box, click the Sound tab.

¢ Use Sound Notifications
Select this option to enable sound notifications in the Dispatch Console.

e Select the event in the list and specify the sound.

e From the Sound drop-down list, select ether 'Sound by default' to play
default sound, or 'Disabled' to disable sound notification for the event.

e Click E] to listen to the sound notification for the selected event.
e Click Select and browse for the audio file on your PC.
= Alarm of Emergency Call duration
Enter the time value, in seconds, for the duration of the alarm tone when
an emergency call is received.
Map
¢ In the Options dialog box, click the Map tab.

Options x

sound {Mp % CoversgeMap Hardware Advanced Audio Alarm  Telephony

= Configure the image parameters that are shown on the map

Map refresh interval 120 2] seconds

Show the direction of motion:

Shaw names of abjects:

Hide overlapping names of cbjects

Shaw PTT on map: [ Radios [] Map Objects

Default Map Filter: @

Select the image size: [zxzzmes <]
Select the defaut image type: @sus ~[+[-]
“The images below wil be shown on the map:

Radio is turned off:
Radio is turned on, but GPS madule does not work:
Radio i turned on and GPS module works properly:

Radio transmits an Emergency Alarm andjor Cal:

Path to Google Earth exe fle

, e®e®e
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¢ Map refresh interval
Enter the time period, in seconds, to update map data.

¢ Show the directions of motion
Select this option to display a direction of motion for map objects.

¢ Show names of objects
Select this option to display object names on the map.

e Hide overlapping names of objects
Select this option to hide overlapping object names.

e Show PTT on map
Select this option to allow the dispatcher to make private calls by
clicking a corresponding radio icon on the map.

o Default Map Filter
Select/unselect the icons for the default map filter (for a description of
the icons, see section 6.6.2.4, Filters).

¢ Select the image size
From the drop-down list, select the size of a radio icon.

¢ Select the default image type
From the drop-down list, select the default image type of a radio icon.

¢ Path to Google Earth exe file
Click the ellipsis (...) button and specify the location of the Google Earth
exe file on your PC. For example, the path may look like: C:\Program
Files\Google\Google Earth Pro\client\googleearth.exe

Coverage Map

TRBOnet Dispatch Console allows displaying RSSI levels on a map. The RSSl is a
received signal strength indicator. It measures the power level of the signal at a
radio's receiver. The RSSI maps can be used by radio system engineers to plan a
further extension of their radio networks.

¢ In the Options dialog box, click the Coverage Map tab.

Options x
Sound Map  CoverageMap Hardware Advanced Audio Alarm  Telephony

O Draw in Dots
(® Draw Coverage Zone

100 =] RSS! Zone Size (m)

value (d8) [Desarption [ color
65 | Excelent 0, 125,0
51| Normal = 255, 165,0
97 Satsfactory 5 184, 134, 11
113 Poor B 55,0, 139
| Bad . 255,0,0

Add Delete Default
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e Draw in Dots

For a more detailed data view, choose this option to display on the map,
dots of RSSI levels representing coordinate points.

" MAPNIK | world x
ClCsle ‘@‘ﬂshmkm E‘Fn @.‘@Phybakku\ prsE.nbyAdaﬂ]che.g Mag)
3
)
% “ & ]
2 @
. !
Mol Nevegy %) MO Vvedenskiy
Smok
Lutheran e sporta 2
S [} 2, ’ ® .vmm, [}
2 % Krotiverksk,
% 4
loe e % » ()
- s ‘#‘ v A% e ..
e - X & o & S
% : (] o
% * o
o % MOVasielskiy %
N %, . s
e L o o % %
2 &% o o 5,
L4 e % e L0 ¥ [ 2Ty
o % e oY Ve %
g.dv‘ R M caciemiy:
e N

8 g&p ;> V‘%o P ¢ o
W Exccellent q:j . f’i, MONDmer?’:;;f i .u : (3 %,@f‘w‘?
Is; A * D e
S s % P ' > o
e p )a‘a‘, ®  Bolshaya Neva®yver \ @w‘*’ @ 2@ Admiralteyskiy
= A
Draw Coverage Zone
For a less detailed view, choose this option to configure and display on
the map, RSSI zones of average RSSI levels using GPS coordinates.
v RSSI Zone Size
Enter the size of the RSSI zone within which RSSI levels will be
averaged.
:nj:uw‘i fs’wm'i Fiter @[ Q[ @) L1PuybackRote & # (4 Saarch by Address ‘é;:-v--si-q A Corvon o [ s §
] St Date: [osorzwa ]
End Date: <Maimum Date > :]
u
S loed || Conce |
5 S \
o’ T
& v
] J‘;’f{AINT‘“M \
= , 2 @(P::::Ts-;‘gzpnpr)
| = ’
— [ morms gt i)
Click Add to add a new RSSI level.

v Value
Enter the minimum level for the signal range (for example, -65 means
-65 and higher).
v" Description
Enter a name of the RSSI level to display in the system.
v" Color
Pick a color for the RSSI indicator on the map.

To view RSSI Levels on the map, click the Location Tracking tab in the
Navigation pane, and on the Map pane toolbar, click Coverage Map. Then
set the Start Date and End Date to display RSSI data.
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Hardware

¢ In the Options dialog box, click the Hardware tab.

Options
Sound Msp  CoverageMap Hardw:
g St hard
3: Sl L o Nl s
[ Use signaling device
Serial port: comML

Canfigure
External Devices:

are  Advanced Audio  Alar

X

Telephon

n attach ar ddn al equipment to
ete)

[ ame Description

5 | Footswitch comM3
{8 Microphone 1

55 | keyboard Wired Keyboard 600

TREOnet Mic Adapter

o Add ELEdit X Delete

us % HID
cc X Directx
7 TiPRO

. COM

k| TRBORet Microphone Adapter

FistV @& TRBOnet Media Dock 2000
FrstT . TREOnet Footswitch

= Use signaling device

Select this option to use an external signaling device.

e Serial port

neocom
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From the drop-down list, select the COM port the signaling device is

connected to.

Click Configure and specify the duration of a signal and which call types to

include in signaling.

Signaling COM port
Duration 0 EI: seconds
Private Cal
Call Alert
Alam
oK Cancel

The External Devices table displays the connected devices

(Type/Name/Description).

e Click the Add link, and from the pull-down menu select the type of
TRBOnet device with a PTT button connected to the PC (Microphone
Adapter, Media Dock, or Footswitch), or the device type (HID, DirectX,

TIPRO, or COM).

¢ In the dialog box that opens, specify the desired device parameters and

click OK.
¢ First VoIP port

Enter the number of the first VolP port for audio communications (4022,
by default). Each additional Dispatch Console will create a connection on

the next port number.
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¢ First IP Camera port
Enter the number of the first IP Camera port for video communications
(13152, by default). Each additional Dispatch Console will create a
connection on the next port number.

e Use proxy server
Select this option to enable a Proxy Server service in TRBOnet Dispatch
Console to access the Internet.

A proxy server can be used when a user's computer cannot be
connected directly to the Internet, but there is another computer with
Internet access in the network.

v" Click the Configure link to specify the alternative server settings.

Configure the proxy server X

Use an alternative server

Settings

Address:  [177.71.134.70

Port: 80 =

Authentication
Use authentication

==

Advanced
¢ In the Options dialog box, click the Advanced tab.

Options X
sound Map  CoverageMap Hardware Advanced Audo  Alarm  Telephony

@R Advanced application options
e

Configuration Scope ~
O Per machine: al dispatchers share the same workspace
@ Per user: a separate workspace for each Windows user account

Enable sticky PTT

Use ‘Space key to press FTT Confiqure...
[ Enable Single PTT Select mode

Voice Options

[ Mute other dispatchers

Configuration Scope

= Per machine
Choose this option to store settings in a common place for all dispatchers
of the Dispatch Console.
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Per user
Choose this option to store settings for each dispatcher separately if they
are using different Windows user accounts.

PTT Options

Tone and PTT when using external PTT device
Select this option to enable Alert Tone for all subscribers on a channel when
the dispatcher presses the PTT button on an PTT external device.

Use Record Mode with external PTT device
Select this option to record all voice transmissions from external PTT
devices (Palm mics, Footswitches, and other devices).

Suggest Queued Message when channel is busy or subscriber radio is
offline

Select this option to record a Queued Voice Message when a radio channel
is busy or subscriber is offline.

Enable sticky PTT
Select this option to start and finish voice calls by a short press of the PTT
rather than holding the PTT down until the end of a voice call.

Use 'Space’ key to press PTT

Select this option to use a hot key for the PTT. Click the Configure link, and
on the keyboard, press the key you want to assign as a hot key for the PTT
button.

Enable Single PTT Select mode
Select this option so that only one PTT box can be selected at a time, that is
you can't have multiple selected PTT boxes.

Voice Options

Mute other dispatchers
Select this option to mute all other dispatchers voice transmissions.

Mute radio-to-radio private calls
Select this option to mute all private calls on the channel.

Mute all channels when transmitting audio or recording a voice
message

Select this option to mute other channels when the dispatcher transmits
audio or records a voice message.

Mute the tone when receiving a Tone and PTT call
Select this option to mute the tone when you receive a Tone and PTT call.

Play a sound when starting a Tone and PTT call
Select this option to play the tone when you start a Tone and PTT call.

Automatically set channel to Solo when transmitting audio
Select this option to mute other channels when transmitting audio.

Automatically unmute channel when transmitting audio
Select this option to automatically unmute a channel when transmitting
through this channel.
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View Options

= Customize the automatic subscriber name pattern
Select this option and click the Configure link to set a custom alias for a
radio in the list of subscribers. Once the changes are made, selecting this
check box will cause a change to the radios in the Radio list pane (upper left
pane of the Main Interface screen).

Display Formats X

Radio display name:

H

Example: My Radio

Allocated radio display name:
| #eAME % (%0WINER %) -
Example: My Radic (John Smith)

Allocated radio display name
{the owner has more than one radio):

| MNAME % (%0WINER %) -
Example: My Radic (John Smith)

Defaults Cancel

¢ Radio display name
Click the ellipsis (...) button and in the Format dialog box pick the fields
to display for a radio.

Format x
YEMNAME %o (YeCHANMEL %)
Example: My Radic (Master Stetion [ Channel)
Add Field:
Radio Callsign
Radio Owner name
Radio ID
Active Channel
Plate Mumber
Make
Phone Number
Email
Cancel

e Allocated radio display name
Click the ellipsis (...) button and in the Format dialog box pick the fields
to display for an allocated (taken) radio.

¢ Allocated radio display name
(the owner has more than one radio)
Click the ellipsis (...) button and in the Format dialog box pick the fields
to display for an allocated (taken) radio in case when a user has more
than one radio.

e Click Defaults to set default settings for radio display.

= Show extended notes
Select this option to enable Extended Notes in the Dispatch Console.

The Extended Notes feature is intended to add predefined Extended Notes
templates, the same as for Extended Messages, for the selected calls and
events.
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For example, a Taxi Dispatcher needs to check clients' calls response period
for the company internal monitoring of the employees. They can add a
predefined template and check the time period. All Extended Notes are
displayed in the Ext. Note column in the Recent Calls/Events tab:

Recent Calls/Events
S Playback (] Save || 11 Pause ¥ Clean ‘%3 Reload | “[f Filter By Radio | = Grouping [/ Auto Filter € Default Settings | T Details ||[] Show Notes "2 Add Note [ Extended Not«
Date W Radio System Sender Redpient Messag Ext. Note Note
%’ 7/7/2014 3:49:56 AM Radio 11 Al Geofencing Alarm [Dat. /
‘.3%‘ 7/7/2014 3:49:56 AM Radio 11 Al Radio left allowed region
d 7/7/2014 3:47:52 AM Repeater #1Slot 1 Radio 105 Dispatcher Administrator Accept 1
3B 7/7/2014 3:41:24 AM Repeater #1Slot 1 RadioServer Radio 105 Telemetry status cann...
=% 7/7/2014 3:90:16 A Administrator Al test
7/7/20143:3:08 M Repeater #18lot 1 Radio 105 unknown group: 1010 Radie Radio 105'calls ... View
S 7/7/2014 3:32:55 AM Admiristrator Radio 105 Dispatcher ‘Adminisira...
S 7/7/2014 3:18:43 AM 105 Al n Du 2
([ 7/7/2014 12:56:40 AM  Intercom Dispatcher 1 Al nter i
[j 7/4/7.0144 01:35AM  Intercom Dispatcher 1 Al
rasaofs3 b w4 R »
ents RecentCalls | Radio State  Active Tasks | Active Routes  User Activity Map.

Click the Extended Notes button (1) to fill the template;
Click the View button (2) to see the Extended Note.

= Show latest note in Unit information details
Select this option to include the latest note about the radio state change in
the Radio information window (see section 6.5.1.3, Radio Pop-up Window).

= Show confirmation dialogs
Select this option to enable confirmation dialogs for dispatcher actions. For
example, when sending a configured Voice Message from the Dispatch
Console, the following confirmation dialog box will appear:

TRBOnet Enterprise 5.1 / Dispatch Console

o Start "Voice Message'?

= Show incoming text messages in a pop-up window
Select this option so that incoming Text Messages will pop up over the
application window.

File View Map Tools Help

Ragio interface
Gt 5 & K 7 @ & K || Redlnterace| RecentColsfruents |

Active calls (8| Quick Commands ]
© [ coaners g B a——
& [ Femen L)
DO m L™
HS 125 Pete) LR
40 000 = ke
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= Show RTT notifications in a pop-up window
Select this option so that incoming Request to Talk messages will pop up
over the application window.

Request to Talk

J 125
. The Request to Talk has been received.
J You must accept or reject it.

Reject Queue

= Close button minimizes application
Select this option so that clicking the Close button will minimize the
Dispatch Console rather than close it.

* Minimize button minimizes to Voice Bar
Select this option so that when you click the Minimize button you will see
only the Voice Bar displayed at the top of the PC's screen.

= Show this number of Recent Calls/Events
Enter the number of items to display in the Recent calls/Events pane.

= Measurement system
From the drop-down list, select either the Metric or the US unit system.

= Coordinate system
From the drop-down list, select the coordinate system to be used.

e On Map
Select this option to display coordinates on the map.

Audio
¢ In the Options dialog box, click the Audio tab.

Options X
Sound Map  CoverageMap Hardware Advanced Audio  alarm | Telephony
Default audio devices: Confiqure
Recorder: Primary Sound Capture Driver
Player: Primary Sound Driver
Selected channek: Defauits A
Recorder [pefautt ~|
Player: [pefautt =]
Speaker: [petault ~|
External PTT: [ ~]
Indicator [ ~|
Unselected channek Defaults
Recorder [pefautt ~|
Player: [pefautt =]
Speaker: [oetauit ~|
Indicator f ~|
System sounds: Defaults
Player: [Defautt =]
Speaker: [oetauit ~|
[ El
Reset All audio devices to default Manage Custom Modes
Canca

Default audio devices

= Recorder
From the drop-down list, select the recording device the microphone is
connected to.
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Alarm

Player
From the drop-down list, select the audio device to play incoming voice
messages and playback voice recordings in the Dispatch Console.

Note: If TRBOnet Dispatch Console is running on the same PC
with TRBOnet Server connected to control stations via a
programming cable and sound card, the playback and
recorder devices cannot be the same for TRBOnet Dispatch
Console and TRBOnet Server.

Selected channel
Select the recorder, player, speaker, and external PTT device for radio
channel boxes which are selected in Dispatch Console.

Unselected channel
Select the recorder, player, and speaker for the radio channel boxes which
are not selected in Dispatch Console.

System sounds
Select the player and speaker for the system sounds.
For the list of system sounds, see section Sound (page 118).

Alarm
Select the player and speaker for the alarm sounds.

Telephony/Intercom/Private Calls
Select the recorder, player, speaker, and external PTT device for the
appropriate voice boxes.

All Call/Groups/Slots
Select the recorder, player, speaker, external PTT device and volume level
for the appropriate voice boxes.

¢ In the Options dialog box, click the Alarm tab.

Options X

Sound Map  CoverageMap Hardnare Advanced Audio {Alarm : Telephony
Configure display options for radios in alarm mode

Mlarm Panel: [Main window

LefLe]

Call Button: [none
Always show radio on map
[ pisplay <
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= Alarm Panel
From the drop-down list, select where to show the alarm panel (in the main
window or in a new window), or select 'None' to hide it.

= Call Button

From the drop-down list, select the call destination when the PTT button is
pressed in the alarm panel (private call, group call, or all call).

@ Radios in Alarm -

235

Request Location
PTT Copy Coordinates
Find on GPS map

Find on Beacon map

18 Jul 2018 17:01
Region 1
18 Jul 2018 17:01

Emergency Call

Request Location
PTT Copy Coordinates
Find on GPS map

Find on Beacon map

Beer 18 Jul 2018 16:58
GPs: 18 Jul 2018 16:57
Region: Region 1

= Always show radio on map
Select this option so that radios in alarm mode will always be displayed on
the map regardless of the filters applied to the radio (see section 6.6.2.4,

Filters).

Note: When this option is selected, you cannot disable the display
of radios in alarm mode.

= Display camera in new window
Select this option so that when a radio is in alarm mode, a window will
open with the camera associated with the radio.

= Display radio in new window
Select this option to display a radio in alarm mode on the selected map in a
new, separate window.

e Map
This field displays the map name. Click the Select map link and specify
the map on which to display a radio in alarm mode.
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B - o X
2 | fites [ B @[Q) @ @8 7 Show Beacans: Al ~ | & (A FindonMap~ & | # Drawing Panel | J7 Route -

Bloom 32

deu s o s3(00

Lattude: 53°5626.78" N: Longiude: 30°1646.14" E
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Telephony
¢ In the Options dialog box, click the Telephony tab.

Options X

Sound Map  CoverageMap Hardware Advanced Audio Alarm  Telephony

Incoming g Call | Call waiting | Held Cal

‘Call Priority Ringtone Action
Normal: Default b play

Emergency: Default b play
b play
b play

5 I
-3
=3

e faul

(=

= Queue all incoming telephone calls
Select this option so that when the telephone line is busy, incoming calls
will be queued rather than rejected.

= Show this number of Recent Phone Calls
Enter the number of items to display in the list of recent calls. The list of
recent phone calls appears when you click the arrow on the right of the dial
string in the Telephony box (see section 6.5.9.1, Phone Calls from/to
Dispatch Console).

Ringtone configuration

On the Incoming Call (Call Waiting) tab:

e Click a corresponding link in the Ringtone column, and from the pull-
down menu, select either Set Default, Set Custom, or Disable.
If you select Custom, in the dialog box that opens, browse for the audio
file on the local PC and click Open.
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e Click a Play link in the Action column to play back the corresponding
ringtone.

On the Held Call tab:

¢ Remind after
Enter the timeout, in seconds, that will be used for playing the reminder
tone when a call is on Hold.

¢ Ringtone
Specify the reminder tone to be played when a call is on Hold.
6.3.4.2 Exporting/Importing Options

A dispatcher can export custom Dispatch Console settings (Volume level, Ul view,
hotkeys configuration, and other settings) as a .config file and save it to the local PC
or to a selected external device.

¢ Click Tools > Export Options and save the file to the specified location.
If you want to apply settings from a different TRBOnet Dispatch Console:

¢ Click Tools > Import Options and browse for the .config file with the desired
settings.

6.3.4.3 Setting Language

e On the Tools menu, click Set Language

Select Language X

Language: |En

= From the drop-down list, select the desired language and click OK.
The changes will apply after you restart the Dispatch Console.
6.3.4.4 Changing Password

e On the Tools menu, click Change Password

Change Password x

{f\s) Change Password

Old password: | ooooo |

Mew password: | tesens |

Repeat password: |uooo. |

= In the Old password box, enter your current password.

= In the New password box, enter the new password.

= |n the Repeat password box, enter the new password again.
= Click OK.
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6.3.5 Help

e Help > Send Feedback
Click this menu item to send your feedback to Neocom Software, either
through E-mail, or online via the site.

e Help > Save System Logs
Click this menu item to save the logs as a .zip file. This .zip file can then be sent
to Neocom support.

e Help > About

/®

neocom
SsoOftware

Click this menu item to see the About dialog displaying information about
TRBOnet Enterprise (applied license, version, build date, and other relevant

information).

6.4 Administration

Click the Administration tab to set system elements and options.

Click the Administration tab (1), and see the full system information in the Server

(2) pane:

File View Map

[ License
[dl Database
{-lh Radio systems

Tools Help

Administration

p—

—

Server

G 1 Line free [«](@] B P intercom

Al Cal [2][«][@]

P crow 10 [1](«][@] 8 P Group 20

[rrivate cal [«[@]

N,
1@ Administration

Select an item in left menu to administer,
Licensed to:

demo
Demo License
Server is available

CapacityPLUS

Version; 26.0.7
CapacityPLUS: Private Cal
Serial pumber: 485TMGS110
Version: 26.0.7
CapacitypLus: All Cal
Serial mumbsers 484TMG#110
Version; 26.0.7
CapacityPLLS: Group #10
Serial pumber: 484TMGS110

CapacityPLUS: Group #20
Serial mumbsers 44TMG110
Version; 26.0.7

CapacityPLLS: Group #30
Serial pumber: 484TMGS110
Version: 26.0.7

¥ Groun 30 [2][«][@]

Telephony

\ Service is avaisble /

— 1

& [¢]S)

<
<

[ 127001 &3 g | & Administrator | (8 Licensed to: demo Demo License

6.4.1 Database

| @ Active-

Go to Administration (1), Database (2) to see the full overview of the database:
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File View Map Tools Help

Administration Database
Gome ~ | W & e free [« e o acal
[F)oatabase] Mlcow 10 [-1][<][@] B P Group 20 [2][=][@] B P Group 30
i} Radio Systems
&3t System Eridging 2 [ Jprvate cal
@, IE‘ELP""”Y o || 1 Backup | s schedute
Al vosce Dispatch u Database Information
i Server name: (local)\SQLEXPRESS
g Localionizackg, Database name: TREONEt
Backup date: 25.0ct 2016 16:28:26
& sob Ticketing Database version: Microsoft SQL Server 2014 (5P2) (KB3171021) - 12.0.5000.0 (X64)
Jun 17 2016 19:14:08
Copyright {c) Microsoft Corporaton
Route Management Express Edition (§4-bit) on Windows NT 5.3 <X64> (Build 10586: )
@ RFID Tracker Data size: 17.23M8
Audio size 2.77M8
[] Text Messages
ﬁ Voice Recording
() Reports
Event Viewer
[75] Radio Allocation 1
e
127001 £3 B | § Administrator | (28 Licensed to: demo Demo License | @ Active~

In the Database pane, the administrator can restore and back up the database and
audio recordings.

For more details on backups, see Appendix D: Backing up and Restoring Database
and Audio Recordings (page 348).

6.4.2 Radio Systems

All radio systems registered in the Server are represented on the Radio Systems
pane.

Go to Administration (1), Radio Systems (2) to see the system parameters:

File View Map Tools Help

Administration Radio e e[
due * |G e ree D OoE (CLE O]
(@ Database ¥ crow 10 [-0][+][@] J8f ¥ Group 20 [2][«][@] S P roup 30 [2][«][e]
e Radio Systems|
8 System Bridging [Jprivate call [n][<]
 rsote e
System type System ID Caption
U\l voice Dispatch |/ Intercom Intercom
+f Phone Telephony
@ Location Tracking |+ Capadty Plus Department1 CapacityPLUS
& 10b Ticketing
Route Management
@ RFID Tracker
[] Text Messages
ﬁ Voice Recording
@ Reports
Event Viewer
7] Radio Allocation / 1
., Administration o«
1 @] | Record 10F3 ¢ [ [mm] ¢ »
6127001 &3 B | $ Administrator | (8 Licensed to: demo Demo License | @ Active-

The administrator is able to see the following radio system parameters in the table:
e System Type - the type of the system.

e System ID - a unique System Identifier configured in TRBOnet Server
configuration for repeater or control stations in the system.

e Caption — the caption of the system.
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/®

6.4.2.1 Radio System Properties

To see the radio system properties, do the following:

e Select a radio system in the list and click the Properties button (1);

or,

double-click the radio system in the list;

or,

neocom
software

click the corresponding element at the bottom of the Dispatch Console
window, and choose Properties (2).

File View Map Tools Help

Administration Radio

[ server
{4 License
-] Database
&
g4 System Bridging
& Telephony
L Tacks

A

7P 1: Line free [«l[2]

3 intercom [9][«][@] 8 I3 & call

Group 10 [
[Jprivate cal [][«l[@]

v || &F Properties

Group 20 [« Group 30

EE]
[»][«][2]
[«

41, Voice Dispatch

«/ Intercom
o Phone

@mﬁmlm

@ Job Ticketing

Rnlllel‘lanag:mcnt

@ RFID Tracker

[] Text Messages

E Voice Recording

C@ Reports

Event Viewer

2

pe—

/Rawrdlm > mlm| <]

apadity Plus Depar

System System ID Caption

Intercom
Telephony
trent1 CapadityPLUS

127001 &3] & Administrator

Licensed to: deme Deme License

‘ @ Active~

Reset

The administrator is able to see Active and Inactive registered systems. In case you
have more than 10 registered systems, systems are grouped and can be seen in the

drop-down list.

Common information for all system elements is listed below:

Description tab

On the Description tab, you can see the general info:

Repeater #1: Slot #1 X
Description  Channels  Transmits
System Type: IIP Site Connect
System ID: IDepartmentl
Caption: IRepeatEr #1: Slot #1
Cancel |
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e System Type
The system type for a repeater/control station (in Digital or Analogue mode).
For more details on the systems, see section 3.2, MOTOTRBO Radio Systems
(page 4).

e System ID

The Unique System Identifier configured in TRBOnet Server for a repeater or
control stations in the system.

e Caption
Enter the system name.

Channels tab

On the Channels tab, you see the list of channels:

Repeater #1: Slot #1 *
Description Channels  Transmits
T Properties Control | =% Reset
‘Name Voice Data
- Repeater #1: Slot #1 RX, TX RX, TX
Channel for private and phone calls:
E

o Click the Properties button to see the channel additional data:

Repeater #1: Slot #1 X

Description  Talk groups  Volume

D: |80cc8f18-33e64b4f-b8€7-551e19dehceb

Mame: |Repeater #1: Slot #1

Type: [MOTCTREC Repeater

Mode: |IP Site Connect

Connected

Serial Number: [as4TMG4110

Firmware version: ‘2.6.0.7

Cancel
= ID
Default registration number (manufacturer's number);
= Name
System element’s name in the system;
= Type

System type for a repeater/control station (in Digital or Analogue mode).
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= Mode
System type for a repeater/connection mode for a control station.

For details on the control station modes, see section 5.9.3.1, Control Station
Connection Modes (page 34).

= Connected

e Serial number
Default system element'’s serial number (manufacturer’'s number).

e Firmware Version
Current system element's firmware version.

e Click the Reset button to test the connection to the system element.

Note: For a repeater, clicking the Reset button reconnects the
repeater.
For a control station, clicking the Reset button reloads the
radio.

Talk groups tab (for repeaters only)

= On the Talk groups tab, you can see selected Talk group info:

Repeater #1: Slot #1 X

Description  Talk groups  volume

Specify available talk groups

[ | Al call
[ |Firemen
v |Police

= Specify available Talk groups for the system element in the list of created
Talk groups.

Selected Talk groups are available on the Radio tab in the system element
box in the drop-down list:

(_D Repeater #1: Slot #2

All call E
Firemen
Police

Session:

Free channel

Sender:

I

RX T =

\_ o,
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Note: Close TRBOnet Server before applying the system element
settings.

Volume tab (for repeaters only)

= On the Volume tab, you can see Volume settings for the repeater:

Repeater #1: Slot #1 %
Description  Talk groups  Volume
+ +
RX ™
Reset Reset
[] configure system volume
cance

e Specify the RX and TX volume levels for the Repeater using a volume
control slider.

e Click the Reset link to set default volume level for RX or TX.

¢ Configure system volume
Select this option to save default volume settings for Voice transmissions
from the selected Repeater.

Transmits tab

e On the Transmits tab, you can see the information about audio and data
transmissions:

Repeater #1: Slot #1 *
Description  Channels  Transmits
Record Audio
[ Manage Audio by DTMF

= Record audio
Select this option to enable audio recordings for the selected repeater.
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= Manage Audio by DTMF
Select this option to manage audio on the selected channel by specified
DTMF tones.

¢ Mute channel
Enter a DTMF sequence to be used to mute the selected channel.

¢ Unmute channel
Enter a DTMF sequence to be used to unmute the selected channel.

6.4.2.2 Intercom Properties

e Select Intercom in the list and click the Properties button;
or,
double-click Intercom in the list of radio systems.

Channels tab

On the Channels tab, you see the list of Intercom channels.
These are the dispatcher groups you added in TRBOnet Dispatch Console (see
section 6.4.16, Dispatcher Groups).

Transmits tab

Intercom X
Description  Channels  Transmits
Record Audio
Voice Call Hang Time (ms):
Group Call: 3000 3:
Private Call: 4000 2
T¥ Timeout: 50 EI: seconds

= Record Audio
Select this option to record all audio transmissions over the Intercom
channel.

Voice Call Hang Time (ms):

= Group Call
This value sets the duration of reserving the channel after the end of a
group call transmission. During this time, only members of the dispatcher
group that the channel is reserved for can transmit.
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6.4.3

Private Call

This value sets the duration during which the private dispatcher call setup is
kept after a dispatcher releases the PTT button. This is to avoid setting up
the call again each time a dispatcher presses the PTT button to transmit.
During this time, other dispatchers can still transmit since the channel is

essentially idle.
TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When the
dispatcher starts a voice session over the Intercom channel, transmission
will be interrupted after this TX Timeout expires.

System Bridge

TRBOnet Dispatch Console provides the System Bridge function that allows
configuring the network for redirecting radio calls.

The administrator can create the following two types of system bridges:

1.

System Bridge for Radio Channels — allows connecting all types of Radios
(analogue and digital radios, supports IP Site Connect, Capacity Plus, Linked
Capacity Plus and Connect Plus modes).

2. System Bridge for Repeaters (Binary Patch) - allows connecting only the

repeater slots in an IP Site Connect system without encoding/decoding voice
and data.

Go to Administration (1), System Bridge (2) to add a System Bridge to the system:

File View Map Tools Help

Administration

[ server A
[8 License
- [] Database
-5 Radio Systems
- #52 System Bridge
FpTeephony T= 2,

< >

() vaice Dispatch
P—
& 30b Ticketing
e—

Dimﬂﬁsags

(R o=

Event Viewer

o e ]

System Bridge

EIEr]

2 L Line free [4:][@] ¥ ¥ intercom [0][+](@] S PP Maint=nace [][=][@]
C [+]

P4 siot 2

S Add -5 Edit | Ek Delete
A Name

Type
| Einary P,
w!| Radio Brid,

1

e

44| 4| 4 |Record 10f2 b |k bH 4

Binary Patch

Firemen-Police

(@]
P dsp 15 ¥l siot 1 [][«][@]

[ 127001 gy & &y By | | Administrator | [ Licensed to: demo Demo License

@ Active~

e Click the Add button (3) to add a System Bridge.

From the drop-down menu, select the System Bridge type.
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Radio Bridge

Radio Bridge X

Name: [Firemen-palice:

Work Mode: [channels redirect the calls to each other =l

PTT Button: [aways Enabled ~l

Channels | Parameters
Channels to redirect calls

* Name
Specify a name for the Radio Bridge to display in the Radio Interface pane.

= Work mode
Select the work mode from the drop-down list. For more details on System
Bridging types, see 6.4.3.1, Radio Bridge Types (page 140).

* PTT Button
Set PTT on the System Bridging interface to be able to transmit voice, or do

not set only to hear the voice from other channels. There are 3 options
available:

e Enable when Bridge enabled
¢ Always Enabled
e Invisible
= On the Channels tab, click the Add button (1) to add a channel to the list.

= In the Radio System column, select a radio channel from the drop-down
list (2).

= In the Group column, select available group for the radio channel (3).
= In the Mode column, select a mode for the radio channel (4).

e Always
Enables System Bridge always, regardless of the radio status
(online/offline).

e By Radio
Enables System Bridging on a selected channel when there are online
radios capable to receive voice calls from the selected group.

= On the Parameters tab, specify call types for System Bridging:

139



neocom
sOoftware

Radio Bridge x
Name: [Firemen-poiice
Work Mode: [channels redrect the cals to each other =l
PTT Button: [nvisiie =l

‘Spedify call types for System Bridge:

[V Voice Call [V Text Message
I~ Check Radio I~ Telemetry
I~ Enable Disable Radio ¥ Location (GPS)
I call Alert [~ User Data

¥ Emergency Alert

o1 et |

= Select call types to use in System Bridge mode.
= Click OK to add System Bridging for the radio channels.

The System Bridges are displayed on the Patch panel of the Radio Interface
pane:

File View Map Tools Help
Voice Dispatch Radio Interface &)

ol & : & (KT =l || Radio Interface | Recent Cals/Events

Start Voice Message

OlE

Voice Message

@Q 235 (Basil) h Free channel ~
PTT
" —
Drag and Drop PTT Box here to
eate new group
Group 10 [9] [«
Police s Bri )
(SR | Admnistator L G'Stef" ridge
pacityP...
CapacityP...
P Group 20 BlE) Cleaners
:rtmebn " Firemen - Police |
PTT S @ cavackvr. E
B Fremen Police
@ capadityP...
Group 30 [ [« [@] v Firemen v

Recent Calls/Events

[ Playback [l Seve~ () Print | 11 Pause ¥ Clear + &i Reload | [ Filter By Radio | = Grouping " Auto Filter
Date |Radio System | Sender | Rechient | Message | Details | Note |
18-Mov-2015 17:18:52  CapadtyPLUS Administrator Firemen Dispatcher 'Administra... Members: Administrator
18-Mov-2016 17:18:52  CapadtyPLUS Administrator Police Dispatcher ‘Administra... Members: Administrator
18-Nov-2016 17:18:49  CapadtyPLUS Administrator Al Allcall from dispatche... Members: Administrator

18-Nov-2016 17:16:31  CapadtyPLUS 125 Al All Call from '125" (00:01) Members: 125 A
|| 4] Record1ofe72 WM 4| 3

Recent Calls/Events  RecentCals | Requestto Tak | Radio State | Active Tasks | Active Routes | User Actity | Map | Cameras

127001 &3 B | § Administrotor | [ Licensed to: demo Demo License | @ active~

6.4.3.1 Radio Bridge Types

1.

140

Channels redirect the calls to each other

This is the most common type of System Bridging when data exchanges
between the channels set in the System Bridging settings. Thus, there is a
common channel for all the subscribers of the specified control stations:

To create this mode of System Bridging, add a System Bridge and set the Work
Mode as Channels redirect the calls to each other.
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To create this type of System Bridging, add a System Bridge and set the Work
Mode as A Channel redirects calls to many Channels.

3. Many channels redirect calls to one channel

»\ .“
». 05
S\
% Control Station
Radi ‘y](‘«' ork ) !

To create this type of System Bridging, add a System Bridge and set the Work
Mode as Many Channels redirect the calls to one Channel.

4. Redirect private calls

Select this mode so that private calls can be redirected between the radio
systems.
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Binary Patch (for IP Site Connect only)

Binary Cross Patch (IPSC Systems only) X

Name: [Binary paten
Rules
Rule 1of 2 A

Siot: Slot 1 M voice Data
[ an calls [ private cals M Group calls

Groups: (Al Groups)

Repeaters: (Al Repeaters)

Rule 20f 2 A
Siot: Slot2 [ voice [ pata
/1 Al calls W/ private Cals [ eroup cals

Groups: (Al Groups)
Repeaters: (Al Repeaters)

i Add X Delete

Name
Specify a name for the Binary Patch to display in the Radio Interface pane.

Rules
Specify the rules for redirecting calls.

Check Voice/Data to transmit on the selected slot.
Select available Call types.
Select available Groups for System Bridging from the drop-down list.

Select available Repeaters to redirect calls in System Bridging from the
drop-down list.

The Binary Patches are displayed on the Patch panel of the Radio Interface pane:
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File View Map Tools Help

Voice Dispatch Radio Interface
@k :

a ‘R Online Dispatehe.
B administrator

O Online, Indaor (0)
@ Online, GPS Fixe

@ Online, No GPS (0)
e O Offline (2)

Free channel

[JRepeater #1: slot #1

Free channel

all

Route Management N "
[JRepeater #1: slot #2 <= [Jancan Radio Bridge
Repeater ... rﬂ
| j] RFID Tracker h Free channel H Free channel Firemen
PTT PTT —
ot = L — roups v
Recent Ca ™
i Voice Recording %) Playback |l Save~ ) Print | 11 Pause <¥ Clear - &i Reload | ‘[ Filter By Radio | = Grouping "7 Auto Filter € Defauh Settings || 4 Details |
— Date | Radio System | sender |Recpient | Message | Detais [ Wote [Ext.rvore |
@ Reports 17-0ct-2016 14:21:07  Repeater #1: Siot #1125 Al Al Call from '125 (00:01) Members: 125 -
17-0ct-2016 14:21:06 Control Station #1 Dispatcher Al All Call from dispatcher *...
{5 Event viewer 170ct-2016 14:21:02  Control Station #1  Dispatcher Al Al Call from dispatcher ..
17-0ct-2016 14:20:57  ConvrolStaten #1  Dispatcher Al 4ll Call from dispatcher ...
aa Radio Allocation 17-Oct-2016 14:20:51 Repeater #1: Slot #1 125 Al All Call from '125' (00:01)  Members: 125
17-Nck-2N1A 14-20-51 Cnntral Statinn #1 Nisnatrher al &l Call from disnatcher ' v
ol 4] 4] Recors 16533 5 [l 4] 5
Administration - -
@ Recent Calls/Events | RecentCals. || Radio State || Active Tasks || | User Actiity | Map | Cameras
127001 &3 B B B | & Administrator | [ Licensed to: demo Demo License | @ Active~

Note: System Bridges can also be created by drag and drop of the
PTT boxes in the Radio Interface pane. It is a temporary
System Bridge, which will be deleted after reconnecting to
TRBOnet Server or exiting TRBOnet Dispatch Console.
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6.4.4 Telephony

Click Administration (1), and then Telephony (2) to configure incoming and
outgoing SIP calls:

File Viev Map Tools Help
Administration Telephony € ]S

d senver (5 1: Line free = Mdcro 10 Pl
3 2 call ) o PGroup 11 [2]=[@]

A7 System Bridging

@ Tasks 2
2] Virtual Modbus Devices
5 1P Cameras

Radio calls configuration

[} Event/Alarm Management Allow subscrbers to make autgoing calis: Yes
(8] swift Event Profies Allow to use DTMF: Yes
L Telemetry Allow to use Text Messages: Yes, Prefix: 'sp:’

1Ty Radio Groups Telemetry
5 Telemetry #1
(5 Radio Statuses

After the called party answers the cal
Start transmission

Uniimited
(B Group Radio Statuses N
- S Profie °
£ cpsprofie #1 v Yes
Yes
U] voice Dispatch 0
@ Location Tracking
&1 30b Ticketing Incoming calls configuration
Call to Dispatch Center: Redirect to dispatchers
Route Management Call to external number: Dedine calls
E Extension numbers (voice menu)
] RFID Tracker start cal automaticaly: Yes
Maximum number length: Uniimited, Accept code: &
[] Text Messages Number
0
ﬂ' Voice Recording <Number>

o Configure 4
Event Viewer —}‘_———

-1

Fp——
127001 &3 € | @ Administrtor | [ Licensed to: demo | @ active-

6.4.4.1 Radio Calls Configuration
Click the Configure button (3) to set radio call configuration parameters:

Radie calls configuration x

[¥ Allow subscribers to make outgoing calls
¥ allow to use DTMF
[¥ Allow to use Text Messages

Prefix: sip:

Play the incoming call tone on the radio: IAf'ber the called party answ... j

Initialize call to radio: ISiart transmission j

Initialize call timeout: IUnIimibed 3: seconds

[ Execute Check Radio before call
[¥ 5end Text Message if cannot establish call

[¥ Play tone when PTT changed = {} +

DTMF Access code: IU
DTMF Deaccess code: |¢

e Allow subscribers to make outgoing calls
Select this option to enable outgoing phone calls from the radio subscribers.

¢ Allow to use DTMF
Select this option to allow radio subscribers to dial the phone number as a
sequence of DTMF tones.

e Allow to use Text Messages
Select this option to allow radio subscribers to initialize phone calls via sending
TMS messages with a specified prefix to the dispatcher.
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= Prefix
Enter the standard prefix for a text message.

Play the incoming call tone on the radio
Select the mode for playing the incoming call tone on the radio that initiates a
call.

= After the called party answers the call
When a radio initiates a phone call to a subscriber via DTMF tones or a TMS
message, the incoming call tone will be played on the radio after the called
party answers the call.

* Immediately
When a radio initiates a phone call to a subscriber via DTMF tones or a TMS
message, the incoming call tone will be played on the radio immediately
that is without waiting for the called party to answer the call.

Initialize call to radio
Select the option how to start a call on a radio.

= Start transmission
Select to start a call to a radio automatically.

= Send ringtone
Select to play a ringtone until the radio user presses the PTT.

Initialize call timeout

Specify a timeout that defines how long to attempt to connect to the called
party.

Execute Check Radio before call

Select this option to execute a Check Radio command before placing a call.

Send text message if cannot establish call
Select this option to send a text message to the radio when the channel is
busy and a phone call cannot be established.

Play tone when PTT changed
Select this option so that the phone will sound a tone when the remote radio's
PTT is pressed or released.

DTMF Access Code

Set the value to that configured for the radios as Access Code in
MOTOTRBO CPS (see Appendix E: SIP Setup for Motorola Phone System,
section Programming Radios).

DTMF Deaccess Code

Set the value to that configured for the radios as Deaccess Code in
MOTOTRBO CPS (see Appendix E: SIP Setup for Motorola Phone System,
section Programming Radios).

6.4.4.2 Incoming Calls Configuration

Click the Configure button (4) to set incoming call configuration parameters:
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Inceming calls configuration X
Call to Dispatch Center: |Open VOiCe menu ﬂ
Call to external number: |Use number as Internal ﬂ
Extention numbers (voice menu)

[¥ Start call automaticaly

Max. number length: Unlimited 3: Accept code: # -
Number Call Description

1} Call dispatcher (any available)
<Number > Call radio with Radio ID = <Mumber >

=, Add [5) Edit [S Delete

e Call to Dispatch Center
Select the mode for handling incoming calls made to the dispatcher.

= Decline calls
All incoming phone calls will be declined.

= Open voice menu
When an incoming call arrives, the subscriber will hear Voice menu
commands.

= Redirect to dispatchers
All incoming voice calls will be redirected to all dispatchers of the Dispatch
center and any free dispatcher will answer the phone call.

¢ Call to external number
Select the mode for handling incoming calls made from unregistered
subscribers.

= Decline Calls
Select this option to decline all phone calls from unregistered subscribers.

= Use number as Radio ID
Select this option so that the system will use unregistered numbers as a
Radio ID and start a Private Call.

= Use number as Internal
Select this option to allow the system to read unregistered numbers
according to Voice Menu rules.

Extension numbers (Voice menu)

e Start call automatically
Select this option to search for the number in the Extensions table
automatically. When this option is disabled, the subscriber must dial the
number according to the following example: 0(phone number)#. The
character # is used to search for the phone number in the table.

¢ Max. number length
Specify the maximum number of characters allowed in a phone number.
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e Accept Code
Specify the character that will be used to finish dialing the number.

All available numbers are listed in the table below.
e Click the Add link to add a number to the table.

To add a static number

= Choose Static number.

Extension number *

{* Static number

" Dynamic number

Number: [ 123456

Call Type: |Ca|| Group j

Channel: |C0mm\ Station #1 j

Group: |AI\ Call j
Cancel

* Number
Enter a phone number to add to the table (contact list).

= Call Type
Select the call type from the drop-down list.

e Call Dispatcher
Select this type to make a phone call to the dispatcher.

e Call Radio
Select this type to make a phone call to the selected radio.

e Call Group
Select this type to make a phone call to the selected group.

= Channel
Select the channel to make a group phone call through (available for Group
Calls only).

= Dispatcher/Radio/Group
Select the dispatcher, radio, or group depending on what you have selected
in the Call Type box.

To add a dynamic number

= Choose Dynamic number.
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Extension number X

" Static number

+ Dynamic number

Prefix: | 123

Call Type: |Ca|| Radio j
|Autn Detect j
|Detected by Radio ID j

Cancel

= Prefix
Specify a prefix to type in on the keyboard.

= Call Type
Select the call type from the drop-down list.

¢ Call Radio
Select this type to make a phone call to a radio.

¢ Call Group
Select this type to make a phone call to a group.

¢ Call Phone
Select this type to make a phone call to a telephone.

= Channel
Select the channel to make a group phone call through (available for Group
Calls only).
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6.4.4.3 Adding SIP Extensions

e Click Administration (1), Telephony (2), Extensions (3), Add > SIP Phone (4)

File View Map Tools Help

Administration Telephony
5 server A~
+[A License
[ Database Configure Calls” Extensions | Redirect Calls | Aliases | Profiles |
L%- :“dt‘: 5‘::”‘5 5 Add[~ ) £dit| 2 Delete®, =S Grouping "/ Auto Filter (G Default Settings
L ystem Bridging
55 Telphony —2 6] si2 Phone SIP User Caption
L Tacks hd £ TRBOnet Mobile Client 1234 Internal PEX Server
] Radio 125 125 125
(i) Voice Dispatch B Radio 235 235 235
Location Tracking
Route Management
[] Text Messages
4|
p—
4| 4| 4 | Record 10f3 b | m M| 4 »
[ 127.00.1 &5 | § Administrator | [ Licensed to: demo Demo License @ Active -

In the Phone User dialog box, specify the following parameters:

Phone User >
SIP ID: 2403
SIP Name: |walt
Caption: |Walt
Password: | -----
Password {repeat): | ----- |
= SIPID
Enter the SIP ID that will be used by the phone user.
= SIP Name

Enter the SIP user name that will be used by the phone user.
= Caption

Enter the caption to be displayed for the phone user.
= Password

Enter the password for the phone user to be authenticated by the
telephone system.

= Password (repeat)
Enter the password again.

6.4.4.4 Redirect Calls

148

If a dispatcher doesn't take a phone call within the set period or they have changed
their status to unavailable, the call is automatically forwarded to a specified
dispatcher, radio, radio group, or phone account. This can be useful during night
shifts when no dispatcher is available.

e Click Administration (1), Telephony (2), Redirect Calls (3), Add (4)
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File VWiew Map Tools Help

Administration Telephony
-l Radio Systems -~ - _ -
|t System Bridging £ L Line fres [¢] [ Jmtercom [=/EA
L Fldisp 15 @Ee) [~EE B « =)
ections X B
8 e " Configure Calls_| Extensions” Redirect Calls | Aliases | Profiles
B pdd B Edit Delete || = GmNg /' Auto Filter & Default Settings
lfl_l_aﬂil Vaoice Dispatch
Drage @ ol g et Call N3 X
Location Tracking cllo | b
Call to:
ﬁ Job Ticketing 4 Target: & Dispatcher 1 -
: 30 =
Timeout: + | seconds
Redirect to:
[ e Type: WERadioGroup " T T T -
ﬁ Voice Recording Radio System: Slot 1 -
- Target: [} Firemen -
Event Viewer
Priority: Normal -
7] Radio Allocation 1
/ OK Cancel
I
P <
44| 44| 4 |Record Dofo v [ 4] r

Br2roo B B € Administrator | £ 21 days before your Support expires | [ Licensed to: demo. @ Active~

In the Redirect Call dialog box, specify the following parameters:

Call to

Target
From the drop-down list, select the dispatcher or dispatcher group.

Timeout
Specify the time period, in seconds, defining how long to wait until the
dispatcher answers a call.

Redirect to

Type
From the drop-down list, select one of the following:
e Decline

The calls will be declined.

¢ Dispatcher
The calls will be redirected to a specified dispatcher or dispatcher group.

¢ Radio unit
The calls will be redirected to a specified radio.

¢ Radio Group
The calls will be redirected to a specified radio group.

¢ Phone account
The calls will be redirected to a phone account from the phone book.

Radio System
If a radio group is selected as the redirection destination, select the radio
system over which to make a call to the specified radio group.

Target

From the drop-down list, select a particular dispatcher/dispatcher group,
radio, radio group, or phone account, depending on what you have
selected in the Type field.
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= Priority
If a radio or radio group is selected as the redirection destination, select the
priority with which the call will be made over the radio system.
6.4.4.5 Aliases

In addition to SIP extensions, the SIP aliases can also be used in your Telephony
system.

e Click Administration (1), Telephony (2), Aliases (3), Add (4)

File View Map Tools Help

Administration Telephony a
B e :

(Jl Database
5h Radio Systems
~#3 System Bridge

- Telephor

@ Tasks (\ 2

B nam b m i b
(i Vawe D

=y Cont
o4 3 <1
% Location Tracking
SIP ID: [2412

& 3ob Ticketing 4

B TRl
[ private call [21][«][@]
e

w

SIP Name: [2412

Route Management Caption: [Eugene

[ Texttessages Cencel
C% Reports
B

1
p———
4[4 4| Record 10F 1 v [ve[mm] 4] i
(127001 &3 B B | § Administrator | [ Licensed to: demo Demo License | @ active-

In the Phone Alias dialog box, specify the following parameters:

= SIPID
Enter the SIP ID that will be used by the phone user.

= SIP Name
Enter the SIP user name that will be used by the phone user.

= Caption
Enter the caption to be displayed for the phone user.
6.4.4.6 Profiles

In order to restrict incoming and outgoing calls as well as set priority for calls, SIP
profiles can be used in your Telephony system.

¢ Click Administration (1), Telephony (2), Profiles (3), Add (4)
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File View Mop Tools Help

Administration Telephony

[ server ~
1: Line free Intercom
8 License >
(0 Database Sales disp 15
il Radio Systems
g System Bridge Group 20 [2] Al cal
& TE‘EP"“"\ [private cal
@ Tads 2
%8 Modbus TCP Connections Calls_|[ Aliases
2 Virtual Modbus Devices i
57 1 cameras v Profile
a
Voice Dispatch General | pattems | Inheritance r
Name: Droite
Location Tracki
@ racieo 4 Description: Restirct dising to JeFF
@ Job Ticketing

™ Apply to Incoming Calls
C@ Reports ™ Apply to Outgoing Calls

‘2] Radio Allocation
L~ 1
< Admosirten 0 et .72 [ = .
127001 &g & B | § Administator | (8 Licensed to: demo Demo License | @ active-

In the Profile dialog box, specify the following parameters:

* Name
Enter a name for the profile.

= Description
Enter a description for the profile.

= Apply to Incoming Calls
Select this check box to apply the profile to incoming calls.

= Apply to Outgoing Calls
Select this check box to apply the profile to outgoing calls.

Click the Patterns tab.

Profile X

‘ General | Patterns | Inheritance

You can use wildcard chars in pattern:

* - any number of characters

? - one character

XXX-yyy -range of numbers from xxx to yyy

*411777 X

Call Priority: Mormal -

o
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= Specify the pattern that will be used to match the numbers in the dial string

or the incoming call numbers.

= Call Priority

From the drop-down list, specify the priority for the calls corresponding to

the specified patterns.
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e Click the Inheritance tab.

Profile X

Call Priority Profile Mame
M Emergency ~ Fedora
[ | Inherit Mals
Emergency
High
Normal
Low

On this tab, you can select the profiles to include in the profile you are
adding/editing.

= Call Priority
From the drop-down list, select the priority for the inherited profile.

6.4.5 Tasks

Go to Administration (1), Tasks (2) to see the list of the tasks created in the system:

File View Map Tools Help

Administration a am
é «s;vj:rense N (EEED [)][«] 7 1: ne fiee [ Jalcal Pl
3 o (o DoE (B DEE) (VEEE Pe)
!y Radio Systems
A System Bridging [ JPrivate Cal [][=]

@;me”h""’ = Add - 5] Edit | Bk Delete
* Ee 2 Task Name a
= [ 8 Agenda

v || ] @ Dispatcher Presence Control

[ §5% Export to SWD - Location of radio

') Voice Dispatch ¥ i Geofencng

vl 3 1dle Time
I;L Location Tracking vl Gy Lone Worker 1

¥ ] Mesages 1_Messages for Period
# Job Ticketing W 72, Missed GPS data loading

¥ 45k Radi rms)
Eouiciissgeges V) 5 SMS an
- vl 5 Timer
@ LI vl ¢ User Activity

) Voice Message

L] TextMessages ¥ '@ voice Message

ﬁ Voice Recording
Evuil‘ﬁcw:r 3

- 1
@ Administration Ll

it 4| 4| Record 120714 | 1| m] «| »
[ 127.00.1 &3 B § Administrator | (8 Licensed to: demo Demo License | @ Active-

Note: After you have created a task you need to enable it. Just select the
check box (3) beside the task you want to enable.

6.4.5.1 Dispatcher Presence Control

When enabled, this feature checks the presence of dispatchers and sends
notifications to interested parties if the specified dispatchers are not present in the
system.
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e Click Tasks (1), and double-click Dispatcher Presence Control (2) in the Tasks

File View Map Tools Help
Administration &[]
0 sever . B rtercom (2] B o 10 Pl
R License
H\‘;‘jDsﬁbsse [=1][<:][@] | ¥ Group 20 [1][«][@] 8 ¥ Group 11 [=2][«][@]
i Radio Systems
50 System Bricging P Growp 22 [][<][2] | M Frivate Cal M@
£ Telephony 1 = )
& Tados / L Add + 5 Edit | [ Delete
332 Virtual Modbus Devices . i L
< i > w| G Dispatcher Presence Control
5% Export to SWD -Loc3tieq of radio
AL, vosce Dispatch | |4 Geofending
5 1dle Time
@ Location Tracking 55 Radio Allocation (Sprite Forms) 2
d Email notifications
SF 30b Ticketing é
Route Management
@ RFID Tracker

[] Text Messages

g Voice Recording
Event Viewer

@ Radio Allocation

. e
| «| <« Record10f7 » M < »

[ 127001 &5 B | € Administrator | [ Licensed to: demo @ Active~

¢ In the Dispatcher Presence Control dialog box, specify the following options:

Dispatcher Presence Control *
Presence timeout 10 2 minutes
Reminder time 30 % seconds
(@) Al Dispatchers
() Selected Dispatchers

Notifications
0K Cancel

= Presence timeout
Enter the time period, in minutes, that will be used as a timeout to check for

the presence of dispatchers.

= Reminder time
Enter the time period, in seconds, that will be used to show a reminder
pop-up dialog before the planned time of performing the check. When the
reminder appears on top of the screen, the dispatcher must click the round
button in the center to confirm their presence in the system.

= All Dispatchers
Choose this option button so that all dispatchers will be checked for
presence.

= Selected Dispatchers
Choose this option button so that only selected dispatchers will be checked
for presence.

¢ Dispatchers
In the drop-down list, select the dispatchers.
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* Notifications
Click this link to select who will receive the appropriate notifications. The
recipients may include dispatchers, Email groups, SMS groups, radios, and
radio groups.

6.4.5.2 Agenda

The Agenda is used to automatically send predefined messages to the radios. It may
be used when you have any software receiving any messages but it is not able to
send them to the subscribers. In this case, TRBOnet Dispatch Console acts as an
intermediary for receiving the messages from the folder and sending them to radios.

e To add an agenda, select Tasks (1), and click Add > Agenda (2).

File View Map Tools Help

Administration

Tasks

&[5

'jz”im * | N B mtercom @] WG 1: e ree Darcal @]
Boor o D Boor s Do

()l Database
154 Radio Systems
A7 System Bridging 1

(EEE D)
[5s Add|~ =) Edit | [k Delete

% Lone Worker
b Export Data
v || & Scheduled Task
@ Voice Message

Import Routes’
() Scheduled Report
@ Hotsos

B3 Timer

. Missed GPS data loading
3% Sign-in notification

vl 55 Timer
Wl & User Activity
W @ Voice Message

¥ ) voice Message

. o
M4 | 4| Record 10f 14 b | W M| 4 r

[ 1270001 &3 B | € Administrator | [ Licensed to: demo Demo License @ Active-

¢ In the Agenda dialog box, specify the following parameters.

Agenda x

Task name: |Agenda

Settings

Outgoing folder (on server):

|C:\0Lrtgoing ‘
Incoming folder (on server):

|C:\Incoming ‘
Wait for response(sec): 120 =

Text to corfim:

o

= Task name
Specify a name for the task.

= Outgoing folder (on server)
Specify the outgoing folder for the text messages to be displayed in the
Dispatch Console (for example, C:\Outgoing).
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* Incoming folder (on server)
Specify the incoming folder for the reports (for example, C:\Incoming

files);

= Wait for response
Specify the time interval, in seconds, for the response.

= Text to confirm

neocom
software

Specify the text to be sent by the subscribers after they receive the

message.

6.4.5.3 Recorder

The Recorder feature allows connecting to an audio recorder via IP.

e To enable the task, select Tasks, and click Add (1) > Recorder (2):

File View Map Tools Help

Administration a
52 System Bridging ~
1 Line fr
2 Telephony Buoisia
¥ Al Call Group 20
232 Virtual Modbus Devices
BT 15 camerae - Group 22 [ rrivate cal
>
E Add |~ ) Edit | [ Delete
gﬁ Voice Dispatch 1 [ % Lone Worker
5 Export Data
% Ut e 2) Scheduled Task
# Voice Message
W Job Ticketing
& Agenda
& Import beacon data frofmRE "Firebird"

- Import Routes

() Scheduled Report
@ Hotsos

L Timer
= Automatic Data Retrieval (Swift GPS)

[5% Sign-in notification

P2 ntercom [=2][<] (@] | ¥ Group 10

P2 Group 11

(1]
[][«][@]
[][«][@]

e —

1| «| «|Record 10f7 v [» | «|

B 127.001 £ ﬁ,\ @ Administrator \ [EA Licensed to: demo

The feature allows replicating audio recordings to the recorder:

IF:

Port:

Audio Recorder

X

Task name: |Audic Recorder

Settings

[10.10.169.121
5054 z

Test of Channels

cace

e Task name

Specify a name for the task.

| @ Active-
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e |IP
Enter the recorder's IP address.

e Port
Specify the recorder's port number.

e C(lick Test of channels to view all available channels on the recorder.
e Click OK to add the task.

6.4.5.4 Import Beacon Data from Firebird DB

The Import beacon data from Firebird DB option allows importing beacon data
from Firebird database to TRBOnet Dispatch Software database.

To enable the task, select Tasks, and click Add (1) > Import beacon data from DB
"Firebird” (2):

File View Map Tools Help

Administration a & [0
?W * | B % 1: Line e P intercom []=lel]
. g Virtual Modbus Devices Group 10 All call (%]
57 P Cameras
(5 Eventjalarm Management [ Group 20 = Group 11
L — M Group 22 [][<][@] Private Call
(i volce Dispatch Add[~ 5 Edit | k Delete

on Track 5 Lone Worker A
< = / 5 Export Data

] / ) Scheduled Task
& sobmickenng 1 @ Voice Message
& Agenda

Route Management - pr— "
[F 1mport beacon data fram DB "Firebird

p [ Import Routes
@ RFID Tracker () Scheduled Report

@ Hotsos
(] Text Messages 0 Timer

= Automatic Data Retrieval (Swift GPS) 2
g' Voice Recording &% Sign-in notification
() Reports
‘Event Viewer

R —

1| 44| 4 |Record 10f7 ¥ | m 4] »
127001 &3 @, | § Administrator | [ Licensed to: demo | @ Active~
Import beacon data from DB "Firebird" X
Mame: Import beacon data from DB " Firshird"|
Settings | Import
Server: User:
[locathst | [svsoea |
Database path: Password:
| | [reseasess |
Part: Update (sec):
3050 2 10 z
Test
Cancel

¢ Name
Specify a name for the task.

e Server
Specify a remote server or a server on the local PC.
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e User
Type in a name of the Firebird DB user.

e Database path
Specify the Firebird DB path.

e Password
Specify a password to connect to Firebird DB (provided at logon).

e Port
Specify the port number to connect to Firebird DB.

e Update (sec.)
Specify the update period for Firebird DB.

e Click Test to test the connection to Firebird DB.

e Click the Import tab to specify Import settings:

Import beacon data from DB "Firebird” x

Name: Import beacon data from DB "Firebird"

Settings  Import

Import data from:
| <The Oldest Date Possible > ﬂ Import

Delete old data

Report:

Carcel

e Import data from
Specify the Firebird DB name.

e Click Import to import data.

¢ Delete old data
Select this option to delete all previously imported data from Firebird DB.

e Report
In this box, an import report will be displayed.

e Click OK to add the task.
6.4.5.5 Import Phone Addresses

The Import Phone Addresses option allows importing phone/address data from a
NENA database to TRBOnet database.

To perform this task:
e Select Tasks, and click Add > Import Phone Addresses (NENA)

¢ In the Import Phone Addresses (NENA) dialog box, browse for the
corresponding *.CSV file, and click OK.
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6.4.5.6 Export Data

TRBOnet Dispatch Console provides the Export Data function, which allows
exporting data to an external database table.

e To add an Export Data task, select Tasks (1), and click Add > Export Data (2):

File View Map Tools Help

Administration a 1K
[ server ~
28 License P intercom [=2][«][@] Bl & 1: Line free [+](@] I Jancan [2][«d[e]
3 Database (B pEE (B pEE ErE D]
) Radio Systems
& System Bridging 1 []Private cal [=][«][@]
&3 Telephony = 3 =
v @Aad - 5 Edit | [k Delete
%% Virtual Modbus Devi i Lone Worker a
|
v || &) Scheduled Task
@ Voice Message
& Agenda
* Import Routes
1) Scheduled Report 2
@ Hotsos
L Timer
= Missed GPS data loading
[ Sign-in notification
vl <3 Timer
¥l g User Activity
¥l @} voice Message
¥l @) Voice Message
2 e
1]« <] Record 10f 14 » | w|mi[ 4] >
(127001 g3 B | § Administotor | [28 Licensed to: demo Demo License | © Active-

¢ In the Export Data dialog box, specify the following parameters:

Export Data X
Task name: Export to database table - Location of radio |
Type: Export to database table j
Data: Location of radio j

Connection Data  Scheduler Advanced

" Default connection

& Spedified comectiont

Server name |Gocal)\sqLExPRESS

Database name ITRBUﬂEt j

¥ Windows authentication

User name I

User password I

Corcel

Connection tab

e Task name
Specify a name for the task.

» Type
Select the type of data export from the drop-down list. TRBOnet Dispatch
Console allows exporting data for third-party systems using data export tasks.

= Export to database table
Allows exporting data to MS SQL Server tables. Specify MS SQL Server
connection parameters, database, and table to export data.
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= Export to Versatrans
Allows exporting data to the Versatrans data collection system via IP. For
more details, visit the official website of Versatrans.

= Export to Google
Allows exporting data to file (file format is KML). For more details, visit the
following website.

= Export to NMEA
Allows exporting data to a file (text file format, export format is NMEA
0183). For more details, visit the following website.

= Export to file
Allows exporting data to a text file.

e Data
Select which data to export from the drop-down list.

e Default connection
Choose this option for default connection to SQL Server.

e Specified connection
Choose this option and specify the SQL Server and database name.

e Server name
Specify the SQL server name.

e Database name
Select the database from the drop-down list.

¢ Windows authentication
Select this option to use Windows authentication, or unselect it to use SQL
Server authentication (SQL Server user name and password will be required).

Data tab
Export Data X
Task name: |Export to database table - Location of radio |
Type: |Expurt to database table j
Data: |Lucatic|r| of radio j

Connection Data  Scheduler Advanced

Table: [Export_L ocations]
Create table  Load columns list
Column mapping:
Table column Data
Date Location date -
Latitude Latitude
Longitude Longitude
Speed Speed
Direction Direction
Predision Accuracy
Rardinn Radin TN hd

0K Cancel
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e Table

the name of the table to be exported into external database (by default, the
name of the table is created after you have specified it in Create table dialog

box).

e Click the Load columns list link to update the columns list in case you have
made any changes to the table.

e Click the Create table link to add a new table for data export:

Scheduler tab

Create table *
Create new table to export data
Active database connection
Table name: Export_Locations
Column list:
Table column Data
v Date Location date -
| Latitude Latitude
| Longitude Longitude
v| Speed Speed
| Direction Direction
| Predsion Accuracy
w| RadiolD Radio ID
v ID Unique radio ID
v Name Radio name
v| ExportDate Export date
-
Cancel
= Select the data fields to add to the table.
Export Data X
Task name: |Export to database table - Location of radio
Type: |Export to database table j
Data: |Location of radio j
Connection Data ~ Scheduler  Advanced
Days of week: | (all days) j
Start time: 13:00 El:
Stop time: 15:00 El:
Repeat every: 01:00:00 El:
" Execute at particular time
Cancel

¢ Days of week

In the drop-down list, select the days of the week on which to export the data.

¢ Execute recurrently with interval

Choose this option to perform data export on a periodic basis.

= Start time

Specify the time at which to start data export.
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= Stop time

Specify the time at which to stop data export.

= Repeat every

Specify a time period for periodic data exports.

¢ Execute at particular time
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SOoftware

Choose this option and specify the times in the columns of the table below.

Advanced tab

Export Data

Task name: |Expurt to database table - Location of radio

Type: |Expurt to database table

Data: |Lucatic|r| of radio

Export only changed data

Export mode

(® Always add new records

(O) Update existing records

Connection Data  Scheduler Advanced

() Update existing and add new records

Ll

Cancel

¢ Export only changed data

Select this option to export only changed location of the radio data.

e Export mode

Choose the mode for exporting data.

6.4.5.7 Geofencing

The Geofencing feature allows controlling the location and speed of radios relative

to manually defined regions on the map.

The Geofencing monitoring consists of the manually defined regions and the tasks.
The regions specify where to apply the rules, while the tasks specify how to apply

the rules for the regions and radios.

o Click Tasks (1), and double-click Geofencing (2) in the Tasks pane.
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Tasks &[]

d sver B intercom [][][@] W& 1: Lne free @] [ Jacal [i[sd(@]
. 10 pEE) (BN Bl] I B oroup 0 bllde]

o et oot omE

]

5k Add ~ 5 Edit | [EL Delete

EEEEEE Task Name sy
Event/Alarm Management & Agenda
(%] swift Event Profiles v ), Dispatcher Presence Control
5% Export to SWD -Locatien of radio
!l Voice Dispatch @ (i Geofenciy
W €5 Idle Time
@ Location Tracking | Gy Lone worker 1

¥l ] Mesages 1_Messages for Period

&F 30b Ticketing Wl %%, Mssed GPS data lo
fio

Route Management
1)) RFID Tracker WV 2 user Actvity

| @ voice Message
[ ] Text Messages ¥ @ Voice Message
g Voice Recording
Event Viewer

i o
W #H 4| Record4of14 | W M 4 r

[ 127001 & @ | 8 Administrator | [ Licensed to: demo Demo License @ Active~

The administrator can add/disable/delete the rules for Geofencing as well as edit
the currently selected rules:

Geofencing and Speed Control X
General | Location| Speed| Regions| Radios| Lone Worker |
onitor Area
i

Specify the general parameters of the rule and the time window when itis active

MName: [Monitor area 3 |

Description: | Watch out for the workers

Activate the rule on a schedule

Days of week: [Monday, Tuesday, Wednesday, Thursday, ... |

Start tme: o0 =
Stop time 18:00 E|C

After the ruleis triggered:
Reset Alarm mode when the rule conditions are no longer met

1

/

[Rerun the m\eyﬁsr each rule edit, server re?ﬂt and ot the start nfea){ scheduied time nindow (ot recommended) (1)

v 7 rd
o o) [ ] [ 7 | o Jle=

e Click the Add Rule button (1) and select the appropriate rule from the drop-
down list (Map Region, Beacons, Radios, Lone Worker) to add a rule to the
current Geofencing configuration. A new rule will be displayed in the list of
rules (4).

e Click the Disable rule button (2) to disable the selected rule.
e Click the Delete rule button (3) to delete the selected rule.

General tab

¢ Name
Specify the rule name.

e Description
Add a description of the rule.

¢ Run the rule on a schedule
Select this option and in the boxes below specify the schedule for the rule to
run.
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In the drop-down list, select the days of the week on which to run the
Geofencing rule.

= Start time

Specify the start time to run the rule.

= Stop time

Set the time to stop running the rule.

¢ Reset Alarm mode when the rule conditions are no longer met
Select this option to reset Alarm mode after the rule is triggered.

Location tab

g and Spee

d Control

¥l Mo

ritor Area 1

| Monitor Area 3

General [ Location | Speed| Regions| Radios| Lone Worker |

Define the subscriber's relitive positioning conditions which wil rigger the rule and
choose spx s to perform when the rule is exeeted

Trigger this rule when a subscriber:
[] Enters the selected regions
Leaves the selected regions

For multiple nestedfoverlapping regions:

(® Crosses outer border only
O Crosses any border

Perform the following actions:
Activate Alarm mode
[] Activate Lone Worker mode
[[] Send Text Message to the source radio
[ Send notification

Recpients
Send Request To Talk to the source radio

[IRerun the rules after each rule edit, server restart and at the start of each scheduled time window (not recommended) (1)

Add Rule

Disable Rule

][ pekterue

oK. | ‘ Cancel ‘

Trigger this rule when a subscriber:

¢ Enters the selected regions
Select this option so that the rule will be triggered as soon as a subscriber

enters the selected region.

¢ Leaves the selected regions
Select this option so that the rule will be triggered as soon as a subscriber

leaves the selected region.

For multiple nested/overlapping regions

Choose one of the options specifying for multiple regions whether to consider
only outer border of the group of regions, or any border of a region within the

group.

Perform the following actions:
Here you specify which actions to execute when the rule is triggered.

e Activate Alarm mode

Select this option to activate an Alarm mode in the Dispatch Console.

e Activate Lone Worker mode
Select this option to automatically activate a Lone Worker mode for the radio
in case of entering or leaving the selected region.
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Send Text Message to the source radio
Select this option to automatically send a text message to the radio when it
enters or leaves the selected region.

Send notification

Select this option to send a notification when the radio enters or leaves the
selected region. Click the Recipients link and specify the recipients to send the
notification to.

Send Request to Talk to the source radio
Select this option to automatically send a Request-to-Talk to the radio when it
enters or leaves the selected region.

Speed tab

Geofencing and Speed Control X

[ [ General] Location| Speed | Regions| Raios| Lone Worker]

| Moritor Area 1

! Moritor Area 3. efine the subs atiributes which wil trigger the rule and choose spedific actions
is executed

50 S
10 Zlkmh
[ stands stil for longer than: 50 - | seconds

Track speed in relation to regions: [Everywhere -

perform the folo
Activate Ala
[ Send Text Message to the source radio
[ Send Call Alert to the source radio

[IRerun the rules after each rule edit, server restart and at the start of each scheduled time window (ot recommended) (1)

[ addmue  [+][ osbierue |[  Deeterue Cancel

Trigger the rule when a subscriber:

164

Moves faster than

Select this option and specify the maximum allowed speed for the vehicles.
The rule will be triggered when the vehicle with the radio exceeds this speed
limit.

Moves slower than

Select this option and specify the minimum allowed speed for the vehicles. The
rule will be triggered when the vehicle with the radio drops below the
specified speed.

Stands still for longer than

Select this option and specify the time period, in seconds, during which the
vehicle is allowed to stand still. The rule will be triggered when the vehicle with
the radio stands still for longer than this specified time period.

Track speed in relation to regions
From the drop-down list, select where to track the speed of the vehicles: inside
or outside the selected regions, or independently of the regions.
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Regions tab

¢ All regions

Geofencing and Speed Control

Monitor Area 1
Moritor Area 3
| Moritor Zone 2

Generall Location| Speed [ Regions | Radios | Lone Worker|

Select the regions where this e can be triggered

[ Route 2

Zone 2

Select Al Deselect Al

[IRerun the rules after each rule edit, server restart and at the start of each scheduled time window (ot recommended) (1)

[ addrue  [~]]

Disable Rule

][ Deleterue

Cancel

Choose this option to apply this rule for all regions.

e Only selected regions
Choose this option to apply the rule for one or several regions.

e Select all

Click this button to select all regions in the list.

e Clear all

Click this button to unselect all regions in the list.

Radios tab

e All radios

Geofencing and Speed Cantrol

| Monitor Area 1
¥l Monitor Area 3.

Generall Location| Speed| Regions [ Radios | Lone worker|

Select radios the ruie is appied for:
O Alradios
@® Only selected radios

1= B3 Firemen
1@ 125 (Pete) 125
@) 235 (Basi) 235
[ Police

-
[N]
w
~

e
e
—
—

5

]
B

\
.

[JRerun the rules after each rule edit, server restart and at the start of each scheduled time window (notrecommended) (1)

[ addrie []]

DisatieRue | |

Delete Rule

Choose this option to apply this rule for all radios.

e Only selected radios
Choose this option to apply the rule for one or several radios.

e Selectall (1)

Click this button to select all radios in the list.
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e Clearall (2)
Click this button to unselect all radios in the list.

e Collapse all (3)
Click this button to collapse the view of radios in the list.

e Expand all (4)

Click this button to expand the view of radios in the list.
WEIMIO
Click this button, and from the drop-down menu, select which list to display:
Radio List, Radio Groups, or Logical Groups.

Geofencing and Speed Control X
General| Location| Speed| Regions| Radios| Lone Worker
vl Monitor Area 1
vl Moritor Area 3 Select the tasks to be executed when the e i triggered
O Altasks
(®) Orly selected tasks
Lone Workers 7
O Lone Worker
Select Al Deselect Al
[JRerun the rules after each rule edt, server restart and at the start of each schedued fime window (notrecommended) (1)
[ _addrue  [r][ Disablerue |[  Deleterue Cancel
e All Tasks

Choose this option to execute all Lone Worker tasks configured by the
administrator when the rule has been triggered.

¢ Only selected tasks
Choose this option, and in the list below, select the Lone Worker tasks to be
executed when the rule has been triggered.

Variable settings for Geofencing rules of event types (Map Region, Beacons, Radios
and Lone Worker) are represented in the table below:

Event type ‘ Tab Name Parameters Description

Common Settings General Name - specify the rule name;

Description — add the rule description;

Scheduler Run the rule on a schedule - select to start a scheduler
for Geofencing rules;

Days of week - select the days of the week on which to
activate the Geofencing rule;

Start time - set the time at which to start the rule;

Stop time - set the time at which to stop the rule.

Radios All radios — choose to apply this rule for all radios;
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Event type ‘ Tab Name Parameters Description

Only selected radios — choose to apply the rule for one
or several radios;

Select all - click to select all radios in the list;

Clear all - click to unselect all radios in the list.

Map Region. General Regions Control — select to enable regions control;
Allows configuring Control mode - select the control mode for regions in
rules when a the dropdown list;

radio(s) enters or
leaves the defined
map region(s).

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Regions Control rule has been triggered;

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Regions
Control rule has been triggered;

Activate Lone Worker if the rule has been triggered -

allows automatically activating a Lone Worker policy for a
radio in case of entering or leaving exact region on map.

Select to enable this option.

Speed and Idle Control - select to enable speed and
idle control;

Control mode - select the control mode for speed and
idle control in the dropdown list;

Maximum Speed - set the maximum speed for radio;

Maximum Idle Time - set the maximum idle time for
radio;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Speed and Idle Control rule has been triggered

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Speed
and Idle Control rule has been triggered;

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Reset Alarm mode if the rule is not triggered - select
to inform radio subscriber if the rule has not been

triggered.
Scheduler See above.
Regions. All regions — choose to apply this rule for all regions;
Select regions Only selected regions — choose to apply the rule for one

to apply the rule | or several regions;
Select all — click to select all regions in the list;

Clear all - click to unselect all regions in the list.

Radios See above.

Lone Worker. All Tasks — choose to apply all tasks configured by the
administrator when the rule has been triggered;
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Event type

‘ Tab Name

Enables Lone
Worker when
the rule has
been triggered

Parameters Description

Only selected tasks — choose this option, and in the list
below, select the Lone Worker tasks to be executed when
the rule has been triggered.

Beacons.

Allows configuring
rules when a radio
(s) enters or leaves
the beacon
coverage zone

General

Control mode:

Control entering beacon coverage zone - select to
enable the rule when a radio enters beacon coverage
zone;

Control leaving beacon coverage zone - select to
enable the rule when a radio leaves beacon coverage
zone;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Beacons rule has been triggered;

Reset Alarm mode if the rule is not triggered — select
to reset Alarm mode in the Dispatch Console
automatically if the rule condition was not triggered (for
example, when Control entering beacon coverage zone
is selected and the radio enters the monitored coverage
zone and then instantly leaves the zone, the alarm mode
in the Dispatch Console will be reset automatically)

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Beacons
rule has been triggered;

Activate Lone Worker if the rule has been triggered —
allows automatically activating a Lone Worker policy for a
radio in case of entering or leaving beacon coverage
zone. Select to enable this option.

Scheduler

See above.

Radios

See above.

Beacons.

Enables the rule
for selected
beacons

All Beacons — choose to apply this rule for all beacons;

Only selected beacons — choose to apply the rule for
one or several beacons.

Lone Worker

See above.
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Event type

Radios.

Allows using
radio(s)1 as a map
region and monitor
when another
radio(s) enters or
leaves radio’s
coverage zone

‘ Tab Name

General

Parameters Description

Control mode:

Control Entering Region — select to enable the rule
when a radio enters the coverage zone associated with
another radio;

Control Leaving Region - select to enable the rule when
a radio leaves the coverage zone associated with another
radio;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Radios rule has been triggered;

Reset Alarm mode if the rule is not triggered — select
to reset Alarm mode in the Dispatch Console
automatically if the rule condition was not triggered (for
example, when Control Entering Region is selected and
radio enters to the monitored coverage zone and then
instantly leaves the zone, alarm mode in the Dispatch
Console will be reset automatically)

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Radios
rule has been triggered;

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Minimum distance between radios - specify the
distance, in meters. When a distance is less than the
selected value, the rule will be triggered according to the
settings above.

Color of region — select the radio coverage zone color.

Scheduler

See above.

Regions

Select radio coverage zones the rule is applied for.

Radios

See above.

Lone Worker.

Allows configuring
scheduled Lone
Worker tasks

General

Days of week - select the days to activate the Lone
Worker rule;

Start time - set the time to start the rule;

Stop time - set the time to stop the rule.

Radios

See above.

Lone Worker

Select all configured by Administrator Lone Worker tasks
or several configured tasks.

When a Lone Worker task is mentioned as Disabled, the
administrator should enable the task.

Idle Time

The Idle Time feature allows monitoring vehicles idle time assigning Telemetry
Commands on selected VIOs.

e Click Tasks (1), and double-click Idle Time (2) in the Tasks pane.
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Idle Time x
Start VIO: = Command: IHigh -
Stop VIO: I 13: Command: IHigh -

Start

File View Map Tools Help

|

e Specify the telemetry VIO and Command to start the Idle Time.

Stop

e Specify the telemetry VIO and Command to stop the Idle Time.

The administrator can see Idle Time reports and statistics.

Click Reports (1), and under GPS reports, click Idle Time Summary or Idle Time

detailed (2) to see a common Idle Time report:
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{15 Location on Date
[ staysin Region

75 Drive Actvity Details 2
1T Drive Activity Summay
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W Job Ticketing
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[] Text Messages
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Idle Time Summary

—Hot defined— -

saved Profiles:

Select data by period:

StartDate: [seimr oo <] [
End Date: [axmmdaes ] [
Filter:

Rt P
Logical Group: ,W;'

Radio ID (e.0. 22,33,40-55,88):

ey

IEI,, "

Speed: 15 kmh
™~ ~3

Generate Report save Report Profile Delete Report Profile

[ Connected &3 B B | | Administrator | [ Licensed to: demo Demo License

| @ Active -

Note: Specify the speed accuracy value in the Speed box (3).
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6.4.5.9 Lone Worker

The Lone Worker policy lets the dispatcher set a time interval the communication
with a subscriber is expected. For example, if a lone worker has not called the
dispatcher for 15 minutes, the radio receives a message and the Dispatcher receives

an alarm signal.

e To add a Lone Worker task, select Tasks (1), and click Add > Lone Worker (2).

File View Map Tools Help

Administration a & <)
(0 Database A .
L Ragio Systems P intercom [=2][«][@] Bl & 1: Line free [+](@] [ Jarcan [2][«d[e]
i3 System Bridging Mcrow 10 (<[] N ¥ crewn 20 [][s:][@] | ¥ Growp 20 [1[](@]
Jegh
? e . et oot o
Virtual Modbus Devices
Add |~ 5 Edit | [, Del
{55 Event/Alam Management B Add]- 3 et | B Deere
(6] Suift Fuent Profies v |[ 2,
h Export Data
(1) voice Dispatch (%) Scheduled Task
@ VoiceMessage
@ Lecation Tracking &l Agenda
_" Import Routes
& 3o0b Ticketing () Scheduled Report
@ Hotsos 2
Route Management ) Timer
% Missed GPS data loading
@ P - " Sign-in notification
vl <3 Timer
[ vextmessages ¥ & vser Acavy
¥l @) voice Message
g aice Recankag ¥l @} voice Message
@ Reports.
Event Viewer
E Administration
1]« 4| Record50f 14 » | w|mi[ 4] >
(127001 g5 | @ Administrtor | (8 Licensed to: demo Demo License | © Active-

In the Lone Worker dialog box that appears, specify the following parameters:

Lone Worker

Task name:

X

Lone Worker 1

Task Start  Conditions  Task Stop

] Manually by dispatcher
Automatically by receiving Text Message from a radio

Message: Start

Automatically by receiving Telemetry Command from a radio
VIC: 1 3
[ Automatically by receiving DTMF command from a radio

Command:

IAny event vl

Message:

e

[] Automatically by receiving Status from a radio

0 >

Send the following text message to the radio

Cancel

Task Start tab
¢ Manually by dispatcher

Select this option to start the Lone Worker task manually by the dispatcher.
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Automatically by receiving Text Message from a radio

Select this option so that the Lone Worker task will start after receiving a
message from a radio. If you select this option, specify a text message in the
Message box.

Automatically by receiving Telemetry Command from a radio

Select this option so that the Lone Worker task will start after receiving a
telemetry command from a radio. If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option so that the Lone Worker task will start after receiving a
predefined DTMF command, for instance, #11#. If you select this option,
specify a DTMF combination without the # characters in the Command box.

Automatically by receiving Status from a radio
Select this option so that the Lone Worker task will start after receiving a
specified status from a radio. If you select this option, specify Status.

Send the following text message to the radio
Select this option and in the Message box enter the text message that will be
sent to the radio when a Lone Worker task is started for that radio.

Conditions tab

172

Lone Worker X

Task name: Lone Worker

Task Start Conditions  Task Stop

Response time 30 2| minutes

Send notification to radio

Reminder time &0 %| seconds

(®) Send Request To Talk
(O send Text Message

[] ResetLone Worker when receiving Text Message

[[] ResetLone Worker when receiving Telemetry command

1 > Any event b

[] ResetLone Worker when the distance has been traveled

=

[] Do not trigger alarm if radio is offiine for less than

Cancel

Response time
Specify the time period, in minutes, that determines how long TRBOnet Server
waits since the last radio transmission.

Send notification to radio

Select this option so that TRBOnet Server will send a notification to the radio
before raising the alarm if the radio has not transmitted for the specified time
period.
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= Reminder time
Specify the time period before it comes to raise the alarm, to send a
notification asking the radio to respond.

= Send Request to Talk
Choose this option to send a Request-to-Talk to the radio.

= Send Text Message
Choose this option to send a text message to the radio. Specify the
message text in the Message box.

¢ Reset Lone Worker when receiving Text Message
Select this option to reset the Lone Worker task after receiving the message
specified in the Message box.

¢ Reset Lone Worker when receiving Telemetry command
Select this option to reset the Lone Worker task after receiving the telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

e Reset Lone Worker when the distance has been traveled
Select this option to reset the Lone Worker task after the distance specified in
the Distance box has been traveled.

¢ Do not trigger alarm if radio is offline for less than
Select this option so that the alarm is not triggered if the radio is offline for a
time less than the time specified in the Interval box.

Task Stop tab

Lone Worker X

Task name: |Lune Worker 1

TaskStart Conditions Task Stop

Manually (on demand of dispatcher)
[ Automatically by receiving Text Message from a radio

[ automatically by receiving Telemetry Command from a radio

Automatically by receiving DTMF command from subscriber
Command: 123 #1237
[ Automatically by receive Status from subscriber

] send Text Message to a radio

Carcel

In the Task Stop tab, you can specify how to stop the Lone Worker task. The
available options are similar to those you specified on the Task Start tab.
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Enabling Lone Worker

e To enable the Lone Worker task for a selected radio, go to Voice Dispatch (1),
right-click the selected radio (2), and choose Start Lone Worker (3):
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Send Call

Request Location
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4 Find on Google Earth

‘Show Route on Google Earth

Monitoring
Specify Custom Icons.
Set Radio Channel

Set On Duty

: Slot #1 0l < 1]

3] [Jintercom

["Reveater #1: Slot #2

ree channel

l
channel

Drag and Drop PTT Bex here to
aeate new group

Patch on Repeaters
ol « =] - R
e —

-y Print | 11 Pause <f Clear - '\ Reload | “[] Filter By Radio

ouping '/ Auto Filter ©» Default Settings )

Date |RadioSystem  sender | Recpient | Message Detais | ote |Ext.Note |
21:0ct-2016 17:56:27  Repeater #1: Slo... Adminstra... Police Dispatcher ‘Adminitr... Members: Admisr... .
210ct2016 17:56:27  Repeater #1: So.... Adminstra... Poice Dispatcher ‘Adminstr... Members: Adminisr
2402016 17:56:23  Repeater #1: Slo... Administa... Al Al Call from depatch,.. Members: Adrinistr...
21-0ct-2016 17:56:17  Repeater #1:Slo.. 125 Al Al call from '125' {00... Members: 125
210ct 2016 17:56:14  Repeater #1: Sio... 235 A Al Callfrom 235' (00.... Members: 235

HAAINA TR Bonmaer 2190 776 o Bl from 35 (01 Merhre: 775 i
W 4[] Record ot 53 O Imimi<] f
et CalifEvents | RecentCale | Rado Sie ] AciveTagal]] I T I

(6127001 g5 B @ | § Administrator | [ Licensed to; demo Demo License | © Active-

e To monitor the Lone Worker task, click the Active Tasks tab:

Recent Calls Events.

e
To: Selected Channels

Drag and Drop PTT Box here to
create new group

Patch on Repeaters
Binary Patch

Enabling Lone Worker from Geofencing

1 Stop | = Grouping 7 AutoFilter ©» Defautt Settings
Task |Radio state
Lone Worker 1 125 {Pete) 125 16:55 17:25
| «|Record 1of 1 v || ¢ Bl
] I — T [ T =

127001 55 B By | & Adminisrator | (28 Licensed to: demo Deme License | © Aciive

e Click Location Tracking (1), and click the Geofencing button (2) in the Map

pane:
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File View Map Tools Help

Location Tracking

7 1 Line free Intercom Group 10

L[]
[][«][e]

Alcal

[[][e]
[][«][e]

Group 20

Group 11 Group 22 Private Cal

neocom
SsoOftware

- [ Beacons
1 @ Beer

64.

T <+ Fiter | @[B[Q[B] 7 [8] showBeacons: a1

2,
%
L

G3]| RFID Tracker Hospital
80m

[] Text Messages e

g e Record: Recent Calls/Events

0 Ruler (4 FindonMap< 4 7 Drowing Panel 7| Route| @ Geofencing] 2
o

5 Playback |l Sove - () Print | 11 Pause < Clear ~ (& Reload | [} Filter By Radio | = Grouping 1/ Auto Filter (> Default Settings || Details | [ Show Notes [ Add Note | [3t Add Message ‘

1@ coffee

W@ Tea
¥ [ Map Objects.

1] camera 1

(] Hospital

91 [ police
- [ Map Regions
UL o T—
-7 [/ Map Routes

Wige 111

@ Reports Date Radio System Sender Redpient Message
09,06 2017 14:43:57 Server [ Connection to Capity Plus 1 has been lost
I [ lus 1 hs been|
{5 event viewer 09.06.2017 1214330 Capacity Plus 1 Admiristrator i Dispatcher Administrator’calls group 11 (00:07)
- 09.06.2017 12:40:06  Capacty Plus 1 125 1 Radio '125'calls group '11' 00:08)
EEI . 09.06.201712:39:55  Capacity Plus 1 Admiristrator 1 Dispatcher ‘Administrator calls group '11' (00:05)
Admiristrator Police Dispatcher Administrator’cals aroup Poice’ (01:00)

09.06,2017 12:38:34  Capadty Plus 1
W] 4[ <] Record1of305 b ||| <

Recent Cals/Events | Recent Calls | RequestToTak | Radio State | ActiveTasks | ActiveRoutes | User Activity | Beacons | Beacon Events | Taglist

@Mnﬁishnﬁnn

Details

Members: Adninistrator, 125
Members: 125

Members: Admiristrator
Members: Adniristrator

127001 & ﬂ,‘ § Administrator ‘ [ Licensed to: demo.

¢ In the Geofencing and Speed Control dialog box, click
Add Rule > Lone Worker (1):

5

File View Map Tools Help

| © active-

GPS Positioning
B £

‘General | Radios | Lone Worker|

vl Moritor Area 1

& () Oniine, GPS ’i ] Monitor Area 3 iame: [Lone worker 2 ‘
®®) CES ] Looe ok, Description: Department 1
®®256. 999

L) voice Dispatch

Days of week: IMnndav, Wednesday

Start tme: 0:00 3:
“ T Stop tme: 0:00 3:

1

/

- [ Beacons.
L @@ seer
¥ @ Coffee
@ Tea
3+ [ Map Objects
¥ [ Abiding place
¥ [ Fre dep
(91 [] Hospital No2
i L &) police depar...
[=RE]=) Map Regions
@77 My zone
& C 4 [ Map Routes

3
) ¥ g Route 1

SR
Palsce

hiratteyskiy

[IRerun the rules after afm rule edit, server restart and at the start of each scheduled tme window (not recommended) (1)

Disable Rule Delete Rule

| [ L= Jle=]

18:40.14"E

| 77 MapRegion
Recent Calls | Radio State | Active Tacks | Active Routes | User Actvity | Beacons | Beacon Events | TagList

lemo Demo License

| @ Active-

2 Mmnern () Beacons |
@g Radios ‘

= Specify a Name for the Lone Worker rule and add a Description.

= Days of week
In the drop-down list, select the days of the week on which to activate the
Lone Worker rule.

= Start time
Specify the time at which to start the rule.

Stop time
Specify the time at which to stop the rule.

Click the Radios tab and add radios to which to apply the

Lone Worker rule:

175



neocom
sofFtware

Geofencing and Speed Control X

General[ Radios | Lone Worker |

| Moritor Area 1

¥l Moritor Area 3 Select radios the re is appled for:
vl <rule name > O Al radios

@ Only selected radios

[A@ 125 (pete) 125
1@ 235 @asi) 235

2la

[IRerun the rules after each rule edit, server restart and at the start of each scheduled time window (ot recommended) (1)

[ addRue  [v][  DscbleRue |  DeleteRue Cancel

= All radios
Choose to apply this rule to all radios.

= Only selected radios
Choose to apply the rule to one or several radios.

= Select all
Click to select all radios in the list.

= Clear all
Click to unselect all radios in the list.

e C(lick the Lone Worker tab and select the configured Lone Worker tasks:

Geofencing and Speed Control X

General| Location| Speed| Regions| Radios | Lone Worker

| Monitor Area 1

¥l Monitor Area 3. Select the tasks to be executed when the rule is triggered

O Altasks
(® Only selected tasks

Lone Workers
] Lene Worker

Select Al Deselect Al

[JRerun the rules after each rule edit, server restart and at the start of each scheduled time window (notrecommended) (1)

[ addrue  [-][ oiblerue || eleterue

= Choose either all configured Lone Worker tasks or several configured tasks.

Note: When a Lone Worker task is mentioned as Disabled, enable
it on the Tasks pane.

6.4.5.10 Radio Allocation (Sprite Forms)

This function is used for direct communication between the dispatcher and the
subscriber via special Tallysman Option board installed into the radio. The
dispatcher and subscriber have special form templates. The dispatcher receives Duty
ID of the subscriber with his template output form whereas the subscriber sends it
using his template input form. The radio name changes to its Duty ID.

176 TRBOnet Enterprise — User Manual



TRBOnet Dispatch Console

neocom
software

Note: Any activity may be decoded with its Duty ID so this is a
way to communicate for the dispatcher and subscribers

only.

e Click Tasks (1), and double-click Radio Allocation (Sprite Forms) (2) in the

Tasks pane.

File View Map Tools Help

- SEE
g el - e (5 1s ine iee T mEE Pl
(1) Database Group 10 Group 20 [][] Group 30 []
A Chmect L]
@,TE‘ED"V 5 Add - 5 Edit | [k Delete
@ Tasks
5% Virtuzl Modbus Devices v laciliape TS
1§ Agends
1=} Voice Dispatch [1 % Dispatcher Presence Control
[ {53 Export to SWD - Location of radio
Location Tracking vl [if Geofendng
¥ 55 1dle Tme:
@ Job Ticketing vl G Lone worker 1
¥l (5] Mesages 1_Messages for Period
Route Management vl “2, Missed GPS data loading
. vl ¢5% Radio Allocation fSprite Forms)
@ RFID Tracker (1 (] Scheduled Report 1™Mgssages for Period
vl 554 sMs and Email notifications’
[ ] Text Messages ¥l 5 Timer
Wl User Activity 2
ﬁ Voice Recording ¥l @ voice Message
- vl @ Voice Message
‘Event Viewer
Fp—
|« <] Record 9015 |w w4 ] »
127001 &8 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~

e Load the Sprite Form (output template) and select the Field Name:

Radic Allocation (Sprite Forms) x

Form Description:

APP_VERSION1=0.14 -
IAPP_VERSION2-1

DATE_MODIFIED=12/12/2012 8:21:053.m,

FORMATTED=
0203000FB3BCOAFS02FBO04ESA20427573018000000106180500028768CEQF1
0FBOOF5025368696674206E756D62657235AD781E

IAS_ARRAY=002, (03, (00, B<OF, 0xB9, (xBC, Ox0A, OxF5, (02, OFB, Bc00, =
(Oc4E, Ox5A, (20, (xd2, (75, (73, B0, ¢80, (00, (c00, (e, (06, (18,
0x05, 000, 302, 0x87, (x68, BxCE, (xDF, Bx10, BxFEB, (00, OxF5, (x02, (53,
0x68, (69, (66, (74, (20, (6E, (75, (6D, (x62, (<65, k72, (35, (xAD,
0x78. I 1E

METADATA=0008000000000000

FORM_TITLE=NZ Bus
FORM_ID=2
FORM_REVISION=3

[Field Data #0]

Prompt="Shif number” -
Load

Field Name | shift number =]

e Click OK to add a Sprite Form.
6.4.5.11 Scheduled Task

This function allows sending scheduled messages to radios.
e To add a scheduled task, click Add (1) > Scheduled task (2):
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File View Map Tools Help

Administration a & |0
g e * | I ntercom ()@ G 1 e fiee T @EE Pl
gﬁ Database Flcon 10 ooR ETE ooE D Pllel
L Radio Systems
Jr System Erdging [ JPrivate Call [«]
@TE‘EW:”V// 1 b Add |+ =) Edit | Zk Delete
<, e 2 E
w A

=% Virtual Modbus Devices v || 4 LoneWorker

) Export Data
“ Voice Message
@ ‘Location Tracking 4 Agenda

" Import Routes

& 3ob Ticketing () Scheduled Report
@ Hotsos d
Route Management L) Timer

. Missed GPS data loading

@ RFID Tracker [2”. Sign-in notification

el 3 Timer
[] Text Messages ¥l {2 User Activity

vl @ Voice Message
Q Voice Recording ¥l @ voice Message
‘Event Viewer
. o

|| <] Record 10F 14w w4 ] »
127001 &3 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~

Scheduled Task s
Task name: IScheduIed Task

Command ~ Scheduler

Command: |Send Text Message Hid I

Mezsage: IAIarm

% Send to radio group

" 5end to subscribed radio
Recipient

[~ Firemen

Canel

= Task name
Specify a name for the task.

= Command
From the drop-down list, select what to send to selected radios.
Send Text Message

¢ Message
Enter the message text in this box.

Send Telemetry
Select this command to send scheduled telemetry commands to selected
radios/groups, or request telemetry states from selected radios/groups.

e VIO
Specify the VIO contact.

¢ Command
From the drop-down list, select the signal level at which to send the
telemetry command to selected radios/groups, or select 'Request state'
to receive telemetry states from selected radios/groups.
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Request Location
Select this command to receive location data from selected radios/groups.

= Send to radio group
Choose this option to send the specified command to selected radio
groups.

= Send to subscribed radio
Choose this option to send the specified command to selected radios.

= Recipient
In this list, select the radio groups/radios to send the specified command to,
or receive telemetry/location data from.

Send Voice Message
Select this command to send a voice message to selected radios/groups:

Scheduled Task X

Task name: |5|:heduled Task 1

Command  Scheduler

Command: |Send Voice Message j

|| Load from file
,ﬁrﬂ Record message
@) Playback message

Call Type Channel Call Target

Private Call Auto Detect 125
Group Call [i5h Repeater #1: Slot... Firemen
Intercom call Intercom All hd

ok Add 3 BRemove

[ Impolite channel access

Cancel

= Load from file
Click this link to load an existing file from your PC.

= Record Message
Click this link to record a new voice message.

= Play back message
Click this link to play back the voice message.

= Specify Call type, Channel, and Call Target for a voice message.
Note: To send a Voice Message to a subscriber from the phone

book, click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

= Impolite channel access
Select this option so that the voice message will be sent regardless of
whether the channel is busy or not.
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Scheduler tab

Scheduled Task X

Task name: |S|:heduled Task 1

Command Scheduler

Start date: |01 October 2016 ~|

Stop date: |13 October 2016 ~|

Days of week: |Munday, Tuesday, Wednesday, Thursday, Friday j

¥ Execute recurrently with interval

Start time: 15:00 3:
Stop time: 18:00 3:
Repeat every: 01:00:00 3:

" Execute at particular time

Cancel

e Start date
Select a date to start the task.

e Stop date
Select a date to stop the task.

o Days of week
In the drop-down list, select the days of the week on which to perform the
task.

e Execute recurrently with interval
Choose this option to perform the task on a periodic basis.

e Start time
Specify the time at which to start the task.

e Stop time
Specify the time at which to stop the task.

e Repeat every
Specify a time period for periodic task executions.

¢ Execute at particular time
Choose this option and specify the times in the columns of the table below.

6.4.5.12 SMS and Email Notifications
TRBOnet Dispatch Console allows managing text messages:

1. Send Text Messages from LAN to a particular radio or talk group (POP3
Server);

2. Forward all Text Messages from radios to base radio to particular email
address (SMTP Server).

Note: Microsoft Exchange Server can be used as SMTP and POP3
servers. For more details on SMTP or POP3 servers, ask your
System Administrator.
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To enable the task, click Tasks (1), and double-click SMS and Email notifications
(2) in the Tasks pane.

File View Map Tools Help

Administration Tasks (€10

E
g e - e ] (5 1s ine iee EE) @EE o
(1) Database M croun 10 [=0][«][@] | B Group 20 [=2][«][@] |} ¥ Group 30 [22][«[e]
il Radio Systems
&g System Bridaing | I []«]
@, TE‘E”““T____/-— 1 = Add - 5 edit | Bk Delete
& Tasks
2k Virtual Modbus Devices v LackHame, 2
& Agenda
,ﬁ—a‘ﬁ Voice Dispatch 3, Dispatcher Presence Contral
55 Export to SWD - Location of radio
g Location Tracking v i Geofending
Wl {3 Idle Tme:
@ Job Ticketing wl G Lone Worker 1
Wl (2] Mesages 1_Messages for Period
Route Management Wl "2, Missed GPS data loading
- | {3 Radio Alocation (Sprite Farms)
0| RFID Tracker | [ SMS and Email notifications
Wl £ Timer
[] Text Messages Wl i User Actity
wl @ Voice Message
' Voice Recording % & v essace
e 2
[75] Radio Allocation
) st
|« 4 |Record 10 0f 14 || wi[ < »
@ 127001 &8 B | § Administrator | [ Licensed to: demo Demo License @ Active~

SMS settings tab

SMS settings  Qutgoing Email settings (SMTP)  Incoming Email settings

Send SMS to recipients if ALARM has been activated
L1 5end MMs to recipients if ALARM has been activated

Forward Text Messages to cell phone recpients
Input messages (from radienetwerk to dispatchers)
Output messages (from dispatchers to radionetwork)

SMS Groups

= Send SMS to recipients if ALARM has been activated
Select this option to send an SMS in case of an alarm on the radio.

= Send MMS to recipients if ALARM has been activated
Select this option to send an MMS in case of an alarm on the radio.

Forward Text Messages to cell phone recipients

* Input messages (from radio network to dispatchers)
Select this option to forward incoming text messages to cell phones.

= Output messages (from dispatchers to radio network)
Select this option to forward outgoing text messages to cell phones.

For more details on SMS settings, see section 5.15.2, Outgoing Mail Server (page 91).
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A radio sends text messages to the base station. TRBOnet Server forwards all text
messages to a particular email address (for example, admin@yourcompany.com).
The administrator receives text messages from radios as regular emails.

Outgoing Email settings (SMTP) tab

SMS and Email notifications X

SMS settings  Outgoing Email settings (SMTF)  Incoming Email settings

Send Email to recipients if ALARM has been activated

= Send Email to recipients if ALARM has been activated
Select this option to send an Email in case of alarm.

Forward Text Messages to email recipients

* Input messages (from radio network to dispatchers)
Select this option to forward incoming text messages to Email address(es).

= Output messages (from dispatchers to radio network)
Select this option to forward outgoing text messages to Email address(es).
Incoming Email settings tab

TRBOnet Server connects to POP3 server, reads emails and sends text messages to
radios or talk groups.

1. Create an email account on your email server.

2. Send an email to radioserver@yourcompany.com. In the Subject field, enter

Radio ID: XXX to send an email to a selected radio, or Group ID: XXX to send
an email to a selected radio group.

Note: If you don't properly specify the email Subject, or specified
a non-existing Radio ID, a corresponding notification will
appear in the Event Viewer of the Dispatch Console.

¢ Forward incoming emails to radio network (from email box to radios)
Select this option to forward incoming emails to radio network.

6.4.5.13 User Activity

The User Activity function allows the dispatcher to create lists of radios, to which
radios can be assigned due to their activity.
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For example, if a subscriber sends an On duty message or presses an exact preset
telemetry button, this subscriber gets assigned to the On duty list in the Dispatch
Console. The dispatcher can also manually assign subscribers to lists.

e To enable the User Activity task, click Tasks (1), and double-click User Activity
(2) in the Tasks pane:

File View Map Tools Help

Administration a & |
g o * | B ntercom (1@ WG 1 e free <l B Jscat <l
(1) Database P cow 10 [1][«][@] 8 ¥ Group 20 [)][<][@] | I Group 30 (][]
il Radio Systems
#51 System Bridging |
&p Teephony 1 S Add - 5 Ed Del
w Tasks/ =N 5 edit | Ek Delete
5% Virtual Modbus Devices o ffack e, iy
[ &l Agenda
/Y Voice Dispatch [] Gy Dispatcher Presence Control
[] 3% Export to SWD - Location of radio
% Location Tracking ¥l [ Geofending
vl {55 Ide Time:
&% s0bTicketing 4 G Lone Worker 1
vl [J Mesages 1 Messages for Period
Route Management [ "= Missed GPS data loading
- ¥l {5% Radio Alocation (Sprite Forms)
@ RFID Tracker vl & sMis and Email notifications
¥ {55 Timer
[ ] Text Hessages vl £ User Activity
¥l @ voice Message
ﬁ Voice Recording [ @) Voice Message
Event Viewer
2
P
4| 44| « | Record 120f 14 ¥ [m|m[ 4] »
127001 58 G| & Administrator | [ Licensed to: demo Demo License | @ nctive-
Lists of radios tab
User Activity x
Lists of radios  Advanced
Name Description
@ offbuty
@ onDuty
@ User Activity = 1
Add Edit Delete
Corce

e Click Add to add

a list of radio activities:
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User Activity List Settings X
General  Logical Groups
Name: [User activity = 1 |
Description:
Background: @ Violet bl Il

Move a radio to this list if:
Manually {on demand of dispatcher)
[ automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command:  |High level -
[] automatically by receiving DTMF command from subscriber

[ automatically by receive Status from subscriber

Cancel

¢ Name
Specify a name for the user activity list.

e Description
Add a description for the user activity list.

e Background
Select the background color to display the radios assigned to the list.

Move a radio to this list if:

e Manually by dispatcher
Select this option to assign radios to the list manually.

¢ Automatically by receiving Text Message from a radio
Select this option to assign a radio to the list after receiving a text message
from the radio. If you select this option, specify a brief text message in the
Message box.

e Automatically by receiving Telemetry Command from a radio
Select this option to assign a radio to the list after receiving a telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

¢ Automatically by receiving DTMF command from a radio
Select this option to assign a radio to the list after receiving a predefined
DTMF command, for instance, #11#. If you select this option, specify a DTMF
combination without the # characters in the Command box.

To assign offline radios to the default User Activity list, click the Advanced tab:
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e Automatically set the default status for offline radios

User Activity
Lists of radios  Advanced

Automatically set the default status for offine radios

Set the default status 10 3 minutes

Cancel

neocom
software

Select this option to allow assigning the default status for offline radios.

e Timeout

Specify the time period, in minutes, after which the default status is set to a

radio.

6.4.5.14 Voice Message

The Voice Message allows automatically broadcasting a predefined Voice Message

after receiving a telemetry command, a text message or a DTMF command.

e To add a Voice Message task, select Tasks (1), and click Add > Voice Message

File View Mep Tools Help
Administration a 8 |
3 server ~
R vicerse 3 mtercom [][«][@] B &2 1: Line free [«][@] B[ Jarcan ][« [e]
(0 Database PGow 10 [2)][«][@] I P Group 20 [)][+][@] |8 ¥ Group 30 [2][+][e]
il Radio Systems
Bt System Bricing [JFrivate call [2][«][@]
@;T&\Enh:r\v—-——_ 1 B Add|- b Edit | 5k Delete
v || %4 LoneWorker A
75 Export Data
() Scheduled Task
B o
& Agenda
17 Import Routes
) Scheduled Report \
@ Hotsos " 2
) Timer
%, Missed GPS datz loading
[3%, Sign-in notification
el <3 Timer
[ ] Text Messages ] % User Activity
vl @ voice Message
ﬁ Voice Recording ¥ @ Voice Message
Event Viewer
@ Administration
1]« « | Record 120f 14 » | m|m] <] »
@ 127001 £ ﬁ,\ € Administrator \ 4 Licensed to: demo Demo License \ @ Active-

The user can have several Voice Message policies for different purposes. Specify a

name of the policy in the Task name box and set the policy's parameters.
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Task Start tab

186

Woice Message x

Task name: Voice Message

TaskStart Task Process TaskStop Message Telemetry

Manually by dispatcher
[ Automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command: High level -

[ Automatically by receiving DTMF command from a radio
,7
Automatically by receiving Emergency from a radio
Emg. Type: |AII j
() Activated by any radio
(@ Activated by specific radios only
Radio: [125 (Pete), walt |

Send the following text message to the radio

Message: | |

Cancel

Manually by dispatcher
Select this option to allow the dispatcher to manually start the Voice Message
task.

Automatically by receiving Text Message from a radio

Select this option to start the Voice Message task after receiving a specified
text message from a radio. If you select this option, specify a brief text
message in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to start the Voice Message task after receiving a telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to start the Voice Message task after receiving a DTMF
command from a radio, for instance, #11#. If you select this option, specify a
DTMF combination without the # characters in the Command box.

Automatically by receiving Emergency from a radio
Select this option to start the Voice Message task after receiving an emergency
command from a radio.

= Emg. Type
From the drop-down list, select the type of emergency to be sent from a
radio.

Activated by any radio
Choose this option to expect receiving data from any radio in the system.

Activate by specific radios only
Choose this option to expect receiving data from selected radios.
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= Radio
In the drop-down list, select the radio(s).
¢ Send Text Message to a radio
Select this option so that a text message will be sent to the radio that activated
the Voice Message task. If you select this option, specify a brief text message
in the Message box.

Task Process tab

Woice Message X
Task name: Voice Message 1
Tack Start Task Process  Task Stop Message Telemetry
" Send voice message once
% Send voice message repeatable
Repeat Interval: &0 3: second(s)
¥ Repeat Count: 10 =
[ Impolite channel access
[ Delay on start: 1 =
Coce

¢ Send Voice Message once
Choose this option to send the voice message to a selected radio (s) only
once.

¢ Send Voice Message repeatedly
Choose this option to send the voice message repeatedly.

* Repeat Interval
Specify the repeat interval, in seconds.

= Repeat Count
Select this check box and specify the number of times to repeat the voice
message.

¢ Impolite channel access
Select this option so that the voice message will be sent regardless of whether
the channel is busy or not.

e Start delay
Select this check box and specify the delay time, in seconds, for the Voice
Message task.

Task Stop tab

Note: These options are available only if you have selected the Send
Voice Message repeatedly option in the Task Process tab.
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188

Woice Message x

Task name: Voice Message

Task Start Task Process TaskStop Message Telemetry

] Manually by dispatcher
[ Automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio
VIO: 1 < Command:

] Automatically by receiving DTMF command

e

[] send the following text message to the radio

Cancel

Manually by dispatcher
Select this option to allow the dispatcher to manually stop the Voice Message
task.

Automatically by receiving Text Message from a radio

Select this option to stop the Voice Message task after receiving a message
from a radio. If you select this option, specify a text message in the Message
box.

Automatically by receiving Telemetry Command from a radio

Select this option to stop the Voice Message task after receiving a telemetry
command from a radio: If you select this option, specify the VIO contact, and
from the Command drop-down list, select the signal level at which the user's
radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to stop the Voice Message task after receiving a DTMF
command from a radio, for instance, #11#. If you select this option, specify a
DTMF combination without the # characters in the Command box.

Send Text Message to a radio

Select this option so that a text message will be sent to the radio that stopped
the Voice Message task. If you select this option, specify a brief text message
in the Message box.
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Message tab

e Load from file

Woice Message x

Task name: Voice Message 1
Task Start Task Process TaskStop Message  Telemetry

|#| Load from file

.Q Record message

) playback messace

l Channel Call Target
Auto Detect 235
Group Call 5 Repeater #1: Slot ... Firemen
op Add ¢ Remove
Cancel

Click this link to load an existing file from your PC.

e Record Message
Click this link to record a new voice message.

¢ Play back message
Click this link to play back the voice message.

e Specify Call type, Channel, and Call Target for a voice message.

Note: To send a Voice Message to a subscriber from the phone
book click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

Telemetry tab

Task name: Voice Message 1 |

Task Start Task Process TaskStop Message Telemetry

Send Telemetry before starting task |

VIO: 1 +| command: ’m‘
Delay after send: 0 ¥ second(s)
Send Telemetry after stopping task
VIO: 1 +| command: ’W‘
Delay before send: 0 ¥ second(s)
Recipient: Selected Radios: 1; Selected Radio Groups: 2 j

[] send Telemetry on every Voice Message

Cancel
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¢ Send telemetry before starting task
Select this option to send a telemetry command before the voice message is
transmitted.

= Specify the VIO contact number.
= Select the signal level from the Command list.

= Delay after sending
Specify the time period, in seconds, to wait before sending the voice
message after the telemetry command has been sent.

¢ Send telemetry after stopping task
Select this option to send a telemetry command after the Voice Message task
is stopped.

= Specify the VIO contact number.
= Select the signal level from the Command list.

= Delay before sending
Specify the time period, in seconds, to wait before sending the telemetry
command after the voice message has been sent.

¢ Recipient
In the drop-down list, select the radios/groups to send the telemetry
command to.

¢ Send Telemetry on every Voice Message
Select this option to send the telemetry command to the selected
radios/groups every time the voice message is sent, provided the voice
message is repeatedly sent.

6.4.5.15 Scheduled Report

The Scheduled Report task allows reporting on selected parameters and sending
these reports to selected Email subscribers groups. The user can have several
Scheduled Report policies for different purposes.

Note: Before configuring the task, you need to create a number
of the Email groups to send reports to. For more details on
Email groups, see section 6.4.18, Email Groups (page 232).

e To add a Scheduled Report task, select Tasks (1), and click Add > Scheduled
Report (2):
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Administration a
g e * | N B ntercom ()@ G 1 e fiee T @EE
é‘ Database Group 10 Group 20 [+] Group 30
Radio Systems
i System Bridging [ JPrivate Call
& Telephony 1 = 5 )
# Add |+ =) Edit | [k Delete
& EXEEE
332 Virtual Modbus Devices v || 6 LeneWorker
5 Export Data
1=} Voice Dispatch () Scheduled Task
“ Voice Message dio
Location Tracking 4 Agenda

" Import Routes

& 3ob Ticketing IO scheduled Report
@ Hotsos d
Route Management L Timer

M ading
@nﬂnn—.ﬁ: 1%, Sign-
vl 3 Timer
[] Text Messages V] User Activity
vl @ Voice Messag
ﬁ e e ¥ @ voice Message
‘Event Viewer

gl Adeiistration | | «| Record 120f 14 _» [ |wi] «|

»

127001 &3 @, | § Administrator | [ Licen

sed to: demo Demo License

| @ Active~

e Specify a name of the policy in the Task name box and set the policy

parameters.

Scheduled Report

Task name: IMesages 1

Report  Scheduler
m System reports 2
U Registered Radios
U Urregistered Radios
-[F) GPs Status
D User Connection Histary
[F) system Bridging Activity
D Channel Change
n Common reports
.[T5) Messages for Period
-[F) State of Radios
U User Messages and Notes
U Radio Allocation
D Radio Disabling
D Telemetry
E Radio Users by Channel
U State of Radios Summary
U Lane Warker Activity
[T} CAN graphics
U CAM messages
D Job Ticketing

Select data by period:

Start Date:
End Date:

Filter:

Message Type:

Radio System:
Private From:
Radio Group:

Logical Group:

|15-0ct-2016 0:00

|<Maximum date>

Ll

j
4

. All Messages

I—Nat defined— d
I—Not defined— j
I—Not defined—- j
I—Nat defined— j

Radio ID {e.q. 22,33,40-55,88):

Find Text:

[ Print notes

-[F}) Change Job Status
U Job Ticket Assignments

[ Print coordinates
I show street names

-[F5) st Finished Routes

™ Bl Mavamant Mataile

Checlc

Server

0K

Cancsl

e On the Report tab, select the type of a report for the Scheduled Report task.

The report details and filter might be different.

For more details on reporting, see section 7.3.7, Reports (page 341).

e Click the Scheduler tab to configure a schedule for the report.

191



o

neocom
sofFtware

Task name: |Mesages 1 ‘

Report  Scheduler

Start date: |25 October 2016 ~|
Stop date: |27 October 2016 ~|
Days of week: |M0nday’,Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday j
Start time: 3:00 3:

Statistic period: | lil |HUurs j ‘
Email groups: Police dep

Check oK Cancsl

Start date and Stop date
Select the time period over which to generate reports and send them to email

group.

Note: The start date may be any date you choose to start the task
on. The stop date must be later or the same as the current
date.

Days of week
In the drop-down list, select the days of the week you want to generate
reports on.

Start time
Specify the time to start generating the report at.

Statistic period

Select the time interval (in minutes, hours, days, weeks, or months) to collect
the data.

Email groups

In the list, select Email groups to send the report to.

The created scheduled report will be displayed in the Tasks pane:
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g Er e 7 1: Line free [«l[@]
(1) Database Group 20 [][]
e e L)@
£ Telechony =L Add - =) Edit | [k Delete
@ Tasks
3% Virtual Modbus Devices v LeckHame, 2
& Agenda
1=} Voice Dispatch G Dispatcher Presence Control
55 Export to SWD - Location of radio
@ Location Tracking wl [ i Geofencing
Wl {3 Idle Time
W Job Ticketing vl G Lone Worker 1
Wl (2] Mesages 1_Messages for Period
Route Management wl 72, Missed GPS data loading
p | {3 Radio Alocation (Sprite Forms)
@ RFID Tracker wl (%] Scheduled Report 1_Messages for Period_26-Nov-2016 00:00:00
| 54 sMs and Email notifications
[] Text Messages Wl 5 Timer
Wl {5 User Activity
'& Voice Recording W @ Voice Message
- wl @ Voice Message
Event Viewer
EE] Radio Allocation
Fp—
4| < | Record 100f 15 ¥ [ i[ < »
[ 127001 & B | § Administrator | [ Licensed to: demo Demo License @ Active~

To enable the task, select the check box in front of the Scheduled Report task you
have already created.

There are three types of the Scheduled Report status icons:
e Green indicates an active task, meaning the task is enabled (checked).
e Grey indicates an inactive task, meaning the task is disabled (unchecked).
e Red indicates a disabled task, meaning the task period is up in the past.
6.4.5.16 HotSOS (Email)

The HotSOS (Email) task is used to automatically create and assign job tickets upon
receiving email messages at the address specified for the radio (Radio > Additional
> Email). In addition, you specify the email address at which to receive email
messages about changes to the created ticket status.

e Go to Administration, Tasks.
¢ In the Tasks pane, click Add > HotSOS (Email).

¢ In the dialog box, specify the following parameters:

HotS0S Configuration *
Name: [Hots05 |
Email: |test@gmail.ccm| |
Source: |Subject j

Status | Hots0s status |
New N

Cancelled Ca

Assigned Ass

Accepted Acc

Rejected R

Completed C

In Progress InP

Cancel

= Name
Enter a name for the task.
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Email

Enter the email address at which you want to receive notifications
concerning the status of the created tickets.

Source

From the drop-down list, select which part of the email message, Subject or
Body, will be included in the job ticket text.

HotSOS Status

Enter the text of the emails that will be sent as notifications upon changes

to the job ticket status.

6.4.5.17 HotSOS (Web Service)

The HotSOS (Web Service) task is used to create and assign job tickets by using the
HotSOS Web Service.

Go to Administration, Tasks.

e In the Tasks pane, click Add > HotSOS (Web Service).

¢ In the dialog box, specify the following parameters:

194

HotS0S Configuration x
Name: [Hetsos |
URL: |hﬂps /ffc int hot-sos net/api/service svc/soap |
Login: |Tesler 123 |
Password: | |
Frovider: [mMoTOTREO |
Paliing Interval: 151
Message LTEXTLEPRIORITY % %0ORDER_ID%

Fomat:
Text Prioity Hoom Mame Hoom Mumber Remark Order ID
Message 1D
Status | Hotsos status
New N 1=
Cancelled Ca
Assigned Ass
Accepted Acc —
Rejected R
ramnlatad r j
Cancel
Name
Enter a name for the task.

Enter the URL of the service.
Login and Password

Enter the login and password of the service account.

Provider

Enter the service provider name.

Polling Interval

Enter the interval, in seconds, to check the service for orders (job tickets).
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* Message Format
Select the fields of a message to include in the job ticket text.

*= HotSOS Status
Enter the text of the messages that will be sent as notifications to HotSOS
upon changes to the job ticket status.
6.4.5.18 Automatic Data Retrieval

The Automatic Data Retrieval task is used to automatically retrieve missing
location data from the radio's option board.

e Go to Administration, Tasks (1).
¢ In the Tasks pane, click Add > Automatic Data Retrieval (Swift GPS) (2).

File View Map Tools Help

: Pt
* |l t: ine free <[] Pl mtercom 2] Bl F veintenace Bl«le]
[ sales [l+] (@) I P Groue 10 DEE (W
[Jemercency Growe  [5)][+] (0] [ JReguer GeRooP (][] @] [ JGroun 20
Jacal DoE) (EEE D<@ B erow 22 [DE]
[orow ¢ D<@ [ Prvate cal B e

EAM igm\lnla

Radio Statuses
1. Location Profie v

(=) voice Dispatch

|22l Location Tracking

4% 30b Ticketing

e

R e

§ voice Recording 2
(2 Reports

SR
| @] 4| Record 1of 11 v |rr|mi[ <] .

@) Connected &3 B B | 8 Administretor | [ Licensed to: demo Demo License | @ Active-

¢ In the dialog box, specify the following parameters:

Automatic Data Retrieval (Swift GPS) *
Task name: ‘Momaﬁc Data Retrieval (Swit GPS)| |
General Radios
Maximum number of simultaneous requests: 3=
Data upload
Retrieve missing locations if the data gap exceeds: I 30 3: seconds
Do not retrieve missing locations older than: I 30 i’ Iminubes j
oK Cancsl

= Maximum number of simultaneous requests
Specify the maximum number of radios being requested at the same time.
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= Retrieve missing locations if the data gap exceeds
TRBOnet Server automatically checks whether the location data is
continuous. If it detects data gaps between any consecutive location data
that exceed this value, it will attempt to retrieve missing information.

= Don't retrieve missing locations older than
TRBOnet Server doesn't check location updates for consistency if they are
older than this value in seconds, minutes, or hours.

= On the Radios tab, specify the radio(s) to retrieve location data from.
In the list of tasks, activate the Automatic Data Retrieval (Swift GPS) task by
selecting the check box next to the task name.
6.4.5.19 Automatic Voice Download

The Automatic Voice Download task is used to automatically retrieve voice data
from the radio's option board when the radio is in WiFi zone.

e Go to Administration, Tasks.
¢ In the Tasks pane, click Add > Automatic Voice Download (Swift).

Automatic Voice Download (Swift) >
Mame: |Vaice Dowrload| |
General Radios
Maximum number of simuttaneous requests: 33:
Saveto: (e ‘
%RADIO_ID%NEYEARY_MONTHE_%DAY%_%HOURYNEMINUTES_%SECOND%

Year Morth Day Hour Minute Second Call Type Source Source Type
Source ID Recipient Recipient Type Recipient 1D

ci\Radio_112018_06_06_17132_57_xxx.tna

Carcsl

¢ In the dialog box, specify the following parameters:

* Maximum number of simultaneous requests
Specify the maximum number of simultaneously requested radios.

= Save to
Specify the path where to save voice data on your PC.

= On the Radios tab, specify the radio(s) to retrieve voice data from.

In the list of tasks, activate the Automatic Voice Download (Swift) task by
selecting the check box next to the task name.

6.4.6 Modbus TCP Connections

TRBOnet Server can receive and send data from/to Modbus hardware and interact
with Modbus data according to desired scenarios. There are two connection modes
between TRBOnet Server and Modbus hardware: Master and Slave.
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To connect TRBOnet Server to Modbus hardware:

File View Map Tools Help

neocom
software

Go to Administration (1), Modbus TCP Connections (2):

Administration odb & |
dgﬁ Radio Systems ~ ;
Bt System Bricging 5 3 1: Line free [«][@] B [ intercom
& Telephony [Jdisp 15 [@] B[ sbot 1
@ Tasks
= 5otz Fl«@l
rtual Modbus Devices v ,—?} Ad.z.i ::!? Edit | :?{ Delete
= 2 Namly | Mode IP Address Port Slave ID | Behavior
[v| ModBud] Master 192.168.77.10 502
(i) voice Dispatch vl ModBusz \Slave 502 1 Custom
% Location Tracking
& 30b Ticketing 3
g Route Management
%] Radio Allocation 1
2 i 1
4| 44| 4| Record 10F2 b | we[wm| 4] »

127007 & B & & ‘ € Admlmstrator‘ [R Licensed to: demo Demo License ‘ @ Active~

¢ In the Modbus pane, click Add (3).

Modbus Cenfiguration X

Modgus_Slave

Mode: Slave <
502

Name.

Port
Slave ID: 1

Custom <

Behavior:

Cancel

= From the Mode drop-down list, select the mode of connection.
¢ If the 'Slave' mode is selected, specify the Port of TRBOnet PC and the
Slave ID to assign to this PC.
Leave Behavior as Custom if this connection will be used for
Event/Alarm management.

If the 'Master' mode is selected, specify the Remote Address, Port, and
ID of the Modbus device, which in turn will be running in the Slave

mode.

Modbus Configuration

X

Name:

Mode:

Port
ID;

Remote Address: [10.10.168.20

ModBus_Master
Master h

502
1
[ Parallel Requesis

Cancel

v' Parallel Requests
Select this check box so that TRBOnet Server can send multiple

requests without waiting for responses from the Modbus device.
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6.4.7 Virtual Modbus Devices

Once you have created the appropriate TCP connection, you can add a Modbus
device:

e Go to Administration, Virtual Modbus Devices, and click Add.

Virtual Modbus Device X

Name. [Pect |

Desciption

Corfiguration:

Table:

1
0

1
0
0
0
0

Edit Filter

Cancel

In the Virtual Modbus Device dialog box, specify the following parameters:

= Name
Enter a name of the device.

= Description
Enter a description of the device.

= Configuration
From the drop-down list, select the slave connection you previously created
for the device (that is, TRBOnet Server running in the Slave mode).

* Table
From the drop-down list, select the appropriate MODBUS data type
('Discrete Inputs', 'Coils’, 'Input Registers’, or 'Holding Registers").
In the 'Address/Value' table, enter the appropriate register values.

6.4.8 IP Cameras
This section describes how to connect IP cameras to TRBOnet Dispatch Console.
Go to Administration, IP Cameras to manage IP cameras in the system.
¢ In the IP Cameras pane, click the Add button.
¢ In the IP Camera Configuration dialog box, specify the following parameters:
{;‘tj;//WDWD]DZZABBM/
Px;t:cn\ =
userﬂnzaﬁnn
e B —
Cance
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6.4.9

= Name
Enter a name for the camera.

= Description
Enter a description for the camera.

= URI
Enter the URI for the camera. Note the use of the RTSP:// prefix and port
number 554 (also note that some cameras may have been configured to
use a different port number other than 554).

= Protocol
From the drop-down list, select UDP.

=  Authorization

e User
Enter the user name for the authentication, if needed.

¢ Password
Enter the password for the authentication, if needed.

Event/Alarm Management

The Event/Alarm Management feature allows you to create rules for Alarms, Emails,
Notifications, Text Messages to radios, and other events. When a configured rule is
executed, the appropriate action(s) will start.

For example, an external application sends some text data, which contains the text
"alarm", to TRBOnet software. The text "Alarm" is configured as the rule to start
sending a predefined voice message (for example, "Alarm in Sector N") to selected
radios (for example, the group "firemen"). As a result, the group "firemen" are
notified about an emergency condition.

e Go to Administration (1), Event/Alarm Management (2) to configure
Event/Alarm Management:

File View Map Tools Help

Administration Event/Alarm Management [e[@]]
] server ~
ddl eeeeee [ intercom [21][<][@] &3 1: Line free o= mEE 2]+l
(1 Database Mcrow 10 paE B 2] I 8 croup 20 e
) Radio Systems
4 System Bridging 5 (Clervatecal— [[][@]]
B Telephony b Add b Edit ] Creste s Copy | Lk Delete
@ Tasks
3% Virtual Modbus Devices iam )

{5, Eventyalarm Management

{44 voice Dispatch

@ Location Tracking

# Job Ticketing

R‘-ltzﬂanﬂgﬂltnt

@ RFID Tracker

[] Text Messages

@ voice Recording

Event Viewer
@ Radio Allocation 1
Fove—— -
M« | 4 | Record20f2 » » |« »
[ 127.001 &y B | © Administrator | [ Licensed to: demo Demo License @ Active~

e Click Add (3) to add a new Event/Alarm Management rule.
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Note: The administrator can also create a copy of the existing
Event/Alarm Management rule. Select a rule in the list and
click the Create a Copy button. The system will create a
copy of the rule with the same configuration parameters.

= Name
Enter a name for the rule.

¢ On the Source tab (1), click Add (2) to add a new event source for the rule.

Event Source X

Event [alarm Reset I~
Alzrm

= | @ Activated by af Alam Reset
COM Port

¥ o O Activated by s

Delivery Confirmation
Dispatcher Presence Alarm

1 DTMF 3

Job Ticket Status
Modbus {master)
Modbus (slave)
PTT Event

Radio Allocation
Radio location data is outdated
Radio State
Radio Status
RFID Signal
Route Events
ScadaEvent

2 ScadaThreshold

SIP call
5MS
| Swift Commands
"] = System Events
Telemetry
e e

* Event
From the drop-down list (3), select the event type to set for the rule.

For a description of the event types, see TRBOnet Enterprise/PLUS Alarm
Management User Guide.

Note: Select the event you want to enable. In case no event is
selected, all configured events are disabled by default.

Event/Alarm Management X

Name: [Wew Event ]

Source | wiorking Hours | Location | Action

Name: Desaription
W TextMessage  Active Radios: Al; Text: ;
W comport Port: COMI; Text: alarm;

gar | | odem

oK Cancel

e Click the Working Hours tab to set the time at which the rule will be valid.

= All Time
Choose this option so that the rule will be valid all the time.

200 TRBOnet Enterprise — User Manual



neocom
TRBOnet Dispatch Console SsOftware

= Selected Time
Choose this option so that the rule will be valid on the selected days of the
week at the specified time.

e Select the days of the week and specify the working hours.

Click the Location tab to set the regions inside or outside of which the rule will
be valid.

When a region(s) is (are) selected, the events specified in the Source tab must
take place inside/outside the selected region to start the action(s).

Note: When COM Port and/or External Network Connection
are selected as the event source, the Location rule should
not be used.

Event/Alarm Management X

Name. [New Event
Working Hours || Location |[Action
[4] Enable

Radio Location: [Inside Regions El
egions

Select Al Clear All
==

= Enable
Select this option to apply All Regions/Selected Regions to the rule.

= Radio Location
From the drop-down list, select whether the rule will be valid
Inside Regions or Outside Regions.

= All Regions
Choose this option to apply the rule inside/outside all map regions.

= Selected Regions
Choose this option to apply the rule only inside/outside selected regions.

e Region
In the list, select the region(s).

Click the Action tab (1) to set actions for the rule.

In the Actions list, the administrator can add and configure the action types to
be started when the events configured and selected in the Source page are
triggered.

Click Add (2) to add an action:
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Name: New Event

[Souree | Action Type Beacon: Edit Properties =
- ®,
_HOLN Action
Souree | warcrg vours | bocstn Beacon: Edit Properties
/ " Camera n New Window
Name Description
& Emal Recpienty N gﬁzﬁmen Notification
Geofencing Rules 3
1 Job Ticket

Map Object: Create New
Map Object: Delete Existing
Map Object: Edit Properties
Modbus
Description: Phone Call Establishment
Radio: Lock
Radio: Private Call
Radio: Remate Monitor
Radio: Request Location
Radio: Set Alarm
Radio: SetLocation Profie
Radio: Set Logical Groups
RFID Signal: Emergency Contact
2 RFID Signal: Supervisor
Route

Scada

Send to External IP Data Source

SMS

Start Lone Worker
= =l Swift Command

- System Bridging

Telemetry
Text Message
Text to Speech

Voice Message

= Action Type
From the drop-down list (3), select the action type.

For a description of the action types, see TRBOnet Enterprise/PLUS Alarm
Management User Guide.

Note: After you configure the rule, enable it by selecting the
check box beside it. In case when no rule is selected, the
action will not be started.

File View Map Tools Help

Administration ent/Ala anageme &l

R ;f!&nse N (= [][«][@] 5 1: Line free <] ] [ Jarcar el
Prisi B o DEE) (/s ooE (VErE D]
) Radio Systems
g System Bridging []Private call DEE]
@;Fli,:hw =k Add (5} Edit =] Create a Copy | =k Delete
@ T
5% Virtual Modbus Devices Name n
[} Event/alarm Management v || C] New Event
Send DTMF
(1Y Voice Dispatch
% Location Tracking
& 30b Ticketing
Route Management
@ RFID Tracker
[ ] Text Messages
Q Voice Recording
Event Viewer
CRE
|« | <[ Record 202 » [w|m] <] .
127001 & B | @ Administrator | [28 Licensed to: dema Demo License | @ Active-

6.4.10 Telemetry
On the Telemetry page, you can configure settings for Telemetry.

6.4.10.1 Radio Groups Telemetry

This is a default telemetry profile that is used to send telemetry commands to radio
groups.

¢ Click Radio Groups Telemetry in the Administration pane.

¢ In the Telemetry configuration pane, click Edit.
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Administration eleme EEE ]
?, Tehoy * | N B ntercom ()@ G 1 e fiee [«
e virtual Modbus Devices Pl om0 moE CEIE plislel
[F8 EventyAlarm Management
(8] Swift Event Profies | [

1y Telemey
P ¥ et B
[ Telemetry =1 i
y Type:
U2 Voice Dispatch Radio Groups Telemetry
) ) / Digital Outputs
% " o G2 VIOL: VIOL: Highlevel (High level)
@ VIO2: VIOR: Highlevel (High level)
& 3ob Ticketing (® VIO3: VIO3: High level (High level)
@ VIOS: VIO High level (High level)

@ VIOS: VIOS: Highlevel (High level)

@ 'RFID Tracker

[] Text Messages

ﬁ Voice Recording

Event Viewer

. o

127001 &3 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~

Radio Groups Telemetry x
Telemetry Type: MOTOTREO
Profile Name: Radio Groups Telemetry
Digital Qutputs
juj Name Command
vio1 VIOL: High level Highlevel
vioz VIO2: High level High level
VIO3 VIO3: High level High level
Vo4 V104: High level Highlevel
vIos VI0S: High level Highlevel
Description
D VIO1 -
Name: |
Command: High level =l
Apply
3 add [SkRemove
G

= Click Add and specify ID (VIO), Name, and Command (signal level).

Note: For Radio Groups Telemetry only the Digital Outputs tab

is available.

6.4.10.2 Adding Telemetry Profile for Radios
e Go to Administration (1), Telemetry (2), and click Add (3):
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File View Map Tools Help

Administration eleme EEE ]
Teleph
? Tehoy * | N B ntercom ()@ G 1 e fiee T @EE Pl
3¢ Virtual Modbus Devices P crow 10 [=0][«][@] | B Group 20 [)][+][@] |8 ¥ Group 30 [2][«][e]
[F8 EventyAlarm Management
(8] swift Event Profiles [_]private Call [1][«][e]
cHEEE— 2 1
Add | =) Edit | Bk Delets
[ Radio Groups Telemetry E“_‘ 5 it | B Delete
[ Telemetrv =1 i
v Type:
U2 Voice Dispatch Auto refresh inputs: Disabled
@ on Tracks Digital Inputs
o 3 © VIOL: Telemetry VK1 (High level)
&, VIOZ: Telemetry VK2 (High level)
@ Job Ticketing (@) VIO3: Telemetry VK3 (High level)
(@ VIOS: Telemetry VK4 (High level)
@ VIOS: Telemetry VKS (High level)
Digital Outputs
@ o @ VIOS: VIOS: Low level (Low level)
RFID Tracker
[] Text Messages
ﬁ Voice Recording
‘Event Viewer
[15] Radio Allocation / 1
) ot -
127001 &3 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~
Telemetry Prafile X
Telemetry type:
Profile name:
Telemetry %2

Specify Telemetry Type for Radio groups:

MOTOTRBO - telemetry from Motorola radios.

Socintech Novox — telemetry from Novox devices connected to the
radio via COM port.

Swift Option Board - telemetry from the option board connected to
the radio.

Sprite — telemetry from Sprite devices.

Note: Sprite telemetry profile can be read but not written.

Profile name
Specify a name of the profile to display in the Dispatch Console.

Click OK.

Telemetry 21

Profie Mame:

Auto

RFID

Telemetry Type:  MOTOTREO

Telemetry #1

Common Digital Inputs  Digital Outputs

request input states

Requestinterval: 600 2 second

Trace digital inputs.
Trace analog inputs

[ Replace state event to VIO events

e
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Common tab

= Auto request input states

Select this option and in the Request interval box specify the time interval,
in seconds, to request input data.

= Trace digital inputs

Select this option to monitor digital input damages.
= Trace analog inputs

Select this option to monitor analog input damages.
= Replace state event to VIO events

Select this option to generate VIO ON/OFF event when the system
compares between the last and the current states of the VIO.

Note: Most of the policies are set to replace events, so it is
recommended to enable this option.

Digital Inputs tab

Telemetry 21

Telemetry Type:  MOTOTREO

Profie Mame: Telemetry #1

Common  Digital Inputs  pigital Qutputs

s} Name Event
vIo1 @ viot High level
Vo2 @ vio2 High level

[ Request location of subscriber Apply

ENY] kRemove

e Click Add to add a VIO (Virtual Input/Output) to the profile.

= ID
Select the VIO to set the parameters for.

= Name
Specify a name for the VIO to be displayed in the Dispatch Console.

= Event
Select the signal level of VIO events from the drop-down list. When an
event with the selected signal level occurs on the selected VIO, the
telemetry will be activated. The signal level must be the same in the radio's

codeplug and in Telemetry configuration in TRBOnet. It is a programmable

option that sets the pin's voltage level to High or Low in order to trigger a
selected functionality.

= Severity
Specify a severity level for the VIO event from the drop-down list.
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= Display as subscriber state
Select this option so that the radio will change its status after it sends the
telemetry command.

* Auto reset state
Select this option to automatically reset the telemetry VIO after the radio
sends the telemetry command.

* Request location of subscriber
Select this option to request a GPS position of the radio after it sends the
telemetry command.

= Click Apply to apply settings to selected inputs.

Digital Outputs tab

Telemetry 21 X

Telemetry Type:  MOTOTREO

Profile Name: Telemetry #1

Common  Digital Inputs  Digital Outputs

D Name Commane d
Vot VIO1: High level High level
vioz VI02: Low level Low level
Vo3 VIO3: High level High level
Vo4 V104 Toggle Toggle level

o 03 -
Name: [
Command: righ level -

Apply

cancel

e Click Add to add a VIO (Virtual Configured PIN) to the profile:
= ID
Select the VIO in the dropdown list to set its parameters;
= Name
Specify a name for the VIO to be displayed in the Dispatch Console.
= Command
Specify a signal level for the command to send to the selected VIO.

= Click Apply to apply settings to selected outputs.

6.4.11 Location Profile

206

The Location Profile feature allows configuring different profiles of location update
settings for built-in GPS receiver. Location Profile overrides default location trigger
configuration in Server settings. For example, fire emergency service has a number
of departments in a city and needs to monitor current position of radio subscribers
(firemen). The administrator can create a number of separate location profiles with
different location tracking settings for each department.

Note: The Location Profile feature is available for MOTOTRBO Generation
Il radios, firmware version 2.4 or later.

Go to Administration (1), Location Profile (2). You can see the default Location
Profile settings (3) in the Location Profile pane.
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File View Map Tools Help

Administration ocation Profile FIEE <

'igfn::':’“a”‘“ Frofies  ~ | Il es T Line free [<][@] I 3 tntercom P[2] BN E Meintenace Ple]
Radio Statuses P sales =[] disp 15 [][«][@] | # Group 10
Vobie CLON: Profie M Group 20 [9][«][@] All Call [0l (@] | ¥ Group 11
Tools 2 Group 22 [][<] [ private cal [1][<]
(@) Disabled Rados
[ || 5 Add 5 Edit | 5k Delete
Ifl_é‘h Voice Dispatch
Profile type: MOTOTRBO
2, Location Tracking Manage tigger manualy Yes
Channel type Nor-scheded (Regular GPS over Voice or Data Revert Channel)
W Job Ticketing Location prcrty: GPS
GPS data Lstitude. Longtude, Direction. Speed. Precision
Route Management {Beacon data 1Bescon: Maior, Minor
Fast GPS on Cannect Plus systems No
[ ] Text Hessages Feriodic T Interval 30.0 sec
(2 Reports
Event Viewer
1 3
[F— —
127001 &3 B B 8 Administrator | [8 Licensed to: deme Deme License | @ Active~

There is a default Location Profile that the administrator can use and edit.
The administrator can do the following:

1. Use default location profile.

2. Create a custom location profile: Add button.

3. Edit a profile: Edit button.

Note: In the default profile, the Name and Description cannot be
changed.

6.4.11.1 Adding a Location Profile
¢ In the Location Profile pane, click the Add button.

Location Profile X

profile type: MOTOTREC -
Profile name: HOACARED

FS 5000
Location Profile #4  |Extended device

e

= Profile type
Select the Profile type (MOTOTRBO, FS 500, or Extended device).

* Profile name
Enter a name of the profile.
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MName: [Location Profile #4|

¥ save GPs data to database

[ Manage trigger manualy

Channel type

Location priority: [Beacon

[Mon-scheduled (Regular GPS aver voice or Data Revert Channel)

¥ GPS data:

Leflel L] Le]

[ otitude, Longituce, Predsion, Direction, Speed

[~ Beacon data: ‘Majm Minor

1 =

[ Fast GPS on Connect Plus systems.
W Periodic trigger
Interval: 0.0 2] second

™ Distance trigger

[ Telemetry trigger

I Emergen
7 shos

Name
Specify a name for the location profile.

Description
Add a description for the location profile.

Save GPS data to database
Select this option so that GPS data is saved in TRBOnet database.

Manage trigger manually
Select this option so that GPS triggering will be started manually by the
dispatcher.

Channel type
From the drop-down list, select a radio channel for sending location data to
TRBOnet Server:

= Non-scheduled
This is a channel with regular GPS (Enhanced GPS not supported).

= Scheduled
This channel is available when the Enhanced GPS feature is configured in
the radio system.

= Non-scheduled with CSBK data
This channel allows using CSBK (Control Signaling Block) while decoding.

= Scheduled with CSBK data
This is a channel with Enhanced GPS, which allows using CSBK (Control
Signaling Block) while decoding.

Location Priority

This option is used when beacons are placed on the maps. If the radio having a
GPS fix enters the range of a beacon placed on the map, its location tracking
will be performed according to the selected priority.

= Beacon
Location tracking will be performed based only on the GPS coordinates of
the beacons placed on the map.
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= GPS
Location tracking will be performed based only on the GPS coordinates
received from the radio.

e GPS data
Select this option to enable the user to select what GPS readings to send to
TRBOnet Server. In the drop-down list, select which GPS data to include in a
packet.

¢ iBeacon data
Select this option to enable sending iBeacon data to TRBOnet Server. In the
drop-down list, select which iBeacon data to include in a packet:

= Major, Minor (included by default and cannot be disabled)

= UUID
iBeacon's Universally Unique Identifier

= TX Power, RSSI
The strength of the beacon's signal as seen on the receiving device.

¢ Number of iBeacons
Specify the number of the most recently detected iBeacons whose data will
be included in the data packet sent to TRBOnet.

e Periodic trigger
Select this option to set a periodic location trigger on a radio. The trigger is a
request to the radio to send its GPS and/or iBeacon data at the specified time
interval.

= Interval
Specify the location update interval, in seconds.

¢ Distance trigger
Select this option to allow receiving location updates by a distance:

= Distance
A radio will send location updates if the travelled distance exceeds a
specified distance from the last GPS point, in meters.

= Min. interval
A radio will send location updates no more than once within this time
interval, in seconds.

e Telemetry trigger
Select this option so that a radio will send GPS and/or iBeacon data upon
sending a Telemetry command.

e Emergency Trigger
Select this option so that a radio will send GPS and/or iBeacon data upon
entering the emergency mode.

= Show emergency mode for Radio when Emergency GPS message is
received
Select this option if you want a Dispatch Console operator to see the
emergency status of a radio that transmitted location data.
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e Click OK to save the location profile settings.
To apply Location Profile to a radio:

e Go to Administration (1), Radios (2), select the radio in the table, and click

Edit (3):
File View Map Tools Help
Administration Registered radio groups and radios 1)
2= 5Ms Groups ~
R, Users [@] B[ Jsroup 1 [_Jeroup 2 L
~i= Logical Groups epester of [P Repester =1: Sot [Jancal
) Radio Groups 2
@ Rados — v
tered
Al voice Dispatch Ak Add Group | =% Add MOTOTRBO Radio =) Add WAVE Radio = Add TRBOnet Mobile [Zb Edit
Callsign & Type Radio ID MDC / Sel-5... | SIP ID Radio Groups | Legical Goups | Description
@ GPS Positioning ® 125 MOTOTREQ... 125 0 2125 Firemen
@ 235 MOTOTRBO... 235 o 2235 Firemen
ﬁ‘ Job Ticketing
Route Management 3
Ql RFID Tracker
[] vext Messages
ﬁ Voice Recording
A=
Event Viewer
“5] Radio Allocation 1
. et 5
1|40 | ¢ | Record 1of2 b | m[m] ¢ »
[ 127001 & By B | 8 Administrator | [ Licensed to: demo Demo License @ Active-
Voice Dispatch 125 X
General | Logical Groups | Additional| TP Call| Cameras |
Callsign: 125 ]
Radio ID: 125 4| MDC ID: o
Rado Grovps: |l ~[+]
H [cteaners ~[+]
Use icon: |@ Fortable Raci vI+=]
Location Service
Location Profie: [Defauit) [~]+]
(Default)
g Location Profile #1
Telemetry Service
s
TLM Profie: (Default) e
Text Messages Service
1 Trna: Standard ~ he
Hide Advanced Settings

= (Click the General tab, and from the Location Profile list select the location
profile to use for the radio.

= Select/clear the Location Enabled check box to enable/disable the location
trigger.

Note: The Location Profile is only applicable when the 'Built-in
GPS receiver' or 'Extended device' (if any) is selected in the
Location Source.

6.4.12 Mobile Client Profile

The Mobile Client Profile feature allows configuring different location profiles that
can be applied to the Mobile Client app running on a smartphone. For information
on how to register a TRBOnet Mobile app, see section 6.4.23.2, Adding TRBOnet
Mobile.

e Go to Administration, Mobile Client Profile.
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You can see the default Mobile Client Profile settings in the Mobile Client
Profile pane.

6.4.12.1 Adding a Mobile Client Profile
¢ In the Mobile Client Profile pane, click the Add button.

¢ In the Mobile Client Profile dialog box, specify the following parameters:

Mebile Client Profile #1 X

Profile Name: Mobile Client Profile #1

Use GPS location

Trigger interval: 30 % seconds

Use Indoor location
Trigger interval: 30 2| seconds
Number of iBeacons: 1

iBeacons filter:

iBeacon UUID
a8934da6-4fa2-4298-8024-bcSh7 1252787

gpAdd 3 Delete # Clear

Cancel

= Use GPS location
Select this option to enable sending GPS data to TRBOnet Server.
e Trigger interval
Specify the time interval, in seconds, used to send GPS location data.
= Use Indoor location
Select this option to enable sending iBeacon data to TRBOnet Server.
e Trigger interval
Specify the time interval, in seconds, used to send iBeacon location data.
e Number of iBeacons
Specify the number of the most recently detected iBeacons whose data
will be included in the data packet sent to TRBOnet.

e iBeacons filter
Click the Add link and enter the UUID of the beacons that will be used
by the mobile client.

Note: If you don't specify the iBeacon UUID, the Mobile Client
app running on an iOS device won't detect any iBeacons.
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6.4.13 Tools
On the Tools page, you can find some useful tools.
6.4.13.1 Swift.Tracker Configuration Tool

Note: This tool is available only for TRBOnet Swift.Tracker v1.0

In general, a MOTOTRBO™ portable radio comes with a standard option board
factory-installed in the radio.

The Generic Option Board replaces this standard option board and newer radios (for
example, XPR 7550) are now manufactured with Generic Option Boards already
installed. Generic Option Boards can be flashed with custom firmware to provide
additional functionality: Man Down, No Movement, Crash Detect, Lone Worker and
event-driven GPS functionality.

The Event-driven GPS feature provides a method to collect GPS data more
frequently and to store and forward this GPS data by event. The feature also allows
collecting and storing GPS data while the radio is out of coverage, and, upon
request, provide the GPS data when the radio is back in coverage.

Go to Administration (1), Tools, Swift.Tracker Configuration Tool (2) to manage
Swift Tracker settings:

File View Map Tools Help

Administration Swift. Tracker Configuration Tool
- [ Telemetry 1 * | W 1: tne free B irtercom bl
2 P aical [][«][@]
M crow 20 P Group 11 [][+][@]
[Jprivate cal ][]
isal =L Add = Edit =k Delete | [[] Clone # Export <= Import
&% Dispatcher Groups Name Description Version
-2, Dispatchers || configuration 1 1
I\l Voice Dispateh \. 3
I% Location Tracking \
42 30b Ticketing 2
Route Management
[ | Text Messages
o —
[:2] radio Allocation 1
g, Administrats T
4|4 | 4 |Record 10f 1 #[w[m 4 13
127000 &8 By | 8 Administrator | [ Licensed to: demo @ Active -

Click Add (3) to add a configuration for Swift Tracker.

¢ Name
Specify a name for the configuration to apply to a radio or a group of radios.

e Description
Add a description for the configuration.

e Set Defaults
Click this button to enable default settings.
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e Import
Click this button to import the Swift Tracker configuration from a file (*.sfc).
e Export
Click this button to save the Swift Tracker configuration as a file (*.sfc) to the
PC.

On the General tab, set general settings for Swift Tracker:

Suift Configuration Toel - o X

Name: [configuration 1 |

Description: ‘ ‘

General | GPS Tracker Tasks

Modules
Enable GPS Tracker

i8]

Enable "Crash Detect”
Enable “Lone Worker"

oooo

General Report
Number of Retries. 3

Retry Delay (sec). 15

Radio Settings

Network Rado ID (CAI D) 13
Target Radio ID: 64250
Port 4004
Automatically Switch to Revert Channel:

Set Defaults Export Import Cancel

Modules

e Enable GPS Tracker
When the check box is selected, the GPS enabled radio will send its data to
TRBOnet Server according to its Generic Option Board (GOB) settings.

¢ Enable "No Movement”
Select to enable No Movement feature.

e Enable "Man Down"
Select to enable Man Down feature.

e Enable "Crash Detect"
Select to enable Crash Detect feature.

e Enable "Lone Worker"
Select to enable Lone Worker feature.

General Report

¢ Number of Retries
Specify the number of additional attempts to send GPS data to TRBOnet
Server if the initial transmission fails. If the channel is busy, as data transfer is a
high priority, then the Transmit Interrupt feature will automatically be enabled.

¢ Retry Delay
Select the time period between data transfer retries.
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Radio Settings

Network radio ID (CAI ID)

Select the TRBOnet Server ID. ID = 13 is the default ID to route packets to
TRBOnet Server. (An ID = 12 will route packets to a control station.)

Target Radio ID

Select the target Radio ID for data transfer. In the case of a direct connection
to the repeater, select the TRBOnet Server ID (TRBOnet Peer ID).

Port

Select the port number for data transfer.

Automatically Switch to Revert Channel
Select this option to automatically transfer data via the revert channel.

Note: If the radio does not have a revert channel, this option must
be disabled.

On the GPS Tracker tab, set GPS Tracker settings:

Swift Configuration Toel - [m] X

Name: [configuration 1 |

Description: ‘ ‘

General GPSTracker Tasks

GOB Data Storage

Save GPS data on passing distance every (m) 50
Adding Data to Report

Speed and Direction.
Add Dats to Report every {m) 250
Minimal Direction Angle () 14

Add Data To Report every fsec): 6000

Report Transmit Conditions

Report Period (sec) 120
Passed Distance is more than () 1000
Speed Exceeds km/h) 120

Stop/Ide Time is more than {sec) 300

set Defaults Export Import Cancel

GOB Data Storage

Save GPS data on passing distance every (m)
Specify the distance a radio will travel before it saves its GPS data to the
Generic Option Board's memory; the data is not added to the report.

Adding Data to Report

Speed and Direction
Select this option to add speed and direction information to the report.

Add Data to Report every (m)

Specify the distance a radio will travel before it adds its GPS data to the report.
The report will be sent to TRBOnet Server at the selected time (see the Report
Period option).
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Note: The distance traveled before adding data to the report
must exceed (greater than) the distance traveled before
saving the data to the GOB.

¢ Minimal Direction Angle
Select the minimum direction angle to add data to the report automatically (if
the radio reverses the direction, the current data will be added to the report
automatically, and the next data recording will be started).

e Add Data to Report every (sec.)
Specify the time period for the report. When the indicated time period is
passed, the radio adds data to the report.

Report Transmit Conditions

¢ Report period (sec.)
Select the time interval between the sending of GPS data to TRBOnet Server.

¢ Passed distance is more than (m)
specify the distance a radio will travel before it sends its GPS data report
type in the distance. When the indicated distance is passed the Option Board
sends the report.

Note: The distance traveled before adding data to the report
must exceed (greater than) the distance traveled before
saving the data to the GOB.

e Speed exceeds
Specify the maximum speed. If the current speed is greater than the specified
one, the radio will send data to TRBOnet Server.

e Stop/Idle Time is more than (sec.)
Select the stop/idle time. When the stop/idle time is greater than the indicated
one, the radio sends data to TRBOnet Server.

On the Tasks tab, set Man Down, No Movement, Lone Worker, and Crash Detect
settings:
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Suift Configuration Toel - o X
Name: |configuration 1 |
Description: ‘ ‘
General | GPSTracker Tasks

General

Activate the aceelerometer on the radio swiiching on

Disable alarm by button click. [m]

“Man Down"” Settings.

Activation Angle (% 60

Fre-Alam {1) Timeout sec): 0

Pre-Alam Tone (1) RingStyleTone 1 v

“No Movement” Settings

Vibration Threshoid (%) B

Fist Pre-Alam Timeout (sec). 0

First Pre-Alam Tone: Ring Style Tone 1 v

“Lone Worker" Settings

Timeout fsecl: 1800

Pre-Alam Tone RingStylsToned v

Second Pre-Alam Notification

Timeout fsec) 5

Pre-lam Tone TalkProhibi v

Volume Level Increase () 50

Pre-Alam Tone Duration (sec). 5

“Crash Detect” Seftings

Crash Threshold (g): 8

Movement Stop Timeout (sec). 0

No Movemert Timsout (sec). B

Emergency Call

TRBOnet Emergency tmeout (sac) 0

MOTOTRBO Emergency timeout fsec) 0

Sound notification after emergency call

Timeout isec): 0

Tone RingStyleTone4 v
set Defaults Export Import Cancel

e Activate the accelerometer on the radio switching on
Select this option so that the accelerometer is enabled when the radio is
turned on.

e Disable alarm by button click
Select this option to enable the radio to turn off the alarm notification by
pressing any button on the radio.

"Man Down" Settings

¢ Activation angle - select activation angle to enable Man Down feature;

e Pre-Alarm (1) Timeout (sec.) - select time period preceding pre-alarm Tone
1;

e Pre-Alarm tone (1) - select pre-alarm tone. All pre-alarm tones can be found
in radio’s codeplug configuration.

"No Movement" Settings

¢ Vibration Threshold (%) - select max. vibration threshold for No Movement
feature;

e Pre-Alarm Timeout (sec.) - select time period preceding pre-alarm Tone 1;

¢ Pre-Alarm tone - select pre-alarm tone. All pre-alarm tones can be found in
radio’s codeplug configuration.
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"Lone Worker" Settings

e Timeout (sec.) - select time period to enable Lone Worker alarm;

e Pre-alarm tone - select pre-alarm tone. All pre-alarm tones can be found in
radio’s codeplug configuration;

Second Pre-Alarm Notification

When pre-alarm tone (1) activates for Man Down, No Movement and Lone
Worker, and there was no user’s activity (the radio remains unchanged), the second
pre-alarm tone activates:

e Timeout (sec.) - select time period preceding pre-alarm Tone 2;

¢ Pre-Alarm tone - select pre-alarm tone. All pre-alarm tones can be found in
radio’s codeplug configuration;

¢ Volume Level Increase (%) - select the percentage of the Volume Level
Increase for pre-alarm Tone 2;

e Pre-Alarm Duration (sec.) - select pre-alarm Tone 2 duration.

"Crash Detect" Settings

¢ Crash Threshold (g) - select acceleration changing value to enable Crash
Detect alarm notification;

¢ Movement Stop Timeout — select the time period of movement stop to
enable Crash Detect alarm notification;

¢ No Movement Timeout - select the time period of the radio without any
movement to enable Crash Detect alarm notification;

Emergency call

e TRBOnet Emergency Timeout (sec.) - select time period preceding

emergency tone to the Dispatch Console for Man Down, No Movement and
Lone Worker options;

e MOTOTRBO Emergency timeout (sec.) - select time period preceding
emergency tone to the Dispatch Console.

Note: MOTOTRBO Emergency Alarm should be set in radio’s
codeplug.

Sound notification after emergency call

e Timeout (sec.) — select time period to repeat the alarm notification. To stop
the alarm notification Dispatcher should disable alarm notification;

e Tone - select the notification tone. All tones can be found in radio’s codeplug
configuration.
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6.4.13.2 Templates for Extended Messages

The Templates can be used for Extended Messages and Extended Notes.

The Extended Messages feature is a special function allowing users to send detailed
preconfigured templates containing necessary information to each other with the
help of the special TRBOnet Dispatch Console application.

This service has been created especially for clients who need to use more detailed
and structured messages in their work. If the standard messages are not enough to
contain all required information, you may use the Extended Messages service.

e Go to Administration (1), Templates (2) to create a new template:

File View Map Tools Help

Administration
(&) Swift Event Profiles ~
[ Telemetry

HEE
[Jancan [][«][e]

[y Radio Statuses
GPs Profile
] % Tooks 2
] Tempiates
43} Indoor 2D Map Converter
S\ Disabled Radios

[JPrivate Call

=l Add From File | = Add =} Edit []] Save ToFile | =k Delete
Preview Name

<

J)) Voice Dispatch
New Form

g Location Tracking

& sobTicketing
Route Management
@ RFID Tracker

[] Text Messages

'& Voice Recording
Event Viewer

e ]

/1

o) 4|+ |Record 10f 1 » [w[mm] «

Group 30 [-0][=]

127001 &9 By | & Administrator | [28 Licensed to: demo Demo License

@ Active -

e Click Add From File (3) to add a template from a file.

template to a custom directory.

e Click Add (4) to create a new template:

Note: Before adding a template from a file, save the created

Select the directory where you saved the template and click OK to add the file.

218

Add/Edit Template - o X
i"i"‘b:"“: Template ID: | 754e575-d966-48c(-add 7-67%F1 091920 | []
e
labi Textbae New Fomn o]
[] CheckBox (3]
== ComboBox o
(DataBindings) ~
AccessibleDescrption
Drag selected AccessibleName
CaEa Accessbleole Defautt
AlowDrop False
Template size: [ Gea fucher ot
E i Appearance Nomal
U LS AutoChedk T
Heght: 500 1= AutoElipsis False
: 3 AtoSize True
BackColor [ ControlLightLight
B || Beckguundinage [ frone)
BackgoundimageLayout  Tie
CausesValidation Tue
CheckAign MiddeLeft
Checked False
CheckState Unchecked
ContextMenuStip (none)
Cursor Def:
Dock None
Enabled Tue
FlatAppearance
FatSvle Standard ¥
Checked
Indicates whether the component i in the checked state
oK Cancel
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= Name (1)
Specify a name for the template to display in the Dispatch Console (1).
= Elements (2)

Select elements to add to the template. Drag and drop the selected
element to the desired place on the mail template box.

= Template size (3)
Specify the template dimensions and background color.

= Click an element on the template. On the right side of the Template dialog
box, you can see the selected element properties.

For directions on how to send an extended message to a radio, see section 6.9.2.1,
Send Extended Text Message to a Radio.

6.4.13.3 Indoor 2D Map Converter

TRBOnet Dispatch Console provides the Map Converter to use custom images as
Indoor 2D Floor plans. The tool allows converting images to the BMAP format that is
supported in Indoor Positioning.

e Click Administration (1), Tools > Indoor 2D Map Converter (2).

File View Map Tools Help

Administration Indoor 2D Map Converter €]
A

3 intercom : Line free e (mEED [« [e]
o MGy Mcow 3 <l

[JPrivate call [2][«][@]

-1

P -

[ 127001 &8 B | § Administrator | [ Licensed to: demo Demo License @ Active -

¢ Name
Specify a name for the new Indoor 2D Map.

¢ Image
Click the ellipsis (...) button and locate the image file (PNG, JPG, TIFF, GIS) on
your computer.

e Directory
Click the ellipsis (...) button and locate the folder where to save the converted
Indoor 2D map on your computer.

o Click Start to convert the image.
To use the converted map

e Click Location Tracking (1). On the Map menu, click Open New Map in Tab
(2):
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File View [Map | Tools Help

S| —
= Save Online Map Data...
i B P EE
[E0 | o @) B ntercom pEE B Pl
ST Do) (EXEENTD) (TSN (ers—
g pA Ceocoding.. D[+ @] B B Privete cal Pl (G seer
B O pen New Map in Tab... W@ Coffee
® e ol — [ Floor plan_ x] D@ rea
- en New Map in Window- = =
5 [ Poily e G - Fiter | @[ D] D] @] 7 [@] show Beacons: a1 ~ [# DrawingPand] % &1 Vep Gbjects
W1 [®] camera 1
i ] | 29| Custom Object~
_||@d Delete Route on Google Earth N ARt B ‘ o s » (][] Hospital
U voice Z z [ poice
Show Radios on Google Earth » 2 2 4
£} 71 [ Map Regions
[ — ey | T
Camera 1SV g1 1 ap Routes
ﬁ Job Ticketing @3 111
Route Management
@ RFID Tracker
1
Text Messages
= A
ﬁ _ Recent Calls/Events ™= |
[ Playback [l Save- (D Print | 11 Pause < Clear - i Reload | ‘[ Filter By Radio | = Grouping "\/ Auto Fiter (> Defautt Settings ’j‘
@ Reports Date Radio System Sender Recpient Message Details
3% 09.06.2017 14:43:57 Server Al Connection to 'Capadity Plus 1'h... i‘
Event Viewer 09.06.201712:43:30  CapadtyPlus1  Administrator bts Dispatcher ‘Administrator' calls gr... Members: Administrator, 125
5 09.06.2017 12:40:06  Capacity Plus 1 125 1 Radio 125 calls group '11 (00:08)  Members: 125
EEI - 09.06.2017 12:39:55 Capadity Plus 1 Administr ator 11 lls or... Members: Administrator
4 09.06.2017 12:38:34 Capadity Plus 1 Administr ator Police lsqr... Members: Administrator A
14| 4| Record 10305 b [m[m[« »
——
IE Recent Calls/Events  RecentCalls  RequestToTak Radio State  ActiveTasks  Active Routes User Activity Beacons BeaconEvents  Taglist
617001 g3 B | @ Administrator | [ Licensed to: demo | @ active~
Select Map... X
Map Type: Beacon2D ~
Caption: | |

Available Maps

Name Path State
Floorplan 1 D:\Images'\Bmaps‘Floorplan 1.bmap O

Add Edit Remove Cancel

e From the Map Type list box, select '‘Beacon 2D'.

e Click Add to and browse for the map you have converted.

e Click OK to open the Indoor map in the Map pane.
6.4.14 Schedulers

The dispatcher can create pre-defined schedules to be used as event sources in
Event/Alarm management, for database backup, and in job ticket templates.
¢ Go to Administration (1), Schedulers (2).

¢ In the Schedulers pane, click Add (3).

220 TRBOnet Enterprise — User Manual



TRBOnet Dispatch Console

File View Map Tools Help

/®

Administration d &)
E poer d ereee </l B Jintercom [ ]1%] IR B ventenace «lel
Efy Telemetry [ seles [2)][«][@] N B &roup 10 [][«][@] B[ ]dsp [][«][e]
[ Radio Statuses
(PRI " PRI r
[ Location Profile [ ] Scheduler = = S X bl
L bk et rofle [Joroup 20 [][«][e]
-4 Tools
3 T aer ] Name: |Database backup Pl
2 Disabled Radios—— 2 T Jreg [ Recrenceattem
= D\spaodver Groups & =
58 Copetchr |3 ade B 8 Days of Week 10:00 3,
=  Monthly [V Monday | Tuesday | Wednesday
E‘Eﬁ T Fm o | ¢ One Time ’|:rnursdav [V Friday I saturday | Tuesday
~ Sunday
Periodically
@ Location Tracking
3
&% s0b Ticketing
Route Management
[ Recurrence Range
[] Text Messages Start: S/21/2018 1200AM ¥,
Stop: <Maximum Date > hd
G Voice Recording
() Reports Caneel
[75] Radio Allocation 1
e
el oo
[ Connected @3 B B B B | | Administrstor | [ Licensed to: demo Demo License | @ Active~

In the Scheduler dialog box, specify the following parameters:

= Name

Enter a name of the scheduler.

Recurrence Pattern

Choose one of the recurrence patterns for the scheduler:

= Days of Week

Specify the time and select the day(s) of the week.

= Monthly

Specify one of the following options:

¢ Specific Day

neocom
software

Specify the ordinal day of the month (in the range 1-31, or select Last).

e Day of Week

Specify the week number in a month (in the range 1-4, or Last) and

select the day of the week.

= One time
Specify the date and time.

= Periodically

Specify the time interval, the repetition period (in seconds/minutes/hours),
and select the day(s) of the week.

Recurrence Range

= Start
Specify the start date/time.

= Stop
Specify the stop date/time.
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6.4.15 Disabled Radios

TRBOnet Dispatch Console provides the Disable function that allows disabling a
radio even when the radio is offline. The system will disable an offline radio as soon
as it gets available.

Note: The dispatcher can disable a radio when they have relevant
Access Rights (for more details on adding and editing
dispatchers, see section 6.4.17, Dispatchers on page 226).

¢ Go to Administration (1), Disabled Radios (2) to disable selected radio:

abled Radio &)
. - M mtercom [1][<][@] B & 1: Line free @ (mEED [+1[@]
LCf) Radio Statuses P crou 10 [2][«][@] ¥ P croup 20 [=0][][@] 88 ¥ Groun 30 [][«][@]

(5 &P Profile

4 Todls [ ]Private Call [2][«][@]
(4} Disabled Radio: a o N
2 Depatcher Gr:u:\ ) DisableRadio " Enable Radio | 1 KillRadio

& pispatehers 2 Radio A Disable date Reason
Emai Groups & 125 21-Nov-2016 12:30
5 238 21-Nov-2016 12:30

<

A1, Voice Dispatch

@mermhu

@ Job Ticketing
Route Management
@ RFID Tracker

[] Text Messages

* 4] Radio Allocation 1
/

04| 40| 4| Record 20F2 ¢ [m|mi| 4] »

@Mn—-ﬂm' i r

127001 &3 B | @ Administrotor | [ Licensed to: demo Demo License | @ active~

e C(lick Disable Radio (3) and in the dialog box that appears:

Lock *
% Disable Radio
Radio: |@ 235 (Basil) 235 |
Unlodk: INo auto unlodking j
Reason:
Tesﬂ
Concel
= Radio
Select a radio from the drop-down list.
= Unlock

Select the time period after which the radio will be unlocked.

= Reason
Enter the reason for disabling the radio.

= (Click OK to disable the radio.
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Message 1 of 3 X
235
Repester #1; Slot #£1
Disabling
The command has been executed. 01-Nov-2016 17:48

Radio has been disabled

[] Do not show this message next time Show on map
Request Location

The Radio is added to the Disabled Radios list and is marked as Disabled in the
Voice Dispatch pane:

EBl=t & 7 03

=] & Online Dispatchers (1)
R Administrator
=] |_U Firemen .

(€] 175 (Pete) 125 B8
(#:57 235 (Basil) 235

IS

|}, Police =]~

e (lick Enable Radio (4) to enable selected radio.
e Select a radio from the drop-down list and specify the reason to enable.
e Click OK to enable the radio.

6.4.15.1 Kill Radio

The Kill Radio feature is available only when a Capacity Max system is used.

Note: This operation is not reversible. If you kill a radio unit, it will be
impossible to recover it.

6.4.16 Dispatcher Groups

The administrator can add, edit, and delete dispatcher groups in the system.

Go to Administration (1), Dispatcher Groups (2) to work with dispatcher groups:

File View Map Tools Help

Administration Registered Dispatche &)
Radio Statuses -~
% Rado st % 1 Line ree (<] I Bintercon Fille]
4, Took 3 i call [][=[@] B Ecroup 20 [@] [][<][]
{5} Disabled Radios
|8, Dispatcher Groups Pcouwp 22 [[«[@] I Bdrrivate cal [[<][@] B F maintenace [«][e]
i D\sDEtﬂ‘\ers\ 2 - Ml sales [DEE[E]
A, voice bi (5% Add| ) Edit | =k Delete | = Grouping 7 Auto Filter (&> Default Settings
Name & Radio ID SIP ID Desaription
Maintenace 60400 60400
% Location Tracking
Sales 60500 60500
@ Job Ticketing
Route Management 3
@ RFID Tracker
[] Text Messages
g voice Recording
Event Viewer
EEI Radio Allocation 1
"
o
|| < |Record 10f2 ¥ ||| 4] »
127001 &3 B | @ Administrotor | [ Licensed to: demo | @ active~
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e Click Add (3) to add a dispatcher group.

Dispatcher Group X

General  Call Group RequestTo Talk

MName: |Maintenace

Description: |

Cancel

On the General tab, specify general parameters for the new dispatcher group.

e Display Name
Specify a name for the dispatcher group to display in the Dispatch Console.

e Description
Add a description for the dispatcher group.

On the Call Group tab, specify the following parameters:

Dispatcher Group %
General Call Group  RequestTo Tak
Radio ID: 50400
Phone Call
SIP ID: [so<00 |
SIP Mame: |Maintenance |
Password: | ““““ il |
Cancel
e Radio ID
Specify the Radio ID of the dispatcher group.
Phone Call
e SIPID

Enter the SIP ID that will be used by the dispatcher group.
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e SIP Name
Enter the SIP user name that will be used by the dispatcher group.

e Password
Enter the password for the dispatcher group to be authenticated by the
telephone system.

On the Request to Talk tab, specify the parameters that will be used by radios to
request a call from the dispatcher group:

Dispatcher Group X
General Call Group RequestTo Talk

Automatically by receiving Text Message from a radio
Message: 60400 |

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command: Any event -
Automatically by receiving DTMF command from a radio
Command:  |50400| #60400%

[ automatically by receiving Status from a radio

Cancel

¢ Automatically by receiving Text Message from a radio
Select this option to request a call from the dispatcher group when a radio
sends a predefined text message. If you select this option, specify a brief text
message in the Message box.

e Automatically by receiving Telemetry Command from a radio
Select this option to request a call from the dispatcher group when a radio
sends a predefined telemetry command. If you select this option, specify the
VIO contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

¢ Automatically by receiving DTMF command from a radio
Select this option to request a call from the dispatcher group when a radio
sends the specified DTMF tones. If you select this option, specify a DTMF
combination without the # characters in the Command box.

e Automatically by receiving Status from a radio
Select this option to request a call from the dispatcher group when a radio
sends the specified Status to TRBOnet Server, for instance, 1. If you select this
option, specify the Status.

Once you have added the dispatcher group to the system, the appropriate PTT box
will appear in the Radio Interface pane.
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6.4.17 Dispatchers

226

The administrator can add, edit, and delete dispatchers in the system.

Go to Administration (1), Dispatchers (2) to work with dispatchers:

File View Map Tools Help

Administration Registered Dispatchers §]
18} Indoor 2D Map Convert a
© schedulers
[ JReguiar GGROUP
2 Dispat s
i
Email smuns‘\
= S Groups
is Roles
Logical Groups 5 Add|-| = Edit | X Delete | = Grouping " Auto Filter @ Defoult Settings
M

< 5 || username 2Role Display Name Radio D P Desaription

A Disp 1 Dispatcher Dispatcher 1 60100 50100
L) voice Dispatch T Disn2 Dispatcher Dispatcher 2 50200 50200

R wan Dispatcher ivan 25
Ig Location Tracking
4 30b Ticketing 3
Route Management
[] Text Messages
A
FRr———

1] | < |Record 10F3 ¥ [ w[wm] ¢ v
[ Connected &3 B B b T € | @ Administrator | [ Licensed to: demo Demo License | @ active-

e Click Add (3) to add a dispatcher.

Dispatcher X

General Dispatcher Rights Radio Systems Radio Groups  Dispatcher Grou| * | *

Authentication: TRECnet Authentication ~
User Name: |Dispau:her 1 |
Password : | ““““ |
Repeat password: | ““““ |
Display Name: |Dispau:her 1 |
Description:

Dispatcher Role: Dispatcher j

[ 1nvisible to all other users
[ 1nvisible to &l except the assigned aroups

[ Allow multiple simultaneous logons

Carcel

¢ On the General tab, specify general parameters for the new dispatcher.

= Authentication
Select the Authentication method from the drop-down list.
Select TRBOnet Authentication to log on as a user registered in TRBOnet
Dispatch Console users list.
Select Windows Authentication to log on using the PC name. The system
automatically shows the PC name as User Name.

Note: The password is not required when Windows
Authentication is used.
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Note: For more details on user access to Allocation Console,
section see section 6.4.20, Users (page 234).

= User Name
Specify a user name for the dispatcher registered in TRBOnet Dispatch
Software users list.

= Password
Specify a password for the dispatcher.

e Display Name
Specify a name for the dispatcher to display in the Dispatch Console.

e Description
Add a description for the dispatcher.

e Dispatcher Role
Form the drop-down list, select the role of the dispatcher in the system
(Administrator or Dispatcher).

Note: In addition to the Administrator and Dispatcher roles, you
can also create custom dispatcher roles. For this, in the
Dispatchers pane, click the Roles tab, and then click Add.

¢ Invisible to all other users
Select this option to make the dispatcher invisible to other users.

¢ Invisible to all except the assigned groups
Select this option to make the dispatcher invisible to other users except for
users belonging to the same group of dispatchers.

e Allow multiple simultaneous logons
Select this option to allow the dispatcher to use multiple instances of Dispatch
Console simultaneously.

On the Dispatcher Rights tab, select the available modules and specify the available
access rights for the dispatcher.

Dispatcher X

General Dispatcher Rights Radio Systems Radio Groups  Dispatcher Grou 4 | *

Available Modules: |(AII Modes) j &
Voice Dispatch Functionality
Use the Voice Dispatch module
Intercom calls
Telephone calls via the SIP 2.0 phone interconnect
Initialize Private calls
Play back the recorded voice communications
[ view all other voice calls in addition to assigned groups
Change control station channels
Configure audio
Tone and PTT
Save and export recorded voice communications
View System Bridge/Patch
Enable /dizable System Bridge/Patch
[] Enable/disable encryption
Allow Call Preemption Mode for: a0 24 minutes
Application

Customize user interface w

Cancel
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On the Radio Systems tab, specify the radio system(s) that will be available for the
dispatcher.

Dispatcher X
General Dispatcher Rights Radio Systems  Radio Groups  Logical Groups |4 | *

(O Al Radio Systems available
(® Only selected Radio Systems avallable

Radio System X
Bl Contral Station #1

[ |Repeater #1: Slot #1 v
¥ |Repeater #1: Slot #2 W

Chedk Al Uncheck Al

Cancel

¢ All Radio Systems are available
Choose this option to make all radio systems available for the dispatcher to
transmit and receive Voice and Data.

e Only selected Radio Systems are available
Choose this option and specify which radio systems will be available to the
dispatcher.

= Select the check box in the left column to add the corresponding radio
system to the Radio Interface for the dispatcher.

= Select the check box in the TX column to allow the dispatcher to make
Voice calls using the corresponding radio system. When the check box is
cleared in the TX column, the dispatcher cannot use the corresponding
radio system to transmit voice and data.

On the Radio Groups tab, specify the radio groups that will be available for the
dispatcher.
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Dispatcher X
General Dispatcher Rights Radio Systems Radio Groups  ogical Groups |4 | *

() All groups are avalable
(® Only selected groups are avaiable

All call

Firemen

Weoie

Chedk Al Uncheck Al

Cancel

¢ All groups are available
Choose this option to make all groups in the system available for the
dispatcher.

e Only selected groups are available

Choose this option and specify which radio groups will be available to the
dispatcher.

= In the list, select the groups to make them available for the dispatcher.

On the Logical Groups tab, select the logical groups that will be available for the
dispatcher.

Dispatcher X
Radio Systems Radio Groups  Dispatcher Groups  Logical Groups  Dispatch| * | *

() All groups are avalable

(® Only selected groups are available

Name Desdription
=H E—ﬂ Cleaning
by EI] Cleaning 1 Cleaning in Department 1
L *ri,] Cleaning 2
= ﬂﬂ Security Groups for Security
|t ﬁﬂ Security 1
E o ‘ﬁl] Security 2

Select Al Deselect All

Carcel

On the Dispatcher Groups tab, select the dispatcher group(s) the dispatcher will
belong to:
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Dispatcher X

Dispatcher Rights Radio Systems Radio Groups Dispatcher Groups [ ogic| 4 | *

() All groups are avalable

(® Only selected groups are avaiable

Group 1B
Maintenace

v | Sales v

Chedk Al Uncheck Al

Cancel

On the Dispatch Call tab, specify Dispatch Call and SIP call settings for the
dispatcher:

Dispatcher X
Radio Groups  Logical Groups  Dispatch Call  Request to Talk  Reports

Radio ID: 60100 3:

Phone Number: | 123-4567 |

Email: |bi||y @gmail.com |
Phone Call
SIP ID: |s0100 |
SIP User: |s0100 |
Password: |oo|ooolooo |
SIP Profile: | v |

Cancel

e RadioID
Specify the Radio ID of the dispatcher.

¢ Phone number
Specify the dispatcher's phone number (additional data).

e Email
Specify the dispatcher's Email (additional data).

Phone Call

e SIPID
Enter the SIP ID that will be used by the dispatcher.

e SIP Name
Enter the SIP user name that will be used by the dispatcher.
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e Password
Enter the password for the dispatcher to be authenticated by the telephone
system.

e SIP Profile
From the drop-down list, select the SIP profile to use.

On the Request to Talk tab, specify the parameters that will be used by radios to
request a call from the dispatcher:

Dispatcher X
Radio Groups  Logical Groups  Dispatch Call  Request to Talk  Reports i I

Automatically by receiving Text Message from a radio

Message: 60100 |

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command: High level -
Automatically by receiving DTMF command from a radio
Command: 60100 #60100%

[ automatically by receiving Status from a radio

Cancel

¢ Automatically by receiving Text Message from a radio
Select this option to request a call from the dispatcher when a radio sends a
predefined text message. If you select this option, specify a brief text message
in the Message box.

e Automatically by receiving Telemetry Command from a radio
Select this option to request a call from the dispatcher when a radio sends a
predefined telemetry command. If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

¢ Automatically by receiving DTMF command from a radio
Select this option to request a call from the dispatcher when a radio sends the
specified DTMF tones. If you select this option, specify a DTMF combination
without the # characters in the Command box.

e Automatically by receiving Status from a radio
Select this option to request a call from the dispatcher when a radio sends the
specified Status to TRBOnet Server, for instance, 1. If you select this option,
specify the Status.

On the Reports tab, specify the reports that will be available to the dispatcher.
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Dispatcher
Radio Groups  Logical Groups  Dispatch Call Request to Talk Reports

() all reports are available
(® Only selected reports are avalable

4

X

3

g.. Queries

| B Lost Devices
E System reports

ED
] ‘D Unregistered Radios
-4 ) 6Ps status
-] D User Connection History
‘D System Bridging Activity
.7 [} Channel Change
E Common reports
. ] ) Messages for Period
] D State of Radios

|:| B User Messages and Motes
-] D Radio Allocation
-.[ ] ) Radio Disabling
] B Telemetry &7

Chedk Al Uncheck Al

¢ All reports are available

Choose this option so that all the reports will be available to the dispatcher.

e Only selected reports are available

6.4.18 Email Groups

Email Groups are used in Event/Alarm Management and Job Tickets configuration to

Choose this option and in the list below select/unselect the reports to
include/exclude.

send emails to dedicated recipient groups.

Go to Administration (1), Email Groups (2) to add/edit/delete email groups in the
system:

File View Map Tools Help

Administration

Telemetry ~
e Sttses B reren (o[ o] G i Lre ree OE) W
() epsprofile Mcow 10 [][«][@] ¥ M Group 20 [-0][«][@] 88 ¥ Group 30
N
W Tools
(5) Disabled Radios [Jerivate cal [)][«]
e E::E:ﬁ:fw“ =l Add =) Edit | I Delete | = Grouping '/ Auto Fiter € Default Settings
/ | Description Email List
= 5Ms Growps v querty @gmail.com, asdf@gmail.com
Region 1 Terminal 1 64@trbonet.com, 65@trbonet.com, §6@trbonet. com
A1, Voice Dispatch

%mermhu

@ Job Ticketing

Route Management

@ RFID Tracker

[] Text Messages

g Voice Recording

Event Viewer

1

P

e

4l

|« | 4| Record 10F2 ¥ [m|mi[ <]

127001 &3 B | @ Administrotor | [ Licensed to: demo Demo License

e Click Add (3) to create an email group.
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Add/Edit Email Groups *
Name: Terminal 1
Description: Region 1 Terminal 1]
Emai list: 64@trbonet.com

65@trbonet.com
66@trbonet.com

Add Remow

i
=]
o

Ok Cancel

* Name
Specify a name for the email group.

= Description
Add a description for the email group.

= Email list
Click Add to add an email address to the Email list.

6.4.19 SMS Groups

SMS Groups are used in Event/Alarm Management configuration to send SMS to
dedicated SMS recipient groups.

Go to Administration (1), SMS Groups (2) to add/edit/delete SMS groups in the
system:

file View Map Tools Help

Administration aller Group I
Pt ~ | FEginereom (3 [[] Jl & e fee OE) EEE [«
5 Toos Boon noE) R oo TR oEE

(4} Disabled Radios

8% Dispatcher Groups [Jprivate Cal el

&} Dipathers = Add 5 Edit | =k Delete | = Grouping "\ Auto Filter @ Default Settings

Email Groups

415015 Groups) Group Nae | Description Phone Numbers

B2 Users — 2 o || Deparbyent 2 Regio 1 Department 2 73117894561, 79217854561
) Departmeqt 3 Region 1 Department 3 792112374567, 79111234567

(1)) Voice Dispatch

3

u:mﬁmrmdﬁug

@ Job Ticketing

an:z}‘lanagumvt

@ RFID Tracker

[] Text Messages

gv\ﬁzm

Ewmtvimu

I:Elmnlmtnl 1
| ] 4| Record 20F2_» [ w|mhi] < | >

127001 &3 B | @ Administrator | [8 Licensed to: demo Demo License | @ active~

Emm istratic e

e Click Add to create a new SMS group:

233



neocom
sOoftware

Add/Edit SM5 Groups X
MName: Department 3
Description: Region 1 Department 3

Phone Numbers: 792112374567
79111234587

oK Cancel

= Name
Specify a name for the SMS group.

= Description
Add a description for the SMS group;

= Phone Numbers
Click Add to add a phone number to the SMS group.

6.4.20 Users
Go to Administration (1), Users (2) to add/edit/delete users in the system:

File View Map Tools Help

Administration e Am
bled Rach

% E::at;:rali:ius " | B ERzrcon [][«][@] Il & 1: Line free @ M Jarca e

], Dipatchers Mo 10 DoeE) (VErE Fdcroup 20 Pl

= Email Gr

s [ JPrivate call [2][«][@]

= s Graups

) - r
= Logical G =L Add [} Edit | [k Delete | = Grouping i/ AutoFilter € Default Settings
35 Logical Grous
ﬁ Radio Groups 2 Login A Display Name SIPID Description
B Radios o |[Bast Basil

Pete Pete 2401

(1} voice Dispatch

L-zti-.rr_ﬁ-g 3

W Job Ticketing

MM—W

@ RFID Tracker

[ Text Messages

ﬁ Voice Recording
Event Viewer
EEI Radio Allocation 1

|| | Record 10F2 » [m|mm]| | 3
127001 &5 B | & Administrator | (28 Licensed to: demo Demo License | © Active-

l— ]

e Click Add (3) to add a new user to the system:

¢ On the General tab, set general parameters for the user:
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Add/Edit User X

General Radios Advanced User Call Logical Groups

‘% Specify user information

Login: |BaS|I |
Password : | """" |
Repeat password: | ““““ |
Display Mame: |Basi| |
Max radios count: 1 =

Description:

Cancel

* Login
Specify the login for the user.

= Password
Type in the individual password for the user.

= Display Name
Specify a name for the user to display in the Dispatch Console.

= Max radios count
Select a number of radios that will be available for the user.

= Description
Add a description for the user.

¢ On the Radios tab, specify the radios that will be available to the user.

Add/Edit User X
General Radios  Advanced User Call  Logical Groups
Specify radios that the user can take
" Allow all radios
¥ Only selected radios
Callsign Group
! ® 111 Police, Firemen
v @ 125 Firemen
® 222 Police, Firemen
@ 235 Firemen
W4 | 4 | Record 2of4 b | M M| 4 »
Cancel

= Allow all radios
Choose this option to allow using all radios in the system.
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= Only selected radios

Choose this option and specify which radios will be available to the user.

e On the Advanced tab, specify settings related to taking/returning radios:

236

Add/Edit User X

General Radios Advanced User Call Logical Groups

I Lock radio on return

¥ Allow DTMF management

Take radio: 1234 #1234
Return radio: 5678 #5673

¥ allow Text Messages management

Take radio: 3214

Return radio: 5678

I Allow Sign In / Sign Out management

—

[ Send notification to radio after itis taken/returned

Canc

Lock radio on return
Select this option so that a radio will be disabled after the users returns it.

Allow DTMF management
Select this option to allow taking/returning radios by sending the specified
DTMF tones.

¢ Take radio
Specify DTMF tones to be sent by the user to take a radio.

¢ Return radio
Specify DTMF tones to be sent by the user to return a radio.

Allow Text Messages management
Select this option to allow taking/returning radios by sending specified text
messages.

e Take radio
Specify the text of the message to be sent by the user to take a radio.

e Return radio
Specify the text of the message to be sent by the user to return a radio.

Allow Sign In / Sign Out management

Select this option to allow taking radios when the user signs in.

e Sign-in ID
Specify the password that the user enters to sign in when they take a
radio.

Send notification to radio after it is taken/returned
Select this option so that a notification is sent to a radio every time the user
takes/returns it.
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e On the User Call tab, specify SIP Call settings for the user:

Add/Edit User *
General Radios Advanced User Call  Logical Groups
Phone Number: 79211234567 |
Email: |24D L@gmail.com |
SIP Call
sIP ID: [2401
SIP Name: [2401

Password: |

SIP Profile: | ™

[ Block incoming calls
[ Block outgeing calls

Cancel

= Phone number
Specify the user's phone number (additional data).
= Email
Specify the user's email address (additional data).
SIP Call
= SIPID
Enter the SIP ID that will be used by the user.
= SIP Name
Enter the SIP user name that will be used by the user.

= Password
Enter the password for the user to be authenticated by the telephone
system

= SIP Profile
From the drop-down list, select the SIP profile to use.

= Block incoming calls
Select this option to block all incoming SIP calls for the user.

= Block outgoing calls
Select this option to block all outgoing SIP calls for the user.

6.4.21 Logical Groups

TRBOnet Dispatch Console allows adding custom logical groups in addition to radio
groups. You can create groups and subgroups and then assign
radios/users/dispatchers to these groups.

Go to Administration (1), Logical groups (2) to work with Logical Groups:
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File View Map Tools Help

Administration ogical Group 8 |
(&) Disabled Radios ~
% Dispatcher Groups M mtercom [1][«][@] B & 1: Line free [Jancal [2][«][@]
% Dispatchers Mcroue 10 DoE EXE @] I B oroun 30 DEE]
Email Groups
= s Groups [ ]Private Call [][«]
%, Users B =
g\ E; Add |- 5} Edit | 3; Delete |
T Radio Groups =% Addasa Child 4] Description
§ Radios 2 v || b AddasaRoot
B [Eaning Cleaning in Department 1
S ] Cleaning 2
Voice Dispatch
el =113 seaurity Groups for Security
F ) _ L] Security 1
Location Tracking L security 2
W Job Ticketing 3
Route Management
@ RFID Tracker
[ Text Messages
ﬁ Voice Recording
Event Viewer
EEI Radio Allocation 1
o v -
127001 &3 & | @ Administrotor | [ Licensed to: demo Demo License | © active~

e Click Add (3) to add a logical group.
= Select Add as a Root to add a logical group as a root folder.

= Select Add as a Child to add a logical group as a child folder.

Group properties X
Name: Cleaning 1
Description: Cleaning in Department 1
Cance

= Specify a Name and Description for the logical group.
= Click OK to add the logical group.

To display logical groups, enable the Logical Group view:

238 TRBOnet Enterprise — User Manual



TRBOnet Dispatch Console

Voice Dispatch
BER&HY oo
L3

Ipr—
a ‘R Onlire oropatnererl}
& administrator
& T cleaning
© T} Cleaning 1
(#)® 125 (Pete) 125
F} cleaning2
& F) security
© T} securty1
[O)C) 235
T} secunty2

Y} voice Dispatch
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o

&E 30b Ticketing
=
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Text Messages
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Ty—

All created logical groups are displayed in the list of radios.

6.4.22 Radio Groups

/®

neocom
software

Go to Administration (1), Radio Group (2) to add/edit/delete Radio Groups in the

system.

File View Map Tools Help

Administration EGIT & [
(&) Disabled Radios ~
Funrill () CIENCP) (NI Lo
& Dispatchers Pcrow 10 Fcrou 20 ¥ Group 30 [1][<d[@]
Email Groups
= 55 Groups [_Jprivate call
@é l“:;‘ crous (5% Add| =) Edit | =k Delete | = Grouping I AutoFilter @ Default Settings
= Name | A Radio D [ MDC / Sel-5 (Hex) | Desariprion
g v |[Cleaners! 30 5 Cleaning group
Firemen 20 0
délﬂ Voice Dispatch Palice 0 0
Location Tracking
—_
& b reterm 3
_
- Route Management
- RFID Tracker
| S—
Text Messages
g 5 -
| S—
_
Radio Allocation / 1
T— -
ie¢ 4] 4| Record 1of 3w [ w]m] <] v
127001 &9 @| € Administrator \ =4 Licensed to: demo Demo License \ @ Active-

e Click Add (3) to add a radio group to the system:

239



&

neocom
sofFtware

240

Group Properties X

Name:; Cleaners

Group ID: 30

Ak 4

MDC /Sel-5: |3 (Hex)

Description: Cleaning group

Use custom Call Tone
|| Load from file

@ Playback message

oK Cancel

Name
Specify a name for the radio group in the system.

Group ID
Specify the Radio ID for the radio group used to identify messages to/from
the radio group.

MDC / Select-5 / Quick Call I / Quick Call 1l

Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to
identify and communicate with a target radio or group of radios depending
on the call type. Or, select Quick Call I / Quick Call Il signaling system and
specify the appropriate parameters.

Description
Add a description for the radio group.

Use custom Call Tone

Select this option and browse for the audio file (WAV, MP3) that will be
used as a custom tone when a group call is started by clicking the Tone and
PTT button in the group's PTT box (see section 6.5.2, PTT Boxes).
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6.4.23 Radios

The administrator can add/edit/delete radios in the system.
e Go to Administration (1), Radios (2).

File View Map Tools Help

Administration Radios EIEE

§ E::a:;:mm ” 7 1: Line free M intercom
%
Email Groups [Jprivate cal [-][+][Z) B[ Jsroup 10
3 [Jeroup 20 Oe) MEEI
i tered
4 Add Group | Eb Add MOTOTRBO Radiol~| =) Add WAVE Radio |5 Add TRBOnet Mobile (= Add Range
< N Calsgn 4| Type RadoD  |MDCD  |SPID Radio Gro... | Logical Gr.... | Desaription
@® 125 MOTOTREO Radia 425 0 125 11; Firemen  Cleaning, ...
Y, voice pispateh ® 13 MOTOTREQ Radi 0 Al
@ 25 MOTOTREO Radio. 235 0 235 Firemen; ... Cleaning
[ Lacation Trackisg @ 3333 TRBOnetMobile 3333 0 3333 1122
= @ ss5 MOTOTREO Radio. 555 0 Al
ﬁ 3Job Ticketing (@ Radio 300  MOTOTREO Radio 300 Al
(7] Route Management
3
|0]| RFID Tracker
[] Text Messages
E Voice Recording
{=| Event Viewer
* 2] Radio Allocation - 1
i |
1] 4] 4| Record 10f 5 b [ w|mm] 4| »
127001 45 € | | Administrator | [ Licensed to: demo | @ Active~

e C(Click Add MOTOTRBO Radio (3) to add a new radio.
On the General tab, specify general settings for the radio:

Voice Dispatch 125 >

General ILogiaI Groups' addiﬁonall SIP Calll Camerasl

Radio Name: 125 |
Radio ID: 125 +| MDCID: 0 =

Radio Groups: |A|| v |
Home Group: |C|eaners | |
Use icon: |_ Portable Radios ~E = |

Extended Device:  [None ~ Test | ~

Location Service

Location Source: |Eu\|t—in GPS receiver w ‘

Location Profile: |(Default) L ‘

Location Enabled

Telemetry Service
TLM Source: |Euw|t—in Telemetry - ‘
TLM Profile: |(Default} LAk ] ‘

Text Messages Service

TME Tunar [2tandard vl
Hide Advanced Settings

Cancel

e Radio Name
Enter a descriptive name for the radio to display in the Dispatch Console.

e Radio ID
Enter a Radio ID for the radio. This ID is used by other calling radios when
addressing the radio, for instance, when making a private call or sending a text
message.
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MDC / Select-5 / Quick Call I / Quick Call 1l

Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to
identify and communicate with a target radio or group of radios depending on
the call type. Or, select Quick Call I / Quick Call Il signaling system and specify
the appropriate parameters.

Radio Groups
In the drop-down list, select a radio group(s) to which to assign the radio.

Home Group
In the drop-down list, select a home group for the radio.

Use icon
From the drop-down list, select an icon for the radio.

Extended Device
From the drop-down list, select the option board type the radio is equipped
with.

Location Service

Location Source

= Built-in GPS receiver
Select if the radio has its own built-in GPS receiver to send GPS data.

= Not equipped with GPS receiver
Select if the radio cannot send GPS data.

Location Profile

From the drop-down list, select the default or preconfigured Location Profile.
For more details on Location Profiles, see section 6.4.11, Location Profile
(page 206).

* Location Enabled
Select/clear this check box to enable/disable the location trigger.

Telemetry Service

TLM Source

= Not equipped with Telemetry
Select if the radio cannot send Telemetry data.

* Built-in Telemetry
Select if the radio has its own built-in Telemetry.

= Extended device
Select if the radio is equipped with an extended device.

TLM Profile

From the drop-down list, select the default or preconfigured Telemetry Profile.
For more details on Telemetry Profiles, see section 6.4.10, Telemetry

(page 202).

Text Messages Service
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* None
Select if the radio is not equipped with a display.

= MSI Proprietary
Select if the radio is equipped with a display and supports the new Text
Messaging service.

= Standard
Select if the radio is equipped with a display and supports DMR Compatible
text messages.

Job Tickets Service

e JTS Type

* None
Select if the radio is not equipped with a display.

= MSI Proprietary
Select if the radio is equipped with a display and supports the Enhanced
Job Ticket protocol.

= Text Messages
Select if the radio is equipped with a display and supports the legacy Job
Ticket protocol.

Radio Status Service

= RS Profile
From the drop-down list, select the default or preconfigured Radio Status
Profile.

On the Logical Groups tab, specify logical groups for the radio:

Voice Dispatch 125 >
General Logical Groups ]Additiunal] SIP Call] Cameras]
MName Description
=l = Cleaning
i bWl Cleaning 1 Cleaning in Department 1
Lo = Cleaning 2
= |l Security Groups for Security
i[5 Security 1
L[ Security 2
Cancel

e Select a logical group in the list of available groups.

e For more information about logical groups, see section 6.4.21, Logical Groups
(page 237).
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On the Additional tab, specify additional information about the radio subscriber:

Voice Dispatch 235 X

General| Logical Groups  Additional ISIP Call| cameras|

Mame:
[Radio 235

Description:

Testradio

’ . \
Load Image...

Make: | |
Plate Number: | |
Phone Number: [+7 §11 1234567 |
Email: |besber@gmai\.com |
Max speed: ’ﬁ
Route Color: [JPowder... »

OK Cancel

Name
Specify a name for the radio subscriber.

Description
Add a description for the radio subscriber.

Click the Load Image button and browse for the photo or image to assign to
the radio subscriber.

Make
Specify a make of the vehicle as additional information.

Plate number
Specify a plate number of the vehicle as additional information.

Phone number
Add a telephone number for the radio subscriber.

Email

Add an email address for the radio subscriber. This email address can then be
used to create and assign job tickets to the radio (see section 6.4.5.16, HotSOS
(Email)).

Max speed

Specify the maximum speed allowed for the vehicle, in kilometers per hour or
in miles per hour, depending on the measurement system specified in
TRBOnet server.

Route Color
Specify a color to display the route passed by the radio on the map.

On the SIP Call tab, specify SIP Call settings for the radio:
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Voice Dispatch 125 X

General | Logical Groups} Additional SIP Call lcamerasl

SIP ID: 2125 |
SIP Name: 2125 |
Password: [seseersaee |
SIP Profile: s 1 ~]

[ Block incaming calls
[ Block outgaing calls

Cancel
e SIPID
Enter the SIP ID that will be used by the radio.
e SIP Name

Enter the SIP user name that will be used by the radio.

e Password
Enter the password for the authentication.

e SIP Profile
From the drop-down list, select the SIP profile to use for the radio.

¢ Block incoming calls
Select this option to block all incoming SIP calls for the radio.

¢ Block outgoing calls
Select this option to block all outgoing SIP calls for the radio.
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On the Cameras tab, select the check box beside the camera that will be associated
with the radio:

Voice Dispatch 125

General] Logical Groups] Addmcnal] SIP Call Cameras l
MName

v
Camera 2

Cancel

6.4.23.1 Importing Radios
The administrator can also import radios from an Excel file (*.xls).

Notes: The Excel file you are importing from must contain at least two
columns (Radio ID and Radio Name). Also note that the first non-
empty row in the table will be considered as a header row.

e Click the arrow on the right of the Add MOTOTRBO Radio button and choose
Import from File.

# Import Radios

Radio ID Callsign

0 10

M i
11 1 | |
220 220 | |

Home Group GP3 ™S

Total: 3

T Import Cancel

In the Import Radios dialog box:
= C(lick Load > Excel.

In the Open dialog box, locate the desired file and click Open.
= Click Import.

As a result, imported radios will be added to the list of registered radios.
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6.4.23.2 Adding TRBOnet Mobile

In addition to MOTOTRBO radios, you can create accounts for TRBOnet Mobile
Clients that can connect to your radio systems.

e Click Add TRBOnet Mobile.

Voice Dispatch 3333 x

General |ogical Groups  Additional Cameras

Radio Name: |3333 |

Radio ID: 3333

Radio Groups: |FirEmer| L |

Home Group: |FirEl‘nEI‘| v |

Dispatcher Groupsy Al for |
¥
Profile: Mobile Client Profile #1 vl |

Use icon: |® Portable Radios ~ |

SIP ID: [3333 |

SIP User: [3333

Password: | oooooooooo |

Password {repeat): | ----------

[ Elock incoming phone calls

In addition to MOTOTRBO radio parameters, TRBOnet Mobile has two more
parameters Dispatcher Groups and Profile.

e Dispatcher Groups
In the drop-down list, select a dispatcher group(s) which to assign to the
mobile client.

e Profile
In the drop-down list, select the profile for the mobile client.
Or, click the plus button on the right to create a profile.

Note: For directions on how to create/edit a Mobile Client Profile,
see section 6.4.12.1, Adding a Mobile Client Profile.

6.4.23.3 Adding WAVE Radio

If the WAVE controller is connected, you can add WAVE radios to your radio
systems.

e Click Add WAVE Radio.
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WAVE Radio x

General ILngiaI Groups} Addiﬁunal] SIP Ca\ll Camerasl

Radio Name: |Wave 145 |

(Radio ID: 145 2 waveID: |145 !

Radio Groups: |Firemen —vo|
Home Group: |Firemen |+ |
Use icon: |® Portable Radios |- |
ExtendedDevice: [None 0] Test | ~
Location Service
Location Source: |Euiltﬁn GPS receiver ~ |
Location Profile: |(Defau\t} e |

Location Enabled
Telemetry Service

| |

Text Messages Service

Hide Advanced Settings

In addition to Radio ID, the WAVE radio has the Wave ID parameter.

= Radio ID
Specify a Radio ID for the WAVE radio. This ID is used by other calling
radios when addressing the radio, for instance, when making a private call
or sending a text message.

= WAVEID
Enter the Wave ID that corresponds to the user registered in the WAVE
server's user database.

6.5 Voice Dispatch

When on the Voice Dispatch tab is selected, the dispatcher can make radio and
phone calls, send text messages to radios and phone numbers, monitor recent calls
and events, radio state, active tasks and routes and view selected map.

6.5.1 Radio List

6.5.1.1 View Options

The toolbar in the upper part of the Radio List pane provides buttons to change the
appearance of the list:

Voice Dispatch

=) i -
& [, onine Dispatehers (1)
9 Dispatcher 1
® 33. Group1
i
=] |_U Firemen (=]

® 1 5 ¢

ER

£ A9E (Dol — T

e Click to view radios by radio groups.
e Click to view radios by radio list.
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Click to view radios by logical groups.
Click to view radios by their statuses.

= Yellow
A radio is online and enters the beacon coverage zone; has Indoor
positioning lock.

Note: When GPS location is available and the radio enters the
beacon coverage zone, the status turns yellow from green.

= Blue
A radio is online; GPS data is not available.

= Green
A radio is online; GPS data is available. This status is shown if the Server has
received GPS data during the last 10 minutes (the time interval is set in the
server configuration).

= Grey
A radio is offline.

Click Fa to open the Settings dialog box to specify which quick buttons to
display in the Radio List pane.

Settings x

Hide/Show quick buttons
Dispatcher Buttons
[ send Message I Request ToTak

Radio Buttons,

[# Find on Map @) Private Cal

[7] Find on Google Earth ¥ Send Message

7] show Route I Request To Tak
[] show Route on Google Earth [F] Blocking Onfoff

[¥] Send Message [T Reset Location Trigger
¥ Request To Tak

Logical Group Buttons
(¥ Send Message

Additional Options
IF] show checkboxes 7] show Location trigger state

a 2 onine pipateh
8 oy

© | radio Group S A
%) Radio1 Zmaew
@ rado2 maew

e Dispatcher Buttons

In this group, select the quick buttons to be displayed in the Radio List for
dispatchers.

Radio Buttons
In this group, select the quick buttons to be displayed in the Radio List for
radios.

Radio Groups Buttons
In this group, select the quick buttons to be displayed in the Radio List for
radio groups.
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¢ Logical Group Buttons

In this group, select the quick buttons to be displayed in the Radio List for for

logical groups.

Note: For the preview, see the lower part of the Settings dialog

box.

e Additional Options
= Show checkboxes

Select this option to display check boxes next to each radio and radio
group. Selecting/clearing a check box will display/hide the corresponding

radio/radio group on the map.

= Show Location trigger state

Select this option to display the Location trigger state for a radio in the

Radio List pane.

2 | |y Firemen

\ (®)235 (Basil)
(% |(D|Radio 200
¢ Grey

A radio is offline.
¢ Blue + white dish

A radio sent ARS but didn't send GPS packets.

e Blue + red dish

A radio sent ARS and GPS packets without GPS data, that is the radio is

out of GPS coverage.

e Green
A radio is fully online (has a GPS fix).

Filter the Radio List

e Click v , and select which radio list elements to display in the Radio List pane.

Voice Dispatch
GliElE & X2
Radio, Radio Group, Online, GPS Fixed -
Type:

ki

| Dispatchers 1

| Dispatcher Group 2

V| Radio Group

| Logical Group
Status:

Online, Indoor

@] Online, GPS Fixed 3

| Online, No GPS

| Offline

| OK | | Cancel
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e Click the arrow button (1).
e Select the object types and statuses (2) to filter radios.

For example, you may select to display only radios and radio groups that are
online and have fixed GPS signal.

e Click OK (3) to apply filter settings.
Refresh the Radio List

e C(Click S to reload the Radio List contents.

6.5.1.2 Quick Filter

Type in Radio ID or Radio name to filter the Radio List. Search results are displayed
in the Radio List pane:

Voice Dispatch

S hHd XYV a2

1L

124
B, oniine Dispatchers (1)
= [ ) Firemen

\wﬁ

6.5.1.3 Radio Pop-up Window

The dispatcher can see the last received radio data in the Radio pop-up window.
Select a radio in the Radio List and hover the mouse pointer over it:

125

=28

Capadty Plus #1 1
Online by ARS
(i) Battery: 60% 3
(i)onDuty 4

Lone Worker 5

12:44PM 12:45PM
Gty Mall 6

Accepted #A09152 7
Accepted #A09155

GPs: 7/12/2018 6:24:35 PM
Speed: 1.9 km/h

Altitude: Unknown 8
Region: MNo

Latitude: 59°56'27.85" N
Longitude:  30°16'47.71°E
7 Liniya Vasil'yevskogo Ostrova,

36, Sankt-Peterburg, Russia,
199178 9

The following information on the radio is displayed in this pop-up window:
1. The current channel/radio system the radio is on.

2. The note about the radio state (displayed only if the Show latest note in Unit
information details option is selected in the Advanced tab of the Options
dialog).
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3. The current battery state, in percent (displayed only if the radio is equipped
with an option board).

4. The User Activity list the radio is assigned to, if a User Activity task is activated.
5. The Lone Worker policy's state, if a Lone Worker task is activated.

6. The route assigned to the selected radio, if a Route Management task is
activated for the selected radio.

7. The associated job tickets.
8. The current GPS data and current location data.
9. The current location resolved to address.
While this pop-up window is open, the dispatcher can do the following:
e Click 2 to request the presence of the radio in the radio network.
e Click = to send a text message to the radio.
e Click &= to request the radio's location.
6.5.1.4 Radio Shortcut Menu
To open the radio's shortcut menu, right-click a radio in the Radio List pane:
This shortcut menu contains the following items:

e Presence in Network
Choose this menu item to send a Check Radio command. If the radio is online
and is located in the coverage area, the dispatcher will see a message like this:

Message 1 of 1 *

125
Rapester £1: Slot #1
Checking Presence in Network

The command has been executed. 14-Nov-2016 17:43

Radio is present in the network
Agent: Radio Metworks
Radio System: Repeater #1: Slot #1 [ Peer 1002

[] Do not show this message next time Show on map
Request Location

Close

e Private Call
Choose this menu item to initiate a Private Call to the selected radio.

e Request to Talk
Choose this menu item to send a talk request to the selected radio.

¢ Request Location
Choose this menu item to request the location of the selected radio (for radios
with GPS module only).

¢ Send Message

Choose this menu item to send a text message to the selected radio (for radios
with display only).
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¢ Advanced > Remote Monitor (Open mic)
Choose this menu item to activate the radio microphone in hidden mode

(remote monitor durat

ion — 30 sec.)

Advanced > Reset Location Trigger
Choose this menu item to customize the Location Update settings. When you
reconnect to the Server or reassign a Location Profile to the radio, temporary
settings will be updated to the Location Profile settings.

1 ]

Reset Location Trigger H

Reset Location Trigger
100

@ Reset location trigger

() Stop location trigger

() Start location trigger

[] change periodic interval

Cancel

= Reset/Stop/Start location trigger
Choose which command to send to the radio.

= Change periodic interval
Select this option and specify the new location update interval.

Advanced > Enable Radio

Choose this menu item to enable the selected radio.

Advanced > Disable Radio

Choose this menu item to disable the selected radio.

Advanced > Send Audio Record
Choose this menu item to send an audio record to the selected radio.

Record audio

Convert Text to Speech
|_._. Start \|L| Cancel | | Load |‘|

= Click Start and start talking to the microphone.

Record audio

Convert Text to Speech
Lu Send ‘|L| Cancel | | Load |'|

= Click Send to send the recorded message to the radio.

= You can also load your message from file, or from Saved Audio Files. Just
click the Load button.
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e Advanced > Hot Key - Private Call

254

= Or, you can send a text message converted to speech. Just click the

Convert Text to Speech link.

Convert Text to Speech

Text:

Pete, get back at work

Listen

x
|5
=

Cancel

Advanced > Send Coordinates To

Choose this menu item to send the coordinates of the selected radio to

selected recipients.

[ .131 Online Dispatchers

I Send copy by Email
I Send copy by 5MS
I Send to offfine radios

Hide Advanced Opticns

Send Text Message X
Target: |235 (Basil}; ‘
Templates: ~| B
Tent: 125 (Pete) Latituds: 5356725 69" N: Longitude:
30*1647.51"E
66
Attachments: @ Add File
Select Radios and Groups
Fitter: | 235
¥ ® 235 (Basi)

SEND Cancsl

= In the dialog box that appears, specify the radio/radio group/dispatcher to

send the coordinates to.
Advanced > Send Email

Choose this menu item to send an Email message to the selected radio

mailbox.

Choose this menu item to assign a hot key that will be used to make a private
call to the selected radio. When the prompt appears, press the desired key or

key combination.

Hot Key

A'r]. Click for the combination to specify
£ W the Hot Key or Escto reset

X

Find on Google Earth

Choose this menu item to display the selected radio location on Google Earth.
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e Show Route on Google Earth
Choose this menu item to display a route traveled by the selected radio on
Google Earth for the specified time period.

Show Route X
Radio: 125 (Pete) "
From: | 15-Nov-2016 0:00 ~|
To: |<Last known location = ﬂ
Color: [ B 105, 105, 105 -]

Optimize Route (group all nearest points)

Cancel

e Monitoring > Monitoring in New Window
Choose this menu item to open a new Map window for the selected radio.

¢ Monitoring > Google Street View
Choose this menu item to open Google Street View with the latest location and
direction of the selected radio.

¢ Monitoring > Yandex Street View
Choose this menu item to open Yandex Panorama with the latest location and
direction of the selected radio.

¢ Set Location Profile
Click this menu item and select the location profile that will be associated with
the radio.

e Specify Status Colors
Choose this menu item to select to set individual parameters for the radio
icons.

Status Colors X

v o+ =
Orline, No GPS @ oniline, No GPS - o+ -
Online, GPS Fixed (@ oniine, GPS Fixed M
Online, Indoor @ Online, Indoor v o+ -
Alarm O Alarm - o+ =

Reset

Preview

Offline Orline Online (GPS) Cnline (Beacon) Mam

® ® ® ® e

OK Cancsl
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= In the Status Colors dialog box, you can specify icons for the statuses of
the selected radio. Select icons from the drop-down list. To set a custom
color for the radio status icon, click the + button and select a color in the
uniform color palette. Click the — button to delete a custom color.

= In the lower part of the dialog box, you can see the preview of the icons.
= To set default icons for the selected radio, click the Reset button.

Set Radio Channel > Radio Active
Select/unselect this menu item to make the selected radio active/inactive.

Set Radio Channel > Channel
Select the radio channel over which to make calls to the selected radio.

Cameras >
Click this menu item and select a camera associated with the radio. As a result,
a new window with the camera view will open.

Set On Duty
Choose this menu item to assign the selected radio to the On Duty list.
See also section 6.4.5.13, User Activity (page 182).

6.5.2 PTT Boxes

The dispatcher can make voice calls from the Dispatch Console by using PTT boxes:

I'/_ Control Station #1 =

Channel 1
All call [~]

Session:

Free channel

Sender:

I

RX [TX

. /

The following options are available for the PTT box:

Click the button to make the channel the default PTT channel.
Click the [+2] (Tone and PTT) button to start transmitting after a tone sound.
Click the [« (Solo) button to mute all channels except this one.

Click the (Mute) button to mute this channel.

Right-click on the selected PTT box to display the shortcut menu which contains the
following commands:

256

Default PTT channel

Select this menu item to make the channel the default PTT channel.

Specify Hot Key

Choose this menu item to assign a hot key that will be used to transmit on this
radio channel. When the prompt appears, press the desired key.
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¢ Specify External PTT
Select the external PTT device that will be associated with this PTT box.

¢ Specify External Indicator
Select the external PTT indicator that will be associated with this PTT box.

e Add to New Group
Choose this menu item to add the channel/group associated with the selected
PTT box to the Patch box. When two or more channels/groups are added to
the Patch box, the dispatcher can click the Create link to create a patch group
for the selected channels/groups.

e Tone and PTT
Click this menu item to start transmitting after playing a tone sound.

e Mute this channel
Click to mute the selected channel.

e Mute all channels except this
Click to mute all channels except the selected one.

¢ Volume
Move the slider to specify the speaker volume level on the selected
channel/group.

e Microphone
Move the slider to specify the microphone volume level on the selected
channel/group.

¢ Private Call Mode
Select this mode to allow making private calls from the PTT box.

¢ Select By Radio ID Mode
Select this mode to allow making calls by entering radio IDs from the PTT box.

¢ Recipient
Select the call recipient for the PTT box.

e Terminate Transmission
Click this menu item to terminate the current call.

Note: The current transmission can also be terminated by clicking
the Terminate button in the PTT box.

(Bsiot 1 M@
All call il

u

\C
j u [security =

RX [T

¢ Reset
Click this menu item to reset connection to the selected channel/group.
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Minimize/Maximize
Click to minimize or maximize the PTT box.

6.5.3 Voice Calls

The dispatcher can make the following types of calls:

Private Call
This is an individual call from the Dispatch Console to a radio via the radio
channel.

All Call
This is a call from the Dispatch Console to all radio groups registered in the
system.

Group Call
This is a call from the Dispatch Console to a selected radio group registered in
the system.

Intercom Call
This is a call from the Dispatch Console to other dispatchers. There are three
types of Intercom Call:

= Intercom Call to all dispatchers
= Group Intercom Call to a group of dispatchers
= Private Intercom Call to a selected dispatcher

Phone Call
This is a call from the Dispatch Console to a selected phone number.

In addition, the dispatcher can send voice mails to offline radios.

6.5.3.1 Private calls

The dispatcher can make a call to any online radio registered in the system. To make
an individual call from the Dispatch Console to a selected radio via the radio,
channel do the following:

Or:
[ ]

Select the radio in the Radio List.

Click the button on the right.

Right-click the radio in the Radio List.

On the drop-down menu, click Private Call.

To terminate a private call, do the following:

Or:

Click the PTT button on the PTT box.

k!
Click the button in the Radio list.

Note: You can also create a special PTT box for Private Calls. For more
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6.5.3.2 All calls
The dispatcher can make a call to all online radios registered in the system (for
example, in the case of alarm). To make a call from the Dispatch Console to all radios

registered in the system, do the following:
e From the drop-down list, select All Call.

(_D Repeater #1: Slot #2

All call 5
All Call
Firemen

Police

Session;

Free channel

Sender:

]

RX (X
f e

- /

e Click the PTT button.

6.5.3.3 Group calls
To make a call from the Dispatch Console to a selected radio group registered in the

system, do the following:
e From the drop-down list, select a group.

(_ 1P Site Connect: Slot #1

All call E
All call
Cleaners

RX /T
i o

e Click the PTT button.

Note: You can also create a special PTT box for Group Calls. For more
details, see View > Configure PTT Boxes on page 96.

6.5.3.4 Intercom calls
The dispatcher can make calls to all dispatchers or to selected dispatchers in the
system. To make an Intercom Call to dispatchers, do the following:
e On the Intercom PTT box, from the drop-down list, select either All Call, or a
group of dispatchers, or an individual dispatcher.
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(Bntercom
Groupl
Offline: Dispatcher 2

Session;

O Sender:

RX JTX

S J

e Click the PTT button.
6.5.4 Predefined Voice Messages

The dispatcher can send predefined voice messages (recorded or voice messages, or
audio files) to a radio or a selected radio group:

File View Map Tools Help

Voice Dispatch Radio Interface

TN

(%) O Radio 204
(%) D Radio 205

] ED Firemen

& B Repeater #1: Slot #1 [ =@ [ Repeater #1: Slot #2 [ [« @ annels
= ‘Al Call All call
(#) ® 235 @asi)

Q D Radio 200 SR @900 seson M Ssessin

Sender:
Patch on Repeaters
- R Binary Patch
% Location Tracking /]
System Bridge
G} sob Tcketing Repeater #1: Slot #2 [z 1 B
- —— Recent Calls/Events ™ |
) Playback (sl Save- () Print | 11 Pause < Clear - ‘€1 Reload | '] Filter By Radio | = Grouping "7 Auto Filter (» Default Settings || 47 Details >
| Gj] RFID Tracker Date | Radio System | Sender | Recipient | Message | Details | Note. |
o 15-Nov-2016 15:43:52  Repeater #1: Sl... Dispatcher 1 125 Private Call: Dispatcher Dispat... Members: Dispatcher 1, 125 j
Text Messages S 15-Nov-2016 13:28:52 235 Al Reset Geofencng Alarm
% 15-Nov-2016 13:28:48 235 Al The Geofendng - Monitor Area.
- 15-Nov-2016 13:28:48 235 All Radio left alowed region My z...
Voice Recording i
L= S 15Noy-2016 13:28:48 235 Al Radio leftallowed reaion My z... =
| ««| <] Record 1ofs78 > |w|wi| <] >
i Euent Vanay Recent CallyEvents | RecentCals | Request toTak | Radio state | Actve Tasis | acti | User actvity | Map | Cameras
Ebu?om@&@‘ﬁupth 1[4 Licensed to: demo Demo Lic | @ Active~

¢ In the Queued Messages panel, click the Voice Message button.
¢ In the confirmation dialog box, click Yes.

6.5.5 Patches

6.5.5.1 Predefined Patch

The Patch function allows configuring the network to redirect calls. A predefined
Patch can be created by the administrator only and a dispatcher cannot configure it.
A predefined Patch is displayed in the Patch panel by default. The Patch feature is
intended to combine different radio channels in a single group to make voice calls
from a dispatcher to radios and from radios to a dispatcher (for example, to connect
a dispatcher with the firemen and police).
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(%) (® Rauio 203
(%) Radio 204
(%) (D Radio 205
© [ Firemen
HEm
€210 125 Pete) ) PTT PTT
@O
(#) ® 235 @asi)

[ Repeater #1: Slot #1 [ <@ A Repeater #1: Slot #2 [ €M@

Drag and Brop PTT Box here to create new group

Group Call Group Call Patch on Repeaters
] — Y CR— oo

T el
@ Dispatcher 1 @ Dispatcher 1 Firemen - Police ]

(@ repeater #1: Slot #2

Voice

=1
)

Police
RX/TX R/ ———————————— =
Fr—— 5 o) || e
v Firemen v

Recent Calls/Events

Playback (& Save~ (2 Print | 11 Pause Clear + & Reload Filter By Radio | = Grouping "/ Auto Filter > Default Settin: £ Details
yt y ping g

Date | Radio System | Sender | Redipient | Message | Note. |
15Nov-2016 17:35:17  Repeater #1:Sl... 125 Firemen Radio '125' cals group i -
i r— 15Nov-2016 17:35:17  Repeater #1:Sl... 125 Police Radio '125' calls group Pol
15Nov-2016 17:35:09  Repeater #1:Sl... 235 Police Radio '235' calls group Pol
| € vocenecorsimg ||[E) stovas srasos  mopester st 23s Fremen Rado 235 cals group Freme... Menbers: 235

15-Now-2016 17:34:37  Repeater #1: 5. All Call from '235' (00:01) Members: 235 A
| «| <] Record 1ofess »ﬁ» wi| <] 3

(6127001 g3 By B | Dispatcher 1 | [ Licensed to: dema Demo License | @ Active-

z

6.5.5.2 Custom Patch

The dispatcher can create a custom Patch to connect selected PTT boxes (for
example, the Emergency and Firemen radio groups). In addition, you can connect
analogue and digital radios via a Patch.

Radio Interface

Radio Interface| Recent Cals/Events

(%) (© Rauio 204 Hee

®Oramzn B oo HE m
© | Firemen To: Selected Channels

®e

B 222 - Voice Message

(®) @ 235 @asil)

(#) (D Radio 200 v

iremen
(#) (D Radio 201 X Cleaners 1
— Create Clear
e O (] [« (F2tch on Repeaters
- . chans chani [I8inary Patch

[] Firemen - Police X
nﬂfi[emr #1:Slot #2 PTT

Firemen Cleaners

Recent Calls/Events
Playback (gl Save~ (=) Print | 11 Pause <¥ Clear » ‘& Reload Filter By Radio | = Groupin Auto Filter © Default Settings Details
yl y ping 9

Date | Radio System | Sender | Recipient | Message | Details | Note.
15Nov-2016 18:03:01  Repeater #1:Sl... Dispatcher 1 Firemen Dispatcher ‘Dispatcher 1 calls .. Members: Dispatcher 1 ﬂ
1500v-2016 17:58:21  Repeater #1: ... Dispatcher 1 Firemen Dispatcher Dispatcher ' calls ... Members: Dispatcher 1
15Nov-2016 17:58:21  Repeater #1:S... Dispatcher 1 Cleaners Dispatcher Dispatcher 1 cals ... Members: Dispatcher 1
15Nov-2016 17:55:01  Repeater #1:Sl... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher 1'calls .. Members: Dispatcher 1

15-Noy-2016 17:55:01  Repeater #1: 5l... Dispatcher 1 Cleaners Disoatcher ‘Dispatcher 1' calls Members: Disoatcher 1 A
| «| «| Record 10f875 »ﬁ» wd »

Recent CalEvents | Recent alls | Reauest o Tak: [ Radiostate | Acte Tasks [ Actve Routes | User actwity [ 1ap [ cameras |
127001 83 B B | § Dispatcher1 | [ License

demo Demo License | @ Active-

1. In the Radio Interface pane, select the PTT boxes you want to combine in a
group. Drag and drop them to the empty Patch box (1).

2. Click the Create link (2) to create a custom Patch.

Note: Until you click the Create link, this patch will remain as a
temporary patch that will be deleted after you reconnect to
TRBOnet Server or restart TRBOnet Dispatch Console.

As a result, the new patch will be added to the Patch panel. Select the check box to
activate the patch.
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Radio Interface

Radio Interface| Recent Cals/Events.

(%) (® Rauio 203
(%) (© Rauio 204 mew
(%) (© Rauio 205

© | Firemen

ODm

Voice Message

Drag and Drop PTT Box here to create new group

Patch on Repeaters
[ JBinary Patch

@@ 235 (Basil) . N @
(%) Radio 200
(#) (D Radio 201

Group
Repeater #1: Slot #2.
Cleaners

Repeater #1: Slot #1
Firemen

[ Firemen - police ]
Repeater #1: Slot #2 -
Polce e
Repeater #1: Slot #1
Fremen

Recent Calls/Events

%) Playback |l Save~ () Print | 11 Pause ¥ Clear = & Reload | ‘[ Fiter By Radio | = Grouping ‘7 Auto Filter ( Default Settings || 7 Details b
Date | Radio System | Sender | Recipient | Message | Details | Note. |
15Nov-2016 18:06:05  Repeater #1:Sl... Dispatcher L Firemen Dispatcher Dispatcher 1 cals ... Members: Dispatcher 1 ﬂ
() 154uov-2016 18:06:05  Repeater #1: Sl... Dispatcher 1 Firemen Dispatcher ‘Dispatcher ' cals ... Members: Dispatcher 1
15-Nov-2016 18:03:06  Repeater #1: Sl... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher 1' calls ... Members: Dispatcher 1
_ ] s5n0v2016 105101 Rapeste 5155l Depatcher L ryemen Dispatcher Dispateher I'cals ... Members: Dispatcher 1
15-Noy-2016 17:58:21  Rex r #1 Sl... Dispatcher 1 Firemen Disoatcher ‘Dispatcher 1' calls Members: Disoatcher 1 _‘ﬂ
rT— g e ;
PIESES Recent CallsEvents MMMMM@@@
(127001 g3 & € | § Dispatcher 1 | [ Licensed to: demo Demo License | @ Active-

6.5.6 Quick Commands

The dispatcher can create Quick Commands (Text Messages, Send Telemetry,
Request Location, Send Voice Message, and some other commands) and display the
Quick Commands panel in the Radio Interface pane. With these commands, the
dispatcher can quickly send Text Message, Telemetry, Location Request, Voice
Message, and some other commands to a radio by clicking the appropriate Quick
Command button.

To configure the Quick Commands panel, do the following:

¢ Make sure Show Quick Commands Panel (2) is selected under the View
menu.

¢ On the Quick Commands panel, click the Configure link (3).

Show Navigation Radio Interface

[Booliels D Radio Interface | Recent Calls/Events

Cenfigure PTT Boxes.

Cenfigure Active Calls Panel.

Configure

To: Selactad Channels

Voice Message
Drag and Drop PTT Box here to
P e
Cleaners
Recent Calls/Events

) Playback [ Save~ (b Print | 11 Pause < Clear + 'S Reload | [ Filter By Radio | = Grouping '/ Auto Fitter =
Date |Radio Syst... Sender  |Redpient | Message | Details | Note |

% 16-Nov-2016 10:22:05 Server all Connection to ‘Repeat. .. -

15Mov-2016 18:26:36  Repeater... Dispatcher 1 Firemen Dispatcher Dispatcher... Members: Dispatcher 1

15-Noy-2016 18:26:28  Repeater ... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher... Members: Dispatcher 1

15-Nov-2016 18:26:21 Hapeater ... Dispatcher 1 Firemen Dispatcher ‘Dispatcher... Members: Dispatcher 1

15-Noy-2016 18:06:12 Disoatcher 1 Cleaners  Disoatcher ‘Disoatcher... Members: Disbatcher 1 &2
| 4| 1] Record 10679 G »<[ |

Recent Cals/Events MMMMMM@@

B 127001 &3 B, B, | 8 Dispatcher 1 | [ Licensed to: dema Demo License | @ Active-

Customize Hot Keys...
Add Radio Interface Page...
Delete Radio Interface Page

Show Channel Selector Box

Audio Message Library...
Extended PTT Boxes
Large PTT Boxes
Medium PTT Boxes

I l Srall PTT Boxes
P

Custom PTT Bxes l

ree channel

Firemen

.(laanels

Show Telephony Tab
Show Extended Messages Tab
Show Radios Tab

¢ In the Configure Quick Commands dialog box, click the Create link.
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* Name
Specify a name for the quick command. This name will be displayed as the
button name in the Quick Commands panel.

6.5.6.1 Send Text Message

CQuick Command X

MName: |Test

Command

Command: |Sand Text Message j

Message: |This is & test]

" Send to Radio Group
{+ Send to Radio

Redipient:

® 13
V@ 125
W@ 235

@ s55

@® 3333

® 2442

(#) 5555

Selected: 2

@ Y -[:E-

Cancel

= Command
From the drop-down list, select Send Text Message.

= Message
Enter the text of the message.

= Send to Radio Group
Choose this option to send the text message to radio groups registered in
the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send a predefined text message to individual radios
registered in the system. In the Recipient box, select target radios.
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6.5.6.2 Send Telemetry

264

Cuick Command X

Name: |Test

Command

Command: |Sand Telemetry ﬂ

VIO: VIO 1 ~ | Command: High level -

" Send to Radio Group
{+ Send to Radio

Recipient:

® 13
M@ 125
M@ 235

@ 555

® 3333

® +42

(#) 5555

Selected: 2

@ a Y- |i=~

Command
From the drop-down list, select Send Telemetry.

VIO

Specify a VIO to which to send a telemetry command.

Command

From the drop-down list, select a telemetry command for the selected VIO.

Send to Radio Group

Choose this option to send the telemetry command to radio groups
registered in the system. In the Recipient box, select target groups.
Send to Radio

Choose this option to send the telemetry command to individual radios
registered in the system. In the Recipient box, select target radios.
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6.5.6.3 Request Location

= Command

Cuick Command

MName: |L0cah0n of 125 and 235

Command

Command: |Request Location

Redipient

® 13
W@ 125
V@ 235

@® 555

@® 3333

(#) 2442

@ 5555

(® Rradio 300

(® Radio 333

(# radio 3562

Selected: 2

&[T

From the drop-down list, select Request Location.

= Recipient

Select radios to which to send a location request.

6.5.6.4 Send Voice Message

= Command

Quick Command

MName: |We are on fire|

Command

Command: |Send Voice Message

|| Load from file
_/Q Record message
'?4_# Play back message

Call Type Channel
Group Call 5} Capacity Plus #1

of Add % Remove

Priority: |Nurmal

From the drop-down list, select Send Voice Message.

* Load from file
Click this link and locate the audio file on your PC.

= Record Message

Click this link to record a new voice message.
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Play back message
Click this link to play back the voice message.

Specify Call Type, Channel, and Call Target for a voice message.

Note: To send a Voice Message to a subscriber from the phone
book, click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

Priority
From the drop-down list, select the priority with which the voice message
will be sent.

6.5.6.5 Send Signaling

266

Cuick Command X

Mame: |Signal 1

Command

Command: ‘Send Signaling

Radio System: ‘Capadt\r Plus #1

Target: ‘Firemen

Ll Ll L] 1]

Type: ‘Cusmm

Freg.2 (Hz)

Duration {ms) Pause (ms)

dp Add Delete % MovelUp w Move Down
o [ e

Command
From the drop-down list, select Send Signaling.

Radio System
From the drop-down list, select the radio system.

Target

From the drop-down list, select the target group to which the signal will be
sent.

Type

From the drop-down list, select the signaling system type (Quick Call I,
Quick Call Il, DTMF, or Custom).

If the Custom type is selected, specify the Frequency 1, Frequency 2,
Duration, and Pause for the signal to be sent.
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6.5.6.6 Send Command to Control Station

Quick Command

MName: ICommand to Control Station

Command

Command: ISand command to Control Station j
Control Station Command |
Iv:
PINS SET ON
PING SET ON
PING SET OFF
PING PULSE
o Add X Delete
Cancel

= Command

neocom
software

From the drop-down list, select Send command to Control Station.

= Click Add

e Control Station
From the drop-down list, select the Swift Agent connected to
TRBOnet Server.

¢ Command

From the drop-down list, select the PIN number and its value.

6.5.6.7 Request To Talk

= Command

Quick Command

MName: IR'I'I' 1

Command

Command: IRequest To Talk

¢~ send to Radio Group
@ Send to Radio

Recipient:

@ 13
V@ 125
@ 235
1@ 555
1@ 3333
C1@ 2+
1@ 5555
(@) Radio 300

Selected: 1

|

From the drop-down list, select Request To Talk.
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= Send to Radio Group
Choose this option to send the request to talk to radio groups registered in
the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the request to talk to individual radios
registered in the system. In the Recipient box, select target radios.
6.5.6.8 Custom Event

= Command
From the drop-down list, select Custom Event.

= EventID
Specify the event ID.

6.5.6.9 Send Swift Command

Quick Command x
Name: |Swif‘t 1
Command
Command: ‘Send Swift Command j
Swift Command: ‘Swiﬂ: Command 1 ﬂ
0=
0=
¥ Send to Radio Group
" Send to Radio
Recipient:
System Group
Capacity Plus #1 Firemen |
o Add X Delete
oK Cancel

= Command
From the drop-down list, select Send Swift Command.

= Swift Command
From the drop-down list, select the appropriate Swift command.

Enter the required parameters, if any.

= Send to Radio Group
Choose this option to send the Swift command to radio groups registered
in the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the Swift command to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.7 Queued Messages

This feature enables dispatchers to send audio messages even if the channel is
currently busy. The dispatcher records a message to be sent to a busy channel and
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then TRBOnet automatically forwards this message a
available:

File View Map Teols Help

VOICE Dlspatch Radio Interface

a ‘R Online Dispatehers
D pispatcher 1

& Group

© ) Cleaners
(%) Radio 200
(£)(D Radio 201

) playback [ Save~ (2 Print |[ 11 Pause < Clear - & Reload

s soon as the channel becomes

| [ Fitter By Radio | = Grouping |7 Auta Filter

Date | Radio Syst... | Sender | Recpient

| Message

| Details | Note |

15Hov-2015 18:26:28  Repeater
15Nov-2015 18:26:35  Repeater
36 16+ov-2016 10:22:05

| 4| < | Record 679 of 679 v || «|

Dispatcher 1 Cleaners
Dispatcher 1 Firemen
server Al

Dispatcher Dispatcher.
Dispatcher Dispatcher.
Connection to Repeat.,

Members: Dispatcher 1
Members: Dispatcher 1

Recent CallEvents | Recent Cals | RequesttoTok | RadioState | Active Tasks | Active Routes User Activity | Mop | Cameras

6127001 &3 B & | © Dispatcher 1 | (8 Licensed to: demo Dema License

‘ @ Active~

To queue an audio message for delivery to the selected recipients, first record a
message by clicking the Record button. Alternatively, you can select an MP3 or WAV
audio file from any storage location, or select a prerecorded message from the

library.
6.5.7.1 Select Audio File

e Click File > Open Audio File and browse for the audio file on the local PC.

Open Audio File...
Audio Message Library
= . ]

Voice Message

6.5.7.2 Audio Message Library
You can select an audio file from the Voice Message
e Click File > Audio Message Library.

templates.

Saved Audio Files

GF Add % Remove | v Filter | Hot Key

Filename Description Severity Hot Key Visibility

Alarm Tone Alarm Hidden
» | Bobby.mp3 Information

Daisy.mp3 Information . Link

send |

cance_|
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e Select an audio file in the list and click OK to use this file as a queued Voice
Message.

6.5.7.3 Record Audio File
You can record a voice message that can be sent to selected radios.

e Click Record > Record audio to open the recording tool:

Record audic

Convert Text to Speech

= Click Start and start talking to the microphone.

Record audio

00:17

"-"lll""""""""‘u'\iﬁll'1L"lﬁ\\ I"'-'L"'H'n‘-,_"f-.‘l"- ‘t;_,.___.____._.__.___._

Convert Text to Speech

= Click Stop to stop recording the message.

Convert Text to Speech

|u Send HL] Cancel | |H Save |‘|

= Click Send to send the recorded message immediately.

= (Click Save > Save as file to save the recorded file as an audio file on the
PC.

Or:

= (Click Save > Save as Saved Audio File to add the recorded file to a list of
the Saved Audio Files.

6.5.8 Activity Monitor Panel

While in this panel, the dispatcher can perform a wide range of tasks, including:
¢ Monitoring and listening to recent calls and viewing system events
e Monitoring selected radio state
e Monitoring active tasks for selected radio
e Monitoring active routes for selected radio
e Enabling and disabling User Activity monitoring
e Displaying selected map in a compact view mode

e Monitoring cameras connected to Dispatch Console
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6.5.8.1 Recent Calls/Events

In the Recent Calls/Events tab, the dispatcher can monitor recent Server events,
view and listen to recent calls.
File View Map Tools Help

Voice Dispatch
EBl=t & RV a8

Radio Interface |&]9)
- Radio Interface|_Recent Cals/Events
~ Quick Commands ~
: @ @@1 o

5o Eo<p Cooe )
() ® 125 Pete) Eev Queued Messages  [X]

epeater
ree chann
alcal

[ Repeater #1: Slot #2 [ =@
Free channel

)@ 222 N
(#)(® 235 Basi) oe v

£)( Radio 200
#)(2) Radio 201

o: Selected Channels

Voice Message

Q Allcall

A1, Voice Dispatch hd
“ecent Calls/Events »
g Location Tracking 5 Playback | Save~ (= Print | 11 Pause - Clear ~ & Reload | [ Filter By Radio | = Grouping |\ Auto Filter
Date Radi System Sender Recpient | Message Detziis Note
@ Job Ticketing -
[ 16-ov-2016 15:22:16 Repeater #1: Sot#2  Administrator Al Al Call from dispat.... Members: Administrator
[j Route Management [ 16-Nov-2015 15:22:15 Repeater #1: Slot 1 Administrator Al All Call from dispat... Members: Administrator
- [0 15ov-2016 15:22:15 Intercom Administrator Al Intercom Call: Disp... Members: Administrator
5] RFID Tracker I6ov-2016 15:22:12 Repeater #1:Slot =2 Administrator  Cleaners  Dispatcher ‘Adminis... Members: Administrator
I640v-2016 15:22:12 Repeater #1:Slot #1  Administrator  Firemen Dispatcher ‘Adminis... Members: Administrator
[~ iext Messoues [ 16+0v-2015 15:22:07 Repea jot=1 Administatr Al Al Call from dispat... Members: Administrator
(7 16ov-2016 15:22:07 Repeater #1: Slot#2  Administrator Al Al Call from dispat.... Members: Administrator
ﬁ . [ 15-Nov-2016 15:22:06 Intercom Administrator Al Intercom Call: Disp... Members: Administrator
B teo-2015 15,3309 235 Al Reset Geofending d
= " Record 50f 636 » | ] « S
e Q ent Cals/Events  RecentCalls | RequesttoTalk | RadioStste | Active Tasks | ActiveRoutes | User Actvity | Map | Camerss Y,
[@ 127001 &3 B B | & Dispatcher 1 | [ Licensed to: demo Demo License @ Active -

Voice Recording
Play back selected call(s)
e Select the voice call recording you want to play back and click the E5) Playback
button on the left of the toolbar.
The Audio player box will appear.

[ Audio player H

Duration:
Left:

Position

T Pause 1| Player re Open
All Call from dispatcher ‘Administrator’ (00:03)
Clear

= Click the Play button to play back the recording.
Click the Pause button to make a pause.
Click the Stop button to finish playing back the recording.
Click the Open button to select a new audio file to play back.

Note: You can play back multiple recordings in a row. Use the CTRL
and/or SHIFT keys to select multiple recordings you want to play

back. Then click the ) Playback button.

271



neocom
sofFtware

272

Save selected call(s)

e Select the voice call recording (or multiple recordings, with the help of
CTRL/SHIFT keys) you want to save as an audio file.

¢ Click Save > Save Selection as Individual Files to save selected recordings in
separate files.
Or

e C(lick Save > Save Selection as Single File to save selected recordings in a
single file.

¢ In the Save As or Browse For Folder dialog box, browse for the folder where
you want to save the file(s).

Recent Calls/Events Toolbar

5 Playback |zl Save~ () Print | Il Pause ¥ Clear ~ % Reload | [F Filter By Radic | = Grouping 7 Auto Filter % Default Settings | " Details | [ Show Notes ] Add Note Add Message
Click the Pause button to pause updating the Recent Calls/Events log.

Click the Clear button to clear the Recent Calls/Events log records.

Click the Reload button to reload all log records.

Click the Filter By Radio button to filter log records by a selected radio/radio group.
In the Radio List pane (the upper-left-pane of the main window), select a radio or
radio group. The Recent Calls and Events for a selected radio will only be displayed
in the Recent Calls/Events pane.

Click the Grouping button to group log records. Select the column you want to
group log records by. Drag and drop the selected column header to the Grouping
field.

Click the Auto Filter button to set a filter for the recent calls and events. You can

filter the Recent Calls/Events list by any parameter. For example, to filter the list by a
selected Sender, select the Sender column (1), and start typing the sender name (2).

[ Playback [ Save~ () Print | 10 Pause <# Clear ~ i Reload | [ Filter By Radio | = Grouping|| 17 Auto Fitter || Details | ["] Show Notes

Date Radio System

Dispatcher ‘Dispatcher 1" calls aroup ...
Dispatcher 1 Al Call from dispatcher ‘Dispatcher 1'...

16-Nov-2016 16:54:16 Repeater #1:
16-Nov-2016 16:53:57 Repes Dispatcher 1 olice Dispatcher Dispatcher 1" calls group
16-Nov-2016 16:53:57 Repe: Dispatcher 1 Dispatcher Dispatcher 1" calls group "

Dispatcher 1 Al Cal from dispatcher Dispatcher 1.,

Dispatcher 1 Al Call from dispatcher ‘Dispatcher 1'...

15-Nov-2016 15:26:35 Repes

Dispatcher Dispatcher 1 calls gr

B 4C M TN4E 0.7E.70 Marpon 4. Clad P bk it 41— S—
| <[ 'Record 0 of's0_» [ w [ ¢ .
=le - it Fiter

Recent Calls/Events | RecentCalls | RequesttoTak | RadioState | Active Tasks | ActiveRoutes | User Activity | Map | Cameras

Click the Default Settings button to apply default settings to all log records.

Click the Details button to see the talk session participants:

[ Playback [ Sove~ (2 Print | 11 Pause <# Clear - '&i Reload | [ Filter By Radio | = Grouping '\ Auto Filter ||| Details | [ Show Notes

Date Radio System Sender ¥ Recpient Message Detais
16-Nov-2016 16:54:16 Repe: LSt =1 Dispatcher 1 Firemen Dispatcher Dispat r ' ... JMembers: Dispatcher 1 -
[ 16-4ov-2016 16:5%03 Repe: lot £2 Dispatcher 1 Al Al Call from dispatcher ‘Dis... [Members: Dispatcher 1
16-ov-2016 16:53:57 Repe: lot £2 Dispatcher 1 Police Dispatcher Dispatcher 1'c... [Members: Dispatcher 1
16-Nov-2016 16:53:57 Repe: Jot #1 Dispatcher 1 Firemen Dispatcher Dispatcher I'c... [Members: Dispatcher 1
D 16-Nov-2016 15:35:23 Repes 1 Dispatcher 1 Al All Call from dispatcher Dis... [Members: Dispatcher 1
D 16-Nov-2016 15:35:16 Repe: #1 Dispatcher 1 Al All Call from dispatcher ‘Dis.... [Members: Dispatcher 1
15-ov-2016 18:26:36 Repe: lot #1 Dispatcher 1 Firemen Dispatcher Dispatcher 1'c... [Members: Dispatcher 1
15-Nov-2016 18:26:28 Repeater lot #2 Dispatcher 1 Cleaners Dispatcher Dispatcher I'c... [Members: Dispatcher 1
] 15-Hov-2015 18:26:21 Repeater #1: Slot #1 Dispatcher 1 Firemen Dispatcher ‘Dispatcher 1" c... mhers: Disnatrher 1 A
LIk ord 0 LIRS 3
B - Eciit Fiter

Recent CallsEvents  RecentCalls  RequesttoTak  RadioState | Active Tasks | ActiveRoutes | User Activity | Map | Cameras
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Click the Show Notes button to enable the Note column. All notes added by the
administrator and dispatchers for the recent calls and events will be shown in the
Notes column. So, you can mark recent calls and events to later find them by notes.

Click the Add Note button to add a note for the selected recording and/or event.
The notes will be displayed in the Recent Calls/Events log if the Show Notes mode

enabled:

Click the Add Message button to add a message for dispatchers to the Recent
Calls/Events log.

Add user message X
Recipient: | Al j
Severity: ® Information -
Message: Test| j
15
Cancel
Recipient
Select either All or an individual dispatcher if you want to see the message.
Severity
Select the severity level to inform dispatchers about the level of importance.
Message
Enter the message text.
Click OK.

As a result, the message will be added an event to the Recent Calls/Events
pane.

6.5.8.2 Recent Calls

On the Recent Calls tab, the dispatcher can see and configure the latest Voice calls,
including Private, Group, and Intercom calls:

Recent Calls

Types: | & Private | &b Group OAII Call | <3 Clear 7 Filter

Most Recent Call aller Call Mumber Actions

-1 27.04.2017 12:1" 1. 3 5 13L&
d All call Group Call Private Call
4 1 calls:1 1 2 Calls: 3 Calls: 1
A7 27042017 12019 27.04.2017 12:18 27.04.2017 12:18

+| 27.04.2017 12:03 235 1 |2 L |||

Recent CallsfEvents | RecentCalls  RequestToTalk  Radio State | Active Tasks | Active Routes  User Activity = Map =~ Cameras

e Click the Private button (1) to display the latest Private calls.
e Click the Group button (2) to display the latest Group calls.
e Click the All Call button (3) to display all call types, including Intercom calls.

In a Call Box, you can see the number of calls and the last call date and time:

LS4~ | Allcall
2 A calls:1
S 2014-07-07 14:02:47
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Click the IS/ button to start a Private call to the Sender-Radio (Radio is displayed in

6.5.8.3

the Sender column).
Click the V] button to mark the calls as viewed.
Click the |/ button to clear the recent call history.

Request to Talk

On the Request to Talk tab, the dispatcher can see Missed Calls and Requests to

Talk:

Reguest To Talk
AQ Missed Call

Most Recent Call
18.04.2017 17:30

Types: B Request To Talk | View: | [ Table BB Cards

Accepted/Queued
Dispatcher 1

F Clear

Caller Call Number

@® 125

Call Type
l Request To T...

|4 4 |Record 1of 1 k| m M|

Recent Calls/Events | RecentCalls = RequestToTalk RadioState | Active Tasks | User Activity = Map

e Click the Missed Call button to display Missed calls.

e Click the Request to Talk button to display Requests to talk.

e Click the Table button to display the calls in a table view.
e Click the Cards button to display the calls as a set of cards.

e Click the Clear button to clear all the records.

7 Filter

e Click the Filter button to set a filter for the records. You can filter the records
by any parameter. For example, to filter by the caller select the Caller column,
click in the empty row and start typing the caller name.

¢ Click the Options button to specify options related to Request to Talk:

274

Request To Talk *
Dispatcher! | Notifications

¥ Enable Request To Talk workflow
¥ Show RTT notifications in @ pop-up window
v after dicking Accept, start a return call
¥ Play a sound when RTT notifications arrive
¥ show notification in the Windows tray
I¥ Synchronize with other dispatchers
v automatically delete Request To Talk record after responding
Iv wait for response from caller

I¥ Enable Responses to a Radio Group

Talk Group: Home Radio Group j

Cancel
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= Show RTT notifications in a pop-up window
Select this option so that incoming Request to Talk messages will pop up
over the application window.

Request to Talk

J 125
. The Request to Talk has been received.
_J You must accept or reject it.

Reject Queue

o After clicking Accept, start a return call
Select this option so that a return call will start as soon as the Accept
button is clicked.

= Play a sound when RTT notifications arrive
Select this option so that an alert tone will sound when a Request to Talk
arrives.

= Display notification in the Windows tray
Select this option so that a notification will be displayed in the Windows
tray when a Request to Talk arrives.

= Synchronize with other dispatchers
Select this option so that a Request to Talk sent to one dispatcher will
automatically be forwarded to all dispatchers.

= Automatically delete Request to Talk record after responding
Select this option to automatically delete the corresponding record after
the Request to Talk call is responded.

= Wait for response from caller
Select this option so that a Request to Talk will be considered responded
only if the radio has answered to the return call.

= Enable Responses to a Radio Group
Select this option so that a response to a Request to Talk will be made to
the selected radio group.

e Talk Group
From the drop-down list, select the radio group.

Note: If the Home Radio Group is selected, and the Home Group
is not specified for the radio that initiated a Request to Talk,
then the response to this Request to Talk will be made as
an All Call.
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On the Notifications tab, specify the following parameters:

Request To Talk X

Dispatcher 1

¥ Send notifications to caller
¥ Autodetect notification type
" Send Text Message

" Send Audio Message
Notification texts:

Queued: |Ca|| queued

Rejected: |Ca|| rejected

Not Available: |Dispatcher is not available

Cancel

= Send notifications to caller
Select this check box to notify the radio when a request is rejected, queued,
or the dispatcher is unavailable.

e Choose one of the option buttons below to specify the way the radio is

notified.

v Autodetect notification type
Choose this option button so that the type of notification will be
selected automatically depending on whether or not the Text
Messages Service is enabled on the radio.

v Send Text Message
Choose this option button to send text notifications to the radio.

v Send Audio Message
Choose this option button to send voice notifications to the radio.

¢ In the Notification texts boxes, enter the corresponding notification

texts. These texts will be used when sending text notifications to the
radio.

6.5.8.4 Radio State

On the Radio State tab, the dispatcher can see the log of radio states for the radio
selected in the Radio List pane (the upper-left-pane of the main window):

125 (Pete)

@=@

Show Notes Add Note Add Message

Date Dispatcher 4/smEte
5”;;'”;1 Set #2 17-Nov-2016 11:35:22 Reset Geofencing Alarm -
S 7oy IuTE s | T Mev2us 113515 Geofendng e: 17-Nov-2016 11:35:15; Latitude: 59°56'27. 78°N; Longitud...
spead:  D.4km 17-Nov-2016 11:35:15 Radio left oute 1
Atude:  Unknown 17-Nov-2016 11:35:15 Radio left allowed region Route 1'
Lofitude:  59°5627.78°N 16-4N0y-2016 10:34:20 Radio Online
Longitude:  30°16'47.08°N 15-Nov-2016 18:47:22 Radio Offine
15-Nov-2016 14:01:27 Radi Oniine
15-Nov-2016 14:00:25 Radio Online
15-Nov-2016 11:25:26 Radio Online

RecentCals/Events | RecentCalls | RequesttoTak | Radio State | Active Tasks | ActiveRoutes | User Activity | Map | Cameras

In the Radio State pane, the dispatcher can do the following:
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Click the Show Notes button to enable the Note column. All notes added by the
administrator and dispatchers for the radio state records will be shown in the Notes
column. So, you can mark radio state records to later find them by notes.

Click the Add Note button to add a note for the selected radio state record. The
notes will be displayed in the Recent Calls/Events log if the Show Notes mode
enabled:

Click the Add Message button to add a message for dispatchers to the Radio State

log.

6.5.8.5 Active Tasks

On the Active Tasks tab, the dispatcher can monitor all active tasks for the selected
radio (for example, Lone Worker, Active Routes, and other tasks).

il stop | = Grouping "\ Auto Filter @ Default Settings

Task Radio State

Lone Worker 1 125 (Pete) R0 = 12:31
Timer 235 (Basi) 0.00:29:16 - Timer started.

id| 4] 4| Record 102 b [ wr[mi[ ¢
Recent Calls/Events | Recent Calls | RequesttoTalk | Radio State | Active Tasks  ActiveRoutes | User Activity | Map | Cameras

The dispatcher can manage active tasks as follows:

Click the Stop button to stop executing the selected task.

Click the Grouping button to group the tasks. Select the column you want to group
tasks by. Drag and drop the selected column header to the Grouping field.

Click the Auto Filter button to set a filter for the active tasks. You can filter the tasks
by any parameter. For example, to filter by selected radio select the Radio column,
and start typing the radio name.

Click the Default Settings button to apply default settings to all active tasks.
6.5.8.6 Active Routes

On the Active Routes tab, the dispatcher can monitor all active routes.

b start | 1l Pause Ml stop | =} Edit @) Export~| = Grouping '/ Auto Filter ©» Default Settings
Name Route
b Route 1 00:01 12:21 1231 10:00 10:40

(¢
17-Nov-2016 12:20 Pointi o

#|«| <« Record1of1 » | » M <
RecentCals/Events | RecentCalls | RequesttoTak | Radio State | Active Tasks | Active Routes | User Activity | Map | Cameras

The dispatcher can manually set statuses for route checkpoints. To do this, right-
click a route point and from the drop-down menu, select the desired status.

Waiting

The checkpoint is waiting to be attended.
Attended

The checkpoint has been attended on time.
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6.5.8.7

6.5.8.8

6.5.8.9
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= Unattended

The checkpoint hasn't been attended on time.
= Alarm

The checkpoint is in Alarm mode.

* Note
Click this item to add a note to the selected checkpoint. The note will be
displayed in the pop-up window that appears when hovering the mouse
pointer over the checkpoint.

User Activity
e Click the User Activity tab to monitor the activity of radio users:

User Activity
% Disable the User Activity monitoring | > Cenfigure.

Off Duty A Time On Duty A Time User Activity #1 4| Time
@ 111 - @ 235 13:15:01 @ 125 13:15:09
R

(@ Radio 200

(@) Radio 201

(&) Radio 202

(@ Radio 203

(&) Radio 204

@) £ =i N5 ~2

Recent Cals/Events | RecentCalls | RequesttoTalk | Radio State | ActiveTasks | ActiveRoutes  User Actvity | Map  Cameras

e C(lick the Configure button to configure the User Activity list:
Map

On the Map tab of the Activity Monitor panel, you can monitor location of radios on

the map and simultaneously perform all available actions in the Radio Interface
pane (make voice calls, send messages, disable and enable selected radios, and
other actions):

G} S} % (| Fiter | @] @[ Q[ @] 17 | Show Beacons: 41 v | & Ruler (% FindonMsp~ il 4 Drawing Panel (A Route~ <& Geofencing il] CoverageMap || SelectMap &% Google Earth
5
- %
2 d
: %
2
%
®
Z
|
o
3
&
v‘d’?a‘

s
Walt © Bt
235 (Basil) =
Lot

-
125 (Pete) 5 itude: 59'5627 56"N: Longtude: 301631 91"

Recent Calls/Events | Recent Calls | Request to Talk | Radio State | Active Tasks | Active Routes | User Activity Map Cameras

For more details on map options, see section 6.6, Location Tracking (page 281).

Cameras

On the Cameras tab of the Activity Monitor panel, you can monitor cameras
connected to Dispatch Console.
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ff Add -

7-2017 4TB 15:22:02

1

Close Close

Recent CallsfEvents | RecentCalls | RequestToTak | Radio State | Active Tasks | Active Routes | User Activity | Map  Cameras

e Click the Add button and select a camera to be displayed on the tab.

Note: You can add up to four cameras to the Cameras tab view.

6.5.9 Phone Calls

The Telephony function allows making calls from telephones to radios and vice
versa.

The phone system must be previously configured by your TRBOnet administrator.
6.5.9.1 Phone Calls from/to Dispatch Console

To make a phone call from the Dispatch Console:

@ Telephony / 2 |£|
|i‘|’el: 2409 ¥ - |
3 _Eﬂ (I Menu 4 &=
June1 | une2 | wnes |
1 ‘| Line 4 \”\ Line 5 |H| Line & ||
===
R | e |
(L | SR | SR
R | |
\ | [ |
N J

¢ In the Telephony box, select the Line (1), enter the phone number (2) and click
thel ™™ | (3) button.
Terminate a phone call

== | button.

e In the Telephony box, click the |
Open a phone book

¢ In the Telephony box, click the ellipsis (...) button (2) or click Menu > Phone
Book (2):
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@ Telephony 2 \ (%]
|| %]

P Mo | =

Hold Call

— Forward Call...
" ine 1 —_— ]

1°F 4 dr 5 4 s 4

‘l 7 |||| 8 IHI 9 ||
‘l * |||| o IHI # ||
. J
Answer an incoming call
@Telephorw IE‘
|walt - ]
Lo | menu | e

[Ctine t ]| tine2 oy Lnes

‘I Line 4 |||| Line 5 |H| Line & ||
1 2 3
% El (i1
7 8 c
® 0 #
- J

¢ In the Telephony box, click the E (3) button.
Forwarding Phone Call to a Radio

e While in a call, click Menu > Forward Call.

@ Telephony
|Tel: 2409 -
-—n

p-Line 4y

Pt

e i

‘l - |||| - IHI : ||

‘l - |||| - IHI o ||

- J

Forward Call X
P J Specify text to searh
a -

~ 125 (Pete)

g Dispatcher 6 235 (Basil)

E| Radio — 1

Radio Group 2
Q Fhone
4 3

Conference Forward | Cancel
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6.5.9.2

6.6

e Click the Radio tab (1), select the radio (2) and click Forward (3).
Add call participant(s)

e C(lick Conference (4).

Note: Only one radio or radio group can participate in a conference call.

Making Telephone Calls from Radios

Make a DTMF call

Note: Only 1.07.02 and higher firmware version for all radios equipped
with dialing keyboard support DTMF.

To make a DTMF call, do the following:

=  Press the PTT button on a portable radio and hold it.

= While holding the PTT button, dial a phone number and press # (For example,
0079521112233#).

= Release the PTT button. The server will automatically initiate a phone call.

Call by sending Text Message

To make a phone call, send a text message with the text PrefixN where:
o Prefix — is a short text to define the special text message (for example, sip:);
¢ N - the phone number.

For example, to initiate a call to a phone subscriber "123 456 7890", the following
text message must be sent to TRBOnet Server: "sip:1234567890".

Terminate a call

To terminate the call, press the PTT button and then press # twice on the radio.

Location Tracking

In the Location Tracking tab, the dispatcher can monitor selected radio location on
supported maps, open different maps in separate tabs and toggle between map
tabs:
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File View Map Tools Help

Location Tracking

: o | KV

(£) (D Radio 204

© ¥ |y Firemen o
BHOm

7 (&) @ 235 (Basil)

[ intercom

7P 1: Line free

Group 10

[Jprivate call

Fcrow 20

- ¥ [ Beacons
1@ Beer
¥ (@ Coffee
@ Tea

Ejkﬂltzhhnagzm‘t

| &9 [ Map Objects
ci

%
B < E :
% b 2
& Hospital No2
Z

ol
A Lsiitude: 53°56723.98"N; Longitude: 30°16°34.85"E

)P ragoz0 AW . e ) rment
= PR %
e .
(1) voice Dispatch - 038 ||& H ez Maproutes
‘bc\‘c}‘ [¥] 3 Route 1
Location Tracking
P = ! o
_ Walt - N
@ gobiicceting \ 125 (Pete) M‘“‘ %
% 100m 235 (Basil) 2 i
AL

@ Recent Calls/Events el
0] soo tacker [ Playback [l Save~ (i Print | 11 Pause ¥ Clear - '&i Reload | [ Filter By Radio | = Grouping 7 Auto Filter > Defautt Settings ”
D Date Radio System | Sender Recipient Message Details Note
E‘Q 18-Nov-2016 10:41:45  CapadtyPLUS Server 235 The Route 1is finished i‘
ﬁ Voice Recording o 17-Nov-2016 20:51:23  CapadtyPLUS 345 125 Private Call: Dispatcher '34...  Members: 345, 125
o 17-Nov-2016 20:51:16  CapadityPLUS 125 345 Private Call: Subscriber '125... Members: 125
o o 17-Nov-2016 20:50:44  CapacityPLUS 456 125 Private Call: Disp: er 45, Members: 456, 125
ueal M © 17Nov-2016 20:50:32  CopactyPlUS 456 125 Private Cal: Dispatcher '45... Members: 456, 125 o
W« | 4| Record10f392 »|w || < LH

"53] Radio Allocation Recent Calls/Events | RecentCalls | RequesttoTak | RadioState | Active Tasks | ActiveRoutes | User Activity | Beacons | BeaconEvents | Taglist

127001 & B | & 45| (8 Licensed to: demo Demo License | @ Active-

The main user interface elements are as follows:
Radio List pane

Voice panel

Map panel

Objects panel

v W=

Activity Monitor panel

While in the Activity Monitor panel, the dispatcher can perform a wide range
of tasks, including:

= Monitoring and listening to recent calls and viewing system events
= Monitoring selected radio state

= Monitoring active tasks for selected radio

= Monitoring active routes for selected radio

= Enabling and disabling User Activity monitoring

= Monitor beacons and beacon events.

6.6.1 Objects

On the Objects panel, the dispatcher can view and enable/disable the following
objects:

e Beacons - all beacons connected to the system.

e Map Objects — all manually created map objects and predefined objects
created with the Map Drawing toolbar.

¢ Map Regions — all map regions created with the Map Drawing toolbar (use
the Add Polygon tool to create a map region).

¢ Map Routes — all map routes created with the Map Drawing toolbar (use the
Draw Route tool to create a map route).
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6.6.1.1

6.6.1.2

Beacons

TRBOnet Dispatch Software provides the Indoor Positioning feature to monitor the
location of radios inside a building where no GPS signal is available. This feature
requires additional hardware (the beacons spread around the building and the
option boards in radios). A radio user will be displayed on the indoor floor plan
when the radio enters the beacon coverage area. The beacon icon on the map
displays the amount of radios that are currently in the beacon coverage area.

File View Map Tools Help

Location Tracking Map |8 |<0]EB] oviects |
=k &V 4 BING_ROAD X' scheme X| E
Gy | [L§ Tea Show Bea Al Show Info: B
+ —
I 7~ =
+ - ¥ ) Beer
@ I RQcoffee 2
A
v|| - Tea0) | i | 3 2 Tea
oon ] Q - T Man Objects
[O[=] camera 1
‘ i / - N | 5 (@] Hospita
N ) i & rol
— < —
[ ‘ [ Man Reg
/1 ‘ | \\ 1 (25 Map Route:
Y " Moo 11
3| \ /
@) | /
I ‘ I[Coffee 1 .
M ® N !
235
o3| /
™|
ﬁ osce Show: |Al 7 AutoFilter ©» Default Settings
Name Description Radios Previous Detection
Ca Reports x,g. Tea 08.06.2017 14:53:58
(3 Coffee 235 08.06.2017 14:55:18
15 event viewer {9 Beer Beer tap 08.06.2017 14:53:34
mmmmmmm
[_3'! Radio Allocation Recent CalsfEvents | Recent Calls | RequestToTalk || Radio State | Active Tasks | Active Routes | User Activity Beacons | BeaconEvents | TaglList
127001 &3 B | & Administrator | [28 Licensed to: demo @ Active-

Beacons are displayed on the building floor plan (1) and in the list of beacons (2) in
the Objects panel. When a radio comes into the range of a beacon, they both are
highlighted in yellow on the floor plan/map (3).

For more details on beacons, see section 6.13, Beacons (page 322)
Map Objects

The dispatcher can create custom and predefined map objects using the Drawing
Panel. The dispatcher can attach 2D or 3D floor plans for Indoor Positioning.

For more details on creating map objects, see section 6.6.2.7, Drawing Panel
(page 287).

In addition, the dispatcher can import and export map objects.

Importing map objects
¢ In the Objects panel, right-click the Map Objects folder and choose Import.
In the Import Map Objects dialog box:
= Click Load and select on the drop-down menu select the file format (Excel,
CSV, or KML/KMZ).

Note: The Excel file you are importing from must contain at least
three columns (Name, Lat and Lon). Also note that the first
non-empty row in the table will be considered as a header
row. The .CSV file must contain 8 comma-separated values
in each row.

= In the Open dialog box, locate the desired file and click Open.
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= Click Import.

As a result, imported map objects will be added to the list of map objects.

Exporting map objects
¢ In the Objects panel, right-click the Map Objects folder and choose Export.
In the Export Map Objects dialog box:
= Select the required objects by checking their check boxes.

= Click Export and from the drop-down menu select the file format (Excel or
CSV).

= |n the Save As dialog box, locate the folder where you want to save the file,
type a filename, and click Save.

6.6.1.3 Map Regions

The dispatcher can create map regions that can be used for Geofencing rules. The
map Regions can be created manually on the map (click any point on the map to
select it as a region border) or, the dispatcher can add map points by GPS
coordinates to create a region.

For more details on creating map regions, see section Draw a Map Region
(page 287).

In addition, the dispatcher can import and export map regions.

Importing map regions
¢ In the Objects panel, right-click the Map Regions folder and choose Import.
In the Import Map Regions dialog box:
= Click Load > Excel.
Note: The Excel file you are importing from must contain at least

two columns (Name and Points) and at least three points
in the second column. Also note that the first non-empty
row in the table will be considered as a header row.

= In the Open dialog box, locate the desired file and click Open.

= Click Import.

As a result, imported map regions will be added to the list of map regions.

Exporting map regions
¢ |n the Objects panel, right-click the Map Regions folder and choose Export.
In the Export Map Regions dialog box:
= Select the required regions by checking their check boxes.
= Click Export > Excel.

= In the Save As dialog box, locate the folder where you want to save the file,
type a filename, and click Save.
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6.6.1.4 Map Routes
The dispatcher can create routes on the map that can be used for Geofencing rules.
For more details on creating map routes, see section Draw a Route (page 289).

6.6.2 Map Tools
The Map toolbar is located in the upper part of the Map pane:

~" BING_ROAD
G Slsle i F\t el El[EES . Show Beacons: Al v | Ruler “4 Findon Map~ 4 | &’ Drawing Panel (i Router <> Geofencing ff]| Coverage Map | | SelectMap &% Google Earth
cﬂ A %
3 2 %,
/1 %, e
A g
@ c
o 5 3,
< % % %
o 4 < 3 Z
% % % 3
5, &
2 o
prS
%
28 5, 9‘0"9
0% ‘o o 2
o s A c\‘e\ﬂ &)
Ll kg %,
Z

- Vasil'yevskiy Island b5
5 %

!
oP

A o o
ws N .
J £

¢ Cothedral R st 5553055 N, Longiude 065077 E |

6.6.2.1 Zoom in/out
e Click to zoom in a map.

e Click to zoom out a map.
6.6.2.2 Bookmarks

e Click to put a bookmark on the map.
e Click Save as Bookmark to save the map region as a bookmark.

Save as Bookmark X

Name: Prince garden

=

e The dispatcher can create any number of the bookmarks. To open a bookmark,
click and select the bookmark in the list.

6.6.2.3 Default View

e Click and choose Save as Default View to save current map view as a
default view. The dispatcher can save only one default view.

To open the default view, click and choose Show Default View.

6.6.2.4 Filters
Select the filters to display radios on the map:

- radio is online, beacons are detected;

- radio is online, GPS data is received,;
@I - radio is online, no GPS data is received;
- radio off, no GPS data is received.
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6.6.2.5

6.6.2.6

286

All filters are enabled by default. Click the selected icon to disable selected radios on
the map.

Click the button and select the visibility of the radios having On Duty and/or
Off Duty states.

Click the button and select which radios to hide according to the radio groups
and/or logical groups they belong to, and the map regions they are currently in.

Click the

button to toggle showing object names on the map.

Ruler

e Click to enable the tool to measure distances on the map.

o Left-click a point on the map to start measuring. Left-click intermediate points
and see the distance displayed at the mouse pointer.

Search by Address

The dispatcher can search map objects by their address.

Note: For online maps, Internet access is required!

. CIick|q Find on Map *| 51 d choose Address to find an address on the map.

Search by Address (BING_ROAD) ®

Broadway13 .

18 Broadway, Tamytown, NY 10551, USA
18 Broadway. Somervile, MA 02145, USA
18 Broadway, Denver, CO 80209, LSA

18 Broadway, Denver, CO 80203, USA

Close

e Click the address in the list to display it on the map.
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file View Map Tools Help
Location Tracking Map

& 1: Line free
Faical B Search by Address (My Map)

Broadway 18 A

@ ® 235 My Map X[ Floor plan X/
B GLC ~ | Filter: Show Beac Al [ Map Objects
a 8 roree 08 s, en [@B]O[B] 7 [ 2] srewescons S Somie AT 58 e
ez 18 Broadway, Tamytown, NY 10531, USA
18 Broadway. Lawrence. MA 01840, USA -] (@) Hospital
() voice Dispatch 18 Broadway, Park Fidge. NJ 07656, LSA 2 @ poice
2 18 Broadway. Améyvile. NY 11701. USA
8118 Broadway, Taunton, MA 02780, USA =/ Map Regions
s, Location Tracking [y Py 18 Broadway, Ashevile, NC 28801, USA 97 Region 1
s & Z 18 Broadway. Bayonne, NJ 07002, USA B v Routes
o, & ) 18 Broadway. Newport, Rl 02840, USA
ﬁ Joh Trcketing s 18 Broadway, Denville, NJ 07834, USA W e 111
(1)
Route Hanagement X
8
| ] RemD Tracker
wm (8 - o
I ()
[] Text Messages Y 2
L 9
E " Recent Calls/Events
) Playback [l Save~ &) Print | 11 Pause < Clear - i Reload | S Filter B hails | 7] show Notes 7
@ Reports Date | Radio system | sender | Recpient [Message [Detals [
42 09.05.2017 14:43:57 Server Al Connection to ‘Capacity Plus 1* has been. ﬂ
{5 Event viewer 09.06.2017 12:43:30  Capadity Plus 1 Administrator 1 Dispatcher ‘Administrator’ cals group '11... Members: Administrator, 125
. 09.06.2017 12:40:06  Capacity Plus 1 125 11 Radio '125' calls group '11' (00:08) Members: 125
- 09.06.2017 12:39:55 Capadty Plus 1 Administrator 11 Dispatcher 'Administrator’ calls group '11... Members: Administrator
09.06,2017 12:38:34 Capadty Plus 1 Administrator Police Dispatcher 'Administrator’ calls aroup 'Po... Members: Administrator A
|+ 4] Record10f305 k| w[m[4] »
E Recent Calls/Events | Recent Calls | RequestToTalk | Radio State | Active Tasks | || ser Acthity | Beacons | | TagList |
127001 &3 & | B Administrator | [ Licensed to: demo | @ Active-

6.6.2.7 Drawing Panel

e Click | & Drawing Panel to display the Drawing toolbar:

ek
5, 2
= 5
C 2
% %
) % s
5 5
Z £ %
o )
2 3, o
% e} 0
% #
’z.o 9@"
? “po‘l
)
A ‘
Hospital % B
= Vasil'yevskiy Island
-ﬁ-‘ Saint
i Andrew’ - = - "
‘5@1_ c:m’:;:j ‘ Latitude: 59°56'31,82" N; Longitude: 30°16'46,55" E

Draw a Map Region

Draw a region manually

e Click and choose Draw on the map.

e Left-click points on the map to create a new map region.

x|

B1iG_RoAD X|[Indoor plen X
), g Fiker Q[@] 7 [2] showBescons ~ | Ruler [ Drawing Panel] ] Coverage Msp »
TRoRAO®GR 22| Custom Object~

Draw a polygonal region Save Cancel
Click on the map to mark comers of a polygonal region. If you make a mistake, right-dick to delete the last placed corner point. The first and the last points —
will be autoconnacted to form a dosed polygon. When you are done, dick Save and spedify additional properties of the region.

g Abiding place

S
o

Vasileostrovskaya B

‘\N
ke

@

e
% 17%
Hospital Na2
5.8

o

o >

2
\19‘* Latitude: 59°56'35.54"N; Longitude: 30°16'63.25"E

e Click the Save link to add a new polygon region.
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Object on Map X

General Region  Logical Groups

Mame: Zone 2

Description: Fecrete area

Cancel

= Name
Specify a name for the new map region.

= Description
Enter a description for the map region.

o
Region tab
Object on Map x
General Region | ogical Groups
Color: |-U,Dr 255 ﬂ
Fill region area
Transparency: |90 = %
Corce
Color

Select a color to display the region on the map.

Fill region area

Select this check box to fill in the region area on the map.
Transparency

Specify the transparency level (in percent) for the fill color.
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Draw a region by coordinates

e Click @ and choose Specify coordinates.

Create Region by Coordinates x
Latitude Longitude 3 6] ol
59,0000000|  25,0000000 Tafhinn™—
58,5000000  27,0000000 . -
58,0000000  25,0000000
Eesti
s
t
70 km
Latitude: 59,2827203; Longitude: 25,9457070 |-
% add ShEdit X Delete Selectmap

e Click the Add link to add a point.

Coordinates input - [m| s
Coordinate system: Decimal Degrees e
Coordinates
Lattude 50.9419768|"
Longtude: 30.2874584
0K Cancel

= Coordinate system

neocom
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From the drop-down list, select the convenient format (for example,

Decimal Degrees) for the coordinates.

Latitude/Longitude
Enter the coordinates of the point.

= Click OK to add the point.
e Click the Edit link to edit the selected point.
e Click the Delete link to delete the selected point.

e Click the Save button to add a region.

Draw a Route

e Click IE‘ and then set route points one after another by clicking on the map.

BING_ROAD X|| Indoc

<) Gl £ - Fites [ @@ Q@] 7 Show Beacons: | Al
7[> OlR Ao 060 a 29| Custom Object~

Ciick to place the

~ | Ruler | Find onMap~ 4, [ Drawing Panel| 7 Router gff] Coverage Map

 done, cick Save and provide addional route properties.

route waypoints on the map. Right-dlick to delete the last waypoint. When you ar

‘ ‘When adding waypoints, follow the actual road trajectory and do not place the waypoints farther than 5 km apart ‘

Zayachy N e v oo
sland

MO Morskoy Sin

Iy ad

Admiralteyskiy

MO Dvortsoviy okrug

4, )
<235 (Basil)
MO Nomyalt
125 (Pete)
Police department No 1

A z
7 Lattude: 59°5705.60"N; Longitude: 301206.21"E
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¢ Once you have finished drawing a route, click the Save link.

¢ In the Object on Map dialog box, specify a name and description for the
route.

e Click the Route tab.

Object on Map X

General RoUte  Logical Groups

Color:

R j

Fill region area

Transparency: (90

LIEN S
=

Tolerance zone (m): 100 meters

Cancel

= Color
Select the color in which to display the route on the map.

= Fill region area
Select this check box to display a transparent edge around the route line.
The edge width is specified by the value of the Tolerance zone parameter.

o Transparency
Specify the transparency, in percent, for the line edge.

= Tolerance zone
Specify the corridor width, in meters. If a radio will pass out of this tolerance
zone, the dispatcher will receive an alarm signal.

Add a Beacon

e Click @ and choose Place on the map.
e Click on the map where you want to place a beacon.
e Click the Save link.

The Beacon properties dialog box will appear.

¢ On the General tab, specify the following parameters:
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Type:
Name:
Major 1D:

Minor 1D:

Beacon properties

Description:

General Logical Groups  Cameras

iBeacon -

|Coﬁea

1
1

Coffee shop at the comer

Cancel

= Type

Select the beacon type from the drop-down list.

= Name

Specify a name for the beacon.

= Major ID and Minor ID
Enter the beacon’s major and minor ID exactly as specified on the iBeacon

device.

= Description

Add a description for the beacon.

neocom
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On the Logical Groups tab, select logical groups that will be associated with

the beacon.

On the Cameras tab, select the check box beside the camera that will be
associated with the beacon.

Note: You can also place a beacon by specifying its coordinates. To do
this, click @ and choose Specify coordinates.

Add a Point of Interest

e Click and choose Place on the map.

e Click on the map where you want to place a POI.

e Click the Save link.

The Object on Map dialog box will appear.
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Object on Map

Name:
ID:

Description:

Bind to PTT
System:

Group:

ral‘ Beacon Map  Logical Groups  Cameras

School dep

2 -

Look after

|Capacity Plus 1

|Firemen

=
K
Cancel

= Name

Specify a name for the new map region.

= Description

Enter a description for the map region.

= Bind to PTT

Select this option to connect the POI to a radio group in your radio system.
Clicking the object's icon on the map will start a call on the selected radio

group.
e System

From the drop-down list, select the radio system.

e Group

From the drop-down list, select the radio group.

On the Logical Groups tab, select logical groups that will be associated with

the object.

On the Cameras tab, select the check box beside the camera that will be

associated with the object.

Note: You can also place a POI by specifying its coordinates. To do this,
click and choose Specify coordinates.

Note: Similarly, you can place other objects with predefined icons, such
as Warning points, Police departments, Emergence departments,
Fire departments, Houses, and Cameras. To do this, click one of the

following icons on the toolbar: AR = RERT B .
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Create a Custom Object

In addition to objects with predefined icons, you can create your own objects to be
then placed on the map.

o Click |22 Custom Object~| ;4 choose Add Custom Object.

Custom Object on Map x
Name: Clown’s nook |
Select image
D:\Images"Popov2 jpg ‘ x
Preview

16x 16 24x24 32x32 -1-Ex-i-5_'
* = m %
Advanced mode Cancel

= Name
Specify a name for the object.

= Select image
Click the Browse button and locate the image file you want to use as an
icon for the object.

Note: You can also assign different images for different icon sizes.
Click the Advanced mode link and select images for
different sizes (16x16, 24x24, 32x32, 48x48).

After you create a custom object, the corresponding con will appear on the Drawing
Panel.

e To delete a custom object, click IMI and choose Delete Custom
Object.

6.6.2.8 Route

Show Route

e C(Click and choose Show Route.

Show Reute X
@ [ LimeGreen E
V(@ 125 (Pete) B 105, 105, 105
@ 222 [ RoyalBlue
¥ (&) 235 (Basi) [ Aqua
I~ @ Radio 200 [ skyslue
I~ (®) Racio 201 [ DarkGray
[~ @ Radio 202 [ DeepskyBlue
[~(®) Radio 203 I DaricSlateBlue
[~ @ Racio 204 [LightGreen
I~ @ Radio 240 mobie: [ Lime: |

& =l
Route Type:  [Static |
48 E|: Hot ~

From |22:00v-2016 0:00 ~|
To: |<Last known location> ~|
Route Style. [Dots and lines with direction -

Optimize Route (group all nearest points)

[ Automatic comsct GPS erors

Configure
Show Events telemetry. alams and etc)
[ Shaw Canlog Events
oK Cancel
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= In the list of radios, select a radio and the color with which to display the
route for the radio.

= Route Type
Select the route type, either Static or Dynamic.

= Show Route for Last
If the Dynamic route type is selected, specify the time period, in hours, for
which to show the route.

* From/To
If the Static route type is selected, specify the start and end dates of the
time period for which to show the route.

= Route Style
Select the style in which to display the route on the map.

= Optimize Route (group all nearest points)
Select this option to group all points in a 100-meter radius.

= Automatic error correction
Select this option to detect and correct invalid GPS data. Click the
Configure link and select the maximum possible speed for your vehicles.

= Show events
Select this option to display TRBOnet server events (telemetry, alarms, and
other events).

= Show CanlLog events
Select this option to display events that occurred in a vehicle (door
opening, and other events).
Export Route

You can export the routes travelled by radio users in a GPX or KML files. To do this,

after you have performed a Show Route command, click and choose
Export Route > Export to GPX file/ Export to KML file.

Play Back Route
e Click and choose Play Back Route.
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Playback Route

Radio Date A GPS Data

| Events | \

125
125
125
125
125
125
125

Total: 660

22-Nov-2016 10:17:17 Latitude: 53°56'25.88°N; Longi
22-Nov-2016 10:18:17 Latitude: 59°56'25.86°N; Longi
22-Nov-2016 10:18:47 Latitude: 59°56'25. 36°N; Longi
22-Nov-2016 10:19:17 Latitude: 59°56'25, 18™N; Longitude: 30°
22-Nov-2016 10:19:47 Latitude: 59°56'25, 27N; Longitude:
22-Nov-2016 10:20:17 Latitude: 53°56'25.37'N; Longitude:
25010v-2016 10:20:47 Latitude: 55°5625.37W; Long

1., 0.6kmh

5
E
ececcoa

Qa@@ﬂM

From: [22440v-2016 0:00

To: [<Lastknown location> -
[] optimize Route (group all neares
Automatic correct GPS errors

Configure
Show Events (telemetry, alarms and etc)

t points)

Show CanLog Events

| Rad A color
@ | [ D
[ERE! [ LimeGreen
V125 Pete) [ 105, 105, 105
[EREE] [ RoyalBlue }=
0 |235 Basi) T Aqua
[ Radio 200 [ SkyBlue
[ [Radio 201 [ DarkGray -

Select Al Unselect Al

= In the list of radios, select the radio and the color with which to display the
route for the radio.

= From/To

Specify the start and end dates of the time period for which to show the

route.

= (lick the Load button.

= Once you have loaded the route points, click the Play button to play back

the route on the

map.

File View Map Toos Hep
Location Tracking p Plybock Roul g
S oo
EEETTEVIEEER e e =
R ooB) 2 i
oo mjae o
. —— s
BinG_ROAD I indosrpon_X) iz
ok 2.0 | e @| @] Q[ @17 | # orawing pag 175 2
ok @ X
DEE E Load F
Froms [22v-2016 0:00 =] ementiio 1
T [t 3
s ) Optmize Route (group st nearest ponts)
[EPe—————
Confioure
2 [EETEp———]
B . el show Cantog Evens
s & cor
= n ‘ D
5 piaymack gl Save- 2 pine | 1 Pause f Cieas - 4 U 151 -
135 (Pete) N 105, 105, 105 ——
RadoSyaten. | Sender
T NORE] -
235 G =0
& voencmina » e S
- BT S
() Reports
2 sttt | unvmecta
F3
5] event vewer wcrs et D8 [T ————
@ —— ACls | RequestioTek | RadoState  AchveTasks | ActhveRoutes | User Actity | Bescons | SeaconEvents | Teglist
127001 & th | § Dspatcher | (8 Licensed tor dermo Dermolicense @ Acner

6.6.2.9 Geofencing

The Geofencing feature allows controlling the location and speed of radios relative
to manually defined regions on the map.

The Geofencing monitoring consists of the manually defined regions and the tasks.
The regions specify where to apply the rules, while the tasks specify how to apply
the rules for the regions and radios.

e On the Map toolbar, click ,

The administrator can add/disable/delete the rules for Geofencing as well as
edit the currently selected rules:
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e For more details on configuring Geofencing rules, see section 6.4.5.7,

Geofencing.
e To enable Geofencing rules, go to Administration, Tasks, and in the Tasks
pane, select the check box next to Geofencing.

6.6.2.10 Coverage Map

The Coverage Map option allows to see RSSI levels on the map.

e On the Map toolbar, click IM'.

o | |
itec| @[ @[ Q@] 7 [ @] showBescons: 8~ | Ruler| o Drawing Panel [ ] Coverage bap] 7

Select RSS! data by period

% | swow o =
‘ il ol
- @ |- =

() Voiee Dipteh
235 (Basi)
4 tocation Tracking et it
Sosacery @ 125 Pete)
G sobraecting &5 : b \
P % L
Ao (&
" Route Hanagement 0 % o
e — Recent ol events . @ o 1 B
) Playback el Save () Paine | 11 Pause # Clear - 3 Reload | \j Fiker By Radio | = Grouping ﬂnﬂ Devaits [ ShowNotes 7|
(] s Hessopes Rassyn [ sende Recoent ~
CoodhPlS  Dspoicher 1 a5 riate ki emtche
) s u [ro—"
— £ w
Q £ u
—— 5 a
25 N
5] wvent vewer CombAU  Dmsbel 28 e ——
19 b |wim] ¢
5] Racio tocation RecentCals | RequestioTek | RadoState | Acive Tasks | Active Routes | User Acity | Bescons | Bescon Events | Taglist.

127001 &8 6 | @ Dispateher1 | [ Licensed to: demo DemolLicense © Actve-

For more details on configuring the Coverage Maps, see section Coverage Map
(page 119).

6.6.2.11 Select Map

e On the Map toolbar, click .

Select Map... b4
Map Type: Online maps e
Caption: ‘My Map|
Available Maps

Name Path State
MAPNIK oK
CYCLE oK
TRANSPORT oK
LANDSCAPE oK
BING_ROAD oK
BING_AREA oK
BING_HYBRID oK
Add Edit Remove Cancel

= Enter the Caption of the map that will be displayed in the active tab.
= In the list of Available Maps, choose the map to be displayed.

Note: For more details on available map types, see section Map
Types (page 110).

6.6.2.12 Google Earth
To open the Google Earth application:
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6.7.1

e On the Map toolbar, click /" Geegle Earth |

Note: Google Earth must be previously installed on the PC. To
download Google Earth, go to the Google Earth website
https://www.google.com/intl/en/earth/desktop/, and click

Download.

Job Ticketing

TRBOnet Dispatch Console provides the Job Ticketing feature — the integrated
ticketing system that allows dispatchers to create, assign, and track job tickets
through the radio network.

Note: Before using the feature, make sure that your TRBOnet
Dispatch Software license includes Job Ticketing.

pane.

File View Map Tooks Help

Job Ticketing

Job Ticketing

e Click the Job Ticketing tab, and manage Job Tickets in the Job Ticketing

(& [@]S)

{5 eventviewer

" Job Ticketing | Statuses | Custom Fields | Templates
=k Add (F2) ~ 5 Edit (F4) & Assign (F5) | = Grouping '/ Auto Filter & Default Settings
Status jul Text « | Specified End Time s e City
# New #AD0006 Check the pipe in ... v 07.06.2017 15:40:00 Mo...
2% New #AD0007 Medium, Check the. St.
| 4| 4| Record 10f2 b | |mH[ 4] »
Processing tasks:
Status D ... Start Time End Time Specified|
+ Accepted #A0000B v e
= Assigned £A00009
| «| «|Record 20f2 »[0r|mr] «] | »
| @ Adive-

B 127001 & € | @ Administrator | [ Licensed to: demo

for job tickets.

Adding a Status for Job Ticketing

Jcb'l'lckeﬁng/zstatusﬁr Custom Fields TTempJabes ]

B Add| 5 Edic £k D:\te

¢ In the Job Ticketing pane, click the Statuses tab to see the statuses available

Name
Cancelled

Assigned
Accepted
Rejected
Completed

Progress

\ Desaription

M| 4| 4 Record 10f7 b | |M| 4

Status

% New

o Cancelled
=+ Assigned
+ Accepted
— Rejected
~ Completed
U InProgress

Click the Add button to add a Job Ticket status.
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lob Ticket Status

Name Accepted

Description

Accept

Status:

| =+ Accepted F
Accepted

~ Completed

3 In Progress

— Rejected

= Name

Specify a Job Ticket status name to display in the system.

Note: The Name value must match the value of the
corresponding Action/Response field configured for a radio
in MOTOTRBO CPS, Job Tickets.

= Description
Add a description for the job ticket status.
= Status
From the drop-down list, select the Job Ticket status.
6.7.2 Adding Custom Fields for Job Ticketing

In addition to the default fields (Priority, Deadline, etc.), you can add custom fields
with pre-defined values to be used in tickets/ticket templates.

¢ In the Job Ticketing pane, click the Custom Fields tab to see the list of
custom fields available for job tickets.

Job Ticketing Tsmmsec Custom FleldsrTEmpIates ]
5 add|Eb Edit = Delete
MName

Values

Town Kotka;Hamina;Loviisa

Quality High;Low;Middle

4| 4| Record 1of2 » | MM 4

e Click the Add button.

Job Ticket Custom Field

Name: Town

Values
Kotka
Hamina

Loviisa

Total: 3
dF Add X Delete

oK Cancel
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In the Job Ticket Custom Field dialog box, specify the following:

= Name

Enter a name for the field.

= Values

Click the Add link and enter a pre-defined value for the field.
6.7.3 Creating a Job Ticket

¢ In the Job Ticketing pane, click the Job Ticketing tab to see the list of

created job tickets.

Job Ticketing T Statuses r Custom Fields T Templates ]

- 3% Edit (F4) =
Text

L Add (F2)

W H| 4 | Record20f2 b | k|| 4

Processing tasks:

Status I B A
+ Accepted FADODDE .. e
= Assigned #A00009

W4 | 4 | Record 10f2 b |k |M| 4

Medium, Chedk the pi...

Start Time

Assign (F5) | = Grouping "/ Auto Filter :4 Default Settings
Created By Prig... [Cove [ e

.. |Cr... | Spedfied End Time
07...
07...

.. | End Time

e Click the Add button to create a job ticket.

Status Colors

Administrator  Medi...
Administrator  Medi...

.. | Spedfied End Time

Note: To create a ticket from a template, click the arrow on the
right of the Add button to select from the available ticket
templates. For directions on how to create templates, see

section 6.7.4.
Job Ticket >
Ticket 1D: [#a00000 |
Priority: Medium ~
Deadine: [21.08.2017 11:54 -~
+5min  +10min  +30min  +1hour
FPredefined Texs: | |8 +|-
Text: Check the pipe
11
Wariables: Priority Due Date Due Time
[] Motify on status changes
] Motify f ticket is not accepted by
[21.04.2017 11:49 =l
Notfication List
Comment:
Hide Advanced Options Cancel

In the Job Ticket dialog box, specify the following parameters:

= Ticket ID

This value will be set automatically once the ticket has been created.
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Priority
From the drop-down list, select the task priority.
Deadline

Select this option and in the box to the right, enter a due date and time for
the task.

Predefined Texts
From the drop-down list, select a predefined text for the Job Ticket.

e Click the B button to edit the predefined text.

Predifined Text Editing X

Text
Check the pipeline|
Check the toll fare

Total: 2

o Add X Delete Priority  Due Date  Dug Time

0K Cancel

e Click the Add link and type the text in the line that appears.
In addition, you can also add to this text:
v" Priority
Click this link to add the ticket priority to the text.
v Due date
Click this link to add the ticket due date to the text.
v Due time
Click this link to add the ticket due time to the text.
Text
Enter the text message in this box.
Notify on status changes
Select this option to send notifications to Dispatchers, Email and/or SMS
groups when a Job Ticket status changes.
Notify if ticket is not accepted by
Select this option to send notifications to dispatchers, Email and/or SMS
groups if a radio does not accept the Job Ticket at the time specified in the
box below.

Notification List
Click this link and choose the recipients of selected notifications.
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Notification List X

Dispatchers || Email | SMS || Radios

MNotify Dispatchers

[] Administrator
Wi Dispatcher 1

[] pispatcher 2

OK Cancel

You can notify dispatchers with the help of notifications in the Dispatch
Console (on the Dispatchers tab, check Notify Dispatchers, and select
dispatchers), Email groups by sending Emails to dedicated Email groups
(click the Email tab, check Notify by Email, and select Email groups) and
phone users by sending SMS to dedicated SMS groups (clcik the SMS tab,
check Notify by SMS, and select SMS groups).

= Comment
Add a comment for the ticket.

6.7.4 Creating a Ticket Template

You can create ticket templates in advance to then use them when creating tickets.

Job Ticketing Tsiah.lses T Custom Fieldg/’Templates]

%. Add _—} Edit oy Binding =" Default Template Delete | = Grouping 7 Auto Filter : Default Settings

MName Priarity Text Specified End Time Comment Bin...
Towns Medium %PRIORITY % in %City %

Cleaning Medium Do deaning in %&Tawn%

W4 | 4 |Record 1of2 r | |M| 1 »

e Click the Templates tab to see the list of templates available for job tickets.
e Click the Add button to create a ticket template.
¢ In the Job Ticket Template dialog box, fill in the desired fields, and click OK.

Note: For information about the fields, see section 6.7.3, Creating
a Job Ticket.

In addition, you can enable automatic creation of the template-based tickets by
using a scheduler. For this, go to Create Automatically by Scheduler, click the
arrow down button and select the corresponding scheduler. Or, click the plus button
on the right, and create a new scheduler.
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6.7.5 Selecting Ticket Status Color

You can also color tickets based on their statuses.

e Click the Job Ticketing tab, and on the toolbar, click the Status Colors

button.
Job Ticketing T Statuses T Custom Fields TTempIates ]
;-;e"}, Add (F2) - _% Edit (F4) - Assign (F5) = Grouping “|_|7 Auto Filter -2 Status Colors
Status jin] Text P Spedfied End Time /|| . Town
£ Mew #A00010 Medium %City% ... S . Kotka
4 New #A00007 Medium, Check... ... % . St.Peter,

In the Select Job Status Color dialog box that opens:

Select Job Status Color X

Status Color
New T e |
Cancelled Custom | Web | System
Assigned == Darkkhaki ~
Accepted [ Beige
Rejected [ LightGoldenrodyellow
Completed B Clive
Progress 3 vellow

g 3 Lightyellow

| [ vory
Expiring Job Ticket B Olivelrab

Time to complete Job Ticket {minute) == YellowGreen
B DarkOliveGreen
Color: [ GreenYellow
3 Chartreuse i

DaELIE

0K Cancel

e Click the arrow on the right, and from the drop-down list, pick the color for the
selected status.

6.7.6 Assigning a Job Ticket

e Select a job ticket in the list, and click the Assign button.
Or, right-click the job ticket and choose Assign.

Job Ticketing T Statuses T Custom Fields T Templates ]

=% Add (F2) ~ =) Edit (F4) - Assign (F5) | = Grouping " Auto Filter & Default Settings Status Colors >
Status  |ID Text Pe... |Cr... |Specified End Time Created By Prio... |Ceue |woe |Qu...
% New FA00007 Medii T == Administrator  Medi....
.
& Mew #A00010 Medil % Edit l Administrator  Medi... ... High
Cancel
| | «|Record 10f2 ¥ | -3‘ B ’
Processing tasks: =a Create Based on..
Resend . —
Statu D .. | End Tii +.. | Sped End Ti
= _% Change Status 3 e peche e
+ Accepted #AOODDOE 0 |
= Add
= Assigned #A00003 Se ACd e
M| H | 4| Record 10f2 b | B |M| 4 3

In the Assign Job Ticket dialog box that appears:
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Assign Job Ticket

*

.b‘ Assign Job Tickst

Radia:

® 111

V (@) 125 (Pete) 125
@ 222

V¥ (@) 235 (Basi) 235
(@ Radio 200
(& Radio 201
(@) Radio 202
[

I IPI

i mmm

<l

=]

]

==

e In the list, select a radio, radio group or logical group to which to assign the
job ticket.

e Click OK to assign the task to selected radio(s).

As a result, the selected radio(s) will receive the job ticket.
6.7.7 Viewing Job Ticketing Statistics

e On the main menu, select Tools, then click Job Ticketing Monitoring to see
the Job Ticketing statistic diagram:

1 1ob Ticketing Montorng

Show: [rodoy -] undare

Depaidhe: Crested Sdets || [roceo [ hesgned tikets Status diagram
+ | Aditrtor 7|+ |tnassned s

For more details on the statistics, see Job Ticketing Monitoring.
6.7.8 Viewing Job Ticketing Reports

e To view a job ticketing report, go to Reports (1), and select Common Reports
(2) — Job Ticketing (3).

¢ On the Common reports pane, click the Query parameters tab, and specify
the appropriate parameters and then click Generate Report.

e Click the Job Ticketing tab to see the generated report.
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File View Map Tools Help

) Chomnel Change P rtercom []<cl[2] B 5: e free EE L Pll2] WP croup 10 Pl

B Common reports 4
115 Messages for Period 2 Group 20 2 Group 30 [:)][«][@] B[ ]Private cal [][«][@]
£ State of Radios
) User Messages and Notes Query parameters ~ Job Tick
1T Radio Alocation |
) Radio Disabling -
[ Telemetry
1.7 Radio Users by Channel
[ state of Radios Summary
£ Lone Worker Activity

) can graphics
) can messages 3

L5 JobTicketing 4"
= ...

{1l voice Dispatch
%PRIORITY%% 07-Nov-2016 07-Nov-2016
B . #A00000 N Administrator Med
|l Location Tracking FRICRITV e 140631 141300 ministrator Medlum =
07-Nov-2016 07-Nov-2016
. #600001  %PRIORITY% Acoepted Administrator Medium
& s0b Ticketing ¢ 1408:58 14:49:55
I 07-Nov-2016 07-Hov-2016
#0002 %DATE% assigned |10 e Administrator Medium
07-Nov-2016 07-Nov-2015
I HADDODZ  BTIME% Accepted o o Administrator Medium
5] RFID Tracker 142525 15:00:35
#A00004  jkg assigneg 07 MOw-2018 07-Mov-2016 Administrator Medium
[] Text Messages 15:01:59 1517:57
BANODOS  Abc Asslgned D/ MNow-2016 U7-Mov-2016 Administrator Medium
ﬂ Voice Recording 15:18:13 15:21:07

#A00006 123 L33 (Cleaning Completed 07-Mov-2016 07-Mov-201 Administrator Medium
@ Reports —1 1) 15:23:19 15:35:02
- #ANODOT 456 New 2;’?;;;“6 Administrator Medium
Event Viewer .
07-Nov-2016 07-Nov-2016 D7-Mov-2016
HADDODE  Visit martre Completed o o o Administrator Medium
@ _ 1538:39  17S@ZL  1M58:49
Durationl: 02:19:41
[ Administraty Duration2: 00:00:28 >
Administration 7l D
3127001 g3 B | @ Administrotor | [ Licensed to: deme Demo License | @ Active-

6.8 Guard Tour / Route Management

The Guard Tour / Route Management feature allows the user to create routes and
assign them to selected radio subscribers or dispatchers.

File Viev Map Tools Help

Route Management Route Management

2 o | Ut ey i 1: Line free [«][@] | M ntercom M Group 10
Seron P (v B [=][<][e@] [ Group 11
31.05.2017 14:58 . == E D —
/! Monitoring
b start | (reate\é Edit =}, Copy @ Export - | [k Delete | = Grouping 7" Auto Filter > Default Settings
(41, Voice Dispatch Name Route
Route 1. 15:00 15:15 1530 1600
Temme
4., Location Tracking & 2 & 8
@ Job Ticketing
2
Route
1
@ 'RFID Tracker
[] Text Messages
4] 4] 4 | Record 10F 1 k|1 mi] 4| v
g 'Voice Recording Active Routes
b Start | 11 Pause Ml Stop | [5b Edit @ Export~ | = Grouping "/ Auto Filter @ Default Settings
(3 Revons Name Route
= b Route 1 00:00 1500 1545 1530 1
Event Viewer @ @ @ B
31.05.2017 14:58 Coffee Hospizal Tea Poic2
[ 1] Tetemetry
1] @] | Record tof 1 v | [mi] 4] "
(127001 g5 g | G Administrator | (A Licensed to: dema | © nctive-

e Click the Route Management tab (1).
6.8.1 Creating a Route

¢ In the Route Management pane on the right, select the Management tab,
then click the Create button (2) to create a new route.
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Route X

Name: [Route 1

Description: [restroute

Rule [l checkpoints, strict order, strict schedule |

StartjStop Kilks! | Route Points | Chedpoint Statuses | Notfications | Tags | Logical Groups

‘Start Route 2
Manually by dispatcher

Automatically by recelving Text Message from a radio
Message 2 |

[ Automatically by receiving Telemetry Command from a radio

1 E [ryevent =]
Automatically by recelving DTMF command from a radio

Command:  [123 #123%

[ Automatically hy eeeeeeee g Status from a radio

[ wait for confirmation from a radio

Pause Route

Resume Route

» %«

Finish Route

Manually by dispatcher
[ Automatically by receiving Text Message from 2 radio

[ Automatically by receiving Telemetry Command from a radie

L E Any event -

[ Automatically by receivin g DTMF command from a radio

o

[ Automatically by receiving Status from a racio

[ Automatically after al points have been attended

Name

Specify a name for the route to display in the route list.
Description

Add a description for the route.

Rule

Select the type of the rule from the drop-down-list:

All checkpoints, strict order, strict schedule
Checkpoints are to be attended in the specified order, each within a
specified time range.

All checkpoints, strict order, loose schedule
Checkpoints are to be attended in the specified order. The time for
attending each checkpoint is not limited.

All checkpoints, loose order, loose schedule
Checkpoints can be attended in any order, each at any time.

Click the Start/Stop Rules tab.

Start Route
Specify the rules to start the route.

Manually by dispatcher

This option is enabled by default and cannot be edited. This option enables
the dispatcher to start the route by clicking the Start button in the Route
Management tab or in the Active Routes pane.

Automatically by receiving Text Message from a radio

The route starts when the radio sends a specific text message to TRBOnet
Server. If you select this option, then specify the text message the radio will
send in the Message box.
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= Automatically by receiving Telemetry Command from a radio
The route starts when the user presses a preconfigured button on the radio
and TRBOnet Server receives a telemetry command from the user's radio. If
you select this option, specify the VIO contact, and from the Command
drop-down list, select the signal level at which the user's radio should send
the telemetry command.

= Automatically by receiving DTMF command from a radio
The route starts when the user sends a specific DTMF command to TRBOnet
Server, for instance, #11#. If you select this option, specify a DTMF
combination without the # characters in the Command box.

= Automatically by receiving Status from a radio
The route starts when the user sends a specific Status to TRBOnet Server,
for instance, 1. If you select this option, specify the Status.

= Wait for confirmation from a radio
Select this option to start the route after the TRBOnet Server receives a
confirmation from the radio. In this case, the route is assigned to the radio
or user and paused. The route will be resumed after a confirmation is
received.

Pause Route
Specify the rules to pause the route.

Resume Route
Specify the rules to resume the route.

Finish Route
Specify the rules to finish or stop the route.

= Automatically when all points have been attended
Select this option so that the route is finished automatically when all
checkpoints have been attended.

= Limit route processing time
Select this option, and specify the maximum allowed time in the Max. Time
box. If the time is exceeded, the route will stop automatically. All
unattended checkpoints automatically change their statuses from ‘Waiting'
to 'Not Attended'.

¢ In the Route dialog box, click the Route Points tab.

Route X
Name: [Route 1
Description: [restroute
Rule: a0 checkpoints, strict order, strict schedule =l
Start/Stop Rules Route Points | Chedpoint Statuses | Notifications | Tags | Logical Graups |
GOt Tine: [Specified tme of day -
yZ o _ [ Name [Tme
o o % [Point 1 9:00
% Paint 2 9:30
NN Z g Coffee 100
9:30 ‘a‘ Fire dep 10:40
©
Point 1 ¥
2:00 5
Fird dep
10:40
© %
00m | Latitude: 59°56'39.85"N; Longitude: 30°16'48.13"'E L
[Bepsponts (& seacons [ map obiects A creste Sbedt X pelete
12 3
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= Click the GPS Points link (1) to add points to the selected map:

Select Map... X
Map Type: Online maps >
Caption: |My Map]|
Available Maps

Name Path State
MAPNIK oK
CYCLE oK
TRANSPORT QK
LAMNDSCAPE QK
BING_ROAD 0K
BING_AREA QK
BING_HYERID QK
Add Remove Cancel

= Select the map. For more details on map types, see section Map Types
(page 110).

= Click the Create link or double-click a selected point on the map to create a
new route point:

oint properties X

Name: [Bank

Location [Fattude: 53°56'35.20; Longitude: 30°16'4.. ~|

Radius: 10 =] meters

I Intermediate way point (not served)

Time: 15:00 =
Time delta: 5 =] minutes

* Name
Specify a name for new point to display on the map.

= Location
This box displays the current GPS coordinates of new point.

= Radius
Specify the radius within which to consider the point as attended.

* Intermediate way point (not served)
Select this option to exclude the point from being used as a checkpoint.

= Time
Specify the time the point is to be attended at.

* Time delta
Specify the time accuracy to attend the point.

= Click OK to add the new point.
= Click the Beacons link (2) to add a beacon as a checkpoint.
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Note: To enable the Indoor feature, make sure your license
includes Indoor Positioning (see section 5.1 License
Information on page 11) and Indoor Service is selected in
the list of available services (see section 5.9.2 Services on
page 29).Services

¢ In the Configuration pane, under Digital Systems, select Services:

Route X
Name: [Route 1
Description: [Test route
Rue: [ checipoints, strict order, strict schedule =l
Start/Stop Rules  Reute Points \che:kpmm Statuses | Notifications | Tags | Logical Groups |
i@ Beer Time: [specified tme of day |
g coffee Hame Time
@Tea Point 1 9:00
Point 2 9:30
Coffee 10:00
Fire dep 10:40

[@epspoints (@ seacons [ map obiects A crezte Ehedc X pelete

= (Click the Create link and then click a beacon in the list.

H
E3
B
x

Radius: =] meters

I Intermediate way point (not served)

Time: 10:00 =
Time delta: 5 =] minutes

= Click the Map Objects link to add a map object as a checkpoint.

Route X
Name: [Route 1
Description: [Test route
Rule: [0 checkpints, strict order, strict schedule =l
Start/Stop Rules Route Points | checkpoint Statuses | Notifications | Tags | Logical Groups|
[@abiding place Time: [specified time of day -]
Fire dep Name Time:
[ Hospital o2 Point 9:00
[Eciice epartment o 1 Pontz @m0
Coffee 10:00
Pt
[E8 eps points () Beacons [ Map Obiects o Create [EbEdit X Delete

= Click the Create link and then click an object in the list.

Name: [Fire dep
Map Object:  |[E Fre dep = |

Radius: 0 =] meters

I Intermediate way point (not served)

Time: 10:40

Time delta: 5 =] minutes
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¢ In the Route dialog box, click the Checkpoint Statuses tab.

Route X
Name: [Route 1
Description: [Test route
Rule: [AT checkmomnts, sirict order, strict schedui =l
Start/Stop Rules| Route Points Checkpeint Statuses | Notficatons | Tags | Logical Groups
Set status to Attended:
€ When racio enters the point area
% By condition when radio s in the point area
Automatically by r ing Text Message from a radio
Message: | Yes
O Automatically by r metry Command from a radio
[] Automatically by receiving DTMF command from a radio
[ Autematically by receiving Status from a radio
Statuses that can be set by dispatcher:  |Waiting, Attended, U... ~
Set status to Alarm:
[] Automatically by receiving Text Message from a radio
[ Automatically by receiving Telemetry Command from a radio
1
[ Automaticaly by
Command: ~ [5 #5
Automatically by receiving Emergency from a radio
Emg. Type:  [Emergency Alarm ~|
[ Autematically by receiving Status from a radio

Select this option so that TRBOnet Server will change the checkpoint status to
‘Attended' based on the information from the radio.

= When the radio enters the point area

Choose this option so that the radio detects the closest beacon and sends
location data to TRBOnet Server. The respective checkpoint changes its
status to 'Attended ' automatically.

= By condition when the radio is in the point area
If this option is chosen, the radio sends a preconfigured command to

TRBOnet Server. The last detected checkpoint changes its status to
‘Attended ' by this command. Configure the preferred command(s):

¢ Automatically by receiving Text Message from a radio

Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific text message from the radio. If
you select this option, then specify the text message the radio will send
in the Message box.

Automatically by receiving Telemetry Command from a radio
Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific telemetry command from the
radio. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's
radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific DTMF command from the radio,
for instance, #11#. If you select this option, specify a DTMF combination
without the # characters in the Command box.
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¢ Automatically by receiving Status from a radio
Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific Status from the radio. If you select
this option, specify the Status.

e Statuses that can be set by dispatcher
Select this option to allow the Dispatch Control operator to manually change
the status of checkpoints in the Active Routes panel.
In the drop-down list, select the checkpoint statuses to be available for the
operator: Waiting, Attended, Unattended, and Alarm.

e Set status to Alarm
Select this option to allow the radio to set an alarm on the attended
checkpoint. Configure the command(s) that can set the checkpoint status to
‘Alarm'.

Automatically by receiving Text Message from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific text message from the radio. If you select this option,
then specify the text message the radio will send in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific telemetry command from the radio. If you select this
option, specify the VIO contact, and from the Command drop-down list,
select the signal level at which the user's radio should send the telemetry
command.

Automatically by receiving DTMF command from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific DTMF command from the radio. If you select this option,
specify a DTMF combination without the # characters in the Command
box.

Automatically by receiving Emergency from a radio
Select this option to set the point to alarm mode after the dispatcher
receives an Emergency from the radio.

e Emg. Type
Select the Emergency type from the drop-down list.

Automatically by receiving Status from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific Status from the radio. If you select this option, specify the
Status.

In the Route dialog box, click the Notifications tab to manage notifications to

a radio.
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Rule: [A checepoints, strct order, strict schedle =]

Start/Stop Rules| Route Points | Checkpoint Statuses NHHEaH57]| rags | Logical Groups |

Vou can use variables i text message:
RouteName}, {Pointhame}, (szme} NextPointhame), {NextPointTime}

[V Send a Text Message on route assign to radio

‘Text Message: [fassion {Routename)

[V Send a Text Message on

Text Message: {RouteName}

[V Send a Text Message on route suspend

Text Message: [he {Routename} is suspended

[ send a Text Message on route resume
Text Message; [he Routename} is resumed

[V send a Text Message on route finish
Text Message; [he {Routeniame} is frished

¥ Send a Text Messag
‘Time before attend:

ien approaching attendance tme

|5 =] minutes

Text Message: [serve (Pointiiame) at (PointTime}

¥ Send a Text Message after point s at
Text Message; [he 4
For the last point: [rhe 4

rved. Nextis {NextPointhame} at {NextPointTime,

[ Send a Text Message if point is not.
Text Message: ¢

[V Send a Text Message

Text Message:

Note: To enable an option, select the check box. The Text
Message boxes already include text. If necessary, replace
the text with your own text, using variables as placeholders
that will be substituted with actual data.

Send a Text Message on route assign

Select this option to inform a radio holder that the route is assigned to.

Send a Text Message on route start
Select this option to inform a radio holder that the route started.

Send a Text Message on route suspend
Select this option to inform a radio holder that the route is suspended.

Send a Text Message on route resume
Select this option to inform a radio holder that the route is resumed.

Send a Text Message on route finish
Select this option to inform a radio holder that the route is finished.

Send a Text Message when approaching attendance time
Select this option to inform a radio holder that the next checkpoint is

neocom
TRBOnet Dispatch Console SsOftware

expected in the time interval specified in the Time before attendance box.
This message is only available for routes with the specified attendance time.

Send a Text Message after point is attended
Select this option to confirm attending a checkpoint.

Send a Text Message if point is not attended

Select this option to notify a radio holder if the point was not attended.

Send a Text Message if point is in alarm mode
Select this option to notify radio holder if the point is in alarm mode.

In the Route dialog box, click the Logical Groups tab.
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Routs X
Name: [Route 1
Description: [restroute
Rule: IAH checkpoints, strict order, strict schedule =l
Start/Stop Rules | Route Foints | Checkpoint Statuses | Notifications | Tags Logical Groups
Name | Desaription
=i Cleaning
i~ [l Cleaning 1 Cleaning in Department 1
[ Cleaning 2
=S security Groups for Security
O
[y Security 2

I Assign Logical Groups to a radio when the route starts

= Select a logical group(s) in the list of available groups.

= Assign Logical Groups to a radio when the route starts
Select this check box so that when the route is assigned to a radio, the
selected logical group(s) will automatically be assigned to the radio.

Note: For more information about logical groups, see section
6.4.21, Logical Groups (page 237).

e Click OK to save settings.

The new route is now added to the route list (1):

6.8.2 Starting a Route

312

File View Map Tools Help

Route Management Route Management €]

T %5 1s Line ree W ntercom ooE B EEE]
b Route 1 00:07 Fca [o][<cJ[o] J Fdcroup 20 [][«]|2] S [ crove 11 [»][«][e]

rou
i
31052017 14:58 - [ private cd [][«][e]

S Cre £ = u
(1)) voice Dispatch Name Route
Route 1 15:00 15:15 1530 16:00
Test o
FEpR—— £ 0e 8
#Junrumig

= e 1 2
@ RFID Tracker
[ ] Text Messages
Q Voice Recording Active Routes
b start| 1 Pause M stop | 5 Edit 49 Export~| = Grouping 7 Auto Filter @ Defautt Settings
@ Reports Name Route
ju b Route 1 00:07 15:00 1515 15:30  16:00
Evuilvitw:r 235 P T I T = T
31.05.2017 14:58 Cofie= Hospral  Tes Poice
E Telemetry
1] @] 4 | Record 1of 1 ¥ | [mi[ 4] 3
(127001 g3 & | § Administrator | [A Licensed to: demo | @ active-

Click the Start button (2) to start the route:
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Start Route X

Mame: |Route 1

Start Date: |14-0ct-2015 10:58 =

Route: |Route 1 j
Create Route | Modify |

Radio: | @ 125 (Pete) 125 |

Radio Owner: | j

Dispatcher: |aail j

In the Start Route dialog box, specify the following parameters:

Name
Enter a name for the route to be started. This name will be displayed in the
Active Routes pane.

Start Date
Select a date to start the route on.

Route

From the drop-down list, select the route to start. Click the Create Route
button to create a new route based on the selected route. Click the Modify
button to modify selected route parameters.

Radio

From the drop-down list, select the radio to assign the route to.

Radio Owner
From the drop-down list, select the Users to assign the route to.

Note: Select only one of the two (Radio or Radio Owner) to
prevent an incorrect route.

Dispatcher
From the drop-down list, select the dispatcher to monitor the route.

Click OK to start the route.

The active route appears (1) in the Active Routes panel.

File View Map Tools Help

Route Management Route Management

b start | Il Pause M Stop M crow 10
Group 11
 Route 1 00:37 L
235
31.05.2017 14:58
b start | 5l Create =) Edit =) Copy @ Export~ | =k Delete | = Grouping [ Auto Filter &> Default Settings
AL voice Dispatch Name Route

Route 1 15:00 1515 1530 16:00
Test rovte:

@mﬁmlmlﬁq Coffes  Hespial  Te:  Powe

4 20b Ticketing

RnltzMilagzmult

@ RFID Tracker

[ estiscusacs

14 44| 4 | Record 1of 1 [+ ][ 4 »
ﬁ Voice Recording Active Routes

b start | 1l Payg€ Wl stop | =b Edit 4 Export~| = Grouping "/ AutoFilter € Default Settings.
() mepons Name Route

b Route 1 00:37 1508 1515 1530 16:00

o o
%YW“ Taa\Pon
2 3

Event Viewer
31.05.2017 14:58

Telemetry

“3) Radio Allocation
14 44] 4 | Record 1of 1k [ e[ ] 4

b

[ 127001 & B | & Administrator | [ Licensed to: demo.

@ Active -
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If a route point is attended in time, it is displayed in green (2)
If a route point is not attended in time, it is displayed in red (3).

For more operations with checkpoints, see section 6.5.8.6, Active Routes
(page 277).

6.8.3 Tracing Active Route on Map

¢ In the Route Management pane, click the Monitoring tab (1).

File View Map Tools Help

Route Management Route Management | & ]
b start Il Pause Ml Stop nagement itoring
"o o Filter EE Show Beacons: Al ~ | & Ruler O Find on Map~
N i 2
. o}

& . =
} Route 2 00:28 [ N\
s 2 5 - 43 b

S e - 5 . B 1 :
05.05.2017 16:26 \ Y P 22 DL\ -
L3 \e b 3 &
| Tl 00:23 [ronosan ./ DNNE, 2 < = \ g
30

235 %,
05.06.2017 16:31 )

¥

(1) voice Dispatch

,
f
.

@ Location Tracking =4

F 30b Ticketing

Ej Route Management

@ RFID Tracker

[] Text Messages

& voice Recording =

() Reports S T
2

Event Viewer 1l Pause M stop | =) Edit @ Export -

o3| Lattude: 59°56:2,02" N; Longitude: 307164245 E |

. Name Route
‘3] Radio Allocation b Route 1 00:23 1631 1651 16:00 17:00

235 I+L o]

05.06.2017 16:31 Hospial  Tes  Poke  Cofies

@ Administration

%) 127.00.1 g Administrator Licensed to: demo Active -
»

e In the upper-left pane, select the route (2) to be traced on the map.

6.8.4 Stopping a Route

Depending on the route configuration settings, a route/guard tour can be stopped
automatically:

e by a command sent from the radio;
e when all checkpoints are attended;
e when the route time is elapsed.

To manually stop the route:

e Click the Stop button to stop the route. Once the route is stopped, it will
disappear from the Active Routes panel.

After the route is stopped, the checkpoint statuses cannot be modified neither
automatically, nor manually.

6.8.5 Generating Route Reports

The administrator can generate reports on the finished routes.

e Click the Reports (1) tab, and in the Reports pane select Common reports >
Completed Routes (2):
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File View Mop Tools Help

Common reports

[ Lone Worker Activities
) can Graphics
[ CAN Messages
) Job Ticketing 2
[ Job Status Change;
B J0b Ticket Assignyfents

B Full Movement Detals
T seaurity reports
[5) Management
[ Indoor reports

Py

7 1: Line free [<]
e DEE
Do ¢ Gl

Completed Routes

[[Jregular GeROLP

[Jrrivate call [1<1EA

) Movement Details v
< SavedProfies:  [otdefied~ 7|
U=l voice Dispatch Select data by period:
Start Date: 10/10/2016 12:00 AM = II'
@ o End Date <Maximum date> ] 2l
Filter:
&5 30b Ticketing
Rado: [Fotdefrea— =]
Route Management Logical Group: Mot defined - -
Radio ID (e.0. 22,33,40-55,88):
[] Text Messages
User: it defined— -
ﬁ Vaice Recording
Dispatcher: ot defined— -
Ge Route Name:
R

Euult\ﬁa.u

I~ show routes with exceptions only

[7%] Radio Allocation

[ —— [

\l' Frint detailed data

GenerateReport | |

Save Repart Profie || Deleereportprofie |

[ Connected 43 B B | § Administrator | [ Licensed to: demo Demo License | @ active -

6.9 Text Messages

In the Text Messages tab, the dispatcher can review and send text messages to other
dispatchers, individual radio subscribers and radio groups:

File View Map Tools Help

Text Messages Text Messages

& |15

Intercom
Group 10
Private Cal

7 1: Line free [«:][@] JAL ] an cal
Mcow 0 DEE, 4; Group 30
" Simple | Extended

¥ Clear (£ Reload |[% inbox | sent

The Paint 1is not served Py

[[«][@]
[+][2]
<]l

e & Online Dispatchers (1) B

& Dispatener 1 o %

O Online, Indoor (0)
5[V

© () Online, GPS Fixed (2)
[T 125 (Pete)

(®® 238 Basi)
_ o

15-Hov-2015 14:05:10 Sent from Server to 125
The Paint 2is not served

21-Nov-2016 11:08:18 Sent from Server to 125

U} Voice Dispatch The Paint 1is served

21-Nov-2016 11:08:15 Sent from Server to 125

% Location Tracking The Paint 2is served

21-Nov-2016 12:30:04 Sent from Server to 125
e Route 1is finished

w Job Ticketing
Route Management
unnrr.-i.a

Text Messages.

22-Nov-2016 17:20:44 Sent from Server to 125
Call 5678: Cannat detect channel to execute this operation

22-Nov-2016 17:21:03 Sent from Server to 125
Call 5673: Cannot detect channel to execute this operation

22-Nov-2016 17:21:15 Sent from Server to 125
Call 5678: Cannot detect channel to execute this operation

[22-Nov-2016 0 Sent from Server to 125
ﬁ rall 5478 Cannat datert channal n aven e thi finn 4
Voice Recording
Recipient: | 125 (Pete) | 3 Send | I Attach File
pete, youre |

(i Repons
hﬂlthﬂ
[ Radio Allocation

3127001 £3 B | G Dispatcher 1 | [ Licensed to: demo Demo License

113
| @ active~

1. Radio List
displays dispatchers and radio subscribers available for text communication.

Note: Radios must be equipped with a display to receive Text
Messages.

Text Messages panel
displays the latest messages transmitted via a radio channel.

New Message panel
provides you with text sending options.
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4. Calls Panel in compact mode
allows making voice calls.

6.9.1 Sending Text Messages

The dispatcher can send a text message to:
e Selected Radio
e Selected Radio Group
e Selected Logical Group
e Selected Dispatcher
¢ All Online Dispatchers or a group of dispatchers

The dispatcher can send a text message to selected subscribers from:
¢ New Message panel
e Radio List

6.9.1.1 New Message panel

¢ In the New Message panel, click the ellipsis (...) button.

File View Map Tools Help
Text Messages Text Messages a

]
220y |® 235 Basl)
¢ |3 Radio 200

= bony |® Radio 201

ey |2
@ By ¢ |3 Rrado202

oy |2 Rado 208
[ ] Text Messages ¢ 12 Rrado204 =l

221y
@ Voice Recording < Cancel

v

@ Boports Recipient: % | Firemen -2 ) send | ] Attach Fite
i [srack= Tontre ..
Event Viewer
[ 1] Tetemetry

[ Radio Allocation .

127001 &3 B | & Dispatcher 1 | [ Licensed to: demo Demo License | @ Active~

¢ In the Select Recipient dialog box, select the radio, radio group or dispatcher
and click OK.

e Type the text message you want to send.

¢ Click the Attach File button if you want to attach a file to the message being
sent.

¢ Click the Send button.
The text message will be displayed in the Text Messages panel.

The message details highlighted in red indicates that the message recipient is offline
and the message will be delivered as soon as the recipient gets back online again.

The message details in grey indicates that the message has been delivered.
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6.9.1.2 Radio List

e On the Radio List, right-click the radio/radio group/dispatcher you want to
send a text message to, and choose Send Message.

=] I_‘, Firemen

f@ [5] Send Message...
11

= | Advanced 3
(% 1 T ——
“'/l@ Specify Status Colors...
&2 —
— VIO1: High level
E/‘@ 2 VIND: Hink lewel

¢ In the Send Text Message dialog box that appears, specify the following
parameters:

Send Text Message X

Target: Firemen; Police; Orline Dispatchers;

Templates: -

T
I

Tent: Shack # 1is onfire

Attachments: @ Add File
Select Radios and Groups

Fitter: | |

¥ #5 Firemen -

] 2% Mobile Client

W %% Police E

W -fl Online Dispatchers
*du Cleanlng

™ send copy by Email
™ Send copy by SMS
I Send to offine radios
™ Confirmed Group Text

Hide Advanced Opticns SEND Cancel

= Target
This box displays the target for the message.

= |n the Text box, type the message text. You can insert a template text from
the Templates list box.

= In the Target list, add recipients by selecting radios/radio groups/logical
groups/dispatchers.

= Send to offline radios
Select this option to store the message on the server if a radio is offline,
and to send it as soon as the radio becomes online.

= Click Send.
6.9.2 Extended Messages

The Extended Messages service is a special function allowing users to send/receive
detailed preconfigured templates containing necessary information.

This service was created especially for clients who need to use more detailed and
structured messages in their work. If the standard messages are not enough to
contain all the information you need to send, you may use the Extended Messages
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service. Also note that an extended message can only be viewed on a Dispatch

Console.

6.9.2.1 Send Extended Text Message to a Radio

Show Modules

Show Voice Panel

EmE

Large PTT Boxes

Small PTT Boxes

@® © Rradio240m

how Extended Messages Tab

() voice Dispatch

5 1: Line free [«](@] [ Jarcal [« (@]
F Group 20 [=2][«][@] |} ¥ Group 30 [22][«[e]

@ 125

jp Send toRadio

~
@ Location Tracking
New Form
@ Job Ticketing 5
Route Management 3
. v
Cil] RFID Tracker 7 o
] Text | — 1 5 playback Il Save- () Print | 11 Pause < Clear -
Date ... |Mes... | Detais | N...
ﬁ Voice R di 4 [ 21Nov-2016 11:13:21  C... 235 Al AlC... Mem... B
[ 210ov-2016 11:13:12 Coov 125 Al AIC... Mem..,
= / [ 200ov-2016 111308 C... 125 Al AIC... Mem...
{5 Event Viewer & 21Nov-2016 11:08:18  C... 5. 125 The
Inbox (0) o 21ov-2016 11:08:18  C... 5. 125 The
2} Radio Allocation = 5 21-Nov-2016 10:56:55 235 Al Rese
3B 21N0v-2016 10:56:42 235 Al The
Administration N L — hd
E New Message... i| 9] '4| Record 1ofs1z v [wml<] L,J

127001 &3 €| & Administrator | [ Licensed to: demo Demo License | @ Active~

e Click Text Messages (1)

e Click the View menu, and select Show Extended Messages Tab (2)

¢ In the Text Messages pane, click the Extended tab (3), and New message (4).
rxmnded
Newmge... ® 15

- o | Send to Radio 1
Labell l:l

AN N\

1

[ Growp 1

< >

[ Playback I Save- () Print | 11 Pause <# Clear - ’_"

“““““ Me... D |

Date
01-Nov-2016 13:48:37
01-Nov-2016 13:48:37
[ 01-Nov-2016 13:48:34
(2 01-vov-2016 13:48:27

Ext, Note

Inbox (0) [T 01-Nov-2016 13:48:23
© [ 01-Nov-2016 13:48:13
[ 01-Nov-2016 13:48:16 .
Hew Message... 0| 9] 4| Record 1oF9 ' [w[m[ <[ LH

e Select the template in the list (1).

e From the drop-down list (2), select the radio to which to send the extended
message.

e Click Send to Radio (3) to send the extended message to the radio.
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On the Voice Recording tab, the dispatcher can display the list of calls according to
certain criteria, listen to the calls and save them to file.

File View Map Tools Help

Voice Recording [ Playback (el Save~ () Print

rouping '/ Auto Filter > Default Settings || 47 Details | [] Show Notes

Seect data by period: Date RadoSy.. Sender | Reoplent | Message Detais Note
© 174iov- Capocity... Admiristr... 235 Private Cal: Dispat... Members: Adni. -]
Start Date: 16-Nov-2016 0:00 Tf Ll || €@ 17Nov-2018N8:47:41  Capadity... Tel: 2409 125 Private Cal: Dispat... Members: Tel: 24...
End Date: IW[ o | || €@ 17-Nov-2016 19\59:46  Capadity... Administr... Radio24... Private Call: Dispat... Members: Adminis.
© 17-0v-2016 13:5%;, Capadty... Administr.. Radio24... Private Cal: Dispat.., Members: Adminis...
Filter: © 171002016 23038 Capagty... 345 125 Private Calls Dispat.... Members: 345, 125
Call Type: Frivate Call ] [ 1702016 20:30:42  Copacity... 256 25 Private Cal: Dispat... Members: 456, 235
Redosysem: [ =] ||@ Te0is sz Capacty.. 125 345 Private Call: Subsar... Members: 125
© 170/-2016 20:32%6  Capadty... 456 235 Private Calls Dispati.. Members: 456, 235
Menbers: Al T || @ 17nov-2016 20:32:54  copecity... 235 256 Private Cal: Subscr.. Members: 235
Radio Group: [soecteditams: 1 =] || @ 1740v-2016 03505 Capacity... 345 25 Private Call: Dispat... Members: 345, 235
gcdGom [ <1 || @ 7oy 203318 capacy... 395 25 Private Call: Dispat... Members: 345, 235
© 1740/-2016 203455 Capaaty... 456 25 Private Call: Dispat... Members: 456, 235
Racio 1D (e.g. 22,33,40-55,88): € 1710/-2016 203700 Capaaty.., 345 235 Private Calls Dispat.. Members: 345, 235
© 171i0v-2016 2037112 Capadty... 345 235 Private Call: Dispat... Members: 345, 235
Find Text: © 171i0/2016 20:39:23  Capadty... 456 25 Private Call: Dispat... Members: 456, 235
| @ 1740v-2016 20:40: 16 Capadty... 235 456 Private Call: Subscr... Members: 235
™ Hide zero session audo message € 17-4N0v-2016 20:40:50  Capacity... 235 456 Private Call; Subscr... Members: 235 P
2 @ 17N0v-2016 20:42:05  Capacty... 345 125 Private Call: Dispat... Members: 345, 125
Load Data © 174i0v-2016 064210 Capadty... 456 25 Private Call: Dispat... Members: 456, 235
© 17110/-2016 20:4400  Capaaty... 125 E Private Call: Subsar... Members: 125
(i) voice Dispatch © 17002016 20:44:16  Capadity... 125 456 Private Call: Subscr.... Members: 125
© 17002016 444 Capadty... 125 256 Private Cal: Subscr.. Members: 125
% Location Tracking @ 17-0v-2016 20:45:07  Capadty... 125 456 Private Call: Subscr... Members: 125
© 71002016 204814 Capaaty... 125 456 Private Call: Subser... Members: 125
0 308 ket © 1740,-2016 4505 Capaaty... 125 345 Private Call: Subsar... Members: 125
© 170,216 204914 Capadty... 125 345 Private Call Subsar... Members: 125
e et © 174002016 204930 Capadty... 125 345 Private Cal: Subscr.. Members: 125
o ) 17N0u-201620:45:45  Capadity... 125 456 Private Cal: Subscr... Members: 125 =
- el €T Recrdaers > w41 o
| ) RFID Tracker
H Sender Admiistrator Date: 17-110v-2016 19:59:56
[ ] TextMessages Reciient: Radio 240 mobile EBiplavbock [ save.
) Private Cal: Dispatcher Adminitrator” calis the radio ‘Radio 240 mable’ (00: 10)
§' voice Recording ~ | Me\mbe:dm;«am Racin 240 moble
T 1

(127001 &3 B, | @ Dispatcher 1 | [ Licensed to: demo Demo License

Click the Voice Recording tab (1).

‘ @ Active-

In the Voice Recording panel, specify the criteria according to which you want
to display call records, and click Load Data (2).

In the right pane, you will see the list of calls according to the criteria you have

specified.

To play back a record, select it in the list and click Playback (3).
6.11 Reports

The Reports tool provides you with various printing forms with monitored radio
network activity data.

Click the Reports tab (1).

File View Map Tools Help

& Queres o
5 tostoevies

Herizna

5 Systemreports

T Registered Radios
) Unregistered Radios

[JRequiar GGROUP

T Redo stotus
v v
() Veice Dispatch
-2, tocotion Track System reports
T Redistered Radios
& 30b Ticketing [ Unreqistered Radios
T Radio Status
Route 15 ser Connecton Histon
it
[] Text Messages 1 Chennel Changes

& voice Recording
(D Reports

T

Fepe—

[ Connected &3 B € | § Administitor | (28 Licensed to: demo Demo License

| © activer

319



neocom
sofFtware

6.11.1 Report Types

TRBOnet Dispatch Console supports the following report types:

Queries — reports for a selected time period with information on Voice
Recording and Messages displayed as an event log (non-printable format).

System reports — reports for a selected time period with information related
to the radio system activities, in a print-ready format.

Common Reports — reports for a selected time period with information on
Messages, Radio States, User Messages and Notes, Allocated Radios, Disabled
Radios, Job Ticketing, Completed Routes etc., in a print-ready format.

Security Reports - reports for a selected time period with information on
radio activities in selected regions, in a print-ready format.

Indoor reports - reports for a selected time period for movement details for
Indoor Positioning, in a print-ready format.

GPS reports - reports for a selected time period with information on radios
location and speed, in a print-ready format.

Data export - a report for a selected time period with information on
extended notes, generated in Excel or XML formats.

6.11.2 Main Report Parameters

320

To generate a report, go to Reports section and select a report type you want to
generate.

When generating a report, you might need to specify the parameters listed below:

Start Date
Date from which to start reporting.

End Date
Date on which to finish reporting.

Message Type
Select available message types from the drop-down list (All Messages, Talk
Sessions, Text Messages, and other message types).

Radio System
In the drop-down list, select the system(s) to include in a report.

Radio
In the drop-down list, select the radio(s) to include in a report.

Radio Group
In the drop-down list, select the radio group(s) to include in a report.

Logical Group
In the drop-down list, select the logical group(s) to include in a report.

Dispatcher
In the drop-down list, select the dispatcher(s) to include in a report.

Radio ID
Enter a Radio ID or multiple Radio IDs.
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e Find Text
Enter the text to filter by.

6.12 Radio Allocation

The radio can be assigned to a selected employee registered in the system.

All available radios are disabled and an employee will need to type in a username
and password to take and enable the selected radio. When an employee returns the
allocated radio, it gets disabled again.

e Click the Radio Allocation tab (1) to assign radios to users:

File View Map Tools Help

Radio Allocation Radio Allocation EfE
= a o
B =E & [ =S % 1 Line free BIE] Muica Plle]
- | [ B Growe 10 [1][«][@] B8 ¥ Group 20 [«][@] B F sroup 30 [][«][@]
[T 125 (Pete)
e = [private call [][«d[@]
® 35 (Basil) || =L Take/Retun Radio | ), Add Missed Data - rouping '\ Auto Filter € Default Settings
Callsign £ Taken by User Group Vehide Make Plate Number Drivers
i @ Firemen, Folice
@ 125 Firemen
@ Location Tracking @ 222 Firemen, Poice
@ 235 Firemen
ﬁf Job Ticketing @ radio 200 Al
@ Racio 201 Al
- Route Management (® radio 202 Al
@ Racio 203 Al
D RFID Tracker (@ Radio 204 Al
[] Text Messages
@ Voice Recording
==
Event Viewer
@ Radio Allocation ~—— 1
IE Administration
4| 4| ¢ | Record20fg | m|mi| ¢ 3
@ 127001 &3 B | & Administrator | [ Licensed to: demo Demo License @ Active~

e Select the radio in the list and click the Take/Return Radio button (2):

Take Radie X
Radio: [125
User: |Pete ﬂ
Password: | “““ 4
I Take Radio Cancel

= Radio
This box displays the selected radio.

= User
From the drop-down list, select the user to allocate the radio to.

= Password
Enter the password for the selected user.

Note: For more details on user access to Allocation Console, see
section 6.4.20 Users (page 234).
e Click the Take Radio button to assign the radio to the selected user.
The administrator can generate reports on the allocated radios.

e Click the Reports (1) tab, and in the Reports pane, select Common reports >
Radio Allocation (2):
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File View Map Tools Help
Common reports
5 Common rey ports
1: Line fr
5] Messages for Period (P LiLne ree el
[ Jsales [[=[@]
[Jemercency Group  [)][4][@]
g [Jaicat =[]
] nel [Jerowp 1 [2][«][@]
E T ~ Report Settings
L vorce Dispatch Allocated Radios
Saved Profles: ~Not defined— -
@ Location Tracking
Select data by period:
@ Job Ticketing StartDate: 4/26/2017 12:00 AM > e
End Date <Maximum date> ~] [
’ Route Management
Filter:
o Radio: ot defined-—- -
Logical Group: ~Not defined— -
ﬂ‘ Voice Recording Radio ID (e.g. 22,33,40-55,88 )
Reports
b Reo . User. Mot defined~- ~
-ﬁ Event Viewer Grouping:
Group by By radios ~
(7] Radio Allocation 1
% Administration Generate Report. Save Report Profile. Delete Report Profile
[ Connected &3 Y B | € Administrator | (8 Licensed to: demo Demo License @ Active-
6.13 Beacons

6.13.1
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TRBOnet Dispatch Console provides the Indoor Positioning feature to monitor the
location of radios inside a building where GPS signals are not present. The feature
requires additional hardware (beacons located around the building and Bluetooth
modules/option boards installed in radios). A radio unit will be displayed on the
indoor floor plan at the beacon location as soon as the radio enters the beacon's
coverage area. A beacon icon on the map will provide a count of the number of
radios that are currently in this beacon's coverage area (for example, Room 1(3) -
there are 3 radios in Room 1).

Note: To enable the Indoor Location Tracking feature, your license
must include Indoor Positioning (see section 5.1, License
Information) and Indoor Service is selected in the list of available
services (see section 5.9.2, Services).

To enable the Indoor Location Tracking feature, your license must include Indoor
Positioning (see License information page) and Indoor Service is selected in the list
of available services (see Services).

Adding a Floorplan

Click the Location Tracking tab (1), then click Map (2) and choose Open New Map
in Tab:
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©/] ) Firemen

b | e —— R ) o
2w ol O 3
[ ICE ] 2 Group 22 D@l

oice = -

/" My Map
7 (-] Fiter [ @[@[Q] @] 7 [ @] show Beacons: | # Drawing Panel

aaaaa

Select Map.. be i
. . Map Regians
12 t 1 - [ Map Routes
Map Type: Beacon2D \ :.P
o= 111
=
G rob Tcketing . ]
& Avaiable Maps
Route Management
Name path state

0| RFID Tracker

[] Text Messages b

g Voice R i 200m

2 )V 4 5 L
@ Reports. Recent Calls/Events F " |
- [ Playback (o Savi \ uto Filter ’j‘
{5] event viewer Date > Petaiis
09.06.2017 10:39 o v = o = lembers: 235 B
9] Radio Allocation 09.06.2017 10:38: lembers: 125 =
wi|«| <] Record1of2se > [m[mi[ ¢ _"J

E Silsation Recent Cals/E... RecentCals | RequestToTak | RaioState | ActiveTasks | ActiveRoutes | User Actvity | Beacons | Beacon Events | Taglist
(127001 g3 g | § Administrtor | [ Licensed to: demo | @ active-

= Map Type
From the drop-down list, select 'Beacon 2D' to enable 2D floor plan, or
'‘Beacon 3D' to enable 3D floor plan (3).

= Click Add (4), and browse for the required map on your PC.
= Click OK (5) to add the map.
6.13.1.1 Floor Plan Toolbar

The Floor Plan pane's toolbar is located in the upper part of the Floor Plan pane:

)| Shownfo: (Name, Rados ) | Images: (Default + (A Route )| Overview )| Select Map
5 6 g © 7 8 9
I
[Beer o} Zone E —— =
Training Room 4 v
P I \“_ N\
O O L = === @I g
a -

amaw ‘

1. Zoom in/out
Click the Zoom buttons to zoom in/out the floor plan.

2. Default View

Click the arrow beside and choose Save as Default View to save current
floor plan as a default view. The dispatcher can save only one default view.

To open the default view, click the arrow beside and choose Show
Default View.
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3. Set Location
Click the Set Location button to manually set a beacon on the floor plan.

4. Available beacons drop-down list
Select a beacon from the list and click the Set Location button to put the
selected beacon on the floor plan. If you are going to add a new beacon,
select 'New Beacon' from the drop-down list and click the Set Location button
to add a new beacon to the floor plan.

5. Show Beacons
The dispatcher can select which beacon types to display on the floor plan.

= All - all beacons are displayed on the map.

= With Radios — beacons with attached radios are displayed on the map.
= Without Radios — beacons without radios are displayed on the map.

= In Alarm - beacons in Alarm mode are displayed on the map.

= No - all beacons are hidden on the map.

6. Show Info
From the drop-down list, select which information to display for beacons.

7. Images
From the drop-down list, select an image size for beacon icons.

8. Route

= Click Route > Show Route to display a route traveled by the radio for the
selected time period.

Show Route

X

Radio: 125 (Pete) R

From: [15410v-2015 0:00

To: |<Last known location =

Lo L] Lo

Color: [ 105, 105, 105

Optimize Route (group all nearest points)

Cancel

e Radio
Select the radio to display the route for.

e From/To
Specify the time period to show the route for.

e Color
Select a color to display the route with.

e Click OK to show the route for the selected radio.
= Click Route > Play Back Route.
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Pla

Ra
Ra
Ra
Ra
Ra

=l
=l
=l
=
[
=l

yback Route

Radio
dio 240 mobile
dio 240 mobile Tea
dic 240 mobile Coffes
dio 240 mobile Tea
dio 240 mobile Beer

CNOROXC]

Beacon

Date
21-Mov-2016 15:16:48
21-Mov-2016 15:16:54
21-Mov-2016 15:16:54
21-Mov-2016 15:15:58
21-Mov-2016 15:17:03

State

Detected
Lost
Lost
Detected

From:  |21-hov-2016 0:00

To:

Radio 201

Radio 202

Radio 203

Radio 204

Radio 240 mobile
Walt

Select Al

Unselect Al

|<Last known location

Led Lo

Load

1%l

Select the time period to request data for.

neocom
software

Select the radio(s) to request data for. Click Select All to display history
for all radios registered in the system. Click Clear All to cancel radio

selection.

Click Load to load the history.

9. Overview
Click this button to view the entire floor plan.

10. Select Map
Click this button to change the map in the current tab.

6.13.2 Adding a Beacon to the Floor Plan

e Click the Set Location button (1) and then click on the map to point the
location of a physical beacon on the floor.

¢ In the dialog box that appears (2), specify the beacon properties.

Location Tracking

BlEe & 74

© [ Firemen
B ®1s
® 235

=]
ve
ve

File View Map Teols Help

Map

73 1: Line free

Intercom

[2][+][2]

.Gmup 10

-

fd
g

Recent Calls/Events

FF Playback =l Save~ () Print

P aical

erties

Type:
Name:
Major ID:
Minor ID.

Descrption:

Date

09,06.2017 10:39:00
09.06.2017 10:38:54

e

Radio 5|
Capaditf
Capacit]

ol w| (| Record1ofzms b |m

Recent Cals/E... | RecentCalls | RequestTo Talk | Rado State || ActiveTasks | Active Routes | User Activity | Beacons

enersl  |ogical Groups  Cameras

[v][«][2]

iBeacon -

[coffes

q
q

Coffes shop {2nd floor)

nnnnnn

Cancel

aaaaa
p Re
ap Aol
Bge 111
| "]
Filter ’j‘
Jers: 235 8|
ers: 125 .
;IJ

BeaconEvents  TagList

®127001 3 @ | 8 Admin

istrator ‘ 4 Licensex

d to: demo

| @ Active~
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Type
Select the beacon type from the drop-down list (K-Term or iBeacon).

Name
Specify a name for the beacon.

Major ID and Minor ID
Enter the beacon’s major and minor ID exactly as specified on the iBeacon
device.

Or, if a K-Term beacon is being added:

Beacon ID

Enter the beacon’s ID exactly as specified on the K-Term device.
Description

Add a description for the beacon.

6.13.3 Editing Beacon Parameters

e Select a beacon in the Objects panel and double-click to edit its parameters.

File View Map Tools Help

& () onlin

e, GPS Fixed (2) I -
O] s pete) | Q|~$|u‘| —
() ® 235 @asin) Qe v

e @ 7On\me‘ No GPS (1) -

(g New

&4 [¥] [ Map Objects

) [ Abiding piace

¥ [ Fire dep

][] Hospital No2

[ [E Police department No 1

(1) voice Dispatch
ARoute~ | Overview | | Select Map

% Location Tracking &+ [ Map Regions

i !

( [ L | I = | -7 My zone
#« Job Ticketing ‘ I " P =2 migp;:zfls
ot araement [Cottee] N\

Manage: ¥
, ) ot % ‘
5 g 7

D) e tracker { " -
[ ] Text Messages == } “ . = W

Recent Calls/Events ed

e Voice Recording 5 Playback |l Save= () Print | 11 Pause < Clear « ' Reload | [} Filter By Radie | = Grouping

Redpient | Message Detaiis Note

s Date Radio Sy... | Sender
Event Viewer

(£ 21Nov-2016 11:13:21  Capadity... 235 Al

@ Radio Allocation

(0] 21Nov-2016 11:13:12  Capadity... 125 Al
[ 21-Nov-2016 11:13:08  Capacity... 125 Al

@ Administration

|| ¢| Record1of617 k| w | ¢

RecentC... Recent... | Request... RadioSt. | ActiveT..

Al Call from ‘235" (... Members: 235 -

All Call from '125' (... Members: 125

All Cal from '125' (... Members: 125 -
»

ActiveR... UserAc..  Beacons Beacon..  Taglist

127001 &3 B | & Administrator | [ Licensed to: demo Demo License

@ Active~

¢ In the Beacon properties dialog box that appears, edit the desired properties.

Note: For more details on K-Term beacons, see the following
article at
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;lte
mID=36.

6.13.4 Importing Beacons

The administrator can also import beacons from an Excel file (*.xls).

Notes: If the Excel file you are importing from contains two columns
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(Name, Hardware ID), the beacons being added will be
considered as K-Term beacons. If the Excel file contains three
columns (Name, Major ID, and Minor ID), the beacons will be
considered as iBeacon beacons. Also note that the first non-empty
row in the table will be considered as a header row.
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¢ In the Objects panel, right-click the Beacons folder, and on the shortcut menu
choose Import.

# Import Beacons - m} *
Mame +  Hardware ID Type
Bar counter Major: 90, Minor: 100 iBeacon
Gate Major: 90, Minor: 200 iBeacon
Waiters' Major: 90, Minor: 300 iBeacon
Total: 3
Import Cancel

In the Import Beacons dialog box:
= Click Load > Excel.

In the Open dialog box, locate the desired file and click Open.
= Click Import.

As a result, imported beacons will be added to the list of registered
beacons.

6.13.5 Unregistered Beacons

If the radio detects an unregistered beacon, this beacon will appear in the
Unregistered Beacons folder at the top of the Objects pane.

Objects .
ks

LJ |:| | =7 Unreqistered Beacons

' Major: 91: Minor: 2232

LJ IEL_'?Beau Configure geofencing

U W5 Map Show all chjects on the map

BB [ Map

@7 [ Map Hide all objects on map
Add Beacon

P

% Delete object
@' Properties

I

To add an unregistered beacon to the Dispatch Console, right-click it and choose
Add Beacon on the shortcut menu.
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TRBOnet Web Console

TRBOnet Web Console is a special online application. It is an extension for TRBOnet
Dispatch Software which allows dispatchers to get access to the system via a Web
browser. The Web Console is the best solution for carriers, operators and systems
with a huge number of users.

This application allows you to monitor your system without any special software
installed on your computer.

7.1 Installing Web Console

e Click Start>Control Panel>Programs and Features.

. N .
¢ Click the Turn Windows features on or off link.
[0}
e ~ 4 [@ » Control Panel > All Control Panelltems » Programs and Features v || | Sesrch Programs and Features 0
Control Panel Home Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
& Turn Windows features on or
off Organize »  Uninstall/Change = @
Install 2 prograth from the ~
network Name Publisher Installed On  Size  *
4 TREOnet Enterprise 5.1 Neocom Software 21-0ct-2016 s1
() TRECnet Watch 23 Neocom Software 02-5ep-2016 "
< Unity Web Play. Unity Technologies ApS 25-Aug-20. 124
& Unlocker 1.0.2 Cedrick Collomb 09-Dec-2015
[ Visual Studio 2010 Prerequistes - English Microsoft Corporation B-Nov-20..  4°
& Windows Driver Package - Google, Inc. (WinUSB) An... Google, Inc. 22-Dec-2015
¥ Windows Driver Package - Moterola Solutions, Inc. (f... Meterola Selutions, Inc. 18-Nov-20...
= Windows Driver Package - Motorola Selutions, Inc. N... Meterola Solutions, Inc. 18-Nov-20...
& Windows Driver Package - Nokia pecsmcfd LegacyDr. 25-Aug-20.
13 12-5ep-2016
220 (4-bit) . 15-Sep-2016 7
& XnView 2.33 o 07-Sep-2015 162
(@ Cryw6a aBTomaTvecKorD oBHOBMEHNA NPOrpaNM  MailRu 12-5ep-2016
&l Uiermp bl 1 ypoit (Micros.. Matikpocod (Mic...  25-Nov-20.. 37:
15 Aeaosofi naxer Microsoft Visual Studio 2010 Tools .. Microsoft Corporation 03-Nov-20... 146y,
< >
%ﬂ Motorola Solutions, Inc. Product version: 12/16/2013 03.06.00.00
=<
o . o
¢ Go to Internet Information Services>World Wide Web

Services>Application Development Features, and make sure all of them are
selected:

&
Turn Windows features on or off

To turn a feature on, select its check box. To turn a feature off, clear its
| check box. A filled box means that only part of the feature is turned on.

O | Hyper-v ~
Internet Explorer 11
=1 @] | Intemnet Information Services
O | FTP Server
[, Web Management Tools
= @] | World Wide Web Services
2 Application Develepment Features
NET Extensibility 3.5
NET Extensibility 46
Application Initiclization
ASP
ASP.NET 35
ASPNET 46
Gl

\

ISAPI Filters
Server-Side Includes
WebSocket Protocol

e Also, make sure that Common HTTP Features>Static Content is selected.
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[l Windows Features - o X

Turn Windows features on or off (2]

Toturn a feature on, select its check box. To tur a feature off, clear ts
check box. Afilled box means that only part of the feature is turned on

WebSocket Protocol ~

e Restart your PC.

e Click Start>All Programs>Accessories>Command Prompt.

e For 32-bit systems:
Go to This PC>Local Disk (C: )> Windows > Microsoft.NET > Framework >
v4.0.30319/aspnet_regiis.
For 64-bit systems:
Go to This PC>Local Disk (C: )> Windows > Microsoft.NET >
Framework64 > v4.0.30319/aspnet_regiis.

¢ Drag the aspnet_regiis file into the Command Prompt then press the space
bar and add the -i key. Then press the Enter key:
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e Go to Control Panel > Administrative Tools.

e Double-click the Internet Information Services (1IS) Manager shortcut and
double-click ISAPI and CGI Restrictions.

3 nternet ofomation Services (1) Manager o x
T Wy s e - T

fle View Help

Connections Actions.
@) 50142 Home
B KO Filer - ¥ Go - EShowAll | Group by: Area - Manage Server
5 .
i
ings
MachineKey Pagesand  Providers
Controls o
L2

oM =

MMETypes  Modules  Output
Caching

¢ In the Restriction column, set Allowed in all lines.

« 83 5012 » Wehoe-

Fle View Help

U;!l ISAPI and CGI Restrictions

pesitythe 154P1 that can run on the Web server,

Puh
s systermI2\inetrA sep. Al
™

ASPNETV20.5... | Atlows

ASPNET w03 | Allowe

ASPNETv40.3.. | Allowe T
Festores View |3 Content View
Contiguration: localhost applicationtlost cantig 5

e Copy the Web Site archive WebConsole to Computer > Local Disc (C:)
>inetpub to create a folder for the Web Console.

¢ Go to Application Pools (1). Double-click DefaultAppPool (2) and check the
.Net CLR Version (3):

[=
< 3+ 5912 » Apphcaonbools BB e

(RE

Connections. - Actions
- \q! Application Paols .
This page
et sprtemgne © b contiinone.of | Edit Application Poel 7 % —

Go « (G Showdll | Groupby: |

Status NETCIRV.. Monaged Pipel.. | [Otf2uliappPool

r T
IDetaukAppPocl  Stated a0

\
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e Click Sites (1), right-click Default Web Site (2) and choose View Applications

3):

G nternet nformation Services (15) Manager
@ [w, o, sk »

Fle View Help

Connections
- “'Jl Sites
% Fitter:
F Name ©

[@odeurWebste 1

L]
e Click the Add Application link.
e g Applications ‘:M

1 Festures View (3 Content View

e Specify the Alias and Physical path for the application:

Add Application 7%

Site name:  Default Web Site

Path: /
Alias: Application pook:
[TRBOnet o | [pefauttappPoct ] Select..

Bample: sales

Physical path:
[cAwebConsole | E\
Pass-through authentication

Connect as... Test Settings...

[ Enable Preload

oK Cancel

e Browse for the folder with unarchived Web Console.

e Click OK.

This page i i at
ier %o - Gshowan |Groupby NoGrowing -
Virtual Path Physical Path Site. Application Pt

e Select Application Pools (1) and click the Set Application Pool Defaults link

(2):
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b
c 3+ S0+ Asplction Paoks FEEYCE
Vew  Hep
x =
= L, y :
< e /
prication 2
AppeationPocildentty
P
Terminste
Tum
d wakt Ma 1
WiebClent Seup
B Webconsole " Respomse Type
Winld (sl seto Htpleveland s
opped, HTTP sy wil rtur an HTTP 503 er. e o Teptevel, HTTP.
ox Cancel
Ready b

e Set Enable 32-Bit Applications to True (3).

The Web Console will be added as an application to under the Default Web
Site:

Wy intemnet Information Senaces (I5) Manager 0 x
(/7 3 » S0142 » Stes » DefaukWebSie » TREONS » Bah @
Fle View Help
Conmections. Axtions.
- &) /TRBOnet Home
gsn‘uz(Ns\vluhm:hM ~| firer « % Go - (FShowall | Groupby: Ases
5 s e =
- @ 0 ; 4 |l @
S A& > =
NET WNET ANET Errer NET WNET Profile  NET Roles T
Authonizat.. Compilation  Page Globahzation Browse Application
s = ﬁ = s
P2 B DT S
NET Trust  NETUsers  Application  Connecti e
e ol emie @
-
3 !
Providers  Session Sate SMITP E-mil
Festures View | (.3 Content View
Rendy b |

Note: Make sure your account has sysadmin privileges (for more
details, see Appendix B: Configuring SQL Server 2012 for
Local System Account on page 343, and Appendix C:
Granting Sysadmin Role to Local System in SQL Server 2012
on page 346) and the database connection is successful
(see section 5.2, TRBOnet Server Database on page 13).

To open Web Console, right-click your application, choose Manage Application >
Browse.

6y tnternet nformation Sendces 15) Manager 0 x
@ 0 5+ s+ Stes » Defoukt WebSite » TREOnet wxh @
Fle View Hep
Conmections. Axtions.
-~ & /TRBONEL Home
V1| °© -
] sg’wwswwnmm ~l| [ rnes + % Go - (iyShow All | Group by: Ares
ASPNET <
Manage Rpplication
Browse Applcation

@

ey “

TRBOnet Web Console is now ready for operation.
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7.2  Configuring Web Console

e If TRBOnet Server is not installed on your PC, select the application and click
Application Settings:

Gy iternet eformation Senaces 15) Manager 0 x

b Stes » Defaur WebSite » TREOnet + [CRSR -

~ Actions.
& /TRBONEt Home
Fier: = % 6o« Eshowil | Group by: Aren -@- Bl el
Manage Application
Browse Application
@

Festures View .3 Content View

<
Ready.

e Specify the IP address and Port of the PC with installed TRBOnet Server:

' lnternet Information Services (15) Manager 0 x
@ 0 5 142 s St » DefaubWebSite » TREON® » [CRE -
fle View elp
Connections. - o Actions.
- & application Settings
o3 soraz pswaamiche || - .
o o ‘
. X &
. Geoup by No Grouping
Hame o oty e olllhda
Faie Loaal
Local
Local
Goagy Local
) Lol
e To10T009 )
MoSpecdOnRoue 120 Local
Lot
Locel
Locat o

[ Festore Vi

Configuration: Default Vieh Sae/ TREGnet’ weh.config

¢ Right click TRBOnet Web Console and choose Edit Permissions.

N IotemetInformation Senaces 15) Manager 0 ox
@77 5 r 12 » stes s DefaumWebSte r TREONE b W @
e view Hep
Comrctions . Aetions
2 S /TREONet Home e
o 2| Fker « % 6o~ EShowAll | Groupby: Aren il
ASPINET A A - - 2
T e \ ST
MNETEmer  NET  NETProfile NETRoles s =
o Globek  Browse Applcation
T
Key Pages and
Cortroh @

te SMTP E-mail

I3 Swildhto Content View  fntent View

Ready

e Click the Security tab and then click the Edit button to edit permissions:
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WebConsole Properties X

General Sharng Securty Previous Versions  Customize
Object name:  C:\WebClgsale

Group or user names:

B2 Authenticated Users N

S8 5YSTEM

SR Administrators (S0142\Administrators)
B2 Users (S0142\Users)

To change permissions, click Edit. m
Pemissions for Authenticated
Allow

Users Deny

Full cortral &

Maodify

Read & execute

List folder contents

Read

Write v

For special permissions or advanced settings, Advanced
click Advanced.

QK Cancel Apphy

e Select User in the Users list. In the Allow column, select Write:

Permissions for WebConsole X

Security
Object name:  C:\WebConsale

GFDLID Or USer names:

SR Autherticated Users

BR.5YSTEM

S8 Administrators (S0142\Administrators)
BB Users (S0142\Users)

Add... Remaove

Pemissions for MNonesosatent Allow

Read & execute

Deny
O
List folder contents O
O
O

Read \

Witte
Special pemissions w

Cancel Aoly

e Click Apply.
e Click OK.
7.3 Using Web Console
7.3.1 Connecting to TRBOnet Server

e Launch the browser.
e In the browser's address bar, enter the |IP address of the PC with the installed
TRBOnet Web Console, and the path (for example, 70.70.700.99/TRBOnet).

Note: For the path, see section 7.1, Installing Web Console,
IIS Manager>Add Application>Alias

As a result, the TRBOnet Login page will open:
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B3 TREGnet WebConsole X+

)

TRBOnet

Build £3.0.1716

Web Interface

Login

Dispatcher 1

‘ 10.10.100.99/TRBOnet/Account/Login.aspx?ReturnUrl=962f TRBonetgs2f

Password

Connect

eocom
Ftware

3

¢ Login

neocom
SsoOftware

Enter the User Name registered in the TRBOnet Dispatch Console Users list.

e Password
Enter the user password.

e (Click Connect.

Once you have connected to TRBOnet Server, you will see a window like this.

B TREOnet WebConsole X+

€ > 0

TR B 0n et o Web Console

Reports Messages Job Ticketing

‘ 10.10.100.99/TRBonet

Map

Radios

~| () Online, Indoor
B v @ Online, GPS fixed
« @ Radio 25
B v @ Online, No GPS
v @125
v @25
< @ Radio 27
= v @ Offline
s ®13
v @3333
v @ 4444
v [®)555
@) 5555
(&) Radio 300
v (@ Radio 333
~ (®) Radio 3662

Radio 333

Radio 27

3333 beapyem

2

27
Radio 3662

g

‘ Text Messages -
.

7.3.2 Radio List

The Radio List pane is located on the left and contains the list of radios. From this
pane, you can perform the following tasks.

Click the Q button to see the selected radio in the center of the map.

Click the #* button to button to display a route traveled by the selected radio on

the map.
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Show Route: x

- @125

From: 24-Nov-2016 0:00

To: 24-Nov-2016 18:41

g Optimize Route (group all nearest
pints)

Load | Cancel

Specify the From and To date and time. Select the Optimize Route option to group
all points in a 100 meter radius.

Click the " button to request a location of the selected radio.

4
\? 125

Click the o button to display the selected radio properties.

Callsign: 125
Talk Group: Firemen
Radio ID: 125
MDC ID: 0
Equipped with Display: -]
Equipped with GPS Module: ]

Cancel

7.3.3 Locking a radio
To disable a radio:
e Right-click the desired radio in the Radio List pane.
¢ In the shortcut menu that opens, click Lock.

e Enter the Lock reason and click OK.

Note: The dispatcher can disable a radio when they have relevant Access
Rights.

7.3.4 Map

7.3.4.1 Map Layers
e Click the small plus button on the right of the Map pane.
e Choose the map layer to display in the Map pane.

¢ In the Overlays list, select whether to display Regions, Map Objects and Radios
on the map. Just select/clear the corresponding check box.
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[ TREOnet WebConsole X =+

- o
& = 0| i x| =& & -

TB BOn et " web console K] send Text

Map Reports Messages  Job Ticketing

© Dispaicher 1 Logout

Radios [SHEY 'B o | Q
Zerk
Dedis g @ Ozepxi ; Base Layer
+ () Online, Indoer 2 At 2, ® openstreetap Mapnik
=« @ Online, GPS fixed 2 % 3 :0pency:r-~|=-p
N s -t Transport
v] @125 Q| )| (ryf? fe ¥l ‘o ® Landscape
ajour cale ¥ J 2
< @25 Q Ao 3

1=« @ Online, No GPS

@Radio2dom... O A ors L3
= v @ Offine

@ 111 Q| ers| L3

] 2GS B Regions

@222 Q| | e | i map Objects

@ Radio 200 Q A s B

(® Radio 201 Q A ers L = .

. Text Messages -~
s
@radoz02 QA B Google WD BT SOOI e TS KRS ap aTor
D u man A - -

7.3.4.2 Zoom In/Out
e Click the large plus button on the left of the Map pane to zoom in the map.

e Click the large minus button on the left of the Map pane to zoom out the map.
Or:

e Use the mouse wheel to zoom in/out the map.
7.3.4.3 Radio Coordinates and Address
¢ In the Map pane, click the radio you want to inspect.

As a result, a window will appear displaying the coordinates and address of the
inspected radio.

[ TREOnet WebConsole X =+ x

- o
& = 0| i x| =M & -

TRBOnet " web consote <] send Text

Map Reports Messages  Job Ticketing © Dispatcher 1 Logout

5 BEBBEE=E Q
RS 2 2
2, 33 — .
< () Onlline, Indoor o piem .
= () Online, GPS fixed + \ =
32
@125 Q A ors T -_— }
2 2 School number 21
v @23 QA s L Q Spices & Joy Wikonahe 21 &
1=« @ Online, No GPS | 3 235
@Radio20m... Q A ers L3 ||| 7] Date. 25-Nov-2016 13:40:12
B v @ Offine Latitude: 59°56'26.40°N
9 Longitude: 30716'47.89°E |
@ 111 Q A ors L3 Altitude: Unknown ‘
@ 222 Q A o :,;J T-ya liniya, 34, Sankt-Peterburg, Russia, 199034 :‘U%'g o
® Radio 200 Q A es L” jroes
® Radio 201 Q A s £ % [ vasileostrovsk
\ Text -~

® Radio 202 Q&A=& Google

N, A -

T WIBp 08E W20 T5 GOOgIE ¢ T8Mms o7 USE  Report s map &rror

7.3.4.4 Filter Radios

You can filter the display of radios on the map. To do this, use the colored car
buttons at the top of the Map pane.

e Click to remove radios that are online and have a detected beacon

position from the map view. Click this button again to bring them back to be
displayed.
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e Click - to remove radios that are online and have a detected GPS position
from the map view. Click this button again to bring them back to be displayed.

F—
e Click to remove radios that are online and have no detected GPS position
from the map view. Click this button again to bring them back to be displayed.

e Click to remove radios that are offline and have no detected GPS position
from the map view. Click this button again to bring them back to be displayed.

o Click 5 and select the visibility of the radios having On Duty and/or Off Duty
states.

7.3.4.5 Search by address
¢ In the Find Address box, enter the address you want to locate on the map.
e Click the lens button on the right.

¢ In the Found addresses window, click the address to locate it on the map.

™
et " web console <] send Text
Map Reports Messages Job Ticketing © Dispatcher 1 Logout
+ () Online, Indoor = 18 Broadway, Tarrytown, NY 10591, USA P o
lon Cafe
B~ O Online, GPS fixed + 18 Broadway, Somerville, MA 02145, USA
v @125 Q A ors L} — 18 Broadway, Denver, CO 80209, USA
— O 235 Q| o ars| 3 18 Broadway, Denver, CO 80203, USA nited
X 18 Broadway, Bayonne, NJ 07002, USA
£ @ Oniline, No GPS | 18 Broadway, Brooklyn, NY 11249, USA ige
@Radio2dom... O A ors L}
E v @ Offline
@1 Q| ors 3
& 222 Q A os &
@ Radio 200 Q A ers G
(® Radio 201 Q A e £ £
@radozz QMm@ | Goog Em|  SSEms—
P NN ~ - -

7.3.5 Text Messages

With TRBOnet Web Console, you can send text messages to radios/radio
groups/dispatchers.

e Click the Messages tab at the top of the window.
e Click the Send Text button.
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R - o x

E = @ | o w| = BB -

TRBOnet ™ web consote <] send Text

Map Reports Messages  Job Ticketing © Dispatcher 1 Logout
235 All Send Text Message 25-Nov-2016
& 13:40

Y Text
18-Nov-2016
ikzas-w\“ See you 13:53
Y - 3 15
18-Nov-2016
gs-w\n (] 2 222 13:47
151 = | e
LG . 2 Radio 200 i =
[] 2 Radio 201
(] 2 Radio 202
- a ndieman
Send to Offline
Send Cancel

In the Send Text Message window that appears:
= Enter the text of the message.
= Select the radios/radio groups/dispatchers to send the message to.

= Select the Send to Offline option to send the message to offline radios.
7.3.6 Job Ticketing

With TRBOnet Web Console, you can create, assign, and track job tickets through
the radio network.

e Click the Job Ticketing tab at the top of the window.

) TREOnet WebConsole X |+ - o x
S x| == H -
TRBOnet "~
Inet” web console <] send Text
Map Reports Messages Job Ticketing  Dispatcher 1 Logout
[Brdd |[Sede || o fosan || Serche | |
L] Status D T Text Performer Creation Time Start Time End Time Spe
Q a a Q a a a a
4 New #A00017 Get out of there 25-Nov-2016 14:10:25
ErEES %) Assign || g Resend |[ Bk archive || @ cancel l
Status D T Text Performer Creation Time Start Time End Time Spe
Q a a Q a a a a
Assigned #A00007 456 07-Nov-2016 15:38:32
Assigned #A00010 Stop smoking 07-Nov-2016 15:42:27
Rejected #A00014 To be done on %DATE% 07-Nov-2016 16:36:00 07-Nov-2016 16:36:33

In the upper pane, you see the list of created job tickets. In the lower pane, there are
assigned job tickets.

7.3.6.1 Add a Job Ticket
e Click the Add button.
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Text: V Check the pipe
Enable Deadline
End Time: 25-Nov-2016 14 [
Priority: Medium u
e Ticket ID
This value will be set automatically once the ticket has been created.
o Text

Enter the text message in this box.

¢ Enable Deadline
Select this option and in the End Time box, specify a due date and time for
the task.

e Priority
From the drop-down list, select the task priority level.

¢ Comment
Enter a comment for the ticket.

e Click OK.

Once you have added a ticket, it will appear in the list of tickets in the upper pane.

7.3.6.2 Assign a Job Ticket
Select the job ticket in the upper pane, and click the Assign button.

[ Cleaners
I\ Firemen
. Police
@ m
< @125
@ 222
@235
@ Radio 200
® Radio 201
(® Radio 202
(® Radio 203
(@ Radio 204
@ Radio 240 mobile

@ walt

<

OK Cancel

e In the list, select a radio(s), radio or logical group to which to assign the job
ticket.

e Click OK to assign the task to selected radio(s).

As a result, the selected radio will receive the job ticket. The assigned job ticket

will appear in the upper pane.
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7.3.7 Reports
e Click the Reports tab at the top of the window.

[ TRBOnet WebConsole X+ - O x

& 5 0 10m0i00smHOnesaowebnconsoie +

i
w
&

TRBOn et " web console <] send Text

Map Reports Messages Job Ticketing © Di her 1 Logout

T GPS Reports Location for period

T3 Location for Period

T3 Drive Activity Detailed Select data by period:

T Staying in a region Start Date: | 18-Nov-2016 11:21 B

T 1dle time detailed End Date: | 25-Nov-2016 11:21 |2 |
) Commen Reports Fiver:

T%) Messages for Period Radio: | pm

GPS Export
B P Min.Interval: | 0 7 Seconds n

T Location for Period O
Show street names
T Drive Activity Detailed

T Staying in a region

¢ In the right pane, select report parameters and click Generate Report.

Once the report is generated, you will see it in a separate tab of your Web

browser.
[ TReOnet WebConscle B Lecation for pencd x4+ - o x
& 3 O | eroacoseeon - howsreemames-fasesunt-1ssanoate- 1 2 nzieencene [ fr | = 4 O

Location for period
from 18-Nov-2016 11:21 to 25-Nov-2016 11:21

Radio: 125 (Cleaning 1)

Altitude | Accuracy
B e o e e e ey
37 0.0 0 on map

18-Nov-2016 Latitude: 59°56'25.95"N

11:21:29 Longitude: 30°16'47.06"  Unknown

18-Nov-2016  Latitude: 59°56'25.96"N

11:22:29 Longitude: 30°16'47.01"  Unknown 35 210 g on m,
18-Nov-2016  Latitude: 50°56'25.96"N

11:22:59 Longitude: 30°16'47.90°  Uknown 46 0.2 0 on map
18-Nov-2016  Latitude: 59°56'25.96"N

11:23:29 Longitude: 30°16'47.90"  Unknown 37 12 o S
18-Nov-2016  Latitude: 59°56'25.96"N Uk 37 02 0

11:23:50 Longitude: 30°16'47.89"E nknown - on map
18-Nov-2016  Latitude: 50°56'25.96"N

11:24:20 Longitude: 30°1647.89%  Uknown 37 3 2 L
18-Nov-2016  Latitude: 59°56'25.96"N Unkrown 37 0> o on
11:25:01 Longitude: 30°16'47.89"E - anmap
18-Nov-2016  Latitude: 59°56'25.96"N

11:25:29 Longitude: 30°16'47.80°  Unknown 37 o2 2 on may
18-Nov-2016  Latitude: 59°56'26.23"N . - .. .

You can print the report, save it as a file, and so forth.
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Appendix A: SQL Server Edition Considerations

How to select SQL Server ‘

0 - 200 subscriber units 200 + subscriber units
Windows 7, Windows Server 2008 MS SQL 2008 Express MS SQL 2008 Standard
Windows 8, Windows Server 2012 MS SQL 2012 Express MS SQL 2012 Standard
Windows 10, Windows Server 2016 MS SQL 2016 Express MS SQL 2016 Standard
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Appendix B: Configuring SQL Server 2012 for Local System
Account

During installation of MS SQL Server 2012, you can grant the required role to
Windows Local System account in advance. On the configuration setup, click
Database Engine Configuration:

5 QU Server 2012 Setup (=5 Eon ==
Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules [ Server Configuration 1. Data Directories | User Instances | FILESTREAM |

Feature Selection

aaolloteas: Fulcs Specify the authentication mode and administrators for the Database Engine.

Instance Configuration Authentication Mode

Disk Space Requirements @ Windows authentication mode
Server Configuration

| Database Engine Configuration |
Error Reporting Specify the password for the SQL Server system administrator (s3] account.

Mixed Mode [SQL Server authentication and Windows authentication)

Installation Configuration Rules
Installation Progress

Enter password:
ey Confirm password

Specify SQL Server administratars

VM_WIN7_002\admin (admin | 5QL Server administrators

have unrestricted access
Add Current User | M

to the Database Engine.
<Back |[ MNext> cancel | [ Help

Windows Authentication mode

e Click Add to add an additional account to MS SQL Server administrators.

¢ In the Select Users or Groups dialog box, click the Advanced button in the
Enter the object names to select box to find a required user name.

Select Users or Groups
Select this object type:
Users, Groups, or Built-in securty principals Ohbject Types...
From this location:
Erter the object names to select {examples):

| Checlc Names

OK

i

e Click the Find button and select SYSTEM account. Click OK to add the user
and close the window.
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Select Users or Groups

Select this object type:

IUsers. Groups, or Builtin security principals

From this location:

Common Queries |

Hame; [stats wih =] I

Description: IStarts with j I

I | Disatied acoounts
I | Nom expiring password

Object Types... |
IM\TYA Locations... |
Calumtis.. |

Find Now |
Stop |

21xl

Diays since last logon: I 'l

Search results:

57
Cancel

Name (RDN)

| In Folder

]

=]
|

8% 15_IUSRS

£ INTERACTIVE
P

MITYA

A2 NETWORK SERVICE

H OWNER RIGHTS

4% REMOTE INTERACTIVE LOGON
83 restore
HE SERVICE
%so LServer20055QLBrowserlser-SMITYA

MITYA

MITYA

|

[~

Select NT AUTHORITY\LOCAL SERVICE (LOCAL SERVICE):

5 SQL Server 2012 Setup

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules
Feature Selection

Installation Rules

Instance Configuration Authentication Mode
Disk Space Requirements ® Windows authentication mode
Server Configuration _
) Mixed Mode (SQL Server authentication and Windows authentication)
Database Engine Configuration
Error Reporting Specify the password for the SQL Server system administrator (sa) account.

Installation Configuration Rules
Installation Progress
Complete

Server Configurstion | Data Directories | User Instances | FILESTREAM |

=5 Bl =

s for the Database Engine.

Specify the authenticati

Enter password:
Confirm password:

Specify SQL Server administrators

mode and admini

VM_WINT_002\admin (admin)

INT AUTHORITY\LOCAL SERVICE (LOCAL SERVICE)

SQL Server administrators
have unrestricted access
to the Database Engine.

Add Current User | I Add... ] Remove ] /

< Back [ MNext > Cancel [ Help

¢ Click Next and follow the prompts to finish the installation.
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Mixed Authentication mode

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules

Setup Role

Feature Selection

Installation Rules

Tnstance Configuration

Disk Space Requirements
Server Corfiguration

Database Engine Configuration
Error Reporting

Installstion Configuration Rules
Ready to Install

Installation Progress

Complete

Server Configuration | Data Directories | FILESTREAM

Specify the authentication mods and administrators for the Database Engine.

Authentication Mode
=) Windows authentication mode

( @ Mixed Mode (SQL Server authentication and Windows authenticati nni’

Specity the password for the SQL Server system administrator (sa) account.

Enter password:

Confitm password

Specify SQL Server adminsirators

TREOnet-PC\Adminuser SOL Server administrators
have unrestricted access

to the Database Engine.

[ Acdcurentuser | | agd.. | [ Remove |

7
/

[ <ok |[ mets [ concal |[ Hep |

e C(lick Mixed Mode (SQL Server authentication and Windows

authentication).

e Enter and confirm the password for SA SQL user in the Enter password and
Confirm password boxes.

e Click the Add Current User button (unless it is already there).

Note: Once you have added the SA account, you'll be able to use this SA
account to connect to SQL Server with administrator privileges as
an alternative to a Windows user account.
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Appendix C: Granting Sysadmin Role to Local System in SQL
Server 2012

If you have already installed MS SQL 2012, you need to grant sysadmin role to
Local System account in MS SQL Server 2012.

e Run SQL Server Management Studio from the Start menu.

| Microsoft SQL Server 2012 Music
|&| Download Microsoft SQL Server Compac
f:] Import and Export Data (32-bit) Erri
waimte arid port Dats 04 hi
!,_.:5 sS0L Ser'-;'e Management Studio Control E
E
, Integration Services Devices ;
| Motorola
Mntarala Salitinns Mafziil+ €

e Connect to your database instance where TRBOnet database is created.

¢ Go to Security node and select Logins.

Dbyect Exploves -8 X
Conmect 8¢ 3] = J
[Py e wing ooz iLEXPRESS (5GL

(34 Logins

#2hi5_PolicyEveraProcessin
o, =M PolicyTsglExecutionL
| BURLTIN Lsers
& NT ALUTHORITY\SYSTEM
B AT Service\ MSSOLESOLEXRH

& NT SERVICE L rier
8 NT SERVICEWTrengmt
b u
& VM_WINT_D0Fuadmin
7 [ Server Rioles
i [ Credentials
3| 3 Server Objects
3 @ Replication
3 3 Management

e Right-click NT AUTHORITY\SYSTEM login and choose Properties.

¢ In the Login Properties window, select Server Roles and select the sysadmin
check box.
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P Genenl ot ~ Db

H

Server e i used to grant server-wide security pmvileges
** Secursbles
)

fy ok ][ comed ]

e Click OK to add sysadmin privileges to the selected user
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Appendix D: Backing up and Restoring Database and Audio
Recordings

Configure Backup

TRBOnet Dispatch Software has an automatic mechanism for database and audio

recordings backup. Initially, it defaults to two paths to store database and audio
recordings.

For TRBOnet Enterprise:

%ProgrambData%\Neocom Software\TRBOnet.Enterprise\Backups and
%ProgramData%\Neocom Software\TRBOnet.Enterprise\Audio.

For TRBOnet Plus:

%ProgrambData%\Neocom Software\TRBOnet.Plus\Backups and
%ProgramData%\Neocom Software\TRBOnet.Plus\Audio.

For your convenience, the default paths can be changed:

e Open TRBOnet Server and stop the TRBOnet Server service.

Configuration Service

* B A
G Network The TRBOnet Server service is installed
& Redundancy
Database Status: ° Service started
I}) Reports Stop service
LF Service Management X
32 dvanced setings «M@k
)\ Geocoding Servers
.| Radio Networks Uninstall Service
) Digital Systems
L} Services
.ol Repeater 21

- Advanced setti
" Privacy
Slot #1
Slot #2
i..L17 Local Slots
-fligh Control Station #1

E:Viev.' Log Entries Export Configuration Import Configuration

< >

Set Defaults Apply oK Cancel

e To customize these backup folders, on the Configuration pane, select
Database, then select the Specify the path for database archives and Use
custom folder for audio files options. Next, enter the new (custom) folder for
the backup database (for example, C:\TRBOnet\Backup\DB) and custom
folder for the audio files (for example, C:\TRBOnet\Backup\Audio). The
database and audio backups will be stored in the selected directories.

348 TRBOnet Enterprise — User Manual



Appendix D: Backing up and Restoring Database and Audio Recordings

neocom
software

Configuration Database
& Service ~
G Netwark SOL Server: (local)\SQLEXPRESS -
i Redundancy Database: TREORet M
== Database X
ra Reports Authentication: Windows M
{} Service Management Login:

X Advanced settings
)\ Geocoding Servers
I:I Radio Networks

) Digital Systems

Password:

Specify the path for database archives

L} Services Path: C:\TRECnet\Backup\DE

3 Repeater %1 Use custom folder for audio files

L2 Advanced sett

Path: iC:\TREOnet\Backup\Audio
Privacy : = Faceell .______.-—-="'
I Slot #1
a0 slot %2 Test Connection
LI Local Slots Uparade Database -
-fligh Control Station #1
Create Database -
< >

Set Defaults Apply oK Cancel

e Save your changes and restart the service.

Back up Database and Audio Recordings

To back up the database and audio recordings, do the following:

¢ In the Dispatch Console go to Administration (1), and select Database (2) in

the Navigation tree.
e Click the Backup (3) button:

File View Map Tools Help

Administration Database

[ server

{8 License % 1: Line free

2 1ntercom Al Call

&)
[2][«][e]

i
.45} Radio Systems
A5 System Bridging 2
-Ep Telephany

(25 Tacke

Moo

[ ]Private Call

[2][<][]
[][][e]

o || % Backup | “ Schedule

10w 20

Group 30

[»][+][e]

Database Information

L2, tocation Tracking

Server name: (local) \SQLEXPRESS

TREONet

25:00t-2016 16:28:26

MR SQL Sarer 014 (°2) (@3171021) - 120.5000.0 064
Jun 172016 18:1-

Capyright () Mot Corporation

Express Edition (64-bit) on Windows NT 6.3 <X64> (Build 10586: )

Databise name:
3 sadap date:

G 30b Ticketing

Database version:

] Route Management

Data size: 17.23v8

2.77M8

@ RFID Tracker
Audio size:

[] Text Messages

@' Voice Recording
() Reports

{5 Event viewer

[1%] Radio Atlocation 1

/

Fry— -

(127001 &3 @, | § Administrator | [ Licensed to: demo Demo License.

e Specify the backup details:

Database maintenance X

|\_!y Remove old data and shrink database

Path:
C:\ProgramDataNeocom Software \TREOnet. Enterprise\Backups

Backup data

Backup audio

Remave
Remove all data older than date:
Audio files
Data

IlO*JUI*ZO].G - I

Cancel

| @ active-

349



neocom
sofFtware

= Backup audio
Select to back up audio recordings.

= Remove
Select to remove audio files and data from the database.

= Remove all data older than date
Specify the date to remove data older than that specified date.

= Audio Files
Select to remove audio files.

= Data
Select to remove data.

= Click OK to run the backup procedure.
The Backup progress bar will be displayed in the lower-right corner.
1. In a while, a ZIP archive will be created in two possible directories:
For TRBOnet Enterprise:

e The default directory is %ProgramData%\Neocom
Software\TRBOnet.Enterprise\Audio for Audio files and
%ProgramData%\Neocom Software\TRBOnet.Enterprise\Backups
for backup files.

e The custom directory is specified in TRBOnet Server settings.
For TRBOnet Plus:

e The default directory is %ProgramData%\Neocom
Software\TRBOnet.Plus\Audio for Audio files and
%ProgramData%\Neocom Software\TRBOnet.Plus\Backups for
backup files.

e The custom directory is specified in TRBOnet Server settings.

2. The archive includes the database backup file and audio recordings files. The
archive name contains the date of backup. New backup files will be placed in
the same directory.

» Comguter » Local Disk &) » ProgamData » Meocom Software » TESOret Enterprise »

eganize = Include in kbeary ¥ Share with = Mew folde - I

Ml Deskicg B TREOnet Enterprise 21,

i Network
ER Control Panel
& Recycle Bin

o5 8040
| G-

Impartant docs
Pies

SA5Plenet_1 2080
[PR—

|
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For TRBOnet.Plus:

GO

———— . —

. » Computer » Local Disk (C:) » ProgramData » Meocom Software » TRBOnet Plus » Backups »

J| NAT

b

=) Recent Places

B Desktop
4 Libraries
@ Documents
Jﬁ Music
[ Pictures
BE Videos
A A Roman Lapin
M Computer
€ Network
I [E3 Control Panel

Organize = Include in library « Share with + New folder

P Name ’ Date modified Type Size
Bl Desktop | 4) TREOnet Plus_20140528.zip 5/28/2014 7:36 PM Compressed (zipp...
& Downloads
%23 Dropbox

& Recycle Bin

2 100 level 2D map
J 585 roman

| Config_Pics

. CP5.8.0.410

| Dispatcher Actior
Elastix

. Elastix 2.2.0 x86 (t
Floor

| Impertant docs
. Jenkins

| Licences

1item

Restore Database

To restore the database

e Open TRBOnet Server and stop the TRBOnet Server service.

Configuration Service
] A
& Metwork The TRBOnet Server service is installed
@& Redundancy
= Database Status: ° Service started

re Reports Stop service
Service Management
;z Advanced settings + Save changes and restart service

------ )\ Geocoding Servers
El Radio Networks Uninstall Service

..4Z) Digital Systems
-4} Services
3 Repeater #1

X Advanced setti
':' Privacy

1 Local Slots

iy Control Station #1 ,

|z View Log Entries Export Configuration Import Canfiguration
> =

Set Defaults Apply oK Cancel

e Unzip the backup archive and open the folder:

neocom
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Favortes
M Desinep

& Downicads

& Recent Places

B Desinop

Audio
Infetot
TREDe Entefarise bk

LT (pn——

fied: 113 109PM

e Run SQL Server Management Studio Express with sufficient rights to

manage databases.

Geoghe Caroma
Googhe fath
HTMIL Help Wodcshop
Hytern ROR

KT

Frte Codee Pack:

Corfgaration Tools
Mactarola
Wil Formes
s Sattwan
Hoiia PC Suite
POF Edits
Pl sty Pro
Sosom Recarder

4 S0L Server la ruggemesi Studis Exp

o a
inwe whare prevn

Sl

L

e Select Database in the navigation tree (for example, TRBOnet):

Ble [ Yo Dong Tech Bnfow Hep

58

ol | ] ey (5 15 S| 4 S

¢ Right-click the selected database, and go to Tasks/Restore/Database:
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-----

mmmmmm

Comnection

e el
O AN 007 s

imw comnaction gropanin
Progen

Raady
Mty Backup Med

Canesl Help

Select Database backup properties:

¢ In the Destination group, type in or select Database name to back up to from
the drop-down list (for example, TRBOnet).

¢ In the Source group, click Device.

e Click the ellipsis (...) button to select the directory with database backup:

e Click Add and select the directory to which you unarchived the database
backup (for example, C:\TRBOnet\Backup\DB).

3 Select backup devices = ==

“\

([ox J[ coce |[ nee |

Speciy the backup media and &3 location for your restare aperation

Backup media type: Fie -
Backup media

Note: Select the *.bak file type.

e Click OK to add the directory.
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N =llEE
D b backupsst selected to be restared
Sedeta e saipt - | I Hep
2 Genesal
= Fies Source
2P Dptiors
Dotsbase
W Dpice: =
Dutiuse -
Detiatian

Cutagaee TREOEL

Betaeta

5 ekt bachup dedces EREE =

A ————

o i
e "
[—
Satarel ]
[
Conmaction [ ot ]
1 VWK 0D SQLDPIESS
[T 07 i)
i /
Pro oM —
Reasy . .
Cancal Hap

e Click OK.

The database is added to the list of restored databases.

45 Restare Dotshese - TRBOnct S B ==
A fay
Selecta prge Lo - Cyep
= Genenl
o Fles Seurce
# options
[
# Dypice: ¢
Dtabase THBEnet
[R—
Detaiese TRECInE
Bestore e The a2 bachup ok (e, Augst 06, 13112127 | Zmetne.
Raston plan
[ ——
I 3 i
Fvg Datatone il SONSQUEPRESS  TRiGnet 1 MRANT

Conmsction
B VM_WINT 002\ SOLEXPRESS
[VM_WINT 000" ad |
i conneclion progate
Fragena
7)o !
= [ ety B eia |
o= Camenl g

e Select the check box and click OK to restore the database.
¢ In the Configuration pane, select Database.

e From the Database drop-down list, select the restored database.

Configuration Database
@ Service -
G MNetwork SOL Server: |{|oG|}\SQLExPRESS ,|
= Database Database: -
£F Service Management
) Authentication: i
X Advanced settings TREONet Test
'g'g Map Servers for Geocoding Login: TREOnet_Testl
|:| Local Agent e il TREOnet_Test1l
= TRBOnet222
TREOnet22222
| Spedify the path foy
pedfy the Path o o oneta20222 -
P Clsersy . lapin, No\Deskiop \IMportant docs
Use custom folder for audio files
L0 Siot #2
i L1 Local Slots =
L...[] Analog Control Stations ‘I Test Connection l|
E Remote Agents ‘[ Upgrade Database ]|

E Friendly Servers
@8 Internal PEX Server
PR External PBX Server ke

1 Set Defaults 1 |[ Apply ]| |[ oK || |[ Cancel

‘[ Create Database 1|
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e Click Test Connection to check the connection to the database.

e Click Upgrade Database to upgrade the database if the current database was
restored from the database version lower than current.

e Click the Save changes and restart service link.

Configuration Service
Fo ol service ~
G Network The TREOnet Server service is installed
& Redundancy

Database Status: (D servics started

(@ Reports Stop service

L} Service Management )
/ Advanced settings + Save changes and restart service

)\ Geocoding Servers

-| Radio Networks Uninstall Service
: Digital Systems

L} Services

: i Audio Paths
‘.. [A] Analog Control Station:
|55 Remote Agents
5= Friendly Servers

v
? Telephony & [‘T_.j;‘“e"" Log Entries Export Configuration Import Configuration

Set Defaults Apply OK Cancel

Restore Audio Recordings

To restore the audio file:

e Launch TRBOnet Server and stop the TRBOnet Server service.

Configuration Service
E A
G Network The TREOnet Server service is installed
& Redundancy
Database Status: D service started

(@ Reports Stop service

L} Service Management 5 " S rectort -
b i S3VEe CNanges and restart Service
}: Advanced settings v

)\ Geocoding Servers
.| Radio Networks Uninstall Service
() Digital Systems

L} Services

Repeater #1

. Advanced setti

Privacy

Slot #1

slot 22

i Local Slots

I Control Station #1 ,

< o ) View Loq Entries Ewport Configuration Import Configuration

Set Defaults Apply OK Cancel

¢ Go to Database section in the navigation tree and specify custom directory for
audio files (for example, for TRBOnet Enterprise
C:\TRBOnet.Enterprise\Backup\Audio; for TRBOnet Plus:
C:\TRBOnet.Plus\Backup\Audio).
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Configuration Database
§ Service
G Network SOL Server: (local)\SQLEXPRESS -
# Redundancy Database: TRECnet -
E)Database
Authentication: Windows h
@ Reports
ﬂ Service Management Login:
X Advanced settings Ermsrris

)‘\ Geocoding Servers
Radio Networks
E Remote Agents
E Friendly Servers

M Specify the path for database archives

Path: D:\Temp{TRBOnet

78 Telephony ! Use custom folder for audio files
" Data Sources
: D:{Templaudia
$ Modbus TCP Path \rempia
24 Email
) sMs ‘ Test Connection |
[ vicense

| Set Defaults |

‘ Upgrade Database

‘ Create Database

OK | | Cancel |

e Go to the directory you specified to store backup audio files.

e Unzip the backup archive:

|- Computer » Locel Disk [C:)

+ ProgramDats + Nescom Scltware » TREOret.Enterprive b Backups b =4 | seo

Organice = g Open

7 Favoribes

M Deskicp
& Devnieud
i Recent Places

B Desttop
i Libraries
| Documents
ot Muie
o Pictures =
B videes
B Roman Lapn
1 Computer
S Hetweork:
I Control Parel
& Recycls Bin
CPS.B.0.410
Elastix
 Inpoetant docs
. Pics
b SASPlanet_1 2060
e s Bart ™
}l Audic  Dabemodfied S%/2013
Nl Freroider

Include in leary =

L Budia
| infocbt {i
| TRBOnet Entefarise bak
TR TREDret Ere

[T r—— = -
Type
File:talder
Test Document 1KB
Bk File 1509 kB
rRAR T archive

s 2011205007

109 PM

e Copy unarchived audio fil

es to the folder specified in TRBOnet Server settings

(for example, C:\ProgramData\TRBOnet Dispatch Software \Audio):

| v Compuar ¢ Lecal Dk f) ¢ Progumbts » Hescamichwn b TRBOnetEmmpsm + Ao + iyl Sareh v
T ——— = L@
8 Donivack : [F—— &
% Acoem Py
o P § oz
J mzm 28
. h“u:"’ FUET
i Libraries
Y Do o 200z 010 .
T o 200z 018 |
_- o 200z 018
— TR
:v“‘" b mz0e 0017
p c.." = A 0z 020345
- :"" A 0020003 15
L8 3
B0 Contrel Panal e
H Mucycis Bin
b PR
k fincte
[ue——
b i
I SasPtanet 120801
b Womssen My
b o
j &7 tams l

e Click the Save changes and restart service link.
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Configuration Service
o B A
G Network The TREOnet Server service is installed
& Redundancy
Database Status: ° Service started
(2 Reports Stop service
{} Service Management X
34 Advanced settings + Save changes and restart service
)\ Geocoding Servers
D Radio Networks Uninstall Service
Q) Digital Systems

{} Services
Repeater %1
Advanced setti
Privacy
i L. Audio Paths
a Analog Control Station:
52 remote Agents
E Friendly Servers

? Telephony e View Log Entries Export Configuration Import Configuration

Set Defaults Apply OK Cancel

Thus, the audio files will be restored.

Schedule Backups

To set a scheduled backup for the database and audio recordings, do the following:

¢ In the Dispatch Console, go to Administration section and select Database in
the Navigation tree:

e Click the Schedule button:

File View Map Tools Help

Administration Database €4

o e " | W% st free W intercom el Acal Dol
I oatabas: P crou 10 [)][<][@] S Ecrovp 20 [0][«][@] ¥ ¥ Group 20 [][«][@]
g Rado Systems
7 System Bridging [ Jerivat= cal [0][<]
2 Teepnony o || & Backup | S Schedule |
EE‘ Voice Dispatch u Database Iniformation
Server name: (ocal) SQLEXPRESS
tocation racking ot e —
Backup date: 25-Oct-2016 16:28:26
& 2o Ticketng Datzbase version: o SaL Server 2044 692) (93171020 - 2059000 (69)
In 372036 1
Copyright (4 )
] Route Management Evovese Edton (450 on Fivema T 6.3 x> (Buid 10585: )
[Blpme Data sz 2w
Audio size: 22.77MB
[] Text Messages
(2 Reports
Event Viewer
papre—
(127001 &3 B | @ Adminisretor | [ Licensed to; demo Demo License | @ Active-

¢ In the dialog box that appears, specify the Backup details:
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Schedule Database Backup X
I é Configure the database backup scheduler
Iv Enable scheduler
Scheduler: |Database Backup AR
[m] (select Al
Backup data [ acf
; [ ahs
[ Backup audio Dty
|:| Remove |:| qwa
§ ] awerty
B = 0-o=cecacon
oK Cancel

e Enable scheduler
Check to enable the database backup scheduler.

e Scheduler
Click the arrow button on the right, and on the drop-down list select the
required scheduler(s). Or, click the plus button on the right, and create a new
scheduler.
For directions on how to create schedulers, see section 6.4.14, Schedulers.

e Backup data
Check to back up data.

e Backup audio
Check to back up audio recording.

¢ Remove
Check to remove audio files and data from the database.

= Remove all data older than [X] days
Select the number of days to remove all data.

= Audio Files
Check to remove audio files.

= Data
Check to remove data.

e Click OK to run the backup procedure.
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Appendix E: SIP Setup for Motorola Phone System

The native MOTOTRBO phone system is supported in the case of a direct IP

connection to the repeater. MOTOTRBO Phone system is recommended for IP Site
Connect mode.

Note: No extra license per repeater is required for Digital Phone Patch
from Motorola.

TRBOnet Software and Repeaters

TRBOnet Server requires a specific setup for a repeater in the IP Site Connect mode
as well as for SIP in order to make the phone system work properly.

Note: MOTOTRBO Phone System is available for repeaters in IP Site
Connect mode. For a system based on the control stations, use
TRBOnet Phone System.

Launch MOTOTRBO CPS and go to Repeater's General Settings page:

[ MOTOTRAC Customer Programming Software - (Samgle DR3000.cth] T )
[J Fe Em Vew Duie Fasus Rerce Wedw lem s

_ax
0 Lo b M M /] i .
Gy et | Sewrn | Rewt Wb Coes | Bumontn
- © b e — |
General Settings |
n

=
(Gerers Seargs e vew o

The Radio ID of actual repeaters in CPS must differ from the TRBOnet Peer ID.
TRBOnet Dispatch Console acts as another virtual peer repeater with Peer ID (for
example, IPSC network consists of 1 master and 3 peers. The repeaters' IDs (Radio
IDs in CPS codeplugs for repeaters) in this case would be 1, 2, 3, 4. The TRBOnet
Peer ID must differ from all the repeaters (the master and all peers, otherwise a

conflict will happen in the network as peers have the same ID). The TRBOnet Radio
ID is 64250.

e Open TRBOnet Dispatch Console. Go to Administration (1), Telephony (2),
Radio calls configuration (3) — Configure (4) and set DTMF Access and
DTMF Deaccess codes (5) to 0 and #, respectively:
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File View Maop Tools Help

Administration Telephony

i (] Database
il Radio Systems
i System Bridging

Virtual Mocbus Devices
Event/Alarm Management

Repeater #1: Slot #2

" Configure Calls | Extensions | RedrectCals [ Aliases [ Profiles

HEE

Alow subseribers to make outgoi

ks Allow to use DTMF:

Allow to use Text Messages:

Radio calls configuration +——— 3

ing calls: Yes

Yes, Prefix: 'sip:’

Backward call to radio:

Initialize call to radio:
Initialize call tmeout:

Execute Check Radio before cal
Send Text Message if cannot ef

Play tone when PTT changed:
DTMF Access code:

DTMF Deaccess code:

| Configure

Incoming calls configuratio

Call to Dispatch Center:
Call to external number:

Extension numbers (voice

Radio calls configuration

IV fliow subscribers to make outgong cais;
[V Allow to use DTMF
[V Allow to use Text Messages
Prefix:
Play the incoming call tone on the radio:
Tnitialize call to radio:
Initialize call tmeout:
[~ Execute Check Radio before call
|¥ Send Text Message if camnot establish call

|¥ Play tone when PTT changed

nlirited = seconds

Start call automaticaly:

DTIF Access code:

= Maximum number length:
: Dumber DTVF Deaccess code: =
0
(4 1 <unber> Lo | co |
@ Administration | Cenfigure

127007 B B @| & Administrator ‘ [ Licensed to: demo Demo License

Programming Radios
A special setup is required for radios in MOTOTRBO CPS.

e Read a subscriber's radio in CPS and go to Phone > System (1):

B MOTOTRBO Customer Programming Software - [Untitled1] - O X
File Edit View Device Features Remote  Window  Help -8 %
F & @ ¥ | & B Q

RM | Open Save

= b 192.168.11.1 -
Cut Copy Paste | Search | Read Wrte Clone | Bluetooth
B @8 Signaling Systems

~
il User Defined 5 To Sys L

Reports | Delste

B8 5Tone Too  DIME
..... il sy
- @ Moc Gateway 1D lﬂ'\
- Sy 2
B & Quik-Cal Il Access Cose o
e 3= e
El- @ Digital Emergency
-----
E)- @8 Capacty Puus Eme
- ) es tg3 Pretime (ms) lﬂ
= ﬁ Pl(;?n;,s1 4——-"” 1 TX Tone Duration (ms) 129 3:
O 8 Enceder -
D seus TX Tone Interval (ms) lﬂ
B @8 Sequences Pause Duration (ms) m
..... asa Seq1 .
< >

[ o]

|Expert view |

e Make sure that Gateway ID (2) is equal to repeater Slot IDs in TRBOnet Server
as well as to TRBOnet Peer ID in TRBOnet Server.

e Set DTMF Access Code to 0 and DTMF Deaccess Code to #, respectively (3).
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/®

[ Fm EM Vew Devce  Fasme  Reschs  Wdow  Hey
w d 3 % 2
Com Sevn | Facors | Dawie | G Comy Paaie
Search enfanced

A SPECIALOPS
n§ SOFFICERA
n§ SOFFICERE

e

Dusl Capaciy Diewci Mase [~

Channel1
m B I8

woice Breunceret e [ 1 |

ST | Il
smmoem et fiom o]
amsan [0
= e | 2
RepetecTime skt [7
Pone Sysien -
A [Dmamed -

Eshanced GPS [
= "

Phone System

. Seiecing

Motes

mhmwmwwﬂmwm anly.
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¢ Go to Repeater/Channels (1) and specify the phone system you have set up

(2):
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Appendix F: NAI VOICE & DATA Support
TRBOnet Dispatch Software supports MOTOTRBO Network Application Interface
(NAI) VOICE and DATA.

NAI protocol allows operating with MOTOTRBO Capacity Plus and MOTOTRBO
Linked Capacity Plus repeaters over IP (Wireline Dispatch Console).

Voice Repeaters must have NAI VOICE and NAI DATA license activated. Data Revert
repeaters must have NAI DATA license activated. A repeater must have 32 Mb
memory.

Software Requirements

Server Computer ‘ Dispatch Computer ‘

TRBOnet Server installed

MOTOTRBO Network Interface Service (MNIS)

MOTOTRBO Device Discovery and Mobility Service TRBOnet Dispatch Console installed
(DDMS)

MS SQL Server 2008 R2 or higher
(can be installed on remote server)

Hardware Requirements

Server Computer Dispatch Computer
CPU Intel Core i7 or higher Intel Core i5 or higher
Memory 3GB 3GB
Multi-channel Sound Card required.
Recommended:
Sound Card — 1. M-Audio Delta 1010 LT

2. Roland OCTA CAPTURE Hi-SPEED USB
Audio Capture

Windows 7/8.x/10

Supported OS Windows Server 2008/2012/2016

Windows 7/8.x/10

Additional devices | — Microphone and speaker (headset)

Note: It is possible to use a virtual machine as a Server computer.
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Voice and Data Flow 1

TRBOnet Voice and Data flow for NAl is represented on the following scheme:

[ ]
o)
TRBOnet Server PC
(]

MS SQL Server

LB

TRBOnet
Server

Dispatcher

MNIS
(Data
Geteway)

DDMS
(Presence
Notifier)

Voice and Data Flow 2
MNIS is responsible for sending/receiving Data Packages and forwarding them to
TRBOnet Server.

DDMS (aka Presence Notifier) is responsible for ARS and notifies TRBOnet Server
when a radio is turned on/off. For more details, see NAI_RM_Training_v02.pdf.

All the repeaters in all sites should be available for TRBOnet Server, which normally
requires Port Forwarding rules on routers. For more details, see MOTOTRBO Linked
Capacity Plus (LCP) - HP MSR 20-20 Router Configuration Guide.

Single PC Installation

TRBOnet Server and Dispatch Console can be installed on the same computer.

LCP/Cap+ System

222 g

Client and Server
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Client-Server Installation

For the systems with 2 and more dispatch positions, it is recommended to have a
dedicated server computer (could be a virtual machine).

Dispatcher 1

LCP/Cap+ System

TRBOnet
Server

Dispatcher N

One TRBOnet Server and up to 30 Dispatchers.

TRBOnet Server and all the LCP sites must be in different networks, behind
corresponding routers:

Site 1, Network 1

E Site 2, Network 2
[ |

TRBOnet
Server
Network 0

Site 3, Network 3

Use the recommended Routers only.
Notes:

e One TRBOnet Server computer is for one LCP System.

e Itis possible to connect two or more LCP systems (System Bridging).
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e TRBOnet System Bridging supports Group and Individual Calls.

e |tis possible to use a Virtual machine as a Server.

LCP/Cap+ System 1
[ ]

LS00

TRBOnet

Server
E i
PN %
Dispatcher
LCP/Cap+ System 2
Swift.Agent
for System 2
Limitations

¢ Logging of Radio-to-Radio TEXT is NOT SUPPORTED.

e Phone Interconnect available with some limitations. For more details, see the
following article at
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ltem|D=53.

e Local Talk Group IDs must be unique per system.
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Radio Subscriber Configuration

Network Settings
= 8 =
| s
@ Accessories Top RadioNetwork Services ControlStation |PSiteC
EB Buttons

i Bluetooth Bluetooth Serial Port Profile Data Routing  USB HIC
i
! 'ﬁ Menu

f ARSRadolD [eas0 =

ARSIP 130250250

ARS UDF Fort |4005 3
Gmsmmn |5425ﬂ 3 )

TMSIP 130260250

TMSUDPPort [ago7 =]

) sys: User Defined UDP Fort | [Disabiea =
E- @8 Digtal Em
i sys- User Defined UDF Fort 2 ||:>‘satm E
= @8 Capacty -
T oy User Defined UDP Port 3 [Disabied =
= @
[T
= ﬁam;wws Voice Only [~
= @ Sequence (MSMMMQID | 3 )

ARS Monitoring 1P 0.0.0.0

& p— = Personality_1
f *‘Lls‘t‘l

El & Channeis Top RX IX
£ @ Zonet
{.‘ Personaity_1 Voice Announcement File INW j
= 1 Channel Pool — -
; On System/Site Change | ™
1 Voice_Rep_1 C l n System/Site Change j—>
-  Data_Rep_Siot_ Privacy [

----- o Data_Rep_Siot_ )
> @& mﬂ Privacy sies [prvacy Key! |

i - Z st RAS Alias | None -
7 @ Roam i
e_, List! Option Board [
S @8 Capacity Pus Lone Worker [
- @ voice _
LD D st Messaging Delay (ms) Iso_a
=- & Data (Compressed UDP Data Header v >
[ b ustt
i futo Roam ¥

Site List | List -
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Personality Settings - 2

v =
E - Phone
- §y can
& RXGroup Lists
E- @ Ogta
L 44B Lst
El- @ Cspacity Plus
L §8B Listt
@& Channess
|;| & Zonet
| (’. Personaity_1
E- @ Channel Pool
- voics_Rep_
-~ Data Rep_Sot_
1 Data_Rep_Siot_

MNIS and DDMS Settings

General Settings

I T

(e 3
(anuwmm e = )

vox [0

Power Level ||’UQ’| vl
TOT (sec) |50 H_

TOT Rekey Delay (sec) |U H.

Hiow Interrupiion [
TX Intesruptible Frequencies [

(MNM |cotoe Code Fres 3

In Cal Crteris. {Fotow At Critzria |

RSS! Threshold (dBm)  [FEgI=

Private Call Confirned [~

Data CallConfirmed [~

MOTOTRBO Network Interface Service Configuration Utility -- MNIS Restart Required 2' i [u] ll

Configuration  View Edit Service Help

-

©coe

- B Forwarding Rules
- BB Application Overi

System Operation Mode | Linked Capacity Plus [~

( MNIS Application ID 64250 3: }

Qws IP Address 192 168.10.76 )

Tunrel IP Address  152.168.10.77

Subnet Mask  255.255.255.0

/®
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Talk Group Settings

Configuration  View Edit Service Help

NDrHOCO®

Group List Type |Capac¢y Plus/LCP vI

C Ao ® D
S e B
[} <#: Linked Capacity Plus
| L Stes [ [FstcaliD | Last Call ID
=} @ Advanced
2 Network

&) Forwarding Rules
-~ Application Ovemc

Master Repeater Settings

MOTOTRBO Network Interface Service Configuration Utility - MNIS Restart Reg
Configuration  View Edt Service Help

N )L HOCO®

Master |P Address |IIJ.II]955
Master UDP Port |5m11 3:

MNIS LE Pot | % Automatically Assigned

' Manualy Assigned [None =

Authentication Key
() Forwarding Rules
- Application Overic
Privacy Setting INW—H
LCP Sites Settings
MOTOTRBO Network Interface Service Configuration Utility -- MNIS Restart Required Y= NS =] 5|
Configuration  View Edit  Service Help
@ LCP_Test
- [ General
- g Seourty ad | peee |
= @ Group List \‘
e T [sten Group List Outbound Data Limit
5@ C ) 1 List1 =2
- L3 Doman1 T List1 =2 )
- @ Capacty Pus ~
] ;8 Linked Capacty Plus
_<cEd
= @ Advanced
- 2 Network
- [ Forwarding Rules
Application Overic
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/®

Advanced Settings

MOTOTREO Network Interface Service Configuration Utility — MNIS Restart

of -Iofx]

Configuration View Edit Service Help

4
LCP_Test
8 Genersl
I Security
= @8 Group List
[T Y
~ &8 Conventional
| =& Doman 1
@@ Capacty Plus
5} < Linked Capacity Plus
| g B Sites

e

ﬁ‘i,- Network

0@
( Data Call Confimmed

@mnreeud UDP Dta Headsr

T
U\

= <

Battery Saver Preamble

2

Indrvidual Data to Registered Site

TX Preamble Duration fms)  [150

Conventional Channel Access |P—an'|al vl
& Forwarding Rules
Application Overic
MNISLEID & e MNiS 1D
' Manually Assigned None ]
.
Network Settings
% MOTOTRBO Network Interface Service Configuration Utility ™ - [m] x
Configuration  View  Edit  Service Help
= @ Untiled
General
- e Securty CAlNetwore  [12 |3
B @8 Group List
li List1 CAl Group Networke 225 |+
£ @ Conventional
- %=H Domain 1
% Capacty Pin ARSUDFPot [a005 1=
() <;#: Linked Capacity Plus
= @ Advanced TMS UDP Port 4007 =

# 2

- [Ep Forwarding Rule
Application Oven|

DDMS Settings

Telemetry UDP Port (4008

| 4

Location Server UDP Port 4001

Battery Management UDP Port 4012

G

User Defined UDP Port 1 Disabled

User Defined UDP Port 2  Disabled |3
User Defined UDP Port 3 Disabled |2

XCMP Enable  []
XCMP Server UDF Port 4004 =

ARS Moritor [

ARS Monitor ID [Nens

( Server Address ) (127001
o

The DeviceRefreshTime parameter defines how often radios should send ARS to
TRBOnet Dispatch Software. The value depends on the number of radios and

channels.
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o
e Ackn Hep
OEIEs H Y
Servce:
EFNY htefaces
'3 MRS Setings
B Watcher Settings
{ Logong
DeviceRefrech Time
Device Registration duration in minutes. rounded up to the nearest 30
mindz nterval Range: 0- 6460 orever)
Setings for 4RSS interface

ARS TRBOnet Settings

Configuration
f Service
G Metwork
@ Redundancy
Database
‘f% Reparts
{:} Service Management
X Advanced settings
A Geocoding Servers
B Radio Networks
% Remote Agents
E Friendly Servers
@ Telephony
k Data Sources
4 Email
BB sms

E License

Set Defaults

Service Management

Presence service

Auto request presence timeout: 5 minutes

AF 4

ARS refresh interval: 1440 minutes

[ 1gnore unregistered Radios

Location service

GPS restart by inactivity timeout: |5 minutes

Ab 4K

Dispatch Console update interval: | 1 seconds

m Automatic error correction
Configure
[] send the latest GPS data to dispatchers on alert

For the last: 10 minutes
GPS points:

Telemetry service

[ Request for the status of GPIO when a radio unit is powered on

Text Messaging service

Version: 5.3.0.1661

Text Message Format: Sender and Text -

Max. message length: 140 + chars

|1 5plit long message into multiple messages
Indoor service
| Remove offline radio from beacon

[ 1gnore beacon position on alarm if GPS is fixed {only K-TERM)

Apply Ok Cancel

¢ Auto request presence timeout

Set this parameter to the value of the DeviceRefreshTime parameter in

MOTOTRBO DDMS.

e ARS refresh interval

Set this parameter to the value of the PersistenceTO parameter in

MOTOTRBO DDMS.
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LCP Repeater Settings

Configuration Repeater #1
& Service -~
5 Network System Name: Repeater #1
¢ Redundancy TREOnet Peer ID: 100 3
batabase TREOnet Radio ID =
!,% Reports net Radio ID: 54250 -
£F Service Management TRBOnet Local Port: 50000 -
X Advanced settings Master Repeater Connection Info:
/N Geocoding Servers Master IP Address: 10,10, 102,131 -
D Radio Networks
0 Digital Systems Master LDP Port: 50011 : Test
{} Services Authentication Key: 99999
3 Repeater #1 i -
H System Type: iLinked Capacity Flus -
Advanced setti i b
. Privacy System Identifier:
00 Audio Paths Use NAT Voice
- [ Analog Control Station: Use MAI Data (MNIS and DOMS)
52 remote Agents o
) Use RCM for control radio activity
E Friendly Servers
‘&R Telephony W
£ >
Set Defaults Apply OK Cancel
Special settings:
e TRBOnet Peer ID - any unique value.
.
e TRBOnet Radio ID - the default TRBOnet ID.
¢ TRBOnet Local Port — any free port on the PC.
.
Audio Paths
Configuration Audio Paths
G Network — ”
r Loadbroups Map
& Redundancy el el
Database Call Type Group ID Site ID
(2 Reports ]| Group call 10 Wide
{:} Service Management w1 Group Call 20 Wide
X Advanced settings K] private Cal
)\ Geocoding Servers ‘f all call
[] Radio Netwarks
..{Z) Digital Systems
L} Services
g IP Site Connect
; Advanced setti
L} DDMS service
L} MNIS data ser,
H X Advanced :
L. Audio Pams/
Control Station #1
fad v Add Delete Configure
< >
Set Defaults Apply oK Cancel

Special settings

e Load Groups from Master Repeater;
e Add Local Groups manually.
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Appendix G: Redundant Server

The TRBOnet Server supports a backup configuration which allows seamless
switching from the primary to redundant server in the case of failure of the primary
server. The Dispatch Console operation will not be interrupted.

Redundant configuration overview

] T~
LR AN
N
\
TRBOnet Dispatcher |
!
/
/
/
I
|
j H tbeat ti D ._
-‘/N = ] eartbeat connection = ]vﬂ
—_— SN [FEESSY —
MS sQL TRBOnet TRBOnet MS SQL
Database 1 Primary Server Redundant Server Database 2

e Primary and Redundant Servers are configured identically.

e Redundant Server is operating in PASSIVE mode (ARS confirmation disabled,
Geofencing disabled, and other settings).

e Redundant Server is monitoring Primary Server status.

e Dispatch Console is connected to Primary Server.

¢ In case of Primary Server failure:
= Dispatch Console connects to Redundant Server automatically.
= Redundant Server becomes ACTIVE.

e Once failed Primary Server is back online, Dispatch Console is to be forcibly
reconnected to Primary Server.

e Primary and Redundant Servers do not exchange any data.
TRBOnet Redundant Server Configuration

¢ In the Configuration pane, select Redundancy.
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Configuration
q Service
0 Network
¢
Database
(2 Reports

Redundancy

W] Redundant server mode
Redundancy Mode: Passive

Main servers:
IP Address

L} Service Management

)’ Advanced settings
------ )\ Geocoding Servers
@ Radio Networks

3| Remate Agents

=l Friendly Servers

ﬁ Telephony

i}’ Data Sources

332 Modbus TCP

=4 Email

[ 5MS

E License

1 M 10.10.234.162 4021

Add Edit Delete Test A |V

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, select Redundant server mode.

¢ Redundancy Mode
Select the mode for a redundant server from the drop-down list.

e To add a primary server, Click Add.

Server Properties >

IP Address: | 10.10.234.152|

Port: 4021 s

OK Cancel Test

o |IP Address
Type the IP address of the primary server.

e Port
Enter the same port number as specified for the Command port.

Passive Mode

In the Passive mode, the Dispatch Console is connected to the primary server. In
case the primary server crashes, the redundant server gets connected to the radio
system and then starts recording to the database (Database 2). The Dispatch
Console automatically connects to the redundant server. After the primary server is
recovered, the Dispatch Console will disconnect from the redundant server and
reconnect to the primary server.

Active Mode
Alternatively, in the Active mode, the redundant server is always connected to the

radio system and records to its database, thus duplicating the primary server's
database (Database 1).

The Active mode has some limitations that are outlined in another section (see
section Restrictions for Active Reserve Mode on page 374).
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Restrictions for Active Reserve Mode

e Go to repeater settings and make sure that TRBOnet Peer ID of the redundant
server differs from the one set for the primary server. Each TRBOnet Server must
have a unique peer ID in the radio system:

Configuration Repeater #1
o service 2
G Network System Name: Repeater #1
@ Redundancy TRBOnet Peer ID: 100 =
Database -
e Reports TREOnet Radio ID: 64250 -
re
-

{} Service Management TREOnet 50000
X Advanced settings

N Geocoding Servers
I:I Radio Networks

er Repeater Connection Info:

Master IP Address: 10.10.102.131 hd

0 Digital Systems Master UDP Port: 50011 -
{:} Services Authentication Key: 99999
p
Al System Type: IP Site Connect A
Advandli] settings
System Identifier: Departmentl

2| Privacy
I Slot #1
LI Slot #2
1 Local Slots
- gigy Control Station #1
@ Analog Control Stations
E Remote Agents
E Friendly Servers W

Use MAI Voice
Use MAI Data (MNIS and DDMS)

Set Defaults Apply 0K Cancel

Dispatch Console Configuration

To add a server to the list of servers:

e Launch TRBOnet Dispatch Console to open the Connect to TRBOnet Server
dialog box, or on the File menu, click Connect to TRBOnet Server.

Connect to TREOnet Server X
Connect to:
Address: 127.0.0.1 v|
Port: 4021 = Configure
Authentication:
Method: TRBOnet Authentication ~
User Name: |admin ’ ‘
Password: | “““““ ‘
D Connect on startup
Cancel

e Click Configure to register the new primary server:
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S Add = Edit | S Delete ‘

Server Label Server Address Port

Servel 10.10.164.45 4021

Server Register TRBOnet Server x
Label: |Server 3
Address:  [127.0.0.1
Port: 4021 S

Redundant servers:
| | Address Port

Delete i
Cancel

= (Click Add to add a new TRBOnet Server:

Label — enter a name for the new primary server.
Address — enter the primary server's IP Address.
Port — specify the command port of the primary server.

Add - click and specify the IP address and port of the redundant
(backup) server for the primary server being registered.

Click OK to save settings and close the dialog box.

Console Connection to Primary and Redundant Servers

¢ Go to File > Connect to TRBOnet Server, and from the drop-down list select
the primary server you created:

Connect to TRECnet Server X
Connect to:
Address: |m |u
Serverl
iz Server2
Authentication:
Method: TRBOnet Authentication ~

User Name: |admin |

Password: | ========== |

[] connect on startup

e Click OK to connect to the primary server.

Now you are connected to the primary server. In case of a lost connection to
the primary server, the Console will try to restore the connection within 30
seconds. After 30 seconds have passed, the console will change connection to
the redundant server automatically. When the primary server is restored, the
Dispatch Console will reconnect to the primary server automatically.
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